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Every effort was made to ensure that the information in this document was accurate at 
the time of release. However, information is subject to change without notice, and Viavi 
Solutions reserves the right to provide an addendum to this document with information 
not available at the time that this document was created. 
 

© Copyright 2015 Viavi Solutions Inc. All rights reserved. No part of this guide may be 
reproduced or transmitted, electronically or otherwise, without written permission of the 
publisher. Viavi Solutions, the Viavi logo, CellAdvisor, RANAdvisor TrueSite, StrataSync, 
and EZ-Cal are trademarks of Viavi Solutions Inc. (“Viavi”). All trademarks and 
registered trademarks are the property of their respective companies. 
 
Google Maps and Google Earth are either trademarks or registered trademarks of 
Google in the United States and/or other countries. 

 
Bluetooth is a trademark or a registered trademark of Bluetooth Special Interest Group 
(SIG) Inc. in the United States and/or other countries. 
 
Android is a trademark or a registered trademark of Google in the United States and/or 
other countries. 
 
iOS is a trademark or a registered trademark of Apple Inc. in the United States and/or 
other countries. 
 
Windows and Windows 7 are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries. 
 

Reproduction and distribution of this guide is authorized for US Government purposes 
only. 
 

This document is a product of Viavi’s Technical Publications Department, issued as part 
of the JD700B Series. The catalog number for a published manual is JD700B362 - 
printed. The catalog number for an electronic manual on CD-ROM is JD700B361 - 
electronic. 
 

The JD700B Series includes third party software licensed under the terms of separate 
open source software licenses. By using this software, you agree to comply with the 
terms and conditions of the applicable open source software licenses. Software 
originated by Viavi is not subject to third party licenses. Terms of the Viavi Software 
License different from applicable third party licenses are offered by Viavi alone. 
 
This product incorporates open source software entitled “zlib”. The zlib is the 
compression library written by Jean-loup Gailly and Mark Adler, who granted permission 
to use this software for any purpose, including commercial applications. 
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This product includes open source software developed by the Apache Software 
Foundation (http://www.apache.org/). 
 
This product used free library for JPEG image compression written and distributed by 
Independent JPEG Group or IJG (http://www.ijg.org/). 
 
This product used free, open-source JavaScript library entitled “jQuery”. It is licensed 
under the MIT License (http://jquery.org/license/). 
 
This product used open source software entitled “Libpcap-1.3.0”. The Libcap-1.3.0 is the 
portable packet-capturing library developed by TCPDUMP (http://www.tcpdump.org). 
 
See “Viewing OSS license” on page 41 for more information. 
 

Specifications, terms, and conditions are subject to change without notice. The provision 
of hardware, services, and/or software is subject to Viavi’s standard terms and 
conditions, available at www.viavisolutions.com/en/terms-and-conditions. 
 

This product was tested according to UL 61010-1:2012 and CAN/CSA C22.2  
No. 61010-1-12. Conformity with these requirements is based upon compliance with the 
standard IEC 61010-1. A copy of the Declaration of Conformity is provided upon your 
request. 
 
Ce produit a été testé selon la norme UL 61010-1 : 2012 et CAN / CSA C22.2 No. 61010-1-12.  
La conformité à ces exigences est fondée sur la conformité à la norme CEI 61010-1. Une copie 
de la déclaration de conformité est disponible sur demande. 
 

This product was tested and conforms to the EMC Directive, 2004/108/EC and its 
amending directives for electromagnetic compatibility. Conformity with this directive is 
based upon compliance with the harmonized European standards: EN61326-1 and 
CISPR11. A copy of the Declaration of Conformity is provided upon your request. 
 

This product was tested and conforms to the Low Voltage Directive, 2006/95/EC and its 
amending directives. Conformity with this directive is based upon compliance with the 
harmonized European standard EN61010-1. A copy of the Declaration of Conformity is 
provided upon your request. 
 

Viavi has established processes in compliance with the Waste Electrical and Electronic 
Equipment (WEEE) Directive, 2002/96/EC, and the Battery Directive, 2006/66/EC. 
 
This product, and the batteries used to power the product, should not be disposed of as 
unsorted municipal waste and should be collected separately and disposed of according 

http://www.ijg.org/
http://jquery.org/license/
http://www.tcpdump.org/
http://www.viavisolutions.com/en/terms-and-conditions
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to your national regulations. In the European Union, all equipment and batteries 
purchased from Viavi after 2005-08-13 can be returned for disposal at the end of its 
useful life. Viavi will ensure that all waste equipment and batteries returned are reused, 
recycled, or disposed of in an environmentally friendly manner, and in compliance with 
all applicable national and international waste legislation. 
 
It is the responsibility of the equipment owner to return equipment and batteries to Viavi 
for appropriate disposal. If the equipment or battery was imported by a reseller whose 
name or logo is marked on the equipment or battery, then the owner should return the 
equipment or battery directly to the reseller. 
Instructions for returning waste equipment and batteries to Viavi can be found in the 
Environmental section of Viavi’s web site at www.viavisolutions.com. If you have 
questions concerning disposal of your equipment or batteries, contact Viavi’s WEEE 
Program Management team. 
 

http://www.viavisolutions.com/
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The purpose of this guide is to help you successfully operate the JD700B series (firmware version 3.060 and 
later) and use its features and capabilities. This document includes instructions that describe how to operate, 
set up, configure, and use the JD700B series, consisting of JD785B/JD745B Base Station Analyzer, 
JD786B/JD746B RF Analyzer, and JD788B/JD748B Signal Analyzer. 
 
Objectif et champ d'application 

Le but de ce guide est de vous aider à utiliser avec succès la série JD700B (version du firmware 3.060 et plus tard) et à 
utiliser ses fonctions et capacités. Ce document contient des instructions qui décrivent comment utiliser, créer, 
configurer et utiliser la série JD700B, composé de JD785B/JD745B Base Station Analyzer, JD786B/JD746B RF 
Analyzer, et JD788B/JD748B Signal Analyzer. 
 

This guide is intended for novice, intermediate, and experienced users who want to use the JD700B series 
effectively and efficiently. We are assuming that you have basic operation experience and are familiar with 
basic mobile communication concepts and terminology. 
 
Hypothèses 

Ce guide est destiné aux débutants, intermédiaires et les utilisateurs avancés qui veulent utiliser série JD700B efficace 
et efficiente. Nous supposons que vous avez une expérience de base du fonctionnement et êtes familier avec les 
concepts de communication mobile et de la terminologie. 
 

It is mandatory to permanently connect this product to the protective earth. 
 
When supplying power to this device, always use an AC power cable that includes an earth (safety) ground 
connection. 
 
Informations de sécurité et de conformité 

Il est obligatoire de se connecter en permanence ce produit à la protecteur terre. Lorsque alimenter en énergie cet 
appareil, utilisez toujours un câble d'alimentation secteur qui comprend une terre de sécurité. 
 

 

WARNING 
Do not attempt to service this product yourself, as opening or removing covers may 
expose you to dangerous voltage and other hazards. Refer all servicing to qualified 
service personnel. 
 
AVERTISSEMENT 
Ne pas tenter de réparer ce produit vous-même, car l'ouverture ou le retrait des capots peut vous 
exposer à des tensions dangereuses et autres risques. Confiez toute réparation à un personnel 
qualifié de service Viavi. 

 

 

CAUTION 
This equipment contains parts and assemblies sensitive to electrostatic discharge (ESD). 
Use ESD precautionary procedures when touching, removing, or inserting ESD sensitive 
parts and assemblies, or damage to components could result. 
 
An electrostatic-sensitive device can only withstand voltage spikes of 10 to 100 volts. Any 
discharge greater than this can damage or effectively destroy such a device while going 
unnoticed by a technician. Common plastics (synthetic insulating materials), clothing, and 
paper or cardboard are the most common source of static charges. 
 
MISE EN GARDE 
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Cet équipement contient des pièces et des assemblages sensibles aux décharges électrostatiques 
(ESD). Utilisez ESD procédures de précaution en cas de contact, la suppression ou l'insertion de 
pièces de l'EDD et des assemblages sensibles, ou des dommages aux composants pourraient en 
résulter. 
 
Un dispositif électrostatique sensible ne peut supporter des pointes de tension de 10 à 100 volts. 
Toute décharge supérieur à ce qui peut endommager ou détruire efficacement un tel dispositif alors 
passer inaperçu par un technicien. Matières plastiques (matériaux synthétiques isolants), les 
vêtements et le papier ou le carton sont la source la plus fréquente de charges statiques. 

 

 

CAUTION 
This instrument uses a Lithium Ion battery that, if not connected correctly, may lead to 
explosion. In case the battery needs to be exchanged, it must be the same kind as or 
compatible with the one shipped with your instrument. 
 
The battery must not be disposed of in a landfill site or as municipal waste, and should be 
disposed of according to your national regulations. 
 
MISE EN GARDE 
Cet instrument utilise une batterie lithium-ion qui, s'il n'est pas connecté correctement, peut conduire 
à une explosion. Dans le cas où la batterie a besoin d'être remplacé, il doit être du même type ou 
compatible avec celui fourni avec votre instrument. 
 
La batterie ne doit pas être éliminé dans un site d'enfouissement ou les déchets municipaux, et doit 
être éliminé conformément à la réglementation nationales. 

 

This guide uses typographical and symbols conventions as described in the following tables. 
 
Conventions 

Ce guide utilise les conventions typographiques et les symboles tels que décrits dans les tableaux suivants. 
 

Table 1 Text formatting and other typographical conventions 

Item Text formatting/symbols used Example(s) 

Buttons or hard keys that 
the user presses on a 
physical device 

Bold, all caps, default font Press the ON button. 
Press the MODE hard key. 
Press the MARKER hard key. 

Hot keys that the user 
presses on a physical 
device 

Bold, all caps, italics, default font Press the SYSTEM hot key. 
Press the MEASURE hot key. 

Soft keys or toggle keys 
that the user presses on a 
physical device to select 
corresponding menus 

Bold, default font Press the Span soft key. 
Press the Channel Power soft key. 

Soft key option separators Denoted by a vertical bar | that 
means “or”, only one option can be 
selected with a single press 

Press the Zone [1|2|3] soft key. 

File type Courier New In .tra file type. 

Required arguments (text 
variables in code) 

Denoted by slanted brackets < >. Enter <password> 

 
Table 2 Symbol conventions 

 

This symbol indicates a note that includes important supplemental information or tips related to 
the main text. 
 
Ce symbole indique une note qui inclut des importante supplémentaire informations ou des pointes relatifs au 
texte principal. 



About This Guide 

22 JD700B Series User’s Guide 

  

 
This symbol represents a general hazard. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 
 
Ce symbole signale la présence d'un danger général. 

  

 

This symbol represents hazardous voltages. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 
 
Ce symbole signale la présence d'un risque d'électrocution. 

  

 
This symbol represents a risk of explosion. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 
 
Ce symbole signale la présence d'un risque d'explosion. 

  

 

This symbol, located on the equipment, battery, or the packaging indicates that the equipment or 
battery must not be disposed of in a landfill site or as municipal waste, and should be disposed of 
according to your national regulations. 
 
Ce symbole, situé sur l'équipement, la batterie ou l'emballage indique que l'équipement ou de la batterie ne 
doivent pas être jetés dans un site d'enfouissement ou les déchets municipaux, et doivent être éliminés 
conformément à la réglementation nationales. 

 
Table 3 Safety definitions 

DANGER 
 
 
 
DANGER 
 

Indicates a potentially hazardous situation that, if not avoided, will result in death or 
serious injury. It may be associated with either a general hazard, high voltage, or risk of 
explosion symbol. 
 
Indique une situation potentiellement dangereuse qui, si elle n'est pas évitée, entraînera la mort 
ou des blessures graves. 

  
WARNING 
 
 
 
AVERTISSEMENT 

Indicates a potentially hazardous situation that, if not avoided, could result in death or 
serious injury. It may be associated with either a general hazard, high voltage, or risk of 
explosion symbol. 
 
Indique une situation de danger potentiel qui, si elle n'est pas évitée, peut entraîner la mort ou des 
dommages corporels graves. 

  
CAUTION 
 
 
 
 
 
 
MISE EN GARDE 

Indicates a potentially hazardous situation that, if not avoided, could result in minor or 
moderate injury and/or damage to equipment. It may be associated with either a 
general hazard, high voltage, or risk of explosion symbol. 
 
When applied to software actions, indicates a situation that, if not avoided, could result 
in loss of data or a disruption of software operation. 
 
Indique une situation de danger potentiel qui, si elle n'est pas évitée, peut entraîner des 
dommages corporels légers ou modérés. 

 

If you require technical assistance, call 1-844-GO-VIAVI or send an email to TAC@viavisolutions.com. For 
the latest TAC information, go to http://www.viavisolutions.com/en/services-and-support/support/technical-
assistance. 
 
 
 

mailto:TAC@viavisolutions.com
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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Viavi wireless RF and fiber test solutions for the field include base station analyzers, cable and antenna 
analyzers, and signaling analyzers for the installation and maintenance of modern wireless communication 
systems. RF and fiber test is critical for wireless operators facing challenges of signal quality and signaling 
interference, and maintaining quality high-bandwidth services. 
  
The JD700B series addresses spectrum analysis, interference analysis, and cable, antenna and modulation 
analysis, covering current wideband technologies such as WiMAX and LTE/LTE-Advanced. 
 

The Base Station Analyzer contains all the features and capabilities required to perform field testing of cell 
sites of all wireless technologies, from 2G to 4G. 
 

The RF Analyzer provides multi-purpose solution for the analysis of RF systems covering all physical 
aspects of transmission, reception, and interference of RF systems up to 8 GHz and 4 GHz, respectively. 
 

The Signal Analyzer contains all the features and capabilities required to perform cell site field testing for all 
wireless technologies from 2G to 4G. 
 

The JD700B series is the optimal test solution for installation and maintenance of cellular base stations and 
cell sites, running with external AC power or battery for the field. 
 
The user interface has been specifically designed with customized menus and simple calibration procedures, 
providing service providers with accurate and reliable measurement results. 
 

 cdmaOne/cdma2000 

 EV-DO 

 WCDMA/HSPA+ 

 GSM/GPRS/EDGE 

 TD-SCDMA 

 WiMAX 

 LTE/LTE-Advanced (FDD and TDD) 

 RF over Fiber (RFoFiber – RFoCPRI and RFoOBSAI) 
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Table 4 Key functions available in product models 

Functionality JD785B/JD745B JD786B/JD746B JD788B/JD748B 

Spectrum Analyzer    

Cable and Antenna Analyzer    

RF Power Meter    

Optical Power Meter    

Fiber Inspection    

Signal Analyzers (optional)    

RFoFiber (optional)    

Interference Analyzer (optional)    

Channel Scanner (optional)    

OTA Measurement (optional)    

 

This instrument is provided with various options/features that are available to be ordered. See “Appendix I – 
Ordering information” on page 700 for more information. 
 

Input voltage is automatically selected within the instrument’s tolerable input line voltage from 100 to 240 
VAC. This instrument does not have a separate line protection fuse. 
 

Table 5 AC power requirements 

Item JD780B Specification JD740B Specification 

AC Power 100 to 240 V AC, 50-60 Hz 100 to 240 V AC, 50-60 Hz 

Power Consumption 42 W in operation 
54 W with battery charging 

42 W in operation 
54 W with battery charging 

 

Table 6 shows weight with standard configurations and the battery pack installed. 
 

Table 6 Physical specifications 

Model Dimension (H x W x D)  

JD785B/JD786B/JD788B 7.7” x 11.6” x 3.2” (195 mm x 295 mm x 82 mm) 

JD745B/JD746B/JD748B 7.7” x 11.6” x 3.2” (195 mm x 295 mm x 82 mm) 



 
 

  

 

 

This chapter provides general guides of how to get started with your JD700B series instrument. Topics 
discussed in this chapter are as follows: 
 

 Unpacking the JD700B series ................................................................................................... 27 

 Exploring the JD700B series ..................................................................................................... 27 

 Installing battery pack ................................................................................................................ 32 

 Starting up the JD700B series .................................................................................................. 32 

 Managing files ........................................................................................................................... 33 

 Configuring system .................................................................................................................... 36 

 Upgrading firmware ................................................................................................................... 39 

 Managing licenses ..................................................................................................................... 40 

 Performing service diagnostic ................................................................................................... 42 

 Using system administration ..................................................................................................... 43 

 Running IP test .......................................................................................................................... 44 

 Activating StrataSync ................................................................................................................ 44 

 Setting communication .............................................................................................................. 47 
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Unpack and inspect the shipping package thoroughly to ensure that nothing was damaged during the 
shipment. Also, check that your delivered package includes all of your ordered items in the shipment. If 
contents in the package are damaged or defective or if there are any missing items, keep the shipping list 
and materials for carrier’s inspection and contact your nearest Viavi's authorized sales and service office. 
 
A basic test set of JD700B series would include the following items in the package. For more options, see 
“Appendix I – Ordering information” on page 700. 
 

Table 7 Items included in a basic test set shipment 

Item Quantity 

JD700B series instrument 
(JD785B, JD786B, JD788B, JD745B, JD746B, or JD748B) 

1 

AC/DC power adapter and power cord 1 

1.5 meter cross LAN cable 1 

1.8 meter USB A-to-B cable 1 

> 1 GB USB memory 1 

Rechargeable Lithium Ion battery pack 1 

12 V DC automotive adapter 1 

Stylus pen 1 

User’s guide and application software CD 1 

 

 
Figure 1 JD785B front panel view 
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The JD700B series analyzers have the same front panel look as like Figure 1, except for the bumpers in 
different colors. 
 

Key Description 

 
POWER ON/OFF – You can turn your instrument on or off. Two LEDs indicate power 
source and status. See “Starting up the JD700B series” on page 32. 

 

You can use these hard keys to activate specified functions as labeled on each key. 
 

Key Description 

 
MODE – You can select an analyzer mode from all the standard and optional modes 
available to your instrument. 

 
FREQ/DIST – You can configure frequency or distance settings. 

 
AMP/SCALE – You can configure amplitude and scale settings. 

 
BW/AVG – You can configure bandwidth and average settings. 

 
TRACE/DISPLAY – You can set up trace and display parameters. 

 
MARKER – You can analyze measurements with markers. 

 
PEAK SEARCH – You can set up peak search parameters. 

 

When the user input field on the screen is inactive, you can use these hot keys to activate specific functions 
instead of numbers. When you see the user input field activated or highlighted, press the ESC hard key to 
use these hot keys. 
 

Key Description 

 
MEASURE – You can select measurements available for your selected analyzer mode. 

 
MEASURE SETUP – You can set measurement parameters available for your selected 
measurement mode. 

 
SAVE/LOAD – You can save or load your current screen, result, setup, or limit into or 
from the internal memory or an external USB memory drive. 

 
SWEEP – You can configure sweep parameters. 

 
TRIGGER – You can select trigger options such as internal, external, and GPS. 

 
SYSTEM – You can configure your system settings or view your current system 
information. 
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PRESET – You can use this key to return to a known state and make measurements. 

 
HOLD – You can change the sweep mode: Continue or Single. 

 
LIMIT – You can set limit settings such as display line, multi segment line, save limits, 
recall limits, or test specification limits. 

 
BACKLIGHT – You can turn the key backlight feature on or off. 

 
HELP – You can have the online help screen on if available. 

 

You can use not only the touchscreen keys but also these physical keys placed along the right side of the 
display to start a specific function associated with each soft key, invoke other screen keys, or select a unit. 
The More screen menu indicates that there are more than seven screen menus for the level. The small 
arrowhead symbol in the screen menu indicates that there are screen menus under the screen menu. 
 

Key Description 

 

ROTARY KNOB WITH ENTER KEY – You can change a value with predefined 
increments or move marker position. Rotating this knob clockwise increases value or 
moves a marker to the right and rotating counter clockwise does vice versa. This knob 
works as the ENTER hard key as well. 

  

ARROW KEYS – You can increase or decrease value or move your selection up, down, 
to the left, or to the right. 

 

NUMERIC KEYS – You can manually enter a value for measurement parameters. 

 
DEL – You can delete data entry. After pressing the ENTER key or selecting a unit soft 
key, you cannot delete or remove data entered. 

 
ENTER – You can save and confirm data entry. 

 
ESC – You can cancel any input in the user input field or dismiss a pop-up window on the 
screen. 

 
PREV – You can go back to the previous menu without changing current setup. 

 

The JD700B series products have the same top view as Figure 2 and Figure 3. 
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Figure 2 Top view of JD785B with optical hardware option 

 
 
 

Figure 3 Top view of JD785B without optical hardware option 

 
 

The Reflection/RF Out port of the Cable and Antenna Analyzer is a precise 50 Ω N-type female connector 
that is used as the output signal port for the Cable and Antenna Analyzer mode. 
 

 

CAUTION 
Do not apply or connect power exceeding +25 dBm to this Reflection/RF Out port. If such 
power is applied, it will degrade the product’s performance and can cause damage to the 
product in worst case. 

 

The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for  
2-port vector measurements in the Cable and Antenna Analyzer mode. 
 

 

CAUTION 
The maximum power allowed to the RF In port is +25 dBm. If the input power exceeds 
the limit, it may degrade the product performance or cause damage to the instrument in a 
worst case. Do not connect any power feed exceeding 1 W directly to this port. 

 

The input power to this port shall be 18 V DC. 
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The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for spectrum 
analysis, signal analysis, and RF power measurement. 
 

 

CAUTION 
The maximum power allowed to the RF In port is +25 dBm for JD780B series and +20 
dBm for JD740B series. If the input power exceeds the limit, it may degrade the product 
performance or cause damage to the instrument in a worst case. 

 

The audio jack is labeled with a headphones icon. Plugging in headphones or earphones turns the speaker 
off. 
 

 CLIENT: This is a communication port that you can connect your instrument and your PC with 
application software JDViewer, JDRemote, or JDMapCreator. You must install driver software for the 
instrument on to the computer. See “Appendix H – Device driver installation” on page 699 for more 
information. 

 HOST: You can use this port to plug in an external USB memory to extend storage capacity or to 
upgrade the instrument’s firmware. It supports most USB memory devices with 32-bit file system. 
You can also use this port to connect an external power sensor, Bluetooth USB adapter, or P5000i 
fiber microscope. See “Appendix G – Bluetooth connection” on page 696 on how to set up and use 
the Bluetooth connection. 

 

You can use this Ethernet communication port to connect your instrument and your PC using the application 
software JDViewer or Motorola WinLMF, if necessary. Two LEDs indicate data transfer activity and link 
status. 

 ACTIVITY: The yellow LED is illuminated during data transfer. 

 LINK: The green LED is illuminated when there is a valid communication connection. 
 

The optical hardware option board for RFoCPRI and RFoOBSAI supports all types of MSA (Multi-Source 
Agreement) compliant SFP transceivers. You can use these SFP/SFP+ ports to connect SFP modules to 
test CPRI/OBSAI protocols, detect an error or alarm, perform interference analysis, and transmit test pattern 
over fiber link. 
 

 GPS: You can plug in a GPS antenna to this SMA type female connector in order to get location 
information and highly accurate reference. 

 TRIGGER: You can use this SMA type female connector to receive PP2S clock or 10 ms 
synchronization signals from an external timing reference. 

 REF: You can use this SMA type female connector to receive 10 MHz, 13 MHz, or 15 MHz reference 
clock signals from an external frequency source. 
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You need to install the Lithium Ion battery pack provided with your instrument. Follow the instruction to install 
or remove the battery pack as needed. 
 

Procedure 

To install the battery pack: 
1 Loosen the latching screw of the battery cover by turning counter clockwise. 
2 Slide out the battery cover to open. 
3 Insert the battery pack with the connector terminal side up and push in until it stops. 
4 Slide in the battery cover to close. 
5 Tighten the latching screw of the battery cover 

by turning clockwise. 
 
To remove the battery pack: 

1 Loosen the latching screw of the battery cover  
by turning counter clockwise. 

2 Slide out the battery cover. 
3 Hold the battery strap and pull it out. 

 
 

 

 

CAUTION 
The battery pack that came with your instrument is Lithium Ion and it may, if not 
connected correctly, lead to explosion. In case you need to replace the battery, you must 
use one of the same kinds or compatible ones. You must dispose a battery according to 
your local safety and environmental regulations. 

 

 

NOTE 
It is recommended that you turn off the instrument to replace the battery. However, if you 
do not want to interrupt the current test, you can leave the module turned on with the AC 
power adapter plugged in. 

 

Use the power button to turn your JD700B series on or off. When external power is supplied via the AC/DC 
adapter, the upper orange LED is illuminated. 
 

Procedure 

To turn on: 
1 Press and hold the      POWER button for a few seconds until the lower green LED indicator is 

illuminated. 
2 Release the button and wait for a few seconds while booting up. 

 
To turn off: 

1 Press and hold the      POWER button for a few seconds until the lower green LED indicator 
goes out. 

2 Release the button. 
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The JD700B series lets you save and load screen, result, setup, limit, logging data, or Fail events depending 
on your selected measurement mode and option. 
 

 

NOTE 
If you see greyed-out menus as you change measurement modes, this indicates that the 
menu(s) are not available to be used. 

 

You can save your current screen, result, setup, and limit into the internal memory or your external USB 
memory drive. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load menu bar appears. 
2 Press the Save soft key. 
3 Select the save option, from the following choices: 

 

To save Select File type 

Current screen Save Screen > Screen .png 

Measurement result in a report 
format with comments and 
captured screen images 

Save Screen > Report .pdf 

Measurement result Save Result .tra 

.gom 

.grr 

.jdt 

RRH profile (only available in 
BBU emulation mode) 

Save Profile .jcm 

Measurement result (.csv) Save Result as CSV Format .csv 

Setup and test configuration Save Setup .sta 

Limit setting Save Limit .jml 

Logging data Save Logging Data .grr 

.gsr 

.csv 

Automatically screen or results 
that falls outside the defined 
limit settings (Failed event) 

Save On Event .png 

.tra 

.csv 

The on-screen keyboard appears. 
 

 

NOTE 
Save Setup saves a test configuration only, not a measurement limit setting. You must 
use Save Limit to save your limit settings. 
 
In the Cable and Antenna Analyzer mode, if the limit line is enabled and set, Save Result 
saves the trace together with the set limit line. 
 
An RFoCPRI/RFoOBSAI spectrum can be saved as a file, but the difference in its data 
point does not allow the saved RFoCPRI/RFoOBSAI spectrum to be overlaid on a regular 
RF spectrum. 
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4 Type the name of the file in the File Name field with or without using a keyword. 
5 Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 
See “Editing or adding a custom keyword” on page 712 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 
713 for more information. 

–  To change the file location in the internal memory or to your USB memory drive, tap the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

6 Press the Save soft key. 
7 If you have selected Save Screen > Report in step 3, pressing the Save soft key in the previous 

step 6 gives you another window where you can specify details on your report. 
 Type the name of the person who performed testing in the Engineer field. a
 Enter a description about the site or place in the Site Information field. b
 Enter your test purpose in the Test Purpose field. c
 Enter a summary of your test results in the Result field. d
 Type your company name in the Company Name field. e
 Enter your company or site address in the Address field. f
 To attach your company logo and up to six captured screens to the report, tap the  g

Click to Attach bar, attach image files as desired, and then tap the Save button. 

 

Depending on the measurement mode, you can let the instrument automatically save measurement screen 
or result that falls outside the defined limit settings or the Fail indicator is on. You can also set to save the 
first event and hold the measurement or to save all the events continuously. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load menu bar appears. 
2 Press the Save soft key. 
3 Press the Save On Event soft key. 
4 Press the Save Type soft key, and then select the save option from the choices: Screen, Result, 

and Result as CSV Format. 
5 Optional. Toggle the Save Then Stop soft key and select On in order to save the first event that 

falls outside the limit(s) and to hold the measurement. Otherwise, leave this feature off to save 
events continuously. 

6 Press the Start soft key to start saving. The on-screen keyboard appears. 
7 Type the name of the file in the File Name field with or without using a keyword. 
8 Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 
See “Editing or adding a custom keyword” on page 712 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 
713 for more information. 

–  To change the file location in the internal memory or to your USB memory drive, touch the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 
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–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

9 Press the Done soft key. 
The “Event Save” appears on the screen and the Start screen menu changes to Stop. 

10 Press the Stop soft key to end the event saving. 

 

You can save logging data if the measurement mode supports the feature and has the activated Save 
Logging Data soft key. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load menu bar appears. 
2 Press the Save soft key. 
3 Press the Save Logging Data soft key. The on-screen keyboard appears. 
4 Type the name of the file in the File Name field with or without using a keyword. 
5 Optional. Do the following: 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 
See “Editing or adding a custom keyword” on page 712 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 
713 for more information. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

–  To change the file location in the internal memory or to your USB memory drive, touch the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

 

 

NOTE 
In is recommended that you use an external USB memory drive to save logging data in 
the Auto Measure mode in order to have enough free space. 

 

6 Optional only in the Auto Measure mode. 
Toggle the Save Screen soft key and select All to save all the Auto Measure screens or Fail to 
save only the ones with the Fail on. 

7 Press the Save soft key to start logging. 
The “Recording” appears on the screen. 

8 Press the ESC hard key to stop logging data and complete saving. 

 

You can load your saved screen, result, setup, and limit from the internal memory or your external USB 
memory drive. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load menu bar appears. 
2 Press the Load soft key. The Load menu bar appears. 
3 Select the load option, from the following choices: 
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To load Select 

Saved screen or report Load Screen 

Measurement result Load Result 

Setup and test configuration Load Setup 

Limit setting Load Limit 

Logging data Load Logging Data 

Map file Load Map 

Scenario Load Scenario 

The file manager window appears. 
 

 

NOTE 
An RFoCPRI/RFoOBSAI spectrum can be recorded and replayed in the RFoCPRI/ 
RFoOBSAI Interference Analyzer (IA) mode only. It is not compatible with a standard 
spectrum logging file in the Interference Analyzer mode. 

 

4 Select the name of the file to be loaded from the internal memory or from your USB drive. 
Information of your selected file appears in the File Information pane. 

5 Press the Load soft key. 

 

The File Manager lets you copy, cut, paste, and delete data files saved in the internal memory or in your 
USB memory drive. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load menu bar appears. 
2 Press the File Manager soft key. The file manager window appears. 
3 To copy, cut, and paste, complete the following steps: 

 Select a file or folder by using the touch screen or the rotary knob. a
 Select the Copy or Cut soft key. b
 Select the location to which the file or folder to be pasted. c
 Press the Paste soft key. d

4 To delete, complete the following steps: 
 Select a file or folder by using the touch screen or the rotary knob. a
 Press the Delete soft key. b

The confirmation dialog box appears. 
Once the file or folder is deleted, you cannot recover it. 

 Select OK to delete. c
5 Press the Exit soft key or the ESC hard key to close the file manager window. 

 

You can improve measurement accuracy by setting frequency reference. 
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Procedure 

1 Press the SYSTEM hot key. 
2 Press the Freq Reference soft key. 
3 Select the frequency reference option: Internal, External 10 MHz, External 13 MHz, 

External 15 MHz, and GPS. 

 

You can set the instrument’ system clock to your region. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Date/Time. The current time zone information box appears. 
3 To change the standard time zone, complete the following steps: 

 Press the Std Time Zone soft key. a
 Select your time zone by using the rotary knob or arrow keys. You can also use the b

Top/Bottom or Page Up/Down soft keys. 
 Press the ENTER hard key to save your change. You can also press the rotary knob. c

4 To change the date format, complete the following steps: 
 Press the Date Format soft key. a
 Select YYMMDD, MMDDYY, or DDMMYY as needed. b

5 To set the date and time manually, complete the following steps: 
 Select Year, Month, Day, Hour, or Minute soft key as needed. a
 Enter a value by using numeric keys. b
 Press the Enter soft key to save your change. c

6 Press the Apply screen key to save and exit. 

 

You can change the system language for the menus, messages, and information on screen. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Language. 
3 Select the language option from the choices available. 

 

Procedure 

1 Press the SYSTEM hot key. 
2 Press the Power On soft key. 
3 Select the power-on option, from the following choices: 

–  Last: Boots up with the last state of the instrument before power-off or shut-down. 

–  Preset: Boots up with the default settings preset in the factory. 

–  User: Boots up with the user-defined setup. 
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When the User is selected, the User Setup menu under System becomes activated. 

4 Optional. If you have selected User in step 3, complete the following steps to specify a user 
setup file to be used: 

 Press the User Setup soft key. a
 Select the name of the user setup file. b
 Press the Done soft key. c

 

 

NOTE 
The Preset is to revert to original factory settings. It is recommended that you use this 
option when you have experienced badly misadjusted settings. 

 

You can change the instrument’s display mode as needed. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Display Mode. 
3 Select a display mode from the choices: Indoor, Outdoor, and Night. 
4 The instrument optimizes screen colors to each choice. 

 

You can set the amount of time up to 255 minutes to let the instrument automatically turn the backlight off 
and enter into power saving mode after no actions or data entries. Default setting is zero, which indicates 
that the sleep mode is turned off and screen backlight is always on. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Sleep Time. 
3 Enter the amount of minutes by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

You can adjust display brightness from one to ten as needed. The larger number you set, the brighter the 
display becomes. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > LCD Brightness. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 
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You can turn the sound on or off or adjust the volume from one to ten as needed. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select the sound option, from the following choices: 

–  To turn the sound or alarm off, toggle the Sound soft key and select Off. 

–  To turn the sound or alarm on, toggle the Sound soft key and select On. 

–  To adjust the volume, complete the following steps: 
 Press the Sound soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

It is recommended that you maintain your instrument up-to-date with its latest firmware in order to achieve 
the instrument’s optimal performance.  
 

Procedure 

1 Press the SYSTEM hot key. 
2 Press the HW/FW Info soft key. 
3 Find the installed version number in the Firmware field. 
4 From a computer with Internet access, visit Viavi’s Software Updates website and check if your 

installed firmware is the latest one. Do the steps 5-6 if you want to update your firmware with 
using your USB memory drive. 

5 Download a latest firmware file from the website to the root directory of your USB memory drive. 

 

NOTE 
It is recommended that you format your memory drive to have enough space to download 
the file. 

6 Unzip the download file into the root directory of your USB memory stick. 
A firmware file (*.fw) and a firmware release note (*.pdf) are extracted. 

 

To update your firmware, you can choose either way of using your USB memory drive or accessing the FTP 
server over the network. 
 

Procedure 

1 Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument 
caused by a power-off in the middle of the upgrade, which may require a repair in the factory. 

2 Plug in the USB memory drive to the USB Host port of your instrument. 

http://www.viavisolutions.com/en/services-and-support/support/software-downloads-and-updates#Group-C
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3 Press the SYSTEM hot key. 
4 Select More (1/2) > Upgrade > USB. 

The file manager window appears. 
5 Highlight the firmware file (.fw) saved in the root directory of your USB drive. 
6 Press the Select soft key. 

The Update Firmware dialog box appears. 
7 Press the OK button to start to install the new firmware.  

The Upgrade Status bar appears. 

 

NOTE 
Firmware upgrade will be done within 30 minutes or so in most cases, but depending on 
the number of files to be reconfigured, it may take longer than that. 

8 After you have restarted the instrument, check the installed firmware version and DSP versions 
in the System settings. Refer to the firmware release note to find correct DSP version and 
compatible application software versions. 

 

 

WARNING 
Do not remove the USB drive while upgrading the firmware. 

 

Procedure 

1 Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument 
caused by a power-off in the middle of the upgrade, which may require a repair in the factory. 

2 Press the SYSTEM hot key. 
3 Select More (1/2) > Upgrade > FTP Server. 

The upgrade server dialog box appears. 

 

NOTE 
Older version of firmware does not have the FTP Server option. It is recommended that 
you update your firmware with the USB option first. 

4 Enter ftp2.jdsu.com in the server address field. 
5 Enter your proxy server address in the proxy server field, if necessary. 

Contact your system administrator for your proxy server information. 
6 Tap the Check button to check if the installed firmware version is the latest one. 
7 Do one of the following: 

–  If you view the latest firmware version information, tap the Install button to continue. 
–  If the message “Your firmware is up to date.” is displayed, tap the Cancel button. 

 

NOTE 
Firmware upgrade will be done within 30 minutes or so in most cases, but depending on 
the number of files to be reconfigured, it may take longer than that. 

8 After you have started the instrument, check the installed firmware version and DSP versions in 
the System settings. Refer to the firmware release note to find correct DSP version and 
compatible application software versions. 

 

The License Manager lets you view installed options, install additional ones, and load evaluation licenses. 
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Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager. The License Manager menu bar appears. 
3 Select the menu, from the following choices: 

–  To view the installed options, select the Installed Options soft key. 
The list of options appears. The “(T)” indicates temporary licenses. 

–  To view the installable options, select the Installable Options soft key. 

 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager. 

The License Manager menu bar appears. 
3 Select the Install an Option soft key. The Installable Options window appears. 
4 Highlight the name of the option from the list by using the rotary knob. 
5 Press the ENTER hard key. You can also press the rotary knob. 

The License Code bar appears. 
6 Enter the number of the license to activate by using the numeric keys. 
7 Press the ENTER hard key. You can also select the Enter soft key. 

 

The temporary license that you received from Viavi is intended for your evaluation only and it expires after its 
specified time limit. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager.  

The License Manager menu bar appears. 
3 Select the Load Temp License soft key. The file manager window appears. 
4 Select the name of the license file. 
5 Press the Load soft key. 
6 Optional. You can check the loaded license using the Installed Options menu. 

 

The JD700B series incorporates software that is covered by either the GNU General Public license or GNU 
Lesser General Public License. Check the OSS license notification for more details. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager. 

The License Manager menu bar appears. 



Chapter 2 Getting Started 

42 JD700B Series User’s Guide 

3 Select the OSS License soft key. 
The Open Source Code Notification & Distribution screen appears. 

 

The Service Diagnostic lets you view system log, perform self test, revert the instrument settings to its 
factory settings, or perform touch alignment. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > System Logging. 
3 Optional. Press the Save soft key to save the system log as a .log file type. 

 

You can run a self-test on your instrument boards and modules. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > Self Test. 

The on-screen instruction appears. 
3 Connect a test cable between the Reflection/RF Out port for Cable and Antenna Analyzer and 

the RF In port for Spectrum Analyzer. 
4 Press the Start soft key. 

The test result window appears. 
5 Optional. Press the Save Screen soft key to save the self-test results. 

 

The Factory Reset is used only when you want to purge all the user settings and data stored in the system 
and return to the instrument’s factory state. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > Factory Reset. 

The confirmation dialog box appears. 
3 Press the Yes soft key to continue. Otherwise, select No. 

 

 

NOTE 
It is recommended that you copy your setup or result data to an external USB memory 
drive so that you can restore them later. 
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When you consistently experience of the instrument responding improperly to your touch on the screen, you 
may need to perform this touch-screen alignment. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > Touch Alignment.  

The white screen with a plus sign (+) in the upper-left corner appears. 
3 Touch the plus sign and repeat until the previous screen is back on. 

 

The Administration is used to disable editing limits, enable modifying online help, or change administration 
password. 
 

You need to log in first to access the administration menus. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Administration. The password box appears. 
3 Enter <password> by using the numeric keys. 

Default password is “0000”. To change the password, see “Changing password” on page 43. 
4 Press the Apply soft key. 

 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Administration, and then enter your password. 
3 Press the Change Password soft key.  

The new password box appears. 
4 Enter a new password up to eight digits by using the numeric keys. 
5 Press the Apply soft key.  

The reconfirmation box appears. 
6 Enter the new password again by using the numeric keys. 
7 Press the Apply soft key to complete changing password. 

 

You can lock the LIMIT hot key and disable editing predefined limit settings to prevent any unintentional 
changes, which could result in incorrect measurements. 
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Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Administration, and then enter your password. 
3 Toggle the Edit Limit soft key and select Disable to lock the LIMIT hot key or Enable to unlock 

the key. 

 

 

NOTE 
Disabling the Edit Limit limits the access to the LIMIT hot key only. The Limit features 
including displaying limit line(s) and Pass/Fail result function properly as predefined. 

 

You can test an Internet Protocol (IP) configuration of the cell site’s backhaul. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Utility > IP Test. 
3 Select the command option, from the following choices: 

–  To display the route and measure transit delays of packets, toggle the Commands soft key 
and select Traceroute. 

–  To display the reachability and measure the round-trip time, toggle the Commands soft key 
and select Ping. 

4 To set the destination IP address to be tested, complete the following steps: 
 Press the Destination IP soft key. a
 Press the First Octal soft key. b
 Enter a value, and then press the Enter soft key. c
 Press the Second Octal soft key and repeat step c. d
 Press the Third Octal soft key and repeat step c. e
 Press the Fourth Octal soft key and repeat step c. f

5 Press the Execute soft key and select Start to start testing. 
Test result is displayed on the screen as the test is progressing. 

6 Press the Execute soft key and select Stop to stop testing. 
7 Optional. Press the Save soft key to save the test result as a .txt file type. 

 

StrataSync is a cloud-based solution that provides asset, configuration, and test data management for Viavi 
instruments. StrataSync manages and tracks test instruments, collects and analyzes results from the entire 
network, and informs and trains the workforce. 
 
The JD700B series is compatible with the Viavi StrataSync cloud. This optional capability allows you to 
manage your instrument inventory ensuring you know where all your valuable equipment is and which 
engineer is using it. In addition, it allows you to keep your instruments current through the remote upgrade 
capability that ensures all instruments have the latest firmware. It also enables the centralized distribution of 
configuration settings to ensure all your engineers use the same instrument settings resulting in consistent 
measurements. 
 



Chapter 2 Getting Started 

 JD700B Series User’s Guide 45 

Once testing is completed, the trace files can be uploaded onto StrataSync for secure storage and sharing. 
This sharing capability allows engineers who have a problem they cannot resolve to request help from an 
expert who can analyze the trace file via StrataSync using applications such as JDViewer, JDFileViewer, 
JDPowerMeter, etc. from anywhere without having to be at the instrument, helping resolve problems even 
faster. 
 

Your JD700B series instrument must have Internet access to be able to connect to the StrataSync. You can 
set up for wireline or wireless Ethernet network connection. You can also use your mobile device’s data 
network such as the Bluetooth tethering on an Android-based smartphone and the Personal Hotspot on an 
iOS-based smartphone. If you want to share your mobile’s data network, you need to connect your 
instrument to your mobile device. 
 

Procedure 

1 Connect one of the Parani-UD100 Bluetooth adapters to the USB port of your JD780B or 
JD740B series. 

2 Turn on Bluetooth on your mobile device, and then activate its tethering or hotspot. 
–  On Android mobile devices: 

a Go to Settings > Connections > Bluetooth. 
b Check the box for Visible to all nearby Bluetooth devices to make your mobile 

device discoverable by your instrument. 
c Go to Settings > More networks > Tethering and portable hotspot. 
d Check the box for Bluetooth tethering to enable sharing your mobile device’s Internet 

connection with your instrument. 
–  On iOS mobile devices: 

a Go to Settings > Bluetooth. 
b Turn on Bluetooth. 
c Go to Settings > Personal Hotspot. 
d Turn on Personal Hotspot to make your mobile device discoverable by your 

instrument and enable sharing your mobile device’s Internet connection with your 
instrument. 

3 On your JD780B or JD740B series instrument, press the SYSTEM hot key. 
4 Select System Configuration > Remote Interface > Bluetooth > Connect. 
5 Press the Scan soft key to discover your mobile device. 

You will find your mobile device from the list on the screen. 
6 Highlight your mobile device name from the list, and then press the Select soft key. 

A dialog box appears. 
7 Tap the Connect button to pair and connect. 
8 On your mobile device, enter 0000 in the PIN field, and then tap the OK button or Pair. 

If the connection is successful, “(Paired & Connected)” appears next to the name of your mobile 
device on your instrument. If the connection is unsuccessful, repeat steps 6 and 7. 

9 Press the PREV hard key to return to the Bluetooth Information screen that displays the paired 
device and connected service including your CellAdvisor’s IP Address. 

 

NOTE 
If you want to use the Web-based remote control described on page 50 using this 
Bluetooth tethering, record the IP address assigned to your JD700B series to have 
access to the instrument on your smartphone’s Web browser. 
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Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Utility > StrataSync. 

The StrataSync setting window appears as shown in Figure 4. 
3 Enter <server address> in the Server Address field for StrataSync. 

The server address at the time of this document production is “stratasync.viavisolutions.com”, 
which may change. 

 

NOTE 
Viavi provides you with the information required to access StrataSync at your 
purchase of StrataSync, including the Server Address, Account ID, and Port 
number. See “JD700B Series Common Options” on page 707 for more information 
on available options. 

4 Enter <account number> in the Account ID field. 
5 Enter <technician number> in the Technician ID field. 
6 To set the port number and proxy server address, complete the following steps: 

 Tap the Detail Settings button. a
The input dialog box appears. 

 Enter <port number> in the Port field. b
 Enter <proxy server address> in the Proxy Server address, if necessary. c

Contact your system administrator for your proxy server information. 
 Tap the Apply button to save and exit. d

7 Tap the Start Sync button. 
Once successfully synchronized, the text “Successfully synchronized with server” appears and 
the StrataSync status icon changes accordingly. 

8 Tap the Apply button to exit. 

 
Figure 4 StrataSync setting window 

 
 

The StrataSync indication icons provide you with the connection and activity status. 
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Indicator Description 

   
Indicates that your instrument is idle to be connected and synchronized with the 
StrataSync server. 

   
Indicates that your instrument is acquiring an authentication, synchronizing with the 
server, and sharing data. 

   
Indicates that your instrument is synchronized successfully. 

   
Indicates that your instrument failed to synchronize with the StrataSync server or 
encountered an error. 

 

JD700B series provides several methods for you to connect your instrument with application software or 
other instruments and devices. 
 

You can configure a network to connect your JD700B series to a computer installed with Viavi software 
applications such as JDViewer or JDRemote via Ethernet. JD700B series supports both IPv4 and IPv6 
protocols. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Ethernet Config > IPv4. 

The Ethernet Configuration box appears. 
3 Do one of the following: 

–  To enable automatic IP addressing, toggle the Mode soft key and select DHCP. 

–  To manually assign fixed IP addresses, complete the following steps: 
 Toggle the Mode soft key and select Static. a
 Press the IP Address soft key. b
 Enter an address including dots in the user input field. c
 Press the ENTER hard key or Enter soft key. d
 Press the Subnet Mask soft key and repeat steps c-d. e
 Press the Gateway soft key and repeat steps c-d. f
 Press the DNS soft key and repeat steps c-d. g

4 Press the Apply soft key to apply and complete the network configuration. 
The message “Applying Network Info…” appears. 

 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Ethernet Config > IPv6. 
3 Do one of the following: 
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–  To enable automatic IP addressing, toggle the Mode soft key and select Auto. 

–  To manually assign fixed IP addresses, complete the following steps: 
 Toggle the Mode soft key and select Static. a

The Ethernet Configuration box appears. 
 Press the IP Address soft key. b
 Type in an address including colons using the on-screen keyboard. c
 Press the Apply soft key to complete the input. d
 Press the Subnet Prefix Length soft key. e
 Enter a length value using the numeric keys, and then press the Enter soft key. f
 Press the Gateway soft key and repeat steps c-d. g
 Press the DNS soft key and repeat steps c-d. h

4 Press the ESC hard key, and then make sure to press the Apply soft key in the IPv6 menu bar in 
order to apply and complete the network configuration. 
The message “Applying Network Info…” appears. 

 

The App SW is set by default to make it easy to connect your instrument to JDViewer, JDRemote, 
JDMapCreator, and other applications. After using other remote interfaces such as SCPI, LMF, and 
USBTMC, it is recommended that you set the LAN and USB settings back to App SW. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Press the System Configuration soft key. 
3 Press the Remote Interface soft key and then do the following: 

–  Select the LAN soft key and then press the App SW soft key. 

–  Select the USB soft key and then press the App SW soft key. 

 

The USB Test & Measurement Class (USBTMC) is a standard for programmatic control of USB-based test 
instruments that defines protocols used to send and receive messages. If you want to use the USBTMC 
protocol to communicate with the instrument remotely, you can turn this TMC Mode on. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Remote Interface > USB. 
3 Press the USBTMC soft key. 

The confirmation dialog box appears. 
4 Press the USBTMC soft key again to confirm the mode change and reboot the instrument. 

 

 

NOTE 
After using the USBTMC mode, you may want to set this setting back to App SW if you 
use JDViewer mainly for remote controlling your JD700B series. 

 

You can use SCPI commands to control your JD700B series remotely. 
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Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Remote Interface > LAN. 
3 Press the SCPI soft key. 

 

 

NOTE 
After using the SCPI mode, you may want to set this setting back to App SW if you use 
JDViewer or JDRemote mainly. 

 

The Local Maintenance Facility (LMF) setting is used in order to perform TX Calibration and TX Audit on 
Motorola's CDMA/EV-DO BTS in the RF Power Meter mode. See “Appendix F – Motorola CDMA/EV-DO 
LMF” on page 694 for more information. 
 

If your JD700B series has the Bluetooth Connectivity option installed with a license, you can use the 
Bluetooth mode to enable communicate between your instrument and your computer with application 
software such as JDRemote and JDViewer or to transfer files to a Bluetooth storage device. See “Appendix 
G – Bluetooth connection” on page 696 for more information. 
 

Wi-Fi Connectivity is an optional feature that you can activate by installing a purchased license on your 
JD700B series. After plugging a USB Wi-Fi LAN card using Realtek NICs into the instrument, you can join a 
wireless network from the instrument so that you can have access to StrataSync or control the instrument 
from the Web-based remote control on a computer. 
 

Procedure 

1 Plug in your USB Wi-Fi LAN card to the USB Host port of the JD700B series. 
The Wi-Fi LAN card is detected and the white Wi-Fi indicator appears on the screen to indicate it. 

 

NOTE 
CellAdvisor JD700B series is compatible only with a USB LAN card that uses Realtek 
NICs (RTL8188eu, RTL8192cu, and RTL8812au). 

2 Press the SYSTEM hot key. 
3 Select System Configuration > Remote Interface > Wi-Fi. 

The Wi-Fi mode is turned on automatically. After searching nearby networks, the instrument 
displays a list of networks. 

4 To select a network to join, complete the following steps: 
 To refresh the networks list, press the Scan soft key. a

The instrument displays all detected networks as Detected and previously connected ones 
as Saved. 

 Highlight a network to join by using the arrow keys or rotary knob. b
 Press the Select soft key. c

The Wi-Fi Connection Info window appears for entries. Figure 5 is an example. 
5 To enter a user identity and a password for the network, complete the following steps: 

 Tap on the input box for Identity, if required. a
The on-screen keyboard appears. 

 Type your identity, and then press the Apply soft key. b
 Tap on the input box for Password, if required. c
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The on-screen keyboard appears. 
 Type a correct password that must be at least eight characters long. d
 Press the Apply soft key. e
 To view the password exactly as entered, tap the checkbox for Show Password to enable it. f

6 To configure IP network settings, complete the following steps: 
 Select the TCP/IP protocol option from the choices: IPv4 and IPv6. a

Sub-selection options change according to your selection. If the selected network supports 
IPv6, you can configure IP settings for it. 

 Do one of the following: b
–  To enable automatic IP addressing, select DHCP for IPv4 or Auto for IPv6. 

It is recommended that you select DHCP unless otherwise you know static IP 
addresses. 

–  To manually assign fixed IP addresses, select Static, and then enter addresses as 
required for IPv4 or IPv6. If you do not have required information, contact your 
network administrator. 

–  To disable the IPv6 protocol, select Off. 

7 Press the Connect soft key. 
Once connected, the Wi-Fi indicator turns to green and the Wi-Fi Connection Info window is 
updated with information about the connected network including SSID, status, authentication 
type, encryption method, BSSID, and assigned IP address(es). If you have selected Auto for 
IPv6 in step 6, you will have Link-Local, Stateless, and Stateful instead of IP Address. If you see 
the green Wi-Fi indication with a red exclamation mark in the center, it means that an IP address 
has not been assigned. 

 

NOTE 
It is important to record the IP address(es) if you want to use the Web Remote on your 
computer. 

8 To disconnect the currently connected network, select the network and then press the 
Disconnect soft key. 

9 To forget the selected network and delete it permanently from the list, press the Remove soft key. 

 
Figure 5 Example of Wi-Fi connection information window 

 

 

If your JD700B series has the Wi-Fi Connectivity option installed with a license, you can enable this Web 
Remote feature to control your instrument from most of Web browsers including Windows Internet Explorer 
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(IE) 6 and later, Firefox, Chrome, Safari, and Android native browser in an accessible network. You can also 
use this feature to allow other users to access your instrument remotely and share the live screen 
concurrently with up to 10 clients in the network. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 To get the IP address assigned to your instrument, do one of the following: 

–  For wireline LAN connection: 
 Select System Configuration > Ethernet Config > IPv4 or IPv6. a
 Toggle the Mode soft key and select DHCP or Auto for automatic IP addressing. b
 Press the Apply soft key. c

The Ethernet Configuration box is updated with assigned IP address(es). For IPv6 
Auto, you will see Link-Local, Stateless, and Stateful instead of IP Address. 

 Record the IP address(es). d

 

NOTE 
If your network does not support the automatic IP addressing, contact your network 
administrator to get a fixed IP address assigned to your instrument. 

–  For wireless LAN connection: 
 Select System Configuration > Remote Interface > Wi-Fi. a
 Select the currently connected network from the list, and then press the Select soft key. b
 Record the IP address displayed at the bottom. c

–  For Bluetooth tethering on an Android-based smartphone or Personal Hotspot on an  
iOS-based smartphone: 

 Select System Configuration > Remote Interface > Bluetooth. a
 Record the IP address assigned to your instrument under Connected Service. b

3 Press the SYSTEM hot key again. 
4 Select System Configuration > Remote Interface. 
5 Toggle the Web Remote soft key and select On to enable it. 
6 Open a Web browser on your computer or mobile device, and then enter the IP address you 

have obtained in step 2, depending on the TCP/IP protocol. Examples are the following: 
–  IPv4: 10.82.26.254 (put the entire address including dots in the URL bar) 

–  IPv6: [fe80::21b:22ff:fea1:924a] (make sure to add the brackets “[” and “]” and put the 
entire address including colons in the URL bar) 

Your instrument’s live screen appears on the Web browser as shown like Figure 6 or Figure 7. 
 NOTE 

The IPv6 protocol is supported on the operation system “Windows Vista” and later. 
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Figure 6 Example of Web remote on iPhone 

 

 
Figure 7 Example of Web remote on Chrome 

 



 
 

  

 

 

This chapter provides instructions on how to use JD700B series’ capabilities for measurement analysis. 
Topics discussed in this chapter are as follows: 
 

 Using marker ............................................................................................................................. 54 

 Using peak search ..................................................................................................................... 55 
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Marker is used to get the information about a specific trace. Six markers can be set on the display and each 
marker can be used independently. The X and Y coordinates of the trace are displayed when the marker is 
placed on any position of the trace. The position displaying the marker’s X and Y coordinates may be slightly 
different for each measurement mode and refer to the description of each measurement. There are three 
different marker types available: Normal, Delta, and Delta pair. Marker position can be set manually by 
entering numeric values (frequency) when one of the marker types is selected. 

 Select Marker: Selects an active marker whose position can be changed with the rotary knob or the 
arrow keys. The assigned number of the active marker is displayed in the Select Marker menu box 
and the active marker number is also displayed right next to the active marker on the trace when the 
Marker View is set to On. 

 Marker View: Displays the selected marker on the screen or hides it. When the Marker View is 
turned off and then on again in the same measurement mode, markers appear at the previous 
positions. If a measurement mode is changed, markers are not restored to their previous positions. 

 Normal: This Normal marker type provides the reading of a marker position on the trace along with 
the marker number between one and six. 

 Delta: This Delta marker type is associated with a Normal marker. A Normal marker must be set 
before a Delta marker is set. When the Delta marker is set, the position set by the Delta marker 
becomes the reference position of the Normal marker and the marker’s X and Y values displays the 
difference compared with the Delta marker. 

 Delta Pair: This Delta Pair marker type is associated with a Normal marker. A Normal marker must 
be set before a Delta Pair marker is set. When the Delta Pair marker is set, the position set by the 
Delta Pair marker becomes the reference position of the Normal marker and the marker’s X and Y 
values displays the difference compared with the Delta Pair marker. The reference position will be 
varied in accordance with trace change. 

 Marker All Off: Turns all the markers the screen off. When the Marker View is selected for those 
markers, the instrument displays those markers back at the previous position. If a measurement 
mode is changed, current settings are not restored. 

 Marker : Sets the X coordinate of the active marker as selected. 
- MarkerCenter: Sets the frequency of the active marker to the center frequency of spectrum 

analyzer. 
- MarkerStart: Sets the frequency of the active marker to the start frequency of spectrum 

analyzer. 
- MarkerStop: Sets the frequency of the active marker to the stop frequency of spectrum 

analyzer. 

 Frequency Count: This Frequency Count is used when a highly accurate reading of the frequency 
is needed for the active marker on the signal. The measurement sweeps get significantly slower 
because the instrument runs the measurement of the signal peak with 1 Hz resolution in background. 
Toggle this key between On and Off to enable or disable the frequency count function for the 
selected marker. 

 Noise Marker: This Noise Marker is used to measure a noise adjacent to a signal by averaging 
several data points to calculate the readout for the Noise Marker as if making a measurement using 
a 1 Hz bandwidth. Toggle this key between On and Off to enable or disable the noise marker 
function for the selected active marker. 
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NOTE 
Frequency Count and Noise Marker functions are used only in the Spectrum Analyzer 
mode. 

 

Each time the Peak Search soft key is pressed, the active marker is positioned at the highest peak of the 
trace. 

 Peak Search: Moves the active marker to the highest peak of the trace. 

 Next Peak: Moves the active marker to the second highest peak of the trace. 

 Next Peak Right: Moves the active marker to the highest peak to the right of its current position. 

 Next Peak Left: Moves the active marker to the highest peak to the left of its current position. 

 Min Search: Moves the active marker to the lowest peak of the trace. 

 Always Peak: When the Always Peak is set to On, the instrument moves the active marker 
automatically to the highest peak of the trace every time the trace is refreshed. 

 



 
 

  

 

 

This chapter provides instructions for using the Spectrum Analyzer function. Topics discussed in this chapter 
are as follows: 
 

 Introduction ................................................................................................................................ 57 

 Display overview ....................................................................................................................... 57 

 Connecting a cable .................................................................................................................... 58 

 Selecting measurement mode .................................................................................................. 59 

 Conducting spectrum measurements ....................................................................................... 66 

 Conducting RF measurements ................................................................................................. 69 
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The advantage of using the Spectrum Analyzer is easy to verify the presence of unwanted signals such as 
spurious and harmonics, which are normally very hard to identify in time domain analysis.  
 
Performance assurance in wireless communication systems includes the observation of the out-of-band 
signal characteristics in order to identify the presence of harmonic signals. Harmonic signals of a carrier may 
interfere with other signals far out of the transmission band, or harmonic signals from other transmitter may 
interfere with in band signals affecting the spectral integrity. 
 
In these days when wide variety of wireless communication services are provided in frequency bands 
assigned very closely to each other, it is critical to ensure that each communication service is carried out 
within their assigned frequency band minimizing interference with adjacent frequency bands. The Adjacent 
Channel Power Ratio (ACPR) characteristic of a power amplifier or other RF components is an important 
factor in evaluating the system performance. 
 
The JD700B series is the optimal solution to perform following measurements: 
 

 Spectrum Analysis 
- Spectrum 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask 
- Adjacent Channel Power (ACP) 
- Multi-ACP 
- Spurious Emissions 
- AM/FM Audio Demodulation 
- Field Strength 
- Route Map 
- Dual Spectrum 
- PIM Detection (Single and Multiple Carriers) 

 

Figure 8 provides overview of each segment of the measurement screen. 
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Figure 8 Spectrum measurement screen 

 

 

There are two ways that you can make a connection of your instrument and the base station to be tested: 
direct or indirect. 
 

Procedure 

To make a direct connection: 
1 Connect the Spectrum Analyzer RF In port of the JD700B series and the PA output port of BTS 

as shown in Figure 9. 
 
To make an indirect connection: 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS as shown in Figure 10. 

 
Figure 9 Direct connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 
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Figure 10 Indirect connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Spectrum Analyzer soft key. The Measure Off mode is selected by default. 
3 Press the MEASURE hot key, and then select the measurement mode from the following 

choices: 
–  Channel Power 

–  Occupied BW 

–  Spectrum Emission Mask 

–  Adjacent Channel Power 

–  Multi-ACP 

–  Spurious Emissions 

–  AM/FM Audio Demod 

–  Field Strength 

–  Route Map 

–  Dual Spectrum 

–  PIM Detection > Single Carrier and Multiple Carriers 

 

You need to set the frequency range to be measured with either the center frequency/span or the start/stop 
frequencies. You can also set the frequency with the channel number and span. 
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Procedure 

To set the center frequency and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Start Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Stop Frequency soft key. 
7 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
8 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the channel number and span: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the sweep direction and select Fwd (forward) or Rev (reverse). 
5 To set the channel number, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key or ENTER hard key to complete the entry. c

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6 To set the span, complete the following steps: 
 Press the Span soft key. a
 Select the span option, from the following choices: b

–  To set the span manually, select Span, enter a value, and then select the unit. 
–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1 Press the Frequency Step soft key, if the Freq is selected. 
2 Enter a value by using the numeric keys. 
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3 Press the unit: GHz, MHz, kHz, or Hz. 
 
Optional. To define the amount of channel increment for the rotary knob: 

1 Press the Channel Step soft key, if the Channel is selected. 
2 Enter a value by using the numeric keys. 
3 Press the Enter soft key. 

 

 

NOTE 
This setting is not used in the Spurious Emissions mode. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference level on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
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NOTE 
For the Field Strength mode, the units change to dBµV/m, dBmV/m, dBV/m, Volt/m, 
Watt/m^2, and dBm/m^2. 

 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamplifier so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

 

NOTE 
This setting is not used in the Field Strength mode. 

 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum value can 
be set up to 20 dB. 
 

Procedure 

To set the scale per division: 
1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
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3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can manually set the Resolution Bandwidth (RBW), Video Bandwidth (VBW), and the proportional VBW 
based on the designated RBW. Selecting Auto changes the value to correspond to your frequency span 
setting for RBW and to the current RBW and VBW/RBW settings for VBW. 
 

Procedure 

To automatically set the RBW and VBW to your selected VBW/RBW ratio: 
1 Press the BW/AVG hard key. 
2 Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW. 

Table 9 shows the ratio example for 30 kHz RBW. 
3 Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003. 
4 Toggle the RBW soft key and select Auto. 
5 Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 
 
To manually set the RBW or VBW to your selected VBW/RBW ratio: 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key. 
3 Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys. 
4 Select the unit: MHz, kHz, or Hz. 

The RBW setting automatically changes to Manual. 
5 Press the VBW soft key. 
6 Enter a value by using the numeric keys. 
7 Select the unit: MHz, kHz, or Hz. 

The VBW setting automatically changes to Manual. 
The RBW or VBW value on the screen changes accordingly. 

 

 

NOTE 
This setting is not used in the Spurious Emissions mode. 

 
Table 8 VBW/RBW ratio example 

RBW Ratio (VBW/RBW) VBW 

30 kHz 1:1 30 kHz 

 1:0.3 10 kHz 

 1:0.1 3 kHz 

 1:0.03 1 kHz 

 1:0.01 300 Hz 

 1:0.003 100 Hz 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
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Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings, and 
gated sweep on or off. 
 

You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time 
beyond an automatic setting. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Select the sweep time option, from the following choices: 

–  To automatically set, toggle the Sweep Time soft key and select Auto. 

–  To manually set, complete the following steps: 
 Press the Sweep Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

The sweep time mode automatically changes to Manual. 

 

 

NOTE 
This setting is not used in the Spurious Emissions mode. 

 

The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal speed 
for most on-going measurements. If you want to hold the measurement or get a single sweep, you can 
change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 
4 Optional. To speed up sweeping, press the Sweep Mode soft key and then select Fast. 

 

NOTE 
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but it is useful to 
identify the existence of interfering signals. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
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The letter HOLD in red disappears and the sweeping resumes. 
 

 

NOTE 
This setting is not used in the in the Field Strength mode, the AM/FM Audio Demodulation 
mode, and the Route Map mode. 

 

You can configure the gated sweep settings with an internal or external trigger source. If you select Gated 
Sweep Settings, you can view the signal in time domain. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Press the Gated Sweep Settings soft key. 
3 Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps: 

 Press the Zero Span Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

4 Set the period, if using the internal trigger source, by doing one of the following: 
–  To select the preset period, complete the following steps: 

 Toggle the Period soft key and select StdSignal. a
 Press the StdSignal soft key, and then select the period from the choices:  b

GSM (4.615 ms), WCDMA (10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), 
and WiMAX (10 ms). 

–  To manually set the period, complete the following steps: 
 Toggle the Period soft key and select Manual. a
 Press the Period soft key to enter the amount of time. b
 Enter a value by using the numeric keys. c
 Select the unit: Sec, mSec, or µSec. d

5 Press the TRIGGER hot key, and then do one of the following: 
–  Select External for an external trigger source. 

–  Select Video or Display Position for the internal trigger source. 

6 Press the PREV hard key to continue setting the gated sweep. 
7 Set the gate delay by completing the following steps: 

 Press the Gate Delay soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

8 Set the gate length by completing the following steps: 
 Press the Gate Length soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

9 Press the PREV hard key to enable gated sweeping. 
10 Toggle the Gated Sweep soft key and select On. 

 

 

NOTE 
This setting is not used in the in the Spurious Emissions mode, the Field Strength mode, 
and the Route Map mode. 

 

You can turn on the RF Source feature to generate a CW signal of different output power levels. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the RF Source soft key. 
3 To set the frequency of the CW signal to be injected, complete the following steps: 

 Press the Frequency soft key. a
 Enter a value within the frequency range of your instrument. b

–  JD740B series: 25 MHz to 4 GHz 

–  JD780B series: 5 MHz to 6 GHz 

 Select the unit option from the choices: GHz, MHz, kHz, and Hz. c
4 To set the output level of the CW signal to be injected, complete following steps: 

 Press the Power Level soft key. a
 Enter a value within the output range for the frequency you have set. b

–  JD740B series: -80 dBm to -30 dBm, 0 dBm 

–  JD780B series: -60 dBm to 10 dBm 

 Press the Enter soft key. c
5 To start to inject the set signal, toggle the RF Source soft key and select On. 
6 To stop injecting the signal, toggle the RF Source soft key and select Off. 

 

If you have configured test parameters as described in the “Configuring test parameters” on page 59, your 
measurement is displayed on the screen as like the following example, Figure 11. 
 

Figure 11 Spectrum measurement with spectrum analyzer 
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Figure 12 Gate sweep measurement with spectrum analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

 

4 To select the detection option, select More (1/2) > Detectors, and then do one of the following: 
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To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

5 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

 

NOTE 
To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Procedure 

To use the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
 
To display the multiple segment line: 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 

 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 
6 Optional. To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 
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8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

If you want to check how much the actual frequency has been drifted from the input center frequency on 
your spectrum, you can set the center frequency as a frequency reference or an offset to view the drifted 
amount in frequency easily. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 Press the Frequency Offset soft key. 
3 Enter a value using the numeric keys. You can also turn the rotary knob to change the value.  

For example, if you have set the center frequency as 89.1 MHz and want to set it as a frequency 
reference, you need to enter “-89.1” in the user input field to view the center frequency as “0”.   

4 Select the unit: GHz, MHz, kHz, or Hz. 
All frequency information on the display changes accordingly. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density, and Peak to Average 
Ratio (PAR) of the signal within the channel bandwidth. 
 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 59. 
2 Press the MEASURE SETUP hot key. 
3 Set the channel power measurement bandwidth to be measured: 

 Press the Integrated BW soft key. a
 Enter a bandwidth by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c
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5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Channel Power soft key to set the limit parameters. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit, and then press the dBm unit soft key. b

5 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit, and then press the dBm unit soft key. b

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 13 Channel power measurement with spectrum analyzer 

 
 
Channel power measurement result shows channel power and spectrum density in a user specified channel 
bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The shaded area 
on the display indicates the channel bandwidth. 
 

The Occupied Bandwidth measures the percentage of the transmitted power within a specified bandwidth. 
The percentage is typically 99%. 
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After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 59. 
2 Press the MEASURE SETUP hot key. 
3 Set the percentage of power within the bandwidth to be measured: 

 Press the Occupied BW % Power soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Occupied BW soft key to set the limit parameters. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit, and then select the unit: MHz, kHz, or Hz. b

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in a 
user specified percentage to determine the amount of spectrum used by a modulated signal. Occupied 
bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power. 
 



Chapter 4 Using Spectrum Analyzer 

72 JD700B Series User’s Guide 

Figure 14 Occupied bandwidth measurement with spectrum analyzer 

 
 

The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of out-of-
band spurious emission outside the necessary channel bandwidth and modulated signal. It measures the 
power ratio between in-band and adjacent channels. The JD700B series indicates either Pass or Fail based 
on the specified limit of the signal. 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 59. 
2 Press the MEASURE SETUP hot key. 
3 Set the main channel bandwidth to be measured: 

 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100, and then press the Enter soft key. b

6 To configure an offset, up to five, complete the following steps: 
 Press the Offset/Limit soft key. a

The Offset/Limit menu bar appears. 
 Press the Offset soft key, and then select the number for the active offset to configure. b
 Toggle the Offset soft key and select On to display or Off to hide the active offset. c
 Press the Offset Frequency soft key to set the center frequency of the offset. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
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 Select the unit: MHz, kHz, or Hz. f
 Press the Measurement Bandwidth soft key to set the bandwidth for the selected offset. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: MHz, kHz, or Hz. i
 Toggle the Reference soft key between Relative and Absolute and select Relative or j

Absolute depending on how to use the reference. 
7 To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

 Press the Start Offset Limit soft key to set the threshold for the power difference between a
the main channel bandwidth and the selected offset bandwidth on the left. 

 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dB soft key. c
 Press the Stop Offset Limit soft key to set the threshold for the power difference between d

the main channel bandwidth and the selected offset bandwidth on the right. 
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dB soft key. f

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Spectrum Emission Mask soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 15 Spectrum emission mask measurement with spectrum analyzer 

 
 

The Adjacent Channel Power (ACP) is the power contained in a specified frequency channel bandwidth 
relative to the total carrier power. It may also be expressed as a ratio of power spectral densities between 
the carrier and the specified offset frequency band. 
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After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 59. 
2 Press the MEASURE SETUP hot key. 
3 Set the main channel bandwidth to be measured: 

 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100, and then press the Enter soft key. b

6 To configure an offset, up to five, complete the following steps: 
 Press the Offset/Limit soft key. a

The Offset/Limit menu bar appears. 
 Press the Offset soft key, and then select the number for the active offset to configure. b
 Toggle the Offset soft key and select On to display or Off to hide the active offset. c
 Press the Offset Frequency soft key to set the center frequency of the offset. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: MHz, kHz, or Hz. f
 Press the Integration Bandwidth soft key to set the bandwidth for the selected offset. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: MHz, kHz, or Hz. i
7 To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

 Press the Lower soft key to set the threshold for the power difference between the main a
channel bandwidth and the selected offset bandwidth on the left. 

 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBc soft key. c
 Press the Upper soft key to set the threshold for the power difference between the main d

channel bandwidth and the selected offset bandwidth on the right. 
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBc soft key. f

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the ACP soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Figure 16 Adjacent channel power measurement with spectrum analyzer 

 
 

The Multi-ACP measurement is used to do multi-channel ACP testing. It helps you to measure ACP in multi-
channel transmitting base station environment. 
 

After configuring test parameters as described in “Configuring test parameters” on page 59, you can set the 
measure setup to continue your measurement. The measurement settings can be saved and recalled as a 
file. You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 
load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Unit soft key and select Freq or Channel. 

–  For the frequency setting, complete the following steps: 
 Press the Lowest Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c
 Press the Highest Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: GHz, MHz, kHz, or Hz. f

–  For the channel setting, complete the following steps: 
 Press the Channel Std soft key. The standard channel window appears. a
 Select the band to be measured by using the rotary knob or the Page p/Page Down b

soft keys. 
 Press the Select soft key or the rotary knob to confirm the selection. c
 Toggle the Link soft key to select the sweep direction and select Fwd (forward) or Rev d

(reverse) as needed. 
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 Press the Lowest Channel soft key. e
 Enter a value by using the numeric keys. f
 Press the Enter soft key or ENTER hard key to complete the entry. g

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

 Press the Highest Channel soft key. h
 Enter a value by using the numeric keys. i
 Press the Enter soft key or ENTER hard key to complete the entry. j

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

3 To set up ACP setting, press the ACP Settings soft key and then complete the following steps: 
 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c
 Press the Span soft key to set the frequency range over which the instrument will sweep. d
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the Average soft key to set the number of measurement to be averaged: g
 Enter a value between 1 and 100. h

 Press the Enter soft key. i
4 To configure an offset, up to five, complete the following steps: 

 Press the Offset/Limit soft key. The Offset/Limit menu bar appears. a
 Press the Offset soft key, and then select the number for the active offset to configure. b
 Toggle the Offset soft key and select On to display or Off to hide the active offset. c
 Press the Offset Frequency soft key to set the offset frequency. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: MHz, kHz, or Hz. f
 Press the Integration Bandwidth soft key. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: MHz, kHz, or Hz. i
5 To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

 Press the Lower soft key to set the threshold for the power difference between the main a
channel bandwidth and the selected offset bandwidth on the left. 

 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBc soft key. c
 Press the Upper soft key to set the threshold for the power difference between the main d

channel bandwidth and the selected offset bandwidth on the right. 
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBc soft key. f

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi-ACP soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Figure 17 Multi-ACP measurement with spectrum analyzer 

 
 

The Spurious Emissions measurement is to identify or determine the power level of in-band or out-of-band 
spurious emissions within the necessary channel bandwidth and modulated signal. The JD700B series 
indicates either Pass or Fail based on the specified limit of the signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 59, you can set 
the measure setup to continue your measurement. The measurement settings can be saved and recalled as 
a file. You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 
load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a

as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
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3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20. b
 Press the Enter soft key. c

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Spurious Emissions soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 18 Spurious emissions measurement with spectrum analyzer 

 
 

The AM/FM Audio Demodulator operates using the power received from radio waves and it serves as an 
alternative to identify interfering signals easily. The instrument sounds demodulated signals that can be 
heard through the built-in speaker or plugged-in headphones. You can hear the sound and identify 
interfering signals easily. 
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After configuring test parameters as described in the “Configuring test parameters” on page 59, you can set 
the measure setup to continue your measurement. The measurement settings can be saved and recalled as 
a file. You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 
load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation 

on and off. 
3 Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as the AM/FM 
demodulator uses the marker position to demodulate. See “Using marker” on page 54 for 
more information. 

4 Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW. 
5 Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval 

between 1 and 20. 
6 Press the Volume soft key, and then turn the rotary knob to set the speaker volume. 
7 Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 

feature to adjust the interval gain of the demodulator. 
8 Optional. You can use the Save On Event soft key to let the instrument automatically save 

measurement screen or result that falls outside the defined limit settings or the Fail indicator is 
on. You can also set to save the first event and hold the measurement or to save all the events 
continuously. See “Using save” on page 33 for more information. 

 

You can show or hide the display line on the screen that is used as a visual reference only. 
 

Procedure 

To view the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line On/Off soft key and select On. 

The straight line appears on the screen. 
 
To dismiss the display line: 

1 Press the LIMIT hot key. 
2 Toggle the Display Line On/Off soft key and select Off. 

 
You can use the multiple segment limit line to set up different limits for different frequency ranges for 
Pass/Fail indication. 
 

Procedure 

To display the multiple segment line: 
1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
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4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 
 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 
6 Optional. To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 19 AM/FM audio demodulation with spectrum analyzer 

 
 

The Field Strength Meter measures the field strength over the frequency range of a connected antenna, 
which is known with its specific bandwidth and gain characteristics. A standard or user-defined antenna can 
be selected from the antenna list in the JD700B series. 
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Procedure 

1 Connect an antenna to be used with your instrument. 
2 Configure test parameters as described in the “Configuring test parameters” on page 59. 
3 Press the MEASURE SETUP hot key, and then do one of the following: 

–  To select the connected antenna from the list stored in the instrument: 
 Press the Antenna List soft key to view the standard and custom antennas. a

The antenna list window appears. 
 Select an antenna to be used for the field strength measurement by using the rotary b

knob, the arrow keys, or Page Up/Page Down soft keys. 
 Press the Select soft key. c

 

NOTE 
You can use the JDViewer to edit or define a custom antenna and add to this list. 

–  To edit the properties of the connected antenna: 
 Press the Antenna Start Frequency soft key. a
 Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or b

Hz. You can also use the rotary knob. 
 Press the Antenna Stop Frequency soft key. c
 Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or d

Hz. You can also use the rotary knob. 
 Press the Gain soft key to enter the gain information for the antenna. e
 Enter a value by using the numeric keys, and then select the Enter soft key. f

 

You can show or hide the display line on the screen that is used as a visual reference only. 
 

Procedure 

To view the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line On/Off soft key and select On. 

The straight line appears on the screen. 
 
To dismiss the display line: 

1 Press the LIMIT hot key. 
2 Toggle the Display Line On/Off soft key and select Off. 

 
You can use the multiple segment limit line to set up different limits for different frequency ranges for 
Pass/Fail indication. 
 

Procedure 

To display the multiple segment line: 
1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 

 Press the # of Line soft key. a
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 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to set and display the limit line for each segment automatically. 
6 Optional. To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 
–  To add a new point, press the Add Point soft key. 
–  To delete the selected point, press the Delete Point soft key. 
–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 20 Field strength measurement with spectrum analyzer 

  
 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map. 
 
The JD700B Series also supports the RAN-IL (Interference Location) feature that enables you to overlay 
user experience data obtained through Viavi’s ariesoGEO on your base map to help you troubleshoot 
problems easily and quickly using your instrument. You can generate raster data files on the ariesoGEO 
application and load them on your instrument. 
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Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 59. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, select 
GPS and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna, select Position. 

–  To collect data/plot points based on time, select Time. 
You do not need a GPS antenna as you would usually use this option indoor. 

6 Press the Plot Item soft key, and then select the measurement option: RSSI or ACP. 
7 Optional. If ACP is selected, set the Main Channel BW and Offset/Limit : 

 Press the Main Channel BW soft key. a
 Enter a value, and then select the unit from the choices: MHz, kHz, and Hz. b
 Press the Offset/Limit soft key. c
 Toggle the Offset soft key and select On to display or Off to hide the offset. d
 Press the Integration Bandwidth soft key. e
 Enter a value, and then select the unit from the choices: MHz, kHz, and Hz. f
 Press the Offset Frequency soft key to set the offset frequency. g
 Enter a value, and then select the unit from the choices: MHz, kHz, and Hz. h

 Press the Offset Limit soft key to set the offset limit. i
 Enter a value, and then select the dB soft key. j

8 Toggle the Plot soft key and select Start. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position or Time setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with screen touch or 
the arrow keys and the distance with the rotary knob. For the Time setting, the instrument 
interpolates points in between two enters on a straight dotted line. You can change the 
direction of the route with the arrow keys and the distance with the rotary knob. 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. See “Using save” on page 33 for more 
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information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for the four different color indicators. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Excellent soft key to set its threshold. 
3 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
4 Press the Very Good soft key to set its threshold. 
5 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
6 Press the Good soft key to set its threshold. 
7 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
8 Press the Poor soft key to set its threshold. 
9 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
10 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 21 Route map measurement screen with GPS 

  
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 To zoom in or zoom out, do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 

 

If you have a set of raster data files generated through the ariesoGEO application, you can load and overlay 
the data on your base map to help you check the signal quality and the strength of interferences while 
driving toward the area of interest. 
 

Procedure 

1 Copy a set of raster data files into your USB memory drive, including the following: 
–  ASCII: .tab, .asc, and .clr files 
–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 
information systems. The color file (.clr) is an optional file, but the image will be 
displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2 Plug in the USB memory drive to your instrument. 
3 Press the TRACE/DISPLAY hard key. 
4 Press the Load Raster Map soft key. 

The file explorer window appears. 
5 Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 22. 

 

NOTE 
If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6 To select the display option, complete the following steps: 
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 Press the Display Options soft key. a
 Select the option you desire from the choices: On, Off, and Blink. b

7 To adjust the transparency level of the image, complete the following steps: 
 Press the Transparency soft key. a
 Enter a value between 0 for opaque and 100 for clear. b
 Press the Enter soft key. c

 
Figure 22 Raster image overlaid on the base map 

  
 

The Dual Spectrum feature lets you view two spectrum measurements, both the Uplink and Downlink 
spectrum, simultaneously eliminating the need to swap between two screens back and forth. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 59. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Active Window soft key between Top and Bottom to select the measurement 

window to configure or work on. You can also tap on the top or bottom chart on the screen. 
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Figure 23 Dual spectrum measurement with spectrum analyzer 

 
 

The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum for 
any technology. When PIM is detected, the normal repair mode is to replace the offending cable and what 
you need to do is replacing the whole cable irrespective of the location of the fault. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Connect cables as instructed on the screen. 
3 Optional. To check any possibility of PIM existence in red color by calculation, complete the 

following steps: 
 Press the Calculated PIM soft key. a
 Press the Radio Band soft key for single carrier. b

There are Radio 1 Band and Radio 2 Band soft keys for multiple carriers. 
 Highlight a desired band and then press the Select soft key. c
 Press the Return soft key. d

4 To set the uplink frequency to be measured, do one of the following: 
–  To set the center frequency and span, complete the following steps: 

 Toggle the Unit soft key and select Freq. a
 Press the Uplink Center Frequency soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Uplink Span soft key. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number and span, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 Press the Channel Std soft key and select a desired band. b
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 Press the Channel Number soft key. c
 Enter a value by using the numeric keys and then press the Enter soft key. d

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

 Press the Uplink Span soft key. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

5 Press the Continue soft key and follow the instructions on the screen. 

 

Figure 24 PIM detection for single carrier 

 
 

Figure 25 PIM detection for multiple carriers 
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Interference is becoming more prevalent in the wireless community with the increasing number of 
transmitters coming on the air. Wireless service providers have traditionally used spectrum analyzers to 
monitor service channels, frequencies, and adjacent spectrum and to locate sources of interference. A 
spectrum analyzer can only show you an interfering signal and you require determining the source of the 
interference. To solve interference problems, you must understand the RF environment, know adjacent 
operating transmitters, and identify any new or unlicensed emitters. 
 
Once a potential interfering signal is identified in the Spectrum Analyzer mode, you can monitor the signal 
further in the Interference Analyzer mode. JD700B series provides two different methodologies to identify 
and determine interference signals: Spectrogram and Received Signal Strength Indicator (RSSI). Locating 
the source of interference signal can be done with geographical information received from the built-in GPS 
receiver. 
 
The JD700B series is extremely effective for locating and identifying periodic or intermittent RF interference. 
Interference signals derive from several kinds of licensed or unlicensed transmitters that cause dropped 
calls and poor service quality.  
 
The JD700B series provides following measurements for interference analysis: 
 

 Spectrum 
 Spectrogram 
 Dual Spectrogram 
 RSSI (Received Signal Strength Indicator) 
 Interference Finder 
 Spectrum Replayer 
 Radar Chart 

 
Using a set of the AntennaAdvisor Handle that holds a broadband directional antenna is mandatory in the 
Rader Chart mode and its built-in compass, GPS antenna, gyro sensor, and low-noise amplifier (LNA) 
benefits you to determine the direction of the interference. 
 

Figure 26 provides descriptions for each segment of the measurement screen. 
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Figure 26 Interference measurement screen 

 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 27 Interference measurement connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 
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CAUTION 
If the input signal level to be measured is less than 0 dBm, set it to 0 dB attenuation or 
turn on the preamp to have better dynamic range for the testing. 

 

In the Interference Finder mode and the Radar Chart mode, you can perform interference hunting using the 
AntennaAdvisor Handle after attaching a broadband directional antenna to it. The handle is a device that 
has a built-in GPS antenna and LNA. 
 

Procedure 

1 Mount a broadband antenna to your AntennaAdvisor Handle according to the quick start guide of 
the AntennaAdvisor Handle. 

2 Connect the RF Type-N jack of the handle to the RF In port of the instrument. 
3 Connect the GPS SMA jack of the handle to the GPS port of the instrument. 

The GPS status indicator appears on the instrument screen. If GPS is locked, the indicator turns 
green. 

4 Connect the USB plug of the handle to the USB Host port of the JD700B series. 
The device icon      appears in the system status bar on the screen. 

 
Figure 28 Connection using AntennaAdvisor handle and log-periodic antenna 

 
 

Procedure 

1 Press the MODE hard key. 
2 Press the Interference Analyzer soft key. The Spectrum mode is selected by default. 
3 To change the mode, press the MEASURE hot key and then select the measurement mode: 

Spectrogram, Dual Spectrogram, RSSI, Interference Finder, or Spectrum Replayer. 
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NOTE 
If the Dual Spectrogram is selected, you can select the left or right measurement pane 
in MEASURE SETUP to configure measurement parameters for the selected 
spectrogram. 

 

You need to set the frequency range to be measured with either the center frequency/span or the start/stop 
frequencies. You can also set the frequency with the channel number and span. 
 

Procedure 

To set the center frequency and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Start Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Stop Frequency soft key. 
7 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
8 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the channel number and span: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the sweep direction and select Fwd (forward) or Rev (reverse). 
5 To set the channel number, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key or ENTER hard key to complete the entry. c

The instrument automatically displays the corresponding center frequency value for the 
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selected channel number. 
6 To set the span, complete the following steps: 

 Press the Span soft key. a
 Select the span option, from the following choices: b

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1 Press the Frequency Step soft key, if the Freq is selected. 
2 Enter a value by using the numeric keys. 
3 Press the unit: GHz, MHz, kHz, or Hz. 

 

Optional. To define the amount of channel increment for the rotary knob: 
1 Press the Channel Step soft key, if the Channel is selected. 
2 Enter a value by using the numeric keys. 
3 Press the Enter soft key. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d
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–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum value can 
be set up to 20 dB. 
 

Procedure 

To set the scale per division: 
1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 
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To turn the external offset off: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

VBW based on the designated RBW. Selecting Auto changes the value to correspond to your frequency 
span setting for RBW and to the current RBW and VBW/RBW settings for VBW. 
 

Procedure 

To automatically set the RBW and VBW to your selected VBW/RBW ratio: 
1 Press the BW/AVG hard key. 
2 Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW. 

Table 9 shows the ratio example for 30 kHz RBW. 
3 Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003. 
4 Toggle the RBW soft key and select Auto. 
5 Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 
 
To manually set the RBW or VBW to your selected VBW/RBW ratio: 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key. 
3 Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys. 
4 Select the unit: MHz, kHz, or Hz. 

The RBW setting automatically changes to Manual. 
5 Press the VBW soft key. 
6 Enter a value by using the numeric keys. 
7 Select the unit: MHz, kHz, or Hz. 

The VBW setting automatically changes to Manual. 
The RBW or VBW value on the screen changes accordingly. 

 
Table 9 VBW/RBW ratio example 

RBW Ratio (VBW/RBW) VBW 

30 kHz 1:1 30 kHz 

 1:0.3 10 kHz 

 1:0.1 3 kHz 

 1:0.03 1 kHz 

 1:0.01 300 Hz 

 1:0.003 100 Hz 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
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Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings, and 
gated sweep on or off. This key is not available in the Dual Spectrum mode. 
 

You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time 
beyond an automatic setting. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Select the sweep time option, from the following choices: 

–  To automatically set, toggle the Sweep Time soft key and select Auto. 

–  To manually set, complete the following steps: 
 Press the Sweep Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

The sweep time mode automatically changes to Manual. 

 

The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal speed 
for most on-going measurements. If you want to hold the measurement or get a single sweep, you can 
change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

 

NOTE 
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use 
this fast sweep mode to identify the existence of interfering signals. 
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You can configure the gated sweep settings with an internal or external trigger source. If you select Gated 
Sweep Settings, you can view the signal in time domain. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Press the Gated Sweep Settings soft key. 
3 Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps: 

 Press the Zero Span Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

4 Set the period, if using the internal trigger source, by doing one of the following: 
–  To select the preset period, complete the following steps: 

 Toggle the Period soft key and select StdSignal. a
 Press the StdSignal soft key, and then select the period from the choices:  b

GSM (4.615 ms), WCDMA (10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), 
and WiMAX (10 ms). 

–  To manually set the period, complete the following steps: 
 Toggle the Period soft key and select Manual. a
 Press the Period soft key to enter the amount of time. b
 Enter a value by using the numeric keys. c
 Select the unit: Sec, mSec, or µSec. d

5 Press the TRIGGER hot key, and then do one of the following: 
–  Select External for an external trigger source. 

–  Select Video or Display Position for the internal trigger source. 

6 Press the PREV hard key to continue setting the gated sweep. 
7 Set the gate delay by completing the following steps: 

 Press the Gate Delay soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

8 Set the gate length by completing the following steps: 
 Press the Gate Length soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

9 Press the PREV hard key to enable gated sweeping. 
10 Toggle the Gated Sweep soft key and select On. 

 

 

NOTE 
This setting is not used in the Spectrum Replayer mode. 

 

The spectrum measurement with an audible indicator is especially useful for locating interferer sources with 
a directional antenna. 
 

You can display up to six traces on the measurement chart simultaneously. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

 

4 To select the detection option, select More (1/2) > Detectors, and then do one of the following: 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

5 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

 

NOTE 
To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

You can use the Sound Indicator to help you identify interfering signals by sounding an alarm. 
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Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 93. 
2 Press the MEASURE SETUP hot key. 
3 Press the Sound Indicator soft key. 
4 Toggle the Sound soft key between On and Off to enable and disable the alarm sound. 
5 Select the alarm reference option from the following choices: 

–  To set the active marker position as the alarm reference, toggle the Alarm Reference soft 
key and select Marker. 

–  To set the limit as the alarm reference, complete the following steps: 
 Toggle the Alarm Reference soft key and select Line. a

The Limit Line menu becomes activated to be set. 
 Press the Limit Line soft key to define a threshold for the limit line. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the dBm soft key. d

6 Optional. To adjust the volume for alarm sound, press the Volume soft key and then turn the 
rotary knob clockwise or counter clockwise. 

7 Optional. You can save logging data automatically so that you can load the measurement data 
and replay in the Spectrum Replayer mode. See “Using save” on page 33 for more information. 

 

You can use the AM/FM Audio Demodulation to identify if the interfering signal is nth harmonics of AM/FM 
audio. The instrument sounds demodulated signals that you can hear through the speaker or headphones. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 93. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation 

on and off. 
4 Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as the AM/FM 
demodulator uses the marker position to demodulate. See “Using marker” on page 54 for 
more information. 

5 Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW. 
6 Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval 

between 1 and 20. 
7 Press the Volume soft key, and then turn the rotary knob to set the speaker volume. 
8 Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 

feature to adjust the interval gain of the demodulator. 
9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

The Interference ID automatically classifies interfering signals over a designated spectrum and displays the 
list of possible signal types corresponding to the selected signal. 
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Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 93. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Interference ID soft key between On and Off to turn the Interference ID on and off. 
4 To set the threshold level manually, complete the following steps: 

 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 110 
for more information. 

 

The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it 
captures spectrum activity over time and uses various colors to differentiate spectrum power levels. When 
the directional antenna is used to receive the signal, you will see a change in the amplitude of the tracked 
signal as you change the direction of the antenna and see a change in the Spectrogram colors. The source 
of the signal is located in the direction that results in the highest signal strength. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 93. 
2 Press the MEASURE SETUP hot key. 
3 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Sec soft key. c

4 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

5 To start a new measurement, press the Reset/Restart soft key. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
 

The spectrogram shows a vertical line on the chart when the marker is enabled on the screen. 
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Figure 29 Interference measurement in spectrogram 

 
 

 The horizontal line or X-axis of the spectrogram is frequency. 

 The vertical line or Y-axis is time. 

 The color identification (Spectrogram) indicates power level of the tracked signal. As the signal 
strength increases, the color on the spectrogram changes accordingly. 

 
Figure 30 Interference measurement in spectrogram with gated sweep on 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 110 
for more information. 

 

The Dual Spectrogram mode is useful to compare two spectrograms displayed simultaneously on the screen. 
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Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 93. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Active Window soft key and select Left or Right spectrogram to be set up. You can 

also tap on the left or right chart on the screen. 
4 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Sec soft key. c

5 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 
 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

6 To start a new measurement, press the Reset/Restart soft key. 
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 31 Interference measurement in dual spectrogram view 

 
 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly useful for 
measuring power-level variations over time. The RSSI measurement lets you assign power limit line for 
audible alarms and increase alarm counters every time a signal exceeds a defined limit line. For long-term 
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analysis, the spectrogram and RSSI measurements can be automatically saved into an external USB 
memory. Post-analysis can be performed with JDViewer application software. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 93. 
2 Press the MEASURE SETUP hot key. 
3 To set up the alarm parameters, complete the following steps: 

 Press the Alarm soft key. a
 Press the Alarm at soft key and select the marker number: M1 to M6. b
 Press the Limit Line soft key to set a threshold for the alarm. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the dBm soft key. e
 Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. f
 Optional. Press the Volume soft key and adjust the volume. g

4 To set up the AM/FM audio demodulation, complete the following steps: 
 Press the AM/FM Audio Demod soft key. a
 Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio b

demodulation on or off. 
 Press the Demod at soft key, and then select the marker number for the frequency to be c

demodulated. 
 

 

NOTE 
For the alarm and AM/FM audio demodulation, you must set the marker(s) first by using 
the MARKER hard key as these features use the marker position to sound alarm or 
demodulate. See “Using marker” on page 54 for more information. 

 

 Press the Demod Mode soft key, and then select the demodulation mode: AM, FM, and CW. d
 Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation e

interval between 1 and 20. 
 Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain f

feature to adjust the interval gain of the demodulator. 
 Optional. Press the Volume soft key and adjust the volume. g

5 To start a new measurement, press the Reset/Restart soft key. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 32 Interference measurement in RSSI 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 110 
for more information. 

 

The Interference Finder is an automatic triangulation algorithm that uses GPS coordinates to locate possible 
interference sources based on three measurements. The interference finder calculates possible interference 
locations using its inscribed circle or circumscribed circle based on measured intersection points. You can 
plot up to seven measurement points and select three that are more representative for triangulation. JD700B 
series automatically logs measurement positions not to lose them while changing measurement modes. 
 
The JD700B Series also supports the RAN-IL (Interference Location) feature that enables you to overlay 
user experience data obtained through Viavi’s ariesoGEO on your base map to help you troubleshoot 
problems easily and quickly using your instrument. You can generate raster data files on the ariesoGEO 
application and load them on your instrument. 
 

After you have made connections as described in the “Using an Omni or Yagi antenna” on page 91 and 
configured test parameters as described in the “Configuring test parameters” on page 93, you need to load a 
map of the area where you want to go out and do interference hunting. 
 

Procedure 

1 Plug in your USB drive that has a map file in .mcf file type created in JDMapCreator. If the 
JDMapCreator application on your computer is connected to the instrument via USB or LAN,  
you can send a map file with a single layer to the instrument directly by using the Send to EQP 
menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
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after loading it. 

2 Press SAVE/LOAD hot key, and then select Load > Load Map. 
3 Navigate to a map file you want to open. 

The File Information pane displays file properties including file name, map type, and address. If 
you see “Sizable Map” for Map Type, you can zoom in and out the base map after loading. 

4 Press the Load soft key. The loaded map appears. 

 

If you have connected the AntennaAdvisor Handle to your instrument, you need to initialize it so that you get 
azimuth data as accurately as possible. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
A message appears at the bottom of the screen to alert you if you have not performed 
initialization of your connected the antenna handle set. 

2 To adjust the integration bandwidth based on the center frequency of the interfering signal that 
you have identified in the Spectrum view, complete the following steps: 

 Press the Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. c

3 Initialize the antenna handle to calibrate the built-in compass by completing the following steps: 
 Hold your antenna handle horizontally in its upright position. a
 Point the antenna to the north, and then press the Initialize AntennaAdvisor soft key. b

 

As the Interference Finder uses triangulation to provide a circle of possible source of the interference, you 
must set three location points so that the straight lines started from the point can create three intersections. 
If you have the AntennaAdvisor Handle, it makes it easy to determine these points using its built-in compass 
and GPS antenna while measure power level of the received signal. 
 

Procedure 

1 Press the Location Setup soft key in the Measure Setup menu bar. 
2 Press the Location soft key to set three location points. 
3 Press the Point [1|2|3] soft key to set the first location point, and then do one of the following: 

–  To automatically get the selected point’s positioning information with GPS locked, press the 
Get GPS Position. The instrument displays the latitude and longitude information of the 
signal received by either the GPS antenna or AntennaAdvisor Handle. 

–  To manually define a position for the selected point, complete the following steps: 
 Press the Latitude soft key, and then set the properties: North/South, Degree, a

Minute, and Second. 
 Press the Longitude soft key, and then set the properties: East/West, Degree, b

Minute, and Second. 
4 To set an azimuth, do one of the following: 

–  Using the AntennaAdvisor Handle, complete the following steps: 
 Press and hold the TRIGGER button on the handle and pan the antenna handle to scan a

through until you find the strongest RSSI value. 
RSSI, polarization, elevation and azimuth readings are continuously updated on the 
screen while pressing the physical button. 



Chapter 5 Using Interference Analyzer 

 JD700B Series User’s Guide 107 

 Release the TRIGGER button to stop scanning. b
–  Using a compass, complete the following steps: 

 Press the Azimuth soft key. a
 Pan your Yagi antenna to find a signal with highest RSSI value, and then measure an b

azimuth of the interfering signal. 
 Enter the measured angle using the numeric keys, and then press the Enter soft key. c

–  Using your instrument without a compass, complete the following steps: 
 Press the Azimuth soft key. a
 Pan your Yagi antenna to find a signal with highest RSSI value. b
 Turn the rotary knob to align the straight line on the base map with the direction of the c

interfering signal. The azimuth calculated by the instrument appears on the screen. 

 

NOTE 
The AntennaAdvisor Handle has a built-in low-noise amplifier (LNA) and you can turn it 
on and off using the physical On/Off button located on the rear side of the handle unit. 
For example, if the received signal is weak, you can turn on the switch to improve S/N. 

5 To save the defined position, press the Save Position soft key and then select one of the soft 
keys to which you want to save the position information. The instrument stores the saved location 
points in the internal memory so that you can load them by using the Load Position soft key. 

6 Press the Location soft key, and then repeat steps 3-5 to set the second location point. 
7 Press the Location soft key, and then repeat steps 3-5 to set the third location point. 

The circumscribed circle appears when the lines from three location points create three 
intersections or vertices. 

   
 

 

When the triangulation is done with three location points and azimuth for each point, you can view a 
circumscribed circle by default. You can change the display mode to inscribed circle or double circles to view 
a narrower area. The center of the green-shaded circle is determined to be where the source of the 
interfering signal resides. 
 

Procedure 

1 Press the Display Setup soft key in the Measure Setup menu bar. 
2 Press the Display Mode soft key, and then select the option from the following choices: 

Circum: It displays a 
circumscribed circle that meets 
three vertices of the triangle. 

 

Inscribed: It displays an 
inscribed circle that meets the 
three sides of the triangle. 

 

Double: It displays both 
circumscribed and inscribed 
circles. 

 
3 Toggle the Screen Mode soft key to select Map or Full as needed. 

–  Map: This option displays what are inside the base map with the map image. 
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–  Full: This option displays three location points and defined circle without the map image. 

 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the green-shaded area on the map and view the location of 
the interference source in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

 

Figure 33 Interference finder measurement in map view 

 
 

If you have a set of raster data files generated through the ariesoGEO application, you can load and overlay 
the data on your base map to help you assume suspicious points of interference easily and pinpoint the 
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source of the interference quickly. 
 

Procedure 

1 Copy a set of raster data files into your USB memory drive, including the following: 
–  ASCII: .tab, .asc, and .clr files 
–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 
information systems. The color file (.clr) is an optional file, but the image will be 
displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2 Plug in the USB memory drive to your instrument. 
3 Press the TRACE/DISPLAY hard key. 
4 Press the Load Raster Map soft key. 

The file explorer window appears. 
5 Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 34. 

 

NOTE 
If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6 To select the display option, complete the following steps: 
 Press the Display Options soft key. a
 Select the option you desire from the choices: On, Off, and Blink. b

7 To adjust the transparency level of the image, complete the following steps: 
 Press the Transparency soft key. a
 Enter a value between 0 for opaque and 100 for clear. b
 Press the Enter soft key. c

 
Figure 34 Raster image overlaid on the map in interference finder 

  
 

The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference 
analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the limit line 
to create failure points when signals exceed it. The failure points are clearly displayed on the trace timeline 
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for quick access during playback. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Press the Spectrum Replayer soft key. 

The file manager window appears. 
3 Select a file to be loaded, and then press the Load soft key. 

The Measure Setup screen menus appear. 
4 Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 

or reverse. 
5 Press the Replay Speed soft key, and then select the speed option: x1, x2, x3, and x4. 
6 Press the Play soft key to start playing. 
7 Press the Pause soft key to pause or stop playing data. 
8 To move to a particular failure position directly and play from there, complete the following steps: 

 Press the Jump to Fail Index soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

9 Optional. Toggle the Time Cursor soft key between On and Off to display or hide the time cursor 
on the screen. This key becomes activated when you play logged data in the Spectrogram mode. 

 

 

NOTE 
If you connected a USB drive, do not remove it while playing. Doing so may freeze the 
USB port, which will require you to restart the instrument to get a USB drive recognized 
again. 

 

You can select the display option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select the display option: Spectrum, Spectrogram, or RSSI. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 115 
for more information. 

 

If you have identified an interfering signal on your spectrum view, you can move to the Radar Chart mode 
and measure RSSI power level through 360 degrees at a location received by the connected broadband 
directional antenna so that you can determine the direction of the source of the interference. A set of the 
AntennaAdvisor Handle with the antenna is mandatory to perform measurements in this mode. 
 
If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files from 
the application, you can load them onto your base map to help you troubleshoot problems easily and quickly. 
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After you have connected your AntennaAdvisor Handle set to the JD700B series as described in the “Using 
an AntennaAdvisor handle” on page 92 and configured test parameters as described in the “Configuring test 
parameters” on page 93, you need to load a map of the area where you want to go out and do interference 
hunting activities. 
 

Procedure 

1 Plug in your USB drive that has a map file in .mcf file type created in JDMapCreator. If the 
JDMapCreator application on your computer is connected to the instrument via USB or LAN,  
you can send a map file with a single layer to the instrument directly by using the Send to EQP 
menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

2 Press SAVE/LOAD hot key, and then select Load > Load Map. 
3 Navigate to a map file you want to open. 

The File Information pane displays file properties including file name, map type, and address. If 
you see “Sizable Map” for Map Type, you can zoom in and out the base map after loading. 

4 Press the Load soft key. 
The loaded map appears. Before pressing the Get GPS Position soft key, you should not 
interpret the center of the radar chart as your current geographical location on the map. 

 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

 

After you have loaded a map for the area of interest, you need to initialize the AntennaAdvisor Handle to 
calibrate its built-in compass in order to obtain more accurate azimuth information. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
A message appears at the bottom of the screen to alert you if you have not performed 
initialization of your connected the antenna handle set. 

2 To adjust the integration bandwidth based on the center frequency of the interfering signal that 
you have identified in the Spectrum view, complete the following steps: 

 Press the Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. c

3 Initialize the antenna handle to calibrate the built-in compass by completing the following steps: 
 Hold your antenna handle horizontally in its upright position. To avoid unnecessary impact a

of external magnetic field, position yourself at the location where the value of magnetic field 
strength displayed on the instrument is green. 

 Point the antenna to the north, and then press the Initialize AntennaAdvisor soft key. b
The message disappears and the red line for the current antenna direction moves to the  
0-degree line and overlaps to let you know that the initialization is done successfully. 

 

 

NOTE 
If is recommended that you re-initialize the AntennaAdvisor Handle after measurements 
to re-calibrate the compass when you notice that the red line on the radar chart is not 
aligned with the north on the map even though you are pointing the antenna to the north. 

 

After you have connected your antenna handle set and done necessary setups, you can monitor the power 
level of the received signal, the amount of polarization, and elevation level real time. Using the Trigger 
button on the antenna handle set, you can plot the RSSI level through 360 degrees at your location. 
 

Procedure 

1 When you have the green GPS indicator, press the Get GPS Position soft key in the Measure 
Setup menu bar to set your current location with GPS locked as the center of the radar chart. 
The latitude and longitude information at the bottom of the display changes from ‘Unknown 
Position’ to the obtained position information. 

2 Optional. To save a position to recall for triangulation in the Interference Finder mode, press the 
Save Position soft key and then select one of the soft keys to which you want to save. 

3 Monitor the RSSI reading of the received signal. If the signal is weak, turn on the LNA switch on 
the antenna handle set to improve S/N. 

 

NOTE 
The AntennaAdvisor Handle has a built-in low-noise amplifier (LNA) and you can turn it 
on and off by toggling the physical On/Off switch located on the rear side of the handle 
unit. 

4 Hold the antenna handle set horizontally and then make the following measurement: 
–  To obtain a RSSI value, complete the following steps: 

 Press the TRIGGER button located on the antenna handle. a
Every time you press the physical button on the handle, a beep is sounded and a power 
level of the received signal is plotted as a blue dot on the radar chart. Depending on the 
strength of the measured value, you may hear different tones of beeping. 

 With panning the antenna horizontally to vary the angle of the direction, repeat b
pressing the TRIGGER button to obtain at least five points if you want to do the 
localization.  

–  To obtain RSSI values continuously, complete the following steps: 
 Press and hold the TRIGGER button located on the antenna handle to start a a

continuous measurement. 
 Pan the antenna handle horizontally through the angle of 360 degrees you desire. b

A beep is sounded repeatedly to let you know that the measurement is continuing and 
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measured values are plotted on the radar chart. See Figure 35 for an example. 
 Release the TRIGGER button to stop the continuous measurement. c

 

NOTE 
The maximum number you can plot on the radar chart is 500 points both in the single 
and continuous measurements. If your measurement reached to 500 points, you need to 
reset the measurement by pressing the Localization soft key twice or performing the 
initialization of the AntennaAdvisor Handle. 
 
Concentric circles indicate different levels of RSSI. The outer circle, the higher power 
level is. You can use the AMP/SCALE hard to adjust the amplitude scale of the chart. 

5 To change the display mode, toggle the Screen Mode soft key and select Map or Full as 
needed. 
–  Map: It displays measured points inside the base map image. If you are in the area outside 

the base map and continue your measurement with the Trigger button, the instrument 
continue obtaining data even though the radar chart disappears from the screen. You can 
view obtained data when you change this display option to Full. 

–  Full: It displays measured points without the base map image. In case that you made 
measurements in the area outside the map image, selecting this option moves your 
measured data to the center of the display so that you can view the result. 

 

The Localization feature lets you view averaged and smoothed measurement data with a bold green line on 
the radar chart that helps you determine the direction of the highest RSSI value. When you have five or 
more data points plotted on the radar chart, you can perform this localization. 
 

Procedure 

1 Press the Localization soft key in the Measure Setup menu bar. 
All the measured points turn to green color and you can view the bold green line that indicates 
the possible direction of the interference source. See Figure 36 for an example. 

2 To clear all the data plots on the radar chart, press the Localization soft key again. 
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Figure 35 RSSI data plotted on the radar chart 

 
 

Figure 36 Localized RSSI data on the radar chart 

 
 

If you have a set of raster data files generated through the ariesoGEO application, you can load and overlay 
the data on your background map to help you view suspicious points of interference easily and pinpoint the 
source of the interference quickly. 
 

Procedure 

1 Copy a set of raster data files into your USB memory drive, including the following: 
–  ASCII: .tab, .asc, and .clr files 
–  BIL: .tab,.hdr, .bil, and .clr files 
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NOTE 
The .tab file type is a geospatial vector data format used in many geographic 
information systems. The color file (.clr) is an optional file, but the image will be 
displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2 Plug in the USB memory drive to your instrument. 
3 Press the TRACE/DISPLAY hard key. 
4 Press the Load Raster Map soft key. 

The file explorer window appears. 
5 Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map. 

 

NOTE 
If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6 To select the display option, complete the following steps: 
 Press the Display Options soft key. a
 Select the option you desire from the choices: On, Off, and Blink. b

7 To adjust the transparency level of the image, complete the following steps: 
 Press the Transparency soft key. a
 Enter a value between 0 for opaque and 100 for clear. b
 Press the Enter soft key. c

 

The Interference Analyzer function provides you with limit setting options for you to select, as you desire. 
They are a single line limit, a multi-segment line limit, and a channel limit. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit, up to 50 segments. 

 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c
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5 Press the Autoset soft key to automatically set the limit for each segment and display the line. 
6 To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Channel Limit soft key. 
3 To define the index table, complete the following steps: 

 Toggle the Table soft key between On and Off to display and hide the channel index table a
on the screen. 

 Press the Index soft key. b
 Enter an index number to be set between 1 and 10 by using the numeric keys, and then c

press the Enter soft key. 
 Press the Start Frequency or Center Frequency soft key depending on your prior d

frequency setting. 
 Enter a value by using the numeric keys, and then select the unit from the choices: GHz, e

MHz, kHz, and Hz. You can also use the rotary knob or the arrow keys. 
 Press the Stop Frequency or Span Width soft key depending on your prior frequency f

setting. 
 Enter a value by using the numeric keys, and then select the unit from the choices: GHz, g

MHz, kHz, and Hz. You can also use the rotary knob or the arrow keys. 
4 To set the limits for Pass/Fail indication, complete the following steps: 

 Toggle the Limit soft key between On and Off to enable and disable the limit. a
 Press the High Limit soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow c

keys, and then press the dBm soft key. 
 Press the Low Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys, and then press the dBm soft key. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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The Global System for Mobile Communications (GSM) is a digital cellular standard that uses Time Division 
Multiple Access (TDMA) multiplexing scheme and Gaussian Minimum Shift Keying (GMSK) modulation. The 
Enhanced Data Rates for GSM Evolution (EDGE) is an enhancement to GSM that promises to deliver 
multimedia and other broadband applications. It uses TDMA and 3π/8 8PSK (phase shift keying) modulation. 
 
This instrument performs measurements using the methods and limits as defined in the 3GPP TS 51.021 
Base Station System (BSS) equipment specification: Radio Aspects V8.9.0 (2003-06) and 3GPP TS 45.005 
Radio Transmission and Reception (version 12.5.0, release 12). The Pass/Fail indictor helps you to 
determine base station performance easily. 
 
This instrument provides the following measurement tools for GSM/GPRS/EDGE system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Output RF Spectrum 
- Spurious Emissions 

 Power vs. Time 
- Power vs. Time (Slot) 
- Power vs. Time (Frame) 

 Modulation Analysis 
- Constellation 

 Auto Measure 

 Over The Air (OTA) 
- Channel Scanner 
- Frequency Scanner 
- Multipath Profile 
- Modulation Analyzer 

 

Figure 37 provides descriptions for each segment of the measurement screen. 
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Figure 37 GSM signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the power amplifier output 
port of BTS. 

 
Figure 38 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
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BTS. 

 
Figure 39 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 40 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the GSM soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask,  
Output RF Spectrum, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot) or Power vs Time (Frame) 

–  Constellation 

–  Auto Measure 

–  OTA > Channel Scanner, Frequency Scanner, Multipath Profile, or 
Modulation Analyzer 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
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5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Spurious Emissions mode. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 
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The scale unit on the screen changes accordingly. 
 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 
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You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the following choices: 

 

To set the trigger level Select 

When using the RF burst (wideband) trigger RF Burst 

To free burst if there is a frequency burst signal Internal FB 

To training sequence code RF Burst & TS 

To external trigger reference External 

To the free trigger Free 

To the locked GPS GPS 
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If you have configured test parameters as described in the “Configuring test parameters” on page 121, your 
measurement result is displayed on the screen as like the following example, Figure 41. 
 

Figure 41 Spectrum measurement screen with GSM signal analyzer 

 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs RF measurements, and 

then select your desired time slot number from 0 to 7. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 
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To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measures in-channel power for GSM/GPRS and EDGE systems, which use dynamic 
power control to ensure that each link is maintained with minimum power. It gives two fundamental benefits 
of keeping overall system interference to a minimum level and of maximizing battery life in the case of 
mobile stations. It determines the power delivered to the antenna system on the RF channel under test. The 
instrument acquires a GSM/GPRS or EDGE signal in the time domain. The average power level above the 
threshold is then computed and displayed. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs measurements, and then 

select your desired time slot number from 0 to 7. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
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 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Figure 42 Channel power measurement with GSM signal analyzer 

 
 
Channel power measurement result shows channel power and spectrum density in a user specified channel 
bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The shaded area 
on the display indicates the channel bandwidth. 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 132 for more 
information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs measurements, and then 

select your desired time slot number from 0 to 7. 
3 Optional. To set the delay, complete the following steps: 
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 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in a 
user specified percentage to determine the amount of spectrum used by a modulated signal. Occupied 
bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power. 
 

Figure 43 Occupied bandwidth measurement with GSM signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 132 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of out-of-
band spurious emission outside the necessary channel bandwidth and modulated signal. It measures the 
power ratio between in-band and adjacent channels. The JD700B series indicates either Pass or Fail based 
on the specified limit of the signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs measurements, and then 

select your desired time slot number from 0 to 7. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Figure 44 SEM measurement with GSM signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 132 for more 
information. 

 

The Output RF Spectrum measures power of the output RF modulation spectrum of the carrier at different 
frequency offsets in different measurement bandwidths. It is used to determine if the output spectrum due to 
modulation and wideband noise for all supported RF channels meets the requirements specified in 3GPP TS 
45.005 and conforms to the specification. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs measurements, and then 

select your desired time slot number from 0 to 7. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Figure 45 Output RF spectrum measurement with GSM signal analyzer 

 
 

 

NOTE 
A set of limit values are applied according to the current channel power and automatically 
displayed in the result table. You can use the LIMIT hot key to enable or disable the 
Pass/Fail indication. See “Setting limit for RF tests” on page 132 for more information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a

as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20. b
 Press the Enter soft key. c

 

Figure 46 Spurious emissions measurement with GSM signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 132 for more 
information. 

 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

Output RF spectrum Output RF Spectrum (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Power vs. Time measurement measures the mean transmission power during the useful part of GSM 
bursts and verifies that the power ramp fits within the defined mask. It also lets you view the rise, fall, and 
useful part of the GSM burst. 
 
This measurement provides masks for both of Base Transceiver Station (BTS) and Mobile Station (MS). The 
timing masks are referenced to the transition from the bit 13 to the bit 14 of the mid-amble training sequence. 
For GMSK measurements, the 0 dB reference is determined by measuring the mean transmitted power 
during the useful part of the burst. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs measurements, and then 

select your desired time slot number from 0 to 7. 
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3 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 
Auto is set by default. The instrument applies a mask automatically based on the selected mode. 

4 Optional. To set the delay, complete the following steps: 
 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Press the Burst Power soft key to set the limit in the Power vs. Time (Slot) measurement. 
4 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
5 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit, and then press the dBm unit soft key. b

6 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit, and then press the dBm unit soft key. b

7 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 47 Power vs. time (slot) measurement with GSM signal analyzer 

 
 



Chapter 6 Using GSM/GPRS/EDGE Signal Analyzer 

134 JD700B Series User’s Guide 

Figure 48 Power vs. time (slot) measurement with GSM signal analyzer 

 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Press the Frame Avg Power soft key to set the limit in the Power vs. Time (Frame) 

measurement. 
4 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
5 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit. b
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 Press the dBm unit soft key. c
6 Set the lower threshold: 

 Press the Low Limit soft key. a
 Enter a value for the lower limit. b
 Press the dBm unit soft key. c

7 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 49 Power vs. time (frame) measurement with GSM signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Time Slot soft key to assign a time slot with which performs measurements, and then 

select your desired time slot number from 0 to 7. 
3 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
4 Toggle the PSK Constellation soft key between On and Off to enable or disable the PSK 
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constellation observation. 

 

NOTE 
The PSK constellation must be turned on to analyze EDGE signals. 

 

5 Optional. To set the delay, complete the following steps: 
 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits in the Constellation measurement. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Phase error rms Phase Error RMS High Limit, Low Limit 

Phase error peak Phase Error Peak High Limit, Low Limit 

Error vector magnitude rms EVM RMS High Limit 

Error vector magnitude peak EVM Peak High Limit 

I/Q origin offset of the I and Q error 
(magnitude squared) offset from the origin 

IQ Origin Offset High Limit 

Carrier to interference (C/I) ratio C/I Low Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 



Chapter 6 Using GSM/GPRS/EDGE Signal Analyzer 

 JD700B Series User’s Guide 137 

Figure 50 Constellation measurement (PSK off) with GSM signal analyzer 

 
 

Figure 51 Constellation measurement (PSK on) with GSM signal analyzer 

 
 

 

NOTE 
Measurement items such as IQ Origin Offset, C/I, EVM RMS/Peak and EVM 95th 
are applicable only to EDGE signal measurements. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
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programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 To select the type of the measurement data to be taken for the determination of the results,  
press the Data Type soft key and then select the data type option from the following choices: 
–  Sample: The Auto Measure takes the last measurement data only. 

–  RMS: The Auto Measure takes data from all 20 measurements and averages them. 

–  Peak: The Auto Measure takes only the highest peak of all 20 measurements. 
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–  Negative Peak: The Auto Measure takes only the lowest peak of all 20 measurements. 

7 To set external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

8 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

9 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

10 To stop running the test, press the Abort soft key. 
11 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

This Over-The-Air (OTA) measurement has channel scanner, frequency scanner, multipath profile, and 
modulation analyzer screens. The GSM OTA has a function to display channel power and related 
information up to 128 GSM down link signals. This channel scanner can quickly identifies improper power 
levels that affect network performance. The transmitter performance can be made on a base station from the 
convenience of your vehicle without taking the base station out of service. It helps you to determine testing 
area's RF environmental condition with the multipath profile. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To select the standard channel, complete the following steps: 
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 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
3 To set the starting channel to be scanned, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 To set the amount of channel increment in scanning channels, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

5 To set the number of channels to be displayed, complete the following steps: 
 Press the # of Channels soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the starting channel for the Zoom In Window. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Zoom Position soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 52 Channel scanner measurement with GSM OTA signal analyzer 

 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To set the starting frequency to be scanned, complete the following steps: 

 Press the Start Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

3 To set the amount of frequency increment in scanning frequencies, complete the following steps: 
 Press the Frequency Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

4 To set the number of frequencies to be displayed, complete the following steps: 
 Press the # of Frequencies soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the starting channel for the Zoom Window. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Zoom Position soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 
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Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 53 Frequency scanner measurement with GSM OTA signal analyzer 

 
 

The Multipath Profile let you determine RF environmental conditions of testing area. The multipath profile is 
the result of portions of the original broadcast signal arriving at the receiving antenna out of phase. This can 
be caused by the signal being reflected off objects such as buildings, or being refracted through the 
atmosphere differently from the main signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 



Chapter 6 Using GSM/GPRS/EDGE Signal Analyzer 

 JD700B Series User’s Guide 143 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Figure 54 Multipath profile measurement with GSM OTA signal analyzer 

 
 

After configuring test parameters as described in the “Configuring test parameters” on page 121, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Procedure 

1 Press the LIMIT hot key. 
2 Select the test item(s) and set the limit(s): 

To set the limit for Select Set 

Frame average power Frame Average Power High Limit, Low Limit 

Frequency error Frequency Error High Limit, Low Limit 

Burst power Burst Power High Limit, Low Limit 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

3 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 55 Modulation analyzer measurement with GSM OTA signal analyzer 

 
 
 



 
 

  

 

 

This chapter provides instructions for using the WCDMA/HSPA+ Signal Analyzer function (option 023) with 
the WCDMA/HSPA+ OTA Analyzer function (option 043). Topics discussed in this chapter are as follows: 
 

 Introduction .............................................................................................................................. 146 

 Display overview ..................................................................................................................... 146 

 Connecting a cable .................................................................................................................. 147 

 Selecting measurement mode ................................................................................................ 149 

 Configuring test parameters .................................................................................................... 149 

 Conducting spectrum measurements ..................................................................................... 154 

 Conducting RF measurements ............................................................................................... 155 

 Conducting modulation measurements ................................................................................... 162 

 Performing auto measurements .............................................................................................. 174 

 Performing power statistics CCDF measurement ................................................................... 175 

 Conducting WCDMA/HSPA+ OTA measurements ................................................................. 176 
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This WCDMA/HSPA+ Signal Analyzer can be used to test a WCDMA transmitter including HSDPA/HSPA+ 
signals to check the base station’s compliance with following standards documentation. 
 

 3GPP TS 25.104 Base Station radio transmission and reception 

 3GPP TS 25.141 Base Station (BS) conformance test 

 3GPP TS 25.211 Physical channel and mapping of transport channels onto physical channels 

 3GPP TS 25.212 Multiplexing and channel coding 

 3GPP TS 25.213 Spreading and modulation 
 
The instrument automatically makes standard defined measurements using the measurement methods and 
limits as defined in the standards. Detailed measurement results allow you to analyze WCDMA and HSPA+ 
system performance. You may alter the measurement parameters for specialized analysis. Pass/Fail testing 
with standard defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine 
base station performance easily. 
 
This instrument provides the following measurement tools for WCDMA/HSPA+ system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Adjacent Channel Leakage power Ratio (ACLR) 
- Multi-ACLR 
- Spurious Emissions 

 Modulation Analysis 
- Constellation 
- Code Domain Power 
- Relative Code Domain Error 
- Codogram 
- Received Code Strength Indicator (RCSI) 
- CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Channel Scanner 
- Scramble Scanner 
- Multipath Profile 
- Code Domain Power 
- Route Map 

 

Figure 56 provides descriptions for each segment of the measurement screen. 
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Figure 56 WCDMA/HSPA+ signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the power amplifier output 
port of BTS. 

 
Figure 57 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
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BTS. 

 
Figure 58 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 59 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the WCDMA soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Modulation > Constellation, Code Domain Power, Relative Code Domain Error,  
Codogram, RCSI, or CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, Scramble Scanner, Multipath Profile, Code Domain Power, 
or Route Map 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 

To set the channel number: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
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4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 

 

NOTE 
In the measurements such as Code Domain Power, Codogram, and RCSI, you may 
need to select the reference option between Relative and Absolute before setting the 
reference level. 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
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As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 
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To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
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TRIGGER hot key to set the external clock. 
 

Table 10 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 
Figure 60 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option from the choices: 

Internal, External 10 MHz, External 13 MHz, External 15 MHz, and GPS. 

 

 

NOTE 
When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 
Table 11 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 
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GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

If you have configured test parameters as described in the “Configuring test parameters” on page 149, your 
measurement result is displayed on the screen as like the following example, Figure 61. 
 

Figure 61 Spectrum measurement screen with WCDMA signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 
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Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 To select the detection option, select More (1/2) > Detectors, and then do one of the following: 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

5 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. This procedure measures the total power 
within the defined channel for WCDMA. This measurement is applied to design, characterize, evaluate, and 
verify transmitters and their components or devices for base stations and mobile stations. 
 
The channel power measurement identifies the channel power within a specified bandwidth (default is 5 
MHz, as per the 3GPP WCDMA technical specifications) and the power spectral density (PSD) in dBm/Hz. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 149, your 
measurement result is displayed on the screen as like the following example, Figure 62. 
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Figure 62 Channel power measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 161 for more 
information. 

 

The 3GPP specifications require the occupied bandwidth (OBW) of a transmitted WCDMA signal to be less 
than 5 MHz, where occupied bandwidth is defined as the bandwidth containing 99% of the total channel 
power. In this measurement, the total power of the displayed span is measured. Then the power is 
measured inward from the right and left extremes until 0.5% of the power is accounted for each of the upper 
and lower part of the span and the calculated difference is the occupied bandwidth. 
 
The spectrum shape of a WCDMA signal can give a useful qualitative insight into the transmitter’s operation. 
Any distortion to the spectrum shape might be an indication of degradation of the transmitter's performance. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 149, your 
measurement result is displayed on the screen as like the following example, Figure 63. 
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Figure 63 Occupied bandwidth measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 161 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses different 
power limits and different measurement bandwidths (resolution bandwidths) at various frequency offsets. It 
may be expressed as a ratio of power spectral densities between the carrier and the specified offset 
frequency band. It provides useful figures-of-merit for the spectral re-growth and emissions produced by 
components and circuit blocks, without the rigor of performing a full SEM measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates them 
to the carrier power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can set 
the mask type according to the output power of the base station be tested. Your measurement result is 
displayed on the screen as like the following example, Figure 64. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Mask Type soft key. 
3 Select the mask type option: – 31 dBm, 31 – 39 dBm, 39 – 43 dBm, or 49 dBm –. 
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Figure 64 SEM measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 161 for more 
information. 

 

The Adjacent Channel Power Ratio (ACPR), designated by the 3GPP WCDMA specifications as the 
Adjacent Channel Leakage power Ratio (ACLR), is the power contained in a specified frequency channel 
bandwidth relative to the total carrier power. It may also be expressed as a ratio of power spectral densities 
between the carrier and the specified offset frequency band. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 149, your 
measurement result is displayed on the screen as like the following example, Figure 65. 
 

Figure 65 ACLR measurement with WCDMA/HSPA+ signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 161 for more 
information. 

 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station environment. 
 

You can set the frequency with either frequency or channel number. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b

band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 
After configuring test parameters, your measurement result is displayed on the screen as like the following 
example, Figure 66. 
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Figure 66 Multi-ACLR measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 161 for more 
information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a

as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 
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NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20. b
 Press the Enter soft key. c

 
After configuring test parameters as described in the “Configuring test parameters” on page 149, your 
measurement result is displayed on the screen as like the following example, Figure 67. 
 

Figure 67 Spurious emissions measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 161 for more 
information. 

 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 
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Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA, 
or HSPA+. HSDPA is set by default. 

4 To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c
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Figure 68 Constellation measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 173 for 
more information. 

 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 
normalized to the total power. It helps to verify that each code channel is operating at its proper level and to 
identify problems throughout the transmitter design from coding to the RF section. System imperfections 
such as amplifier non-linearity will present themselves as an undesired distribution of power in the code 
domain. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c
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128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

Figure 69 Code domain power measurement with WCDMA/HSPA+ signal analyzer 

1) Full screen 
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2) Full screen with constellation 

 

3) Zoomed screen (Width 64) 

 

4) Zoomed screen with constellation (Width 64) 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 173 for 
more information. 

 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

4 Toggle the Constellation soft key between On and Off to enable or disable the constellation 
chart on the Code Domain Power screen. 

5 Toggle the Control Channel soft key and select the control channel mode option: 
–  Normal: You can view the relative ratio of each control channel vs. total power. 

–  Delta: You can view the relative ratio of each control channel vs. CPICH channel. 

 

The Relative Code Domain Error (RCDE) measurement provides relative code domain error analysis that is 
particularly required by HSPA+. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

 

NOTE 
It is recommended that you select HSPA+ for RCDE testing. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
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 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 70 Relative code domain error with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 173 for 
more information. 

 

You can view your measurement results in a different view option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

4 Toggle the Constellation soft key between On and Off to enable or disable the constellation 
chart on the Code Domain Power screen. 

5 Toggle the Control Channel soft key and select the control channel mode option: 
–  Normal: You can view the relative ratio of each control channel vs. total power. 

–  Delta: You can view the relative ratio of each control channel vs. CPICH channel. 

 

The Codogram displays how the code level is changing over time and makes it easier for you to view traffic 
channels as they initiate and terminate and to track traffic channels call levels over time. The Codogram 
measurements can be saved into an external USB memory so that a post-analysis can be done with the 
application software JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
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 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the time interval, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

9 To start a new measurement, press the Reset/Restart soft key. 
10 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 71 Codogram in full view with WCDMA/HSPA+ signal analyzer 

 
 

You can view your measurement results in a different view option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c

4 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. 

 

The Received Code Strength indicator (RCSI) is used to track the code channels such as CPICH, P-CCPCH, 
S-CCPCH, PICH, P-SCH, and S-SCH. It is particularly useful to observe signal fluctuations of the dedicated 
control channels over the time. The RCSI measurements can be saved into an external USB memory so that 
a post-analysis can be done with the application software JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b

Setting this on makes the S-CCPCH in the Alarm Code menu activated. 
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b

Setting this on makes the PICH in the Alarm Code menu activated. 
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
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 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 Press the Alarm Code soft key, and then select the alarm code option: None, CPICH, P-
CCPCH, S-CCPCH, PICH, P-SCH, or S-SCH. 

 

 

NOTE 
The alarm codes S-CCPCH and PICH become activated in case that you have enabled 
the S-CCPCH and PICH respectively. 

 

8 To set the alarm mask, complete the following steps: 
 Press the Set Mask soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 72 RCSI measurement with WCDMA/HSPA+ signal analyzer 

 
 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
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 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

 

The CDP Table is used to look at a numeric and textual description of all the active code channels in the 
signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c
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Figure 73 CDP Table measurement with WCDMA/HSPA+ signal analyzer 

 
 

If the CDP table spans over to the next page(s), you can change pages up and down to view your 
measurement results. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select Page Up or Page Down as needed. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Error vector magnitude EVM High Limit 

Peak code domain error PCDE High Limit 

Carrier feed through Carrier Feed Through High Limit 

Correlated power in coded channel CPICH High Limit [Abs|Rel] 
Low Limit [Abs|Rel] 

Highest level among inactive channels Max Inactive High Limit 

Relative code domain error RCDE High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 



Chapter 7 Using WCDMA/HSPA+ Signal Analyzer 

174 JD700B Series User’s Guide 

 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

 

NOTE 
The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
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4 Toggle the Test Time soft key and select the test time option: 
–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 To set external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
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After configuring test parameters as described in the “Configuring test parameters” on page 149, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Figure 74 CCDF measurement with WCDMA/HSPA+ signal analyzer 

 
 

This Over The Air (OTA) measurement has channel scanner, scramble scanner, multipath profile, code 
domain power, and route map screens. Scramble scanner displays six scrambling codes and powers to 
inform neighbor cells existence and its power. The multipath profile graph helps you to determine testing 
area's RF environmental condition. The code domain power shows not only modulation performance metric 
but also amplifier capacity and code utilization metric. The amplifier capacity (code utilization) measurement 
is an estimate of the amount of power amplifier capacity (code utilization) that is being used expressed in 
percent of maximum. 
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Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

To set the frequencies to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
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5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 75 Channel scanner measurement with WCDMA/HSPA+ OTA signal analyzer 

 
 

The WCDMA/HSPA+ mobile receives signals from multiple base stations that all of these signals share the 
same spectrum and are present at the same time. Each base station has a unique scrambling code assigned 
to the particular base station and it differentiates its signal from other base stations in the area. 
 

Figure 76 Scramble scanner measurement with WCDMA/HSPA+ OTA signal analyzer 
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The Multipath Profile enables you to determine RF environmental conditions of testing area. It indicates the 
amount of power of the dominant pilot signal that is dispersed outside the main correlation peak due to 
multipath echoes that are expressed in dB. This value should be very small ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving antenna 
out of phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

Figure 77 Multipath profile measurement with WCDMA/HSPA+ OTA signal analyzer 

 
 

Channels with high correlation factors are determined to be active channels and are indicated as such on 
the display. Once the channels are decoded, the analyzer determines the power of each channel relative to 
the total signal power. 
 
This measurement helps to verify that each code channel is operating at its proper level and helps to identify 
problems throughout the transmitter design from the coding to the RF section. System imperfections, such 
as the non-linearity of amplifiers, will present themselves as an undesired distribution of power in the code 
domain. 
 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the scramble code, complete the following steps: 
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 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA, 
or HSPA+. HSDPA is set by default. 

4 To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

5 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

7 To set the maximum amplifier power, complete the following steps: 
 Press the Max Amplifier Power soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

8 To set the CPICH power, complete the following steps: 
 Press the More (1/2) soft key. a
 Press the CPICH soft key. b
 Enter a value by using the numeric keys. c
 Press the dBm soft key. d

9 To set the threshold for CPICH dominance, complete the following steps: 
 Press the CPICH Dominance > soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
Recommended value is 10. Color of the CPICH Dominance indicator on the screen 
bases on this setting. 

10 To set the threshold for multipath power, complete the following steps: 
 Press the Multipath Power < soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 78 Code domain power measurement with WCDMA/HSPA+ OTA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map.  
 
The JD700B Series also supports the RAN-IL (Interference Location) feature that enables you to overlay 
user experience data obtained through Viavi’s ariesoGEO on your base map to help you troubleshoot 
problems easily and quickly using your instrument. You can generate raster data files on the ariesoGEO 
application and load them on your instrument. 
 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 149. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
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35 for more information. 
4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: CPICH Power or Ec/Io. 
7 Toggle the Plot soft key and select Start. 
8 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

9 Toggle the Plot soft key and select Stop to stop plotting. 
10 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 33 for more information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for the four different color indicators for CPICH power or Ec/Io. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

 

To set the limit for Select Set 

CPICH Power CPICH Power Excellent, Very Good, Good, Fair, Poor (dBm) 

CPICH Ec/Io Ec/Io Good, Fair, Poor (dB) 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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Figure 79 Route map measurement (CPICH Power) with WCDMA/HSPA+ OTA signal analyzer 

 
 

Figure 80 Route map measurement (CPICH Ec/Io) with WCDMA/HSPA+ OTA signal analyzer 

 
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a
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The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 

 

If you have a set of raster data files generated through the ariesoGEO application, you can load and overlay 
the data on your base map to help you check the signal quality and the strength of interferences while 
driving toward the area of interest. 
 

Procedure 

1 Copy a set of raster data files into your USB memory drive, including the following: 
–  ASCII: .tab, .asc, and .clr files 
–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 
information systems. The color file (.clr) is an optional file, but the image will be 
displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2 Plug in the USB memory drive to your instrument. 
3 Press the TRACE/DISPLAY hard key. 
4 Press the Load Raster Map soft key. 

The file explorer window appears. 
5 Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 81. 

 

NOTE 
If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6 To select the display option, complete the following steps: 
 Press the Display Options soft key. a
 Select the option you desire from the choices: On, Off, and Blink. b

7 To adjust the transparency level of the image, complete the following steps: 
 Press the Transparency soft key. a
 Enter a value between 0 for opaque and 100 for clear. b
 Press the Enter soft key. c
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Figure 81 Raster image overlaid on the base map in WCDMA/HSPA+ OTA signal analyzer 

  
 
 
 



 
 

  

 

 

This chapter provides instructions for using the LTE-FDD Signal Analyzer (option 028) and LTE-Advanced 
FDD Analyzer (option 030) with the LTE-FDD OTA Analyzer (option 048) and the LTE-FDD RAN 
Performance Indicator (option 014). Topics discussed in this chapter are as follows: 
 

 Introduction .............................................................................................................................. 187 

 Display overview ..................................................................................................................... 188 

 Connecting a cable .................................................................................................................. 188 

 Selecting measurement mode ................................................................................................ 190 

 Configuring test parameters .................................................................................................... 190 

 Conducting spectrum measurements ..................................................................................... 195 

 Conducting RF measurements ............................................................................................... 196 

 Conducting power vs. time (frame) measurements ................................................................ 203 

 Conducting modulation measurements ................................................................................... 204 

 Performing auto measurements .............................................................................................. 222 

 Performing power statistics CCDF measurements ................................................................. 228 

 Performing carrier aggregation measurements ...................................................................... 229 

 Conducting LTE-FDD OTA measurements ............................................................................. 232 

 Performing RAN performance testing ..................................................................................... 246 
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The LTE (Long-Term Evolution) Signal Analyzer of the JD700B series performs power and spectrum 
measurements as well as modulation analysis to test the proper transmitter performance of FDD LTE 
systems. It performs conformance testing according to the following standards providing a simple Pass/Fail 
indication on each test. 
 

 3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) Radio 
Transmission and Reception 

 3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 
Conformance Testing 

 3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels and 
Modulation 

 3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and Channel 
Coding 

 3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Layer 
Procedures 

 
This instrument provides the following measurement tools for FDD LTE system: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Frame 

- Time Alignment Error 

- Data Allocation Map 

 Auto Measure: 

- Conformance Test 

- Maintenance Test 

- Signal Performance Test 

- DAS Test 
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 Power Statistics CCDF 

 Carrier Aggregation 

 Over The Air (OTA) 

- Channel Scanner 

- ID Scanner 

- Multipath Profile 

- Control Channel 

- Datagram 

- Route Map 

 RAN Performance Indicator 
 

Figure 82 provides descriptions for each segment of the measurement screen. 
 

Figure 82 LTE-FDD signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 
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Figure 83 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 84 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 
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Figure 85 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the LTE - FDD soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe, 
Frame, Time Alignement Error, or Data Allocation Map 

–  Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance,  
or DAS Test 

–  Power Statistics CCDF 

–  More (1/2) > Carrier Aggregation 

–  More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel, 
Datagram, or Route Map 

–  More (1/2) > RAN Performance Indicator 

 

 

NOTE 
The Carrier Aggregation soft key is activated if the license for the option 030 LTE-
Advanced FDD is installed and so does the RAN Performance Indicator for the option 
014 LTE-FDD RAN Performance Indicator. 
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You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 

To set the channel number: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 
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Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 

To set the reference or attenuation level manually: 
1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

 

NOTE 
In the measurements such as Control Channel, Subframe, and Frame, you can select 
the reference option between Relative and Absolute instead. 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. As you increase the reference setting, the attenuation level also increases 
acoordingly. 

 

Optional. To change the scale unit: 
1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 193 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

To turn the external offset off: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 
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The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 

To return to the continuous sweep mode: 
1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
TRIGGER hot key to set the external clock. 
 

Figure 86 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option from the choices: 

Internal, External 10 MHz, External 13 MHz, External 15 MHz, and GPS. 

 
Table 12 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
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locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 
Your measurement result is displayed on the screen as like the following example, Figure 87. 
 

Figure 87 Spectrum measurement screen with LTE-FDD signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 
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The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of the 
signal in the LTE channel bandwidth. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 197 

3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  
5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 

Figure 88 Channel power measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 203 for more 
information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
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Figure 89 Occupied bandwidth measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 203 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses different 
power limits and different measurement bandwidths (resolution bandwidths) at various frequency offsets. It 
may be expressed as a ratio of power spectral densities between the carrier and the specified offset 
frequency band. It provides useful figures-of-merit for the spectral re-growth and emissions produced by 
components and circuit blocks, without the rigor of performing a full SEM measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates them 
to the carrier power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the mask type, complete the following steps: 

 Press the Mask Type soft key. a
 Select the mask type option, from the following choices: b

–  Wide Area BS Category A 
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–  Wide Area BS Category B 

–  Local Area BS 

–  Home BS 

 

Figure 90 SEM measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 203 for more 
information. 

 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in an 
adjacent frequency channel according to the standards. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the following choices: 1.4 MHz,  

3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
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Figure 91 ACLR measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 203 for more 
information. 

 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station environment. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 201 

 Toggle the Unit soft key and select Channel. a

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

 Press the Lowest Channel soft key to set the starting channel. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d
 Press the Highest Channel soft key to set the stopping channel. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Press the Enter soft key. g

 

Figure 92 Multi-ACLR measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 203 for more 
information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
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2 To set up the range table and parameters, press the Range Table soft key and then complete 
the following steps: 

 Press the Range soft key, and then select the range number between 1 and 20 to add  a
as a new or change the existing settings. 

 Do the following as desired: b
–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100, and then press the Enter soft key. b

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20, and then press the Enter soft key. b

 

Figure 93 Spurious emissions measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 203 for more 
information. 
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By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot in an LTE signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
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synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

 

Figure 94 Power vs. time (frame) measurement with LTE – FDD signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
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 Press the dB soft key. c
–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 

 

Figure 95 Constellation measurement with LTE-FDD signal analyzer 

 
 

Figure 96 Constellation measurement with LTE-FDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

The Data Channel measures the constellation for the specified resource block as well as the modulation 



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 207 

accuracy of each PDSCH at the specified subframe. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
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Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Figure 97 Data channel measurement with LTE-FDD signal analyzer 
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Figure 98 Data channel measurement with LTE-FDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram for 
the selected resource block. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected resource block. 

 

The Control Channel measures the constellation for the specified control channel as well as modulation 
accuracy of the control channel at the specified subframe. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
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2 To set the nominal channel bandwidth to be measured, complete the following steps: 
 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding all the PDCCH signals from one 
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subframe. 

 

Figure 99 Control channel measurement with LTE-FDD signal analyzer 

 
 

Figure 100 Control channel measurement with LTE-FDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

You can use the MARKER hard key to place a marker on a control channel and display the IQ diagram for 
the selected channel. 
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Procedure 

1 Press the MARKER hard key. 
2 Press the Channel soft key to select the channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 
3 Turn the rotary knob to move the highlight from one to another in the channel summary table. 
4 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

channel. 

 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 
–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 
–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 

be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 
–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 

combiner or an antenna. 
8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.  
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
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Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH 
appears as well depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding all PDCCH signals from one subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Figure 101 Subframe measurement with LTE-FDD signal analyzer 
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Figure 102 Subframe measurement with LTE-FDD signal analyzer (Chart On) 

 
 

Figure 103 Subframe measurement with LTE-FDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

You can use the TRACE/DISPLAY hard key to view the RE and RS power at the symbol. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or dismiss the chart.  

If this setting is on, the MARKER hard key is activated. 
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If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 

 

The Frame measures the modulation accuracy of all the data and control channels at the frame (10 ms). 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

4 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

5 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

6 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

7 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
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key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. If this setting is on, the measurement items MBSFN 
RS, PMCH QPSK, PMCH 16 QAM, and PMCH 64 QAM appear in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Figure 104 Frame measurement with LTE-FDD signal analyzer 
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Figure 105 Frame measurement with LTE-FDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

In eNode-B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. These 
signals shall be aligned. The time alignment error in Tx diversity is specified as the delay between the 
signals from two antennas at the antenna ports. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

4 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
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key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

 

Figure 106 Time alignment error measurement with LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

The Data Allocation Map function represents data allocation as a frame. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
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 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 To set the threshold for PDSCH, complete the following steps: 

 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

5 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Display Channel soft key. 
3 Select the display mode from the choice: PDSCH, PMCH, and Both. 
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Figure 107 Data allocation map measurement with LTE-FDD signal analyzer 

 
 

Figure 108 Data allocation map measurement with LTE-FDD signal analyzer (MBMS On) 

 
 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c
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4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit, Low Limit 

P-SS power Power > P-SS Power High Limit, Low Limit 

S-SS power Power > S-SS Power High Limit, Low Limit 

PBCH power Power > PBCH Power High Limit, Low Limit 

Subframe power Power > Subframe Power High Limit, Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit, Low Limit 

Frame average power Power > Frame Avg Power High Limit, Low Limit 

Time alignment error for MIMO Time Alignment Error > MIMO High Limit 

Time alignment error for 
aggregation of component 
carriers (intra-band 
contiguous, intra-band non-
contiguous, and inter-band) 

Time Alignment Error > Carrier 
Aggregation 

Intra Cont 
Intra Non-cont 
Inter Band 

Time error Time Error High Limit, Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
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5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Conformance Test is to test if eNode-B meets some specified standards that have been developed for 
verification. Its test procedure and test setups have been developed by 3GPP. Test results can be saved as 
a .csv file type. 
 

You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item 
makes the test item included in the conformance test. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limit for BTS output power, complete the following steps: 

 Press the BTS Output Power soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key. c
 Enter a value for the upper limit, and then press the dBm unit soft key. d
 Press the Low Limit soft key. e
 Enter a value for the lower limit, and then press the dBm unit soft key. f

3 To set the limit for total power dynamic, complete the following steps: 
 Press the Total Power Dynamic soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the Low Limit soft key. c
 Enter a value for the lower limit, and then press the dBm unit soft key. d

4 To verify signal quality, press the Signal Quality soft key, and then do the following as needed: 

To set the limit for Select Set 

Frequency error Frequency Error > Test Limits[E-TM2| 
E-TM3.1|E-TM3.2|E-TM3.3] 

High Limit, Low Limit 

Error vector magnitude EVM > Test Limits [E-TM2|E-TM3.1| 
E-TM3.2|E-TM3.3] 

High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

Time alignment error Time Alignment Error High Limit 

RS power RS Power High Limit, Low Limit 
 

5 To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the 
following as needed: 

To set the limit for Select Set 

Occupied bandwidth Occupied BW High Limit 

Adjacent channel power ratio ACLR  

Spectrum emission mask SEM Mask Type 



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 223 

Spurious emissions Spurious Emissions Range Table 
 

6 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

7 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

After setting frequency as described in the “Configuring test parameters” on page 190, you can continue 
your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
4 Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma. 
5 To set external offset, complete the following steps: 

 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

7 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

8 When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the 
instrument to either Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM 
mode on the eNode-B side. 

9 Press the Continue soft key to continue testing. 
10 Repeat the steps 8-9 until completion of the test. 

A conformance test report appears at the end of the test. 
11 Optional. To stop running the test, press the Abort soft key. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 20 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
Following settings are required only when you run the Auto Measure Maintenance Test on the instrument 
using “Current” configuration setting. Additional settings are not required when you run Auto Measure using 
a scenario generated in the PC application software, JDViewer. 
 

You can set test limits for test item(s) in the auto measurement. 
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Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the Allowed % Change soft key for each test item to compare two 
measurement values displayed in the result table. This requires setting the Display mode 
to Compare in advance. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following as needed: 
 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a

measured, from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Toggle the Cell ID soft key and select Auto or Manual as desired: b

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. c
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 225 

2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On. e
 Enter a value by using the numeric keys, and then press the dB soft key. f
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the g

MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. 

 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically h
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

–  Compare: You can compare two measurement values for each test time with the 
Allowed % Change setting on. You can view results vs. factory-defined or user-defined 
references. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

4 Press the Replace Reference soft key to replace existing reference values for comparison with 
new measurement data. 

5 Press the Load From soft key to select the location from which references file to be loaded. 

 

Unlike the other auto measurement tests, the Signal Performance Test runs measurements continuously. 
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You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel 

power. Other RF test items are not used in the signal performance test. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

3 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

4 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the antenna 
ports 2 and 3 are disabled. 

5 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured, 
from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

6 Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as 
channel power and subframe frequency error. 

7 Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation 
profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM. 

8 Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such 
as TX1 - RS0, TX2 - RS1, and time alignment error. 

9 Toggle the External Offset soft key and select On to set the external offset value. 
10 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

 

The Distributed Antenna System (DAS) testing enables you to check the degradation of performance in the 
signal transmission from a radio band to antennas distributed from it. You can save measurement values at 
both the radio band and antennas and then compare results with percentage of changes. You can also save 
test results in the .csv file format for ease of analysis. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Settings soft key and then set the following; 

 Press the Bandwidth soft key and then select the nominal channel bandwidth to be a
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. b
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Toggle the Cell ID soft key and select Auto or Manual as desired: c
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On to set the external offset value. e
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the f

MBMS soft key and select On or Off. 
 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically g

or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

3 To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as 
you desire. See “Using save” on page 33 for more information. 

4 Press the Continue soft key to do the reference test first or press the Skip Reference Test soft 
key if you already saved test results from the radio band under test. 

5 Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting 
frequency” on page 255 for more information. 

6 Press the PREV hard key. 
7 Press the Limit soft key and then set the limits and allowed percentage change for each test 

item. See “Maintenance test” on page 291 for more information on setting limits. 
8 Keep pressing the PREV hard key until you see the Run Test soft key. 
9 Press the Run Test soft key. 

The instrument runs specified tests to gather reference measurement values. The measurement 
table appears when the reference test is done. 

10 Press the Continue soft key to run the testing on an antenna (Ant 1). 
11 Optional. To change the settings such as External Offset, press the Settings and then change 

the settings as needed. 
12 Press the Continue soft key. 

The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table 
when the test is done. 

13 To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the 
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band. 

14 To view test results for each antenna, press the Select Antenna soft key and then select the 
antenna tab number to display on the screen. 

15 Optional. Press the Delete Test soft key to delete the selected antenna tab. 
16 Optional. Press the Retest Reference soft key to obtain reference measurement values again. 
17 Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 33 for more information. 
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Figure 109 DAS measurement with LTE-FDD signal analyzer 

 
 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 
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Figure 110 CCDF measurement with LTE-FDD signal analyzer 

 
 

Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to provide 
high data rate required for LTE-Advanced. Component carriers to be aggregated can be intra-band 
contiguous, intra-band non-contiguous, or inter-band. The JD700B series provides carrier aggregation 
measurements supporting for all the different modes with carrier aggregation bands added to the channel 
standard. This functionality is activated if the license for the option 030 LTE-Advanced FDD is installed. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To configure parameters for up to 5 component carriers, complete the following steps: 

 Press the CA Configuration soft key. a
The component carrier configuration window appears. 

 Press the CA Range soft key. b
 Enter the number of the component carrier to be set between one and five. c
 Press the Enter soft key. d
 Toggle the Turn On soft key and select On to set parameters and view the results for the e

selected component carrier on the screen or Off to turn it off. 
 Set the following parameters as needed: f

–  Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port, 
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type 

 To set more component carriers, repeat the steps c-f. g
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3 Press the MEASURE SETUP hot key again 
4 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

5 To select the subframe number to be measured, do one of the following: 
–  If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set 

the subframe number. 

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

–  If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key, and then 
select 0 or 5. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

7 Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH 
precoding. 

8 To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis. 

The screen changes according to the selected option. 
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Figure 111 Carrier aggregation measurement with LTE-FDD signal analyzer (MA) 

 
 

Figure 112 Carrier aggregation measurement with LTE-FDD signal analyzer (SA) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 221 for 
more information. 

 

You can use the MARKER hard key to place the marker at a specific channel. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the IQ Diagram soft key between On and Off to display or dismiss data on the IQ 
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diagram for each component carrier. 
3 Press the Channel soft key to select the channel to be displayed on the IQ diagram. 
4 Use the rotary knob to move and select an item under EVM. 

 

The FDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile, 
Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP, RSRQ, 
RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental conditions of 
testing area. The OTA Control Channel provides summary of all control channels including RS power 
variation over time. 
 

The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 
scanning when that frequency goes silent. 
 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
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4 To set the center frequency for the selected index, complete the following steps: 
 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Figure 113 Channel scanner measurement with LTE-FDD OTA signal analyzer 

 
 

The LTE mobile receives signals from multiple base stations that all of these signals share the same 
spectrum and are present at the same time. Each base station has unique scrambling code assigned to the 
particular base station and it differentiates its signal from other base stations in the area. 
 
The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ 
(Reference Signal Received Quality) that predict the downlink coverage quickly. 

 RSRPs from entire cells help to rank between the different cells as input for handover and cell 
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reselection decisions. 

 RSRQ provides additional information when RSRP is not sufficient to make a reliable handover or 
cell reselection decision. 

 
All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and Google 
Earth by using JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 114 ID scanner measurement with LTE-FDD OTA signal analyzer 
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The Multipath Profile enables you to determine RF environmental conditions of testing area. It indicates the 
amount of power of the dominant pilot signal that is dispersed outside the main correlation peak due to 
multipath echoes that are expressed in dB. This value should be very small ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving antenna 
out of phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 Toggle the Display soft key and select RS or Sync. 

The RS Window soft key becomes activated if RS is selected. 
4 Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,  

4 µs, or 8 µs. 
5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 115 Multipath profile measurement with LTE-FDD OTA signal analyzer 

 
 

DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS power is 
indicated on the BCH. The absolute accuracy is defined as the maximum deviation between the DL RS 
power indicated on the BCH and the DL RS power at the BS antenna connector. 
 
The OTA Control Channel provides summary of all control channels including RS power trend over time. 
GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is connected and 
locked to the GPS satellites. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
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4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Select the test item(s) and set the limit(s) as needed: 

To set the limit for Select Set 

P-SS error vector magnitude P-SS EVM High Limit 

S-SS error vector magnitude S-SS EVM High Limit 

RS error vector magnitude RS EVM > RS0 EVM 
RS EVM > RS1 EVM 
RS EVM > RS2 EVM 
RS EVM > RS3 EVM 

High Limit 

Frequency error Frequency Error High Limit, Low Limit 

Time error Time Error High Limit, Low Limit 

Time alignment error Time Alignment Error High Limit 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

You can use the TRACE/DISPLAY hard key to select the display option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select Power or EVM. 

The screen changes according to the selected option. 

 

Figure 116 Control channel measurement with LTE-FDD OTA signal analyzer 

 
 

The OTA Datagram is a time-varying spectral representation that shows how the power of a signal varies 
with time. The power allocated to the specific resource block will be represented with an amplitude axis (in 
dBm) and the waterfall diagram will show the trend of past resource block power over certain period. Using a 
marker function facilitates analysis of accumulated resource block power for data utilization. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 190, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c
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4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To set the time cursor at a specific position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

7 To start a new measurement, press the Reset/Restart soft key. 
8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 117 Datagram measurement with LTE-FDD signal analyzer 

 
 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
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outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map.  
 
The JD700B Series also supports the RAN-IL (Interference Location) feature that enables you to overlay 
user experience data obtained through Viavi’s ariesoGEO on your base map to help you troubleshoot 
problems easily and quickly using your instrument. You can generate raster data files on the ariesoGEO 
application and load them on your instrument. 
 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 190. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR, 
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io. 

 

NOTE 
The instrument collects the strongest Cell ID’s data to plot points. 

7 Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then 
select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and  
20 MHz. 

8 Toggle the Plot soft key and select Start to start plotting. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 
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See “Using save” on page 33 for more information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

To set the limit for Select Set 

RSRP RSRP Excellent, Very Good, Good, Fair, Poor (dBm) 

RSRQ RSRQ Good, Fair, Poor (dB) 

RS-SINR RS-SINR Good, Fair, Poor (dB) 

S-SS RSSI S-SS RSSI Excellent, Very Good, Good, Fair, Poor (dBm) 

P-SS Power P-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Power S-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Ec/Io S-SS Ec/Io Good, Fair, Poor (dB) 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 118 Route map measurement (RSRP) with LTE-FDD OTA signal analyzer 
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Figure 119 Route map measurement (RSRQ) with LTE-FDD OTA signal analyzer 

 
 

Figure 120 Route map measurement (RS-SINR) with LTE-FDD OTA signal analyzer 
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Figure 121 Route map measurement (S-SS RSSI) with LTE-FDD OTA signal analyzer 

 
 

Figure 122 Route map measurement (P-SS Power) with LTE-FDD OTA signal analyzer 
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Figure 123 Route map measurement (S-SS Power) with LTE-FDD OTA signal analyzer 

 
 

Figure 124 Route map measurement (S-SS Ec/Io) with LTE-FDD OTA signal analyzer 

 
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
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 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c
area of interest. 

 Press the center of the rotary knob to zoom into the selected area. You can also press d
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 
 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 

 

If you have a set of raster data files generated through the ariesoGEO application, you can load and overlay 
the data on your base map to help you check the signal quality and the strength of interferences while 
driving toward the area of interest. 
 

Procedure 

1 Copy a set of raster data files into your USB memory drive, including the following: 
–  ASCII: .tab, .asc, and .clr files 
–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 
information systems. The color file (.clr) is an optional file, but the image will be 
displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2 Plug in the USB memory drive to your instrument. 
3 Press the TRACE/DISPLAY hard key. 
4 Press the Load Raster Map soft key. 

The file explorer window appears. 
5 Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 125. 

 

NOTE 
If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6 To select the display option, complete the following steps: 
 Press the Display Options soft key. a
 Select the option you desire from the choices: On, Off, and Blink. b

7 To adjust the transparency level of the image, complete the following steps: 
 Press the Transparency soft key. a
 Enter a value between 0 for opaque and 100 for clear. b
 Press the Enter soft key. c
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Figure 125 Raster image overlaid on the base map with LTE-FDD OTA signal analyzer 

  
 

The JD700B series provides the optional feature that lets you conduct correlated uplink and downlink testing 
with your instrument connected to your mobile device via Bluetooth. The RANAdvisor TrueSite application 
installed on your smartphone collects data and transfers uplink data based on your parameter settings and 
then your instrument consolidates the data into the measurement results and displays them as performance 
indicators. It helps you troubleshoot a problem and identify the cause of the problem fast. 
 
To perform this testing, you need both of these installed: the license for the option 014 LTE-FDD RAN 
Performance Indicator on your instrument and the RANAdvisor TrueSite app with the license on your 
smartphone. 
 

To set up a Bluetooth connection and enable data collection with remote control properly, you need to pair 
your instrument with your smartphone and set the app’s local Bluetooth control option to Slave once at the 
beginning. 
 

Procedure 

1 Connect a Bluetooth adapter to the USB Host port and an Omni antenna to the RF In port of your 
CellAdvisor instrument. 
The instrument detects the adapter and turns on its Bluetooth automatically. 

2 Make your smartphone visible to your instrument by doing the following steps: 
 On your smartphone, turn on Bluetooth. a
 Check the checkbox for Visible to all nearby Bluetooth devices to enable this option. b

3 Pair with your smartphone by doing the following steps: 
 On your instrument, press the MEASURE SETUP hot key. a
 Press the Bluetooth Connect soft key. b
 Press the Scan soft key. c

The instrument lists detected Bluetooth devices with their MAC address and status. 
 Highlight your mobile device from the list by touching on the screen. d



Chapter 8 Using LTE-FDD Signal Analyzer 

 JD700B Series User’s Guide 247 

 Press the Pair soft key. e
The pairing dialog box appears on your smartphone. 

 On your smartphone, enter 0000 and then tap the OK button. f
If pairing is successful, the status of your device on the list changes to “Paired”. 

4 Make sure to set your smartphone as a slave by completing the following steps: 
 On your smartphone, open the RANAdvisor TrueSite icon. a
 Go to Settings > General. b
 Tap the Automation Control Mode menu under Automation Control Options. c
 Select the Local Bluetooth Control option. d
 Tap Slave. e

The application restart dialog box appears. 
 Tap Continue. f

The application closes itself. 

 

NOTE 
It is very important for you to set the local Bluetooth control option to Slave on the 
RANAdvisor TrueSite app in order to give your instrument a control to collect necessary 
data from the app over Bluetooth successfully. 

 

 

To specify uplink measurement data that will be transferred to your instrument, you need to set map display 
parameters of your choice on the RANAdvisor TrueSite application. 
 

Procedure 

1 After you have paired and set your smartphone as a slave, open the RANAdvisor TrueSite icon 
on your device again. 

2 Tap the (+) button at the bottom of the Home screen. 
The Main Screen appears. 

3 Tap the Customization menu. 
The Choose Operation menu box appears. 

4 Select Map Display Parameters > LTE Serving and Neighbor Parameters. 
5 Make sure to check the checkbox for the following two mandatory parameters: 

–  Serving E-ARFCN 

–  Serving Physical Cell-ID 

 

NOTE 
It is very important for you to select these two parameters to identify the Uplink Channel 
Number, Cell ID, Group ID, and Sector ID. 

6 Select other parameters up to six from the list of parameters supported by the CellAdvisor 
instrument. See “Appendix L – Supported map display parameters” on page 715 for more 
information. 

 

NOTE 
As the RANAdvisor TrueSite app can transfer data of up to eight parameters at a time, it 
limits you to select eight parameters in total: two compulsories and six electives. After you 
have selected all eight parameters, the app blocks any further selection. In this case, you 
need to uncheck any selected optional parameters in order to enable other optional 
parameters. 

7 Tap the OK button and then the Back key to return to the Home Screen. 

 

After you have set the local Bluetooth control option and selected desired parameters on the app, you need 
to connect your instrument to your smartphone via Bluetooth to enable data collection from RANAdvisor 
TrueSite so that you can view consolidated measurement results on your instrument and save results as a 
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file. 
 

Procedure 

1 Make sure to have the RANAdvisor TrueSite app opened on your device. 
2 Press the MEASURE SETUP hot key on your instrument. 
3 Press the Bluetooth Connect soft key. 
4 Highlight your paired smartphone to connect from the list. 
5 Press the Connect soft key. 

The connected device information appears above the RAN Performance Indicator chart to 
indicate a successful connection. 

6 The instrument automatically sets the correlated downlink channel number for the received uplink 
channel number and displays measurement results as like Figure 126. Observe the consolidated 
measurement results on the screen for your troubleshooting. 

 

NOTE 
If the Cell ID of the uplink channel is not identical to the one of the downlink channel, the 
instrument displays “---“ for the parameters to indicate invalid measurement results. 

7 If you want to see measurement results for other parameters, select new parameters on the 
RANAdvisor TrueSite app. See “Setting parameters on RANAdvisor TrueSiteTM” on page 247. 

8 Optional. To save your settings and results, go to SAVE/LOAD > Save and then perform 
functions as you desire. See “Using save” on page 33 for more information. 

 

Figure 126 RAN performance indicator with LTE-FDD signal analyzer 

 
 

To analyze your measurement data easily with color codes, you can use the limit feature and set a 
performance score level for each measurement parameter. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To analyze the quality of user experience, do the following as needed: 
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To set the level for Select Set 

Data throughput Data Throughput Good, Bad (kbps) 

Channel quality indicator CQI Good, Bad 

Modulation type Modulation Type (On/Off only) 
 

3 To check the performance of eNode-B, do the following as needed: 

To set the level for Select Set 

Reference signal received power RSRP Good, Bad (dBm) 

Reference signal received 
quality 

RSRQ Good, Bad (dB) 

Signal to interference and noise 
ratio 

SINR Good, Bad (dB) 

Error vector magnitude More (1/2) > EVM Good, Bad (%) 

Time alignment error More (1/2) > Time Alignment Error Good, Bad (ns) 

Frequency error More (1/2) > Frequency Error Good, Bad (ppm) 
 

 
 



 
 

  

 

 

This chapter provides instructions for using the LTE-TDD Signal Analyzer (option 029) and LTE-Advanced 
TDD Analyzer (option 031) with the LTE-TDD OTA Analyzer (option 049) and the LTE-TDD RAN 
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The LTE (Long-Term Evolution) Signal Analyzer of the JD700B series performs power and spectrum 
measurements as well as modulation analysis to test the proper transmitter performance of TDD LTE 
systems. It performs conformance testing according to the following standards providing a simple Pass/Fail 
indication on each test. 
 

 3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) Radio 
Transmission and Reception 

 3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 
Conformance Testing 

 3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels and 
Modulation 

 3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and Channel 
Coding 

 3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Layer 
Procedures 

 
This instrument provides the following measurement tools for TDD LTE system: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time: Slot and Frame 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Time Alignment Error 

- Data Allocation Map 

 Auto Measure 

- Conformance Test 

- Maintenance Test 

- Signal Performance Test 

- DAS Test 

 Power Statistics CCDF 

 Carrier Aggregation 

 Over The Air (OTA) 
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- Channel Scanner 

- ID Scanner 

- Multipath Profile 

- Control Channel 

- Datagram 

- Route Map 

 RAN Performance Indicator 
 

Figure 127 provides descriptions for each segment of the measurement screen. 
 

Figure 127 LTE-TDD signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 
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Figure 128 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 129 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 
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Figure 130 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the LTE - TDD soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot) or Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe,  
Time Alignement Error, or Data Allocation Map 

–  Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance,  
or DAS Test 

–  Power Statistics CCDF 

–  More (1/2) > Carrier Aggregation 

–  More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel, 
Datagram, or Route Map 

–  More (1/2) > RAN Performance Indicator 

 

 

NOTE 
The Carrier Aggregation soft key is activated if the license for the option 031 LTE-
Advanced TDD is installed and so does the RAN Performance Indicator for the option 
015 LTE-TDD RAN Performance Indicator. 
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You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 To define the amount of frequency increment for the rotary knob, complete the following steps: 

 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6 To define the amount of channel increment for the rotary knob, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 
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Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 

 

NOTE 
In the measurements such as Control Channel and Subframe, you can select the 
reference option between Relative and Absolute instead. 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
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Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

To turn the external offset off: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 
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The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
TRIGGER hot key to set the external clock. 
 

Figure 131 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
Table 13 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in internal 
time base. 

External  (green) The green EXT icon indicates that an external reference is connected and 
locked and that the instrument uses the same reference clock as the signal 
source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 
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GPS 
 (green) 

The green GPS antenna icon indicates that a GPS antenna is connected and 
locked. 

GPS 
 (yellow) 

The yellow GPS antenna icon indicates that a GPS antenna is connected 
and locking is in progress. 

GPS 
 (grey) 

The grey GPS antenna icon indicates that a GPS antenna is not connected, 
failed, or unable to be locked. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 If you enable the gated sweep for the guard period, you can easily identify the existence of the 
interference in uplink call activities. 

 To turn it on, toggle the Guard Period soft key and select Enable. a
The Subframe No menu deactivates. 

 To turn it off, toggle the Guard Period soft key and select Disable. b

 

NOTE 
In LTE-TDD, the guard period is a special subframe, normally Subframe #1 and optionally 
Subframe #6, where there happens the switching from DL to UL. You should not see any 
data transmission in the guard period spectrum. 

5 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 
Your measurement result is displayed on the screen as like the following example, Figure 132. 
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Figure 132 Spectrum measurement screen with LTE-TDD signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace settings More (1/2) > 
Trace Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 



Chapter 9 Using LTE-TDD Signal Analyzer 

 JD700B Series User’s Guide 261 

difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of the 
signal in the LTE channel bandwidth. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 
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Figure 133 Channel power measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 268 for more 
information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 
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Figure 134 Occupied bandwidth measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 268 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses different 
power limits and different measurement bandwidths (resolution bandwidths) at various frequency offsets. It 
may be expressed as a ratio of power spectral densities between the carrier and the specified offset 
frequency band. It provides useful figures-of-merit for the spectral re-growth and emissions produced by 
components and circuit blocks, without the rigor of performing a full SEM measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates them 
to the carrier power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the mask type, complete the following steps: 

 Press the Mask Type soft key. a
 Select the mask type option, from the following choices: b

–  Wide Area BS Category A 
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–  Wide Area BS Category B 

–  Local Area BS 

–  Home BS 

4 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

5 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 

Figure 135 SEM measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 268 for more 
information. 

 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in an 
adjacent frequency channel according to the standards. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 

Figure 136 ACLR measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 268 for more 
information. 

 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station environment. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

 Press the Lowest Channel soft key to set the starting channel. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d
 Press the Highest Channel soft key to set the stopping channel. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Press the Enter soft key. g

 

Figure 137 Multi-ACLR measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 268 for more 
information. 
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Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a

as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20. b
 Press the Enter soft key. c
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Figure 138 Spurious emissions measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 268 for more 
information. 

 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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The Power vs. Time measurement measures the modulation envelope in the time domain, showing the 
signal rise and fall shape of LTE signal and the power of each time slot in an LTE signal. 
 

The Power vs. Time (Slot) in LTE-TDD Signal Analyzer measures the modulation envelope in the time 
domain, showing the signal rise and fall shapes of LTE signal. 
 

 

NOTE 
In this measurement, desirable level of the input power is lower than -10 dBm. If the input 
power to be measured is -10 dBm or higher, it is highly recommended that you use an 
external attenuator. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the slot number to be measured, complete the following steps: 

 Press the Slot No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. This 

MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s): 

To set the limit for Select Set 

Slot average power Slot Avg Power High Limit, Low Limit 

Off power Off Power High Limit 

Transition period Transition Period High Limit 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 139 Power vs. time (slot) measurement with LTE – TDD signal analyzer 

1) Off to on 
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2) On to off 

 
 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot in an LTE signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. This 

MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
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Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Figure 140 Power vs. time (frame) measurement with LTE – TDD signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 
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 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Press the Uplink-Downlink Configuration soft key, and then select the number of 
uplink/downlink between one and six. 

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
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type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Figure 141 Constellation measurement with LTE-TDD signal analyzer 

 
 

Figure 142 Constellation measurement with LTE-TDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 288 for 
more information. 
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The Data Channel measures the constellation for the specified resource block as well as the modulation 
accuracy of each PDSCH at the specified subframe. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

 

NOTE 
You can view detailed current resource block on the I-Q diagram, particularly in a 
dynamic field environment. 

8 Select More (1/2) > Uplink-Downlink Configuration, and then select the number of 
uplink/downlink between one and six. 

9 Optional. Select More (1/2) > Miscellaneous, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
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key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Figure 143 Data channel measurement with LTE-TDD signal analyzer 
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Figure 144 Data channel measurement with LTE-TDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 288 for 
more information. 

 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram for 
the selected resource block. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected resource block. 

 

The Control Channel measures the constellation for the specified control channel as well as modulation 
accuracy of the control channel at the specified subframe. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

8 Press the Uplink-Downlink Configuration soft key, and then select the number of 
uplink/downlink between one and six. 

9 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c
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NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 

 

Figure 145 Control channel measurement with LTE-TDD signal analyzer 
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Figure 146 Control channel measurement with LTE-TDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 288 for 
more information. 

 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram for 
the selected resource block. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the Channel soft key to select the channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 
3 Turn the rotary knob to move the highlight from one to another in the channel summary table. 
4 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected channel. 

 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 



Chapter 9 Using LTE-TDD Signal Analyzer 

 JD700B Series User’s Guide 281 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

8 Press the Uplink-Downlink Configuration soft key, and then select the number of 
uplink/downlink between one and six. 

9 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH 
appears as well depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b



Chapter 9 Using LTE-TDD Signal Analyzer 

282 JD700B Series User’s Guide 

 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and  
E-TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Figure 147 Subframe measurement with LTE-TDD signal analyzer 
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Figure 148 Subframe measurement with LTE-TDD signal analyzer (Chart On) 

 
 

Figure 149 Subframe measurement with LTE-TDD signal analyzer (MBMS On) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 288 for 
more information. 

 

You can use the TRACE/DISPLAY hard key to view your measurement result with the chart. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or dismiss the chart. If this setting is on, 

the MARKER hard key is activated. 
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If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 

 

In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. These 
signals shall be aligned. The time alignment error in Tx diversity is specified as the delay between the 
signals from two antennas at the antenna ports. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

4 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

 

Figure 150 Time alignment error measurement with LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 288 for 
more information. 

 

The Data Allocation Map function represents data allocation as a mapping. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
4 To set the threshold for PDSCH, complete the following steps: 

 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

5 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 
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Figure 151 Data allocation map measurement with LTE-TDD signal analyzer 

 
 

Figure 152 Data allocation map measurement with LTE-TDD signal analyzer (MBMS On) 

 
 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Display Channel soft key. 
3 Select the display mode from the choice: PDSCH, PMCH, and Both. 
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You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c

4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit, Low Limit 

P-SS power Power > P-SS Power High Limit, Low Limit 

S-SS power Power > S-SS Power High Limit, Low Limit 

PBCH power Power > PBCH Power High Limit, Low Limit 

Subframe power Power > Subframe Power High Limit, Low Limit 
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OFDM symbol power Power > OFDM Symbol Power High Limit, Low Limit 

Time alignment error for 
MIMO 

Time Alignment Error > MIMO High Limit 

Time alignment error for 
aggregation of component 
carriers (intra-band 
contiguous, intra-band non-
contiguous, and inter-band) 

Time Alignment Error > Carrier 
Aggregation 

Intra Cont 
Intra Non-cont 
Inter Band 

Time error Time Error High Limit, Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Conformance Test is to test if eNode-B meets some specified standards that have been developed for 
verification. Its test procedure and test setups have been developed by 3GPP. Test results can be saved as 
a .csv file type. 
 

You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item 
makes the test item included in the conformance test. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limit for BTS output power, complete the following steps: 

 Press the BTS Output Power soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key. c
 Enter a value for the upper limit, and then press the dBm unit soft key. d
 Press the Low Limit soft key. e
 Enter a value for the lower limit, and then press the dBm unit soft key. f

3 To set the limit for total power dynamic, complete the following steps: 
 Press the Total Power Dynamic soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the Low Limit soft key. c
 Enter a value for the lower limit, and then press the dBm unit soft key. d

4 To set the limit for on/off power, press the On/Off Power soft key, and then do the following as 
needed: 

To set the limit for Select Set 

Off power Off Power High Limit 
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Transition period Transition Period High Limit 
 

5 To verify signal quality, press the Signal Quality soft key, and then do the following as needed: 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Error vector magnitude EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

Time alignment error Time Alignment Error High Limit 

RS power RS Power High Limit, Low Limit 
 

6 To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the 
following as needed: 

To set the limit for Select Set 

Occupied bandwidth Occupied BW High Limit 

Adjacent channel power ratio ACLR  

Spectrum emission mask SEM Mask Type 

Spurious emissions Spurious Emissions Range Table 
 

7 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

After setting frequency as described in the “Configuring test parameters” on page 254, you can continue 
your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
4 Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma. 
5 To set external offset, complete the following steps: 

 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

7 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

8 When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the 
instrument to either Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM 
mode on the eNode-B side. 

9 Press the Continue soft key to continue testing. 
10 Repeat the steps 8-9 until completion of the test. 

A conformance test report appears at the end of the test. 
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11 Optional. To stop running the test, press the Abort soft key. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 20 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
Following settings are required only when you run the Auto Measure Maintenance Test on the instrument 
using “Current” configuration setting. Additional settings are not required when you run Auto Measure using 
a scenario generated in the PC application software, JDViewer. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the Allowed % Change soft key for each test item to compare two 
measurement values displayed in the result table. This requires setting the Display mode 
to Compare in advance. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
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The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a

measured, from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Toggle the Cell ID soft key and select Auto or Manual as desired: b

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. c
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On. e
 Enter a value by using the numeric keys, and then press the dB soft key. f
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the g

MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. 

 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically h
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 
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2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

–  Compare: You can compare two measurement values for each test time with the 
Allowed % Change setting on. You can view results vs. factory-defined or user-defined 
references. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

4 Press the Replace Reference soft key to replace existing reference values for comparison with 
new measurement data. 

5 Press the Load From soft key to select the location from which references file to be loaded. 

 

Unlike the other auto measurement tests, the Signal Performance Test runs measurements continuously. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel 

power. Other RF test items are not used in the signal performance test. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

3 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

4 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the antenna 
ports 2 and 3 are disabled. 
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5 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured, 
from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

6 Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as 
channel power and subframe frequency error. 

7 Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation 
profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM. 

8 Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such 
as TX1 - RS0, TX2 - RS1, and time alignment error. 

9 Toggle the External Offset soft key and select On to set the external offset value. 
10 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

 

The Distributed Antenna System (DAS) testing enables you to check the degradation of performance in the 
signal transmission from a radio band to antennas distributed from it. You can save measurement values at 
both the radio band and antennas and then compare results with percentage of changes. You can also save 
test results in the .csv file format for ease of analysis. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Settings soft key and then set the following; 

 Press the Bandwidth soft key and then select the nominal channel bandwidth to be a
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. b
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Toggle the Cell ID soft key and select Auto or Manual as desired: c
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On to set the external offset value. e
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the f

MBMS soft key and select On or Off. 
 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically g

or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

3 To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as 
you desire. See “Using save” on page 33 for more information. 

4 Press the Continue soft key to do the reference test first or press the Skip Reference Test soft 
key if you already saved test results from the radio band under test. 

5 Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting 
frequency” on page 255 for more information. 

6 Press the PREV hard key. 
7 Press the Limit soft key and then set the limits and allowed percentage change for each test 

item. See “Maintenance test” on page 291 for more information on setting limits. 
8 Keep pressing the PREV hard key until you see the Run Test soft key. 
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9 Press the Run Test soft key. 
The instrument runs specified tests to gather reference measurement values. The measurement 
table appears when the reference test is done. 

10 Press the Continue soft key to run the testing on an antenna (Ant 1). 
11 Optional. To change the settings such as External Offset, press the Settings and then change 

the settings as needed. 
12 Press the Continue soft key. 

The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table 
when the test is done. 

13 To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the 
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band. 

14 To view test results for each antenna, press the Select Antenna soft key and then select the 
antenna tab number to display on the screen. 

15 Optional. Press the Delete Test soft key to delete the selected antenna tab. 
16 Optional. Press the Retest Reference soft key to obtain reference measurement values again. 
17 Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 33 for more information. 

 

Figure 153 DAS measurement with LTE-TDD signal analyzer 

 
 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Figure 154 CCDF measurement with LTE-TDD signal analyzer 

 
 

Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to provide 
high data rate required for LTE-Advanced. Component carriers to be aggregated can be intra-band 
contiguous, intra-band non-contiguous, or inter-band. The JD700B series provides carrier aggregation 
measurements supporting for all the different modes with carrier aggregation bands added to the channel 
standard. This functionality is activated if the license for the option 031 LTE-Advanced TDD is installed. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To configure parameters for up to 5 component carriers, complete the following steps: 

 Press the CA Configuration soft key. a
The component carrier configuration window appears. 



Chapter 9 Using LTE-TDD Signal Analyzer 

 JD700B Series User’s Guide 297 

 Press the CA Range soft key. b
 Enter the number of the component carrier to be set between one and five. c
 Press the Enter soft key. d
 Toggle the Turn On soft key, and then select On to set parameters and view the results for e

the selected component carrier on the screen or Off to turn it off. 
 Set the following parameters as needed: f

–  Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port, 
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type 

 To set more component carriers, repeat the steps c-f. g
3 Press the MEASURE SETUP hot key again. 
4 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

5 To select the subframe number to be measured, do one of the following: 
–  If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set 

the subframe number. 

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

–  If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key and then 
select 0 or 5. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

7 Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH 
precoding. 

8 To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis. 

The screen changes according to the selected option. 
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Figure 155 Carrier aggregation measurement with LTE-TDD signal analyzer (MA) 

 
 

Figure 156 Carrier aggregation measurement with LTE-TDD signal analyzer (SA) 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 288 for 
more information. 

 

You can use the MARKER hard key to place the marker at a specific channel. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker. 
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3 Press the Channel soft key to select the channel to be displayed on the IQ diagram. 
4 Use the rotary knob to move and select an item under EVM. 

 

The TDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile, 
Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP, RSRQ, 
RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental conditions of 
testing area. The OTA Control Channel provides summary of all control channels including RS power 
variation over time. 
 

The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 
scanning when that frequency goes silent. 
 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 
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 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Figure 157 Channel scanner measurement with LTE-TDD OTA signal analyzer 

 
 

The LTE mobile receives signals from multiple base stations that all of these signals share the same 
spectrum and are present at the same time. Each base station has unique scrambling code assigned to the 
particular base station and it differentiates its signal from other base stations in the area. 
 
The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ 
(Reference Signal Received Quality) that predict the downlink coverage quickly. 

 RSRPs from entire cells help to rank between the different cells as input for handover and cell 
reselection decisions. 
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 RSRQ provides additional information when RSRP is not sufficient to make a reliable handover or 
cell reselection decision. 

 
All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and Google 
Earth by using JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 158 ID scanner measurement with LTE-TDD OTA signal analyzer 
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The Multipath Profile enables you to determine RF environmental conditions of testing area. It indicates the 
amount of power of the dominant pilot signal that is dispersed outside the main correlation peak due to 
multipath echoes that are expressed in dB. This value should be very small ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving antenna 
out of phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Toggle the Display soft key and select RS or Sync. 

The RS Window soft key becomes activated if RS is selected. 
4 Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,  

4 µs, or 8 µs. 
5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 159 Multipath profile measurement with LTE-TDD OTA signal analyzer 

 
 

DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS power is 
indicated on the BCH. The absolute accuracy is defined as the maximum deviation between the DL RS 
power indicated on the BCH and the DL RS power at the BS antenna connector. 
 
The OTA Control Channel provides summary of all control channels including RS power trend over time. 
GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is connected and 
locked to the GPS satellites. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 
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 Press the Enter soft key. c
4 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

6 Go to SAVE/LOAD > Save, and then select the save option from the choices available for your 
measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Select the test item(s) and set the limit(s) as needed: 

To set the limit for Select Set 

P-SS error vector magnitude P-SS EVM High Limit 

S-SS error vector magnitude S-SS EVM High Limit 

RS error vector magnitude RS EVM > RS0 EVM 
RS EVM > RS1 EVM 
RS EVM > RS2 EVM 
RS EVM > RS3 EVM 

High Limit 

Frequency error Frequency Error High Limit, Low Limit 

Time error Time Error High Limit, Low Limit 

Time alignment error Time Alignment Error High Limit 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

You can use the TRACE/DISPLAY hard key to select the display option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select Power or EVM. 

The screen changes according to the selected option. 

 

Figure 160 Control channel measurement with LTE-TDD OTA signal analyzer 

 
 

The OTA Datagram is a time-varying spectral representation that shows how the power of a signal varies 
with time. The power allocated to the specific resource block will be represented with an amplitude axis (in 
dBm) and the waterfall diagram will show the trend of past resource block power over certain period. Using a 
marker function facilitates analysis of accumulated resource block power for data utilization. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 254, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c
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4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To set the time cursor at a specific position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

7 To start a new measurement, press the Reset/Restart soft key. 
8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.  
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth. 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 161 Datagram measurement with LTE-TDD signal analyzer 

 
 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
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time directly on top of a loaded floor plan or a map.  
 
The JD700B Series also supports the RAN-IL (Interference Location) feature that enables you to overlay 
user experience data obtained through Viavi’s ariesoGEO on your base map to help you troubleshoot 
problems easily and quickly using your instrument. You can generate raster data files on the ariesoGEO 
application and load them on your instrument. 
 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 254. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR, 
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io. 

 

NOTE 
The instrument collects the strongest Cell ID’s data to plot points. 

7 Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then 
select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and  
20 MHz. 

8 Toggle the Plot soft key and select Start to start plotting. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 
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See “Using save” on page 33 for more information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

 

To set the limit for Select Set 

RSRP RSRP Excellent, Very Good, Good, Fair, Poor (dBm) 

RSRQ RSRQ Good, Fair, Poor (dB) 

RS-SINR RS-SINR Good, Fair, Poor (dB) 

S-SS RSSI S-SS RSSI Excellent, Very Good, Good, Fair, Poor (dBm) 

P-SS Power P-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Power S-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Ec/Io S-SS Ec/Io Good, Fair, Poor (dB) 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 162 Route map measurement (RSRP) with LTE-TDD OTA signal analyzer 
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Figure 163 Route map measurement (RSRQ) with LTE-TDD OTA signal analyzer 

 
 

Figure 164 Route map measurement (RS-SINR) with LTE-TDD OTA signal analyzer 
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Figure 165 Route map measurement (S-SS RSSI) with LTE-TDD OTA signal analyzer 

 
 

Figure 166 Route map measurement (P-SS Power) with LTE-TDD OTA signal analyzer 
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Figure 167 Route map measurement (S-SS Power) with LTE-TDD OTA signal analyzer 

 
 

Figure 168 Route map measurement (S-SS Ec/Io) with LTE-TDD OTA signal analyzer 

 
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b
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the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 

 

If you have a set of raster data files generated through the ariesoGEO application, you can load and overlay 
the data on your base map to help you check the signal quality and the strength of interferences while 
driving toward the area of interest. 
 

Procedure 

1 Copy a set of raster data files into your USB memory drive, including the following: 
–  ASCII: .tab, .asc, and .clr files 
–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 
information systems. The color file (.clr) is an optional file, but the image will be 
displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2 Plug in the USB memory drive to your instrument. 
3 Press the TRACE/DISPLAY hard key. 
4 Press the Load Raster Map soft key. 

The file explorer window appears. 
5 Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 169. 

 

NOTE 
If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6 To select the display option, complete the following steps: 
 Press the Display Options soft key. a
 Select the option you desire from the choices: On, Off, and Blink. b

7 To adjust the transparency level of the image, complete the following steps: 
 Press the Transparency soft key. a
 Enter a value between 0 for opaque and 100 for clear. b
 Press the Enter soft key. c
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Figure 169 Raster image overlaid on the base map with LTE-TDD OTA signal analyzer 

  
 

The JD700B series provides the optional feature that lets you conduct correlated uplink and downlink testing 
with your instrument connected to your mobile device via Bluetooth. The RANAdvisor TrueSite application 
installed on your smartphone collects data and transfers uplink data based on your parameter settings and 
then your instrument consolidates the data into the measurement results and displays them as performance 
indicators. It helps you troubleshoot a problem and identify the cause of the problem fast. 
 
To perform this testing, you need both of these installed: the license for the option 015 LTE-TDD RAN 
Performance Indicator on your instrument and the RANAdvisor TrueSite app with the license on your 
smartphone. 
 

To set up a Bluetooth connection and enable data collection with remote control properly, you need to pair 
your instrument with your smartphone and set the app’s local Bluetooth control option to Slave once at the 
beginning. 
 

Procedure 

1 Connect a Bluetooth adapter to the USB Host port and an Omni antenna to the RF In port of your 
CellAdvisor instrument. 
The instrument detects the adapter and turns on its Bluetooth automatically. 

2 Make your smartphone visible to your instrument by doing the following steps: 
 On your smartphone, turn on Bluetooth. a
 Check the checkbox for Visible to all nearby Bluetooth devices to enable this option. b

3 Pair with your smartphone by doing the following steps: 
 On your instrument, press the MEASURE SETUP hot key. a
 Press the Bluetooth Connect soft key. b
 Press the Scan soft key. c

The instrument lists detected Bluetooth devices with their MAC address and status. 
 Highlight your mobile device from the list by touching on the screen. d
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 Press the Pair soft key. e
The pairing dialog box appears on your smartphone. 

 On your smartphone, enter 0000 and then tap the OK button. f
If pairing is successful, the status of your device on the list changes to “Paired”. 

4 Make sure to set your smartphone as a slave by completing the following steps: 
 On your smartphone, open the RANAdvisor TrueSite icon. a
 Go to Settings > General. b
 Tap the Automation Control Mode menu under Automation Control Options. c
 Select the Local Bluetooth Control option. d
 Tap Slave. e

The application restart dialog box appears. 
 Tap Continue. f

The application closes itself. 

 

NOTE 
It is very important for you to set the local Bluetooth control option to Slave on the 
RANAdvisor TrueSite app in order to give your instrument a control to collect necessary 
data from the app over Bluetooth successfully. 

 

 

To specify uplink measurement data that will be transferred to your instrument, you need to set map display 
parameters of your choice on the RANAdvisor TrueSite application. 
 

Procedure 

1 After you have paired and set your smartphone as a slave, open the RANAdvisor TrueSite icon 
on your device again. 

2 Tap the (+) button at the bottom of the Home screen. 
The Main Screen appears. 

3 Tap the Customization menu. 
The Choose Operation menu box appears. 

4 Select Map Display Parameters > LTE Serving and Neighbor Parameters. 
5 Make sure to check the checkbox for the following two mandatory parameters: 

–  Serving E-ARFCN 

–  Serving Physical Cell-ID 

 

NOTE 
It is very important for you to select these two parameters to identify the Uplink Channel 
Number, Cell ID, Group ID, and Sector ID. 

6 Select other parameters up to six from the list of parameters supported by the CellAdvisor 
instrument. See “Appendix L – Supported map display parameters” on page 715 for more 
information. 

 

NOTE 
As the RANAdvisor TrueSite app can transfer data of up to eight parameters at a time, it 
limits you to select eight parameters in total: two compulsories and six electives. After you 
have selected all eight parameters, the app blocks any further selection. In this case, you 
need to uncheck any selected optional parameters in order to enable other optional 
parameters. 

7 Tap the OK button and then the Back key to return to the Home Screen. 

 

After you have set the local Bluetooth control option and selected desired parameters on the app, you need 
to connect your instrument to your smartphone via Bluetooth to enable data collection from RANAdvisor 
TrueSite so that you can view consolidated measurement results on your instrument and save results as a 
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file. 
 

Procedure 

1 Make sure to have the RANAdvisor TrueSite app opened on your device. 
2 Press the MEASURE SETUP hot key on your instrument. 
3 Press the Bluetooth Connect soft key. 
4 Highlight your paired smartphone to connect from the list. 
5 Press the Connect soft key. 

The connected device information appears above the RAN Performance Indicator chart to 
indicate a successful connection. 

6 The instrument automatically sets the correlated downlink channel number for the received uplink 
channel number and displays measurement results as like Figure 170. Observe the consolidated 
measurement results on the screen for your troubleshooting. 

 

NOTE 
If the Cell ID of the uplink channel is not identical to the one of the downlink channel, the 
instrument displays “---“ for the parameters to indicate invalid measurement results. 

7 If you want to see measurement results for other parameters, select new parameters on the 
RANAdvisor TrueSite app. See “Setting parameters on RANAdvisor TrueSiteTM” on page 247. 

8 Optional. To save your settings and results, go to SAVE/LOAD > Save and then perform 
functions as you desire. See “Using save” on page 33 for more information. 

 

Figure 170 RAN performance indicator with LTE-TDD signal analyzer 

 
 

To analyze your measurement data easily with color codes, you can use the limit feature and set a 
performance score level for each measurement parameter. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To analyze the quality of user experience, do the following as needed: 
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To set the level for Select Set 

Data throughput Data Throughput Good, Bad (kbps) 

Channel quality indicator CQI Good, Bad 

Modulation type Modulation Type (On/Off only) 
 

3 To check the performance of eNode-B, do the following as needed: 

To set the level for Select Set 

Reference signal received power RSRP Good, Bad (dBm) 

Reference signal received 
quality 

RSRQ Good, Bad (dB) 

Signal to interference and noise 
ratio 

SINR Good, Bad (dB) 

Error vector magnitude More (1/2) > EVM Good, Bad (%) 

Time alignment error More (1/2) > Time Alignment Error Good, Bad (ns) 

Frequency error More (1/2) > Frequency Error Good, Bad (ppm) 
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This CDMA Signal Analyzer can be used to test a CDMA transmitter including cdmaOne and cdma2000 
signals to check the base station’s compliance with following standards documentation. 
 

 3GPP2 C.S0002 Physical Layer Standard for cdma2000 Spread Spectrum Systems 

 3GPP2 C.S0010 Recommended Minimum Performance Standards for cdma2000 Spread Spectrum 
Base Station 

 
This instrument automatically makes standard defined measurements using the measurement methods and 
limits as defined in the standards. Detailed measurement results allow you to analyze cdmaOne and 
cdma2000 system performance. 
 

 cdmaOne uses dual BPSK (Binary Phase-Shifting Key) for the forward link and OQPSK (Offset 
Quadrature Phase Shift Keying) for the reverse link. 

 cdma2000 uses QPSK (Quadrature Phase Shift Keying) modulation for the forward link and QPSK 
modulation with HPSK spreading for the reverse link. Both forward and reverse links may have 
several channels, and individual characteristics for each channel. The chip rate depends on the 
mode selected. 

 
You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard defined 
or user defined upper and lower limits and the Pass/Fail indictor help you to determine base station 
performance easily. 
 
This instrument provides the following measurement tools for CDMA system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Adjacent Channel Power Ratio (ACPR) 
- Multi-ACPR 
- Spurious Emissions 

 Modulation Analysis 
- Constellation 
- Code Domain Power 
- Codogram 
- Received Code Strength Indicator (RCSI) 
- CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Channel Scanner 
- PN Scanner 
- Multipath Profile 
- Code Domain Power 
- Route Map 
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Figure 171 provides descriptions for each segment of the measurement screen. 
 

Figure 171 CDMA signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 172 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 
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Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 173 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

 

NOTE 
For accurate PN Offset and Time Offset measurements with the CDMA Signal Analyzer 
function, a PP2S should be connected to the External Trigger. Without a GPS connection, 
measurement results could be invalid numbers. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Figure 174 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the CDMA soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,  
Multi-ACPR, or Spurious Emissions 

–  Modulation > Constellation, Code Domain Power, Codogram, RCSI, or CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power, 
or Route Map 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
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2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard”” on page 689 for more 
information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
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 Press the unit soft key or the ENTER hard key. c
This unit key name changes according to the setting in the Units menu. 

 

NOTE 
In the measurements such as Code Domain Power, Codogram, and RCSI, you may 
need to select the reference option between Relative and Absolute before setting the 
reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 
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NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
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The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. Connecting an external trigger is necessary 
for accurate modulation measurements on CDMA systems. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
TRIGGER hot key to set the external clock. 
 

Table 14 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 
Figure 175 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 
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NOTE 
When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 
Table 15 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

If you have configured test parameters as described in the “Configuring test parameters” on page 321, your 
measurement result is displayed on the screen as like the following example, Figure 176. 
 

Figure 176 Spectrum measurement screen with CDMA signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 To select the detection option, select More (1/2) > Detectors, and then do one of the following: 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

5 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
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The channel power measurement identifies the total RF power, power spectral density (PSD) and peak to 
average ratio (PAR) of the signal within the channel bandwidth (1.23 MHz for cdmaOne). 
 
After configuring test parameters as described in the “Configuring test parameters” on page 321, your 
measurement result is displayed on the screen as like the following example, Figure 177. 
 

Figure 177 Channel power measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 333 for more 
information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 321, your 
measurement result is displayed on the screen as like the following example, Figure 178. 
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Figure 178 Occupied bandwidth measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 333 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various frequency 
offsets. It may be expressed as a ratio of power spectral densities between the carrier and the specified 
offset frequency band. It provides useful figures-of-merit for the spectral re-growth and emissions produced 
by components and circuit blocks, without the rigor of performing a full SEM measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates them 
to the carrier power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, your 
measurement result is displayed on the screen as like the following example, Figure 179. 
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Figure 179 SEM measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 333 for more 
information. 

 

The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the adjacent 
frequency channel (or offset) to the average power in the transmitted frequency channel. It may be 
expressed as the ratio of the integrated signal power in the adjacent channel to the integrated signal power 
in the main channel. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 321, your 
measurement result is displayed on the screen as like the following example, Figure 180. 
 

Figure 180 ACPR measurement with CDMA signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 333 for more 
information. 

 

The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many 
channels as possible. It helps you to measure ACPR in multi-channel transmitting base station environment. 
 

You can set the frequency with either frequency or channel number. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b

band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 
After configuring test parameters, your measurement result is displayed on the screen as like the following 
example, Figure 181. 
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Figure 181 Multi-ACPR measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 333 for more 
information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a

as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 
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NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20. b
 Press the Enter soft key. c

 
After configuring test parameters as described in the “Configuring test parameters” on page 321, your 
measurement result is displayed on the screen as like the following example, Figure 182. 
 

Figure 182 Spurious emissions measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 333 for more 
information. 

 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 
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Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACPR ACPR (On/Off only) 

Multi-ACPR Multi-ACPR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

In order to make accurate measurements of time offset and PN, you must connect an external trigger before 
making a modulation measurement. 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 183 Constellation measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 341 for 
more information. 

 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 
normalized to the total power. It helps to verify that each code channel is operating at its proper level and to 
identify problems throughout the transmitter design from coding to the RF section. System imperfections 
such as amplifier non-linearity will present themselves as an undesired distribution of power in the code 
domain. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
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 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 184 Code domain power measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 341 for 
more information. 

 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

The Codogram displays how the code level is changing over time and makes it easier for you to view traffic 
channels as they initiate and terminate and to track traffic channels call levels over time. The Codogram 
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measurements can be saved into an external USB memory so that a post-analysis can be done with the 
application software JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Select More (1/2) > Threshold. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 

6 To set the time interval, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

 

8 To start a new measurement, press the Reset/Restart soft key. 
9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 185 Codogram in full view with CDMA signal analyzer 

 
 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

The Received Code Strength Indicator (RCSI) is used to track the power variation of cdmaOne or cdma2000 
control channels such as Pilot, Paging, Sync, and Q-Paging over time. The RCSI measurements can be 
saved into an external USB memory so that a post-analysis can be done with the application software 
JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
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2 To set the Pseudo-Noise (PN) offset, complete the following steps: 
 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 

6 Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, Page, Sync, 
or Quick Page. 

7 To set the alarm mask, complete the following steps: 
 Press the Set Mask soft key. a
 Enter a value by using the numeric keys. b
 Press the [dB|dBm] soft key. c

8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 186 RCSI measurement with CDMA signal analyzer 

 
 

You can view your measurement results in a different view option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

The CDP Table is used to look at a numeric and textual description of all the active code channels in the 
signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 
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Figure 187 CDP Table measurement with CDMA signal analyzer 

 
 

If the CDP table spans over to the next page(s), you can change pages up and down to view your 
measurement results. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 
4 Select Page Up or Page Down as needed to scroll the screen up and down. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Time offset Time Offset High Limit, Low Limit 

Waveform quality (Rho) Rho Low Limit 

Carrier feed through Carrier Feed Through High Limit 
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Pilot power Pilot Power High Limit [Abs|Rel] 
Low Limit [Abs|Rel] 

Highest level among inactive channels Max Inactive High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

 

NOTE 
The Time Offset compares the PN offset timing with the overall system time and the 
instrument checks the start of PN offset in comparison to either the GPS signal or the 
even second clock signal. 

 

 

NOTE 
The Rho measures the modulation quality for a CDMA transmitter along with EVM and 
Walsh Channel Power. It includes all errors occurred along the transmitter chain such as 
base band filtering, abnormality of I/Q modulator and distortion in power amplifier. A 
perfect Rho value is 1.0 indicating that all of the power is being transmitted correctly. 

 

 

NOTE 
The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
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the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 To set external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 
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–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Figure 188 CCDF measurement with CDMA signal analyzer 
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This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code 
Domain power screens. It is used to verify CDMA transmitter performance at any location providing reflective 
measurements and identifying signals providing from different sites. The Code Domain power shows not 
only modulation performance metric but also amplifier capacity and code utilization metric. The Amplifier 
capacity (code utilization) measurement is an estimate of the amount of power amplifier capacity (code 
utilization) that is being used expressed in percent of maximum. 
 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
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7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

After configuring other test parameters as described in the “Configuring test parameters” on page 321, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You can 
also use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on 
to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Figure 189 Channel scanner measurement with CDMA OTA signal analyzer 

 
 

Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active PNs in 
an area. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 190 PN scanner measurement with CDMA OTA signal analyzer 

 
 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It indicates the 
amount of power of the dominant pilot signal that is dispersed outside the main correlation peak due to 
multipath echoes that are expressed in dB. This value should be very small ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving antenna 
out of phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 191 Multipath profile measurement with CDMA OTA signal analyzer 

 
 

Channels with high correlation factors are determined to be active channels and are indicated as such on 
the display. Once the channels are decoded, the analyzer determines the power of each channel relative to 
the total signal power. 
 
This measurement helps to verify that each code channel is operating at its proper level and helps to identify 
problems throughout the transmitter design from the coding to the RF section. System imperfections, such 
as the non-linearity of amplifiers, will present themselves as an undesired distribution of power in the code 
domain. 
 

After configuring test parameters as described in “Configuring test parameters” on page 321, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
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 Enter a value between -50 and zero by using the numeric keys to change the value in the b
Manual mode. 

 Press the Enter soft key. c
5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 

that indicates the power of Quick Page Walsh code 80. 
6 To set the maximum amplifier power, complete the following steps: 

 Press the Max Amplifier Power soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

7 To set the pilot power, complete the following steps: 
 Press the Pilot Power soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

8 To set the threshold for pilot dominance, complete the following steps: 
 Select More (1/2) > Pilot Dominance >. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases 
on this setting. 

 

9 To set the threshold for multipath power, complete the following steps: 
 Select More (1/2) > Multipath Power <. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

 

10 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 192 Code domain power measurement with CDMA OTA signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map. 
 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 321. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. With the Full setting, you can view all the 
collected points of the route without the loaded map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 
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6 Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io. 
7 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the Plot soft key and select Start. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 33 for more information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for the four different color indicators for Pilot power or Ec/Io. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limits for pilot power if you have selected Pilot for the plot item, complete the following 

steps: 
 Press the Pilot Power soft key. a
 Press the Excellent soft key to set its threshold. b
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. c
 Press the Very Good soft key to set its threshold. d
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. e
 Press the Good soft key to set its threshold. f
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. g
 Press the Fair soft key to set its threshold. h

 Enter a value, and then press the dBm soft key. You can also use the rotary knob. i
 Press the Poor soft key to set its threshold. j
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. k

3 To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps: 
 Press the Ec/Io soft key. a
 Press the Good soft key to set its threshold. b
 Enter a value, and then press the Enter soft key. You can also use the rotary knob. c
 Press the Fair soft key to set its threshold. d
 Enter a value, and then press the Enter soft key. You can also use the rotary knob. e
 Press the Poor soft key to set its threshold. f
 Enter a value, and then press the Enter soft key. You can also use the rotary knob. g

4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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Figure 193 Route map measurement with CDMA OTA signal analyzer 

1) Pilot Power 

 

2) Pilot Ec/Io 

 
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
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 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b
the selected area. 

 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c
area of interest. 

 Press the center of the rotary knob to zoom into the selected area. You can also press d
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 
 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 
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The EV-DO Signal Analyzer of the JD700B series performs power and spectrum measurements as well as 
modulation analysis to test the proper transmitter performance of EV-DO systems. It performs conformance 
testing according to the following standards providing a simple Pass/Fail indication on each test. 
 

 3GPP2 C.S0024-B. cdma2000 High Rate Packet Data Air Interface Specification 

 3GPP2 C.S0032-B. Recommended Minimum Performance Standards for cdma2000 High Rate 
Packet Data Access Network 

 
You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard defined 
or user defined upper and lower limits and the Pass/Fail indictor help you to determine base station 
performance easily. 
 
This instrument provides the following measurement tools for EV-DO system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Adjacent Channel Power Ratio (ACLR) 
- Multi-ACPR 
- Spurious Emissions 

 Power vs. Time: Idle Slot and Active Slot 

 Modulation Analysis 
- Constellation 
- Code Domain Power 
- MAC Codogram 
- Received Code Strength Indicator (RCSI) 
- MAC CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Channel Scanner 
- PN Scanner 
- Multipath Profile 
- Code Domain Power 
- Route Map 

Figure 194 provides descriptions for each segment of the measurement screen. 
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Figure 194 EV-DO signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 195 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
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BTS. 

 
Figure 196 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 197 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the EV-DO soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,  
Multi-ACPR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Idle Slot) or Power vs Time (Active Slot) 

–  Modulation Analysis > Constellation > Composite 64, Composite 128, Pilot, MAC 64, 
MAC 128, or Data 

–  Modulation Analysis > Code Domain Power > Pilot, MAC 64, MAC 128, or Data 

–  Modulation Analysis > MAC Codogram, RCSI, or MAC CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power,  
or Route Map 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
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See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 
 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b

Up/Page Down soft keys. 
 Press the Select soft key or the rotary knob to confirm the selection. c

4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 

 

NOTE 
In the measurements such as Code Domain Power and MAC Codogram, you may 
need to select the reference option between Relative and Absolute before setting the 
reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
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 Press the dB soft key or the ENTER hard key. d
–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 

Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

To set the scale per division: 
1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
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2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. Connecting an external trigger is necessary 
for accurate modulation measurements on EV-DO systems. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 
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To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
TRIGGER hot key to set the external clock. 
 

Table 16 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 
Figure 198 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 

 

NOTE 
When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 
Table 17 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 
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External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

If you have configured test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 199. 
 

Figure 199 Spectrum measurement screen with EV-DO signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 
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Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak to 
average ratio (PAR) of the signal in the EV-DO channel bandwidth (1.23 MHz). 
 
After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 200. 
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Figure 200 Channel power measurement with EV-DO signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 371 for more 
information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 201. 
 

Figure 201 Occupied bandwidth measurement with EV-DO signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
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limit and Pass/Fail indication. See “Setting limit for RF tests” on page 371 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various frequency 
offsets. It may be expressed as a ratio of power spectral densities between the carrier and the specified 
offset frequency band. It provides useful figures-of-merit for the spectral re-growth and emissions produced 
by components and circuit blocks, without the rigor of performing a full SEM measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates them 
to the carrier power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 202. 
 

Figure 202 SEM measurement with EV-DO signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 371 for more 
information. 

 

The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the adjacent 
frequency channel (or offset) to the average power in the transmitted frequency channel. It may be 
expressed as the ratio of the integrated signal power in the adjacent channel to the integrated signal power 
in the main channel. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 203. 
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Figure 203 ACPR measurement with EV-DO signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 371 for more 
information. 

 

The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many 
channels as possible. It helps you to measure ACPR in multi-channel transmitting Base Station environment. 
 

You can set the frequency with either frequency or channel number. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b

band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
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 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 
After configuring the test parameters, your measurement result is displayed on the screen as like the 
following example, Figure 204. 
 

Figure 204 Multi-ACPR measurement with EV-DO signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 371 for more 
information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
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 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. a
 Press the dB soft key or the ENTER hard key. b
 Press the RBW soft key. c
 Enter a value by using the numeric keys. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the VBW soft key. f
 Enter a value by using the numeric keys. g
 Select the unit: GHz, MHz, kHz, or Hz. h

6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 
After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 205. 
 

Figure 205 Spurious emissions measurement with EV-DO signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 371 for more 
information. 

 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACPR ACPR (On/Off only) 

Multi-ACPR Multi-ACPR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Power vs. Time (Idle Slot and Active Slot) in EV-DO Signal Analyzer verifies that the transmitter output 
power has correct amplitude, shape, and timing for the EV-DO format. 
 

 Idle Slot: Slot with no data in traffic channel. 

 Active Slot: Slot with the loaded data in traffic channel. 
 
Forward link of 1xEV-DO is a frame structure and each frame consists of 16 slots. The frame period for 
1xEV-DO is 26.667 ms, which is also the period of one pilot channel. Each frame is divided into 16 slots of 
1.666 ms. 1xEV-DO uses CDMA modulation scheme, but unlike its previous systems the Pilot, MAC (Media 
Access Control), and Data (Traffic) Channel are not transmitted simultaneously; instead they are transmitted 
in TDM (Time Division Multiplex). 
 

The Power vs. Time (Idle Slot) measurement provides the idle slot that includes the Pilot and MAC channels 
with the masks in all regions. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 206. 
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Figure 206 Power vs. time (idle slot) measurement with EV-DO signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 373 for 
more information. 

 

The Power vs. Time (Active Slot) measurement includes the Pilot, MAC, and Data channels with the upper 
and lower masks. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 359, your 
measurement result is displayed on the screen as like the following example, Figure 207. 
 

Figure 207 Power vs. time (active slot) measurement with EV-DO signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 373 for 
more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s): 

To set the limit for Select Set 

Pilot power Pilot Power High Limit, Low Limit 

Medium access control power MAC Power High Limit, Low Limit 

Data power during the data period Data Power High Limit, Low Limit 

On/off power ratio of the pilot and MAC 
powers to the data power 

On/Off Ratio Low Limit 

 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

In order to make accurate measurements of time offset and PN, you must connect an external trigger before 
making a modulation measurement. 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually, and then press the Enter soft key. b

3 To set the incremental step for the PN offset, complete the following steps: 
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 Press the PN Increment soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 382 for 
more information. The Max Inactive is not used in the Constellation mode. 

 

Figure 208 Constellation measurement with EV-DO signal analyzer 

1) Composite 64 

 

2) Composite 128 
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3) Pilot 

 

4) MAC 64 

 

5) MAC 128 
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6) Data 

 
 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 
normalized to the total EV-DO power. It helps to verify that each code channel is operating at its proper level 
and to identify problems throughout the transmitter design from coding to the RF section. System 
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of power in 
the code domain. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 382 for more information. 

 

Figure 209 Code domain power measurement with EV-DO signal analyzer 

1) Pilot 

 

2) MAC 64 
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3) MAC 128 

 

4) Data 

 
 

The MAC Codogram displays the power variation for every code over time, presenting a clear view of the 
traffic load per channels at any given time. The MAC Codogram measurements can be saved into an 
external USB memory so that a post-analysis can be done with the application software JDViewer. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
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 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
6 To set the time interval, complete the following steps: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

 

8 To start a new measurement, press the Reset/Restart soft key. 
9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 210 MAC Codogram in full view with EV-DO signal analyzer 

 
 

The Received Code Strength Indicator (RCSI) is used to track the power variation over time of EV-DO 
channels: Pilot, MAC, Data, and Slot. The RCSI measurements can be saved into an external USB memory 
so that a post-analysis can be done with the application software JDViewer. 



Chapter 11 Using EV-DO Signal Analyzer 

380 JD700B Series User’s Guide 

 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
6 Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, MAC, Data, 

or Slot. 
7 To set the alarm mask, complete the following steps: 

 Press the Set Mask soft key. a
 Enter a value by using the numeric keys. b
 Press the [dB|dBm] soft key. c

8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 211 RCSI measurement with EV-DO signal analyzer 

 
 

The MAC CDP Table is used for the user to look at a numeric and textual description of all the active control 
channels in the signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
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Figure 212 MAC CDP Table measurement with EV-DO signal analyzer 

 
 

If the MAC CDP table spans over to the next page(s), you can change pages up and down to view your 
measurement results. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select Page Up or Page Down as needed to scroll the screen up and down. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Time offset Time Offset High Limit, Low Limit 

Carrier feed through Carrier Feed Through High Limit 

Highest level among inactive channels Max Inactive High Limit 

Waveform quality (Rho) for pilot Pilot Rho Low Limit 

Waveform quality (Rho) for MAC MAC Rho Low Limit 

Waveform quality (Rho) for data Data Rho Low Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
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5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

 

NOTE 
The Time Offset compares the PN offset timing with the overall system time and the 
instrument checks the start of PN offset in comparison to either the GPS signal or the 
even second clock signal. 

 

 

NOTE 
The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
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The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. a
 Toggle the PvsT soft key and select the slot option: Idle or Active. b
 Toggle the External Offset soft key and select On. c
 Enter a value by using the numeric keys, and then press the dB soft key. d

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 
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The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Figure 213 CCDF measurement with EV-DO signal analyzer 
 

 
 

This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code 
Domain power screens. It is used to verify EV-DO transmitter performance at any location providing 
reflective measurements and identifying signals providing from different sites. The Code Domain power 
shows not only modulation performance metric but also amplifier capacity and code utilization metric. The 
Amplifier capacity (code utilization) measurement is an estimate of the amount of power amplifier capacity 
(code utilization) that is being used expressed in percent of maximum. 
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Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

After configuring other test parameters as described in the “Configuring test parameters” on page 359, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You can 
also use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on 
to the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 214 Channel scanner measurement with EV-DO OTA signal analyzer 

 
 

Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active PNs in 
an area. 
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After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 215 PN scanner measurement with EV-DO OTA signal analyzer 

 
 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It indicates the 
amount of power of the dominant pilot signal that is dispersed outside the main correlation peak due to 
multipath echoes that are expressed in dB. This value should be very small ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving antenna 
out of phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
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use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 216 Multipath profile measurement with EV-DO OTA signal analyzer 

 
 

Channels with high correlation factors are determined to be active channels and are indicated as such on 
the display. Once the channels are decoded, the analyzer determines the power of each channel relative to 
the total signal power. 
 
This measurement helps to verify that each code channel is operating at its proper level and helps to identify 
problems throughout the transmitter design from the coding to the RF section. System imperfections, such 
as the non-linearity of amplifiers, will present themselves as an undesired distribution of power in the code 
domain. 
 

After configuring test parameters as described in “Configuring test parameters” on page 359, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
6 Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 

16 QAM, or 64 QAM. 
7 To set the threshold for pilot dominance, complete the following steps: 

 Press the Pilot Dominance > soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases 
on this setting. 

 

8 To set the threshold for multipath power, complete the following steps: 
 Press the Multipath Power < soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

NOTE 
Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 217 Code domain power measurement with EV-DO OTA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map. 
 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 359. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 
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NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io. 
7 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the Plot soft key and select Start. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 33 for more information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for the four different color indicators for Pilot power or Ec/Io. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

To set the limit for Select Set 

Pilot Power Pilot Power Excellent, Very Good, Good, Fair, Poor (dBm) 

Ec/Io Ec/Io Good, Fair, Poor (dB) 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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Figure 218 Route map measurement with EV-DO OTA signal analyzer 

1) Pilot Power 

 

2) Pilot Ec/Io 

 
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c
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area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 

 
 



 
 

   

 

 

This chapter provides instructions for using the TD-SCDMA Signal Analyzer function (option 025) with the 
TD-SCDMA OTA Analyzer function (option 045). Topics discussed in this chapter are as follows: 
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The Time Division-Synchronous Code Division Multiple Access, also known as TD-SCDMA, is a 3G mobile 
telecommunications standard that is pursued by the Chinese Academy of Telecommunications Technology 
(CATT) in the People's Republic of China. The TD-SCDMA uses the TDD scheme while the WCDMA uses 
the FDD. 
 
This TD-SCDMA Signal Analyzer can be used for testing of TD-SCDMA systems, made according to the 
following standard documentation. 
 

 3GPP TS 25.105 Base Station radio transmission and reception (TDD) 

 3GPP TS 25.142 Base Station conformance testing (TDD) 

 3GPP TS 25.222 Multiplexing and channel coding (TDD) 

 3GPP TS 25.223 Spreading and modulation (TDD) 
 
The instrument automatically makes standard defined measurements using the measurement methods and 
limits as defined in the standard. The detailed results allow you to analyze TD-SCDMA/HSDPA system 
performance. You may alter the measurement parameters for specialized analysis. Pass/Fail testing with 
standard defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine 
base station performance easily. 
 
This instrument provides the following measurement tools for TD-SCDMA system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask 
- Adjacent Channel Leakage power Ratio (ACLR) 
- Multi-ACLR 
- Spurious Emissions 

 Power vs. Time: 
- Power vs. Time (Slot) 
- Power vs. Time (Frame) 
- Power vs. Time (Mask) 
- Timogram 

 Modulation Analysis 
- Constellation 
- Midamble Power 
- Code Power 
- Code Error 

 Auto Measure 

 Over The Air (OTA) 
- Sync-DL ID Scanner 
- Sync-DL ID vs. Tau 
- Sync-DL ID Multipath 
- Sync-DL ID Analyzer 
- Route Map 
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Figure 219 provides descriptions for each segment of the measurement screen. 
 

Figure 219 TD-SCDMA signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 220 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 
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Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 221 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 222 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 
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CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Select More (1/2) > TD-SCDMA. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot), Power vs Time (Frame), 
Power vs Time (Frame), or Timogram 

–  Modulation Analysis > Constellation, Midamble Power, Code Power, or Code Error 

–  Auto Measure 

–  OTA > Sync-DL ID Scanner, Sync-DL ID vs Tau, Sync-DL ID Multipath,  
Sync-DL ID Analyzer, or Route Map 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
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3 To select the standard channel, complete the following steps: 
 Press the Channel Std soft key. The standard channel window appears. a

See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 
 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b

Page Up/Page Down soft keys. 
 Press the Select soft key or the rotary knob to confirm the selection. c

4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 

 

NOTE 
In the measurements such as Midamble Power, Code Power, and Code Error, you 
may need to select the reference option between Relative and Absolute before setting 
the reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 
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 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
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Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation in the spectrum and RF 
analysis. A maximum of 100 times of averaging can be set. When the averaging reaches to your setting, a 
new measurement value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 
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To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
TRIGGER hot key to set the external clock. 
 

Figure 223 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
Table 18 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 
Your measurement result is displayed on the screen as like the following example, Figure 224. 
 

Figure 224 Spectrum measurement screen with TD-SCDMA signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 
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Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement determines the average power of an RF signal burst at or above a 
specified threshold value. 
 
The purpose of the Channel Power measurement is to determine the power delivered to the antenna system 
on the RF channel under test. The instrument acquires a TD-SCDMA signal in the time domain. The average 
power level above the threshold is then computed and displayed. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Figure 225 Channel power measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 412 for more 
information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Figure 226 Occupied bandwidth measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 412 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses different 
power limits and different measurement bandwidths (resolution bandwidths) at various frequency offsets. It 
may be expressed as a ratio of power spectral densities between the carrier and the specified offset 
frequency band. It provides useful figures-of-merit for the spectral re-growth and emissions produced by 
components and circuit blocks, without the rigor of performing a full SEM measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates them 
to the carrier power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 To select the mask type according to the output power of the base station, complete the following 

steps: 
 Press the Mask Type soft key. a
 Select the mask type option: - 26 dBm, 26 – 34 dBm, or 34 dBm –. b

4 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
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 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Figure 227 SEM measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 412 for more 
information. 

 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in an 
adjacent frequency channel according to the standards. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Figure 228 ACLR measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 412 for more 
information. 

 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station environment. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b
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band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 

Figure 229 Multi-ACLR measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 412 for more 
information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a
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as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100, and then press the Enter soft key. b

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20, and then press the Enter soft key. b

 

Figure 230 Spurious emissions measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 412 for more 
information. 
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By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Power vs. Time (P vs T) measurement analyzes the amplitude profile and timing of the burst signal and 
provides a time mask for the signal. It measures the mean transmit power during the “useful part” of TD-
SCDMA bursts and verifies that the power ramp fits within the defined mask. TD-SCDMA is a Time Division 
Multiple Access (TDMA) scheme with seven time slots, or bursts, per RF channel and by using the “Multi-
Slot” function, up to seven slots in a frame can be viewed at one time. 
 

The Power vs. Time (Slot) in TD-SCDMA Signal Analyzer measures the modulation envelope in the time 
domain, showing the signal rise and fall shape of TD-SCDMA signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
4 To set the number of maximum users, complete the following steps: 
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 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

5 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 

Spec or Full. 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

 

Figure 231 Power vs. time (slot) measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 418 for 
more information. 
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The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot of the TD-SCDMA signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
4 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

5 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 

Spec or Full. 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 
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Figure 232 Power vs. time (frame) measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 418 for 
more information. The On/Off Ratio is not used in the power vs. time (frame) tests. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
4 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

5 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 

Spec or Full. 
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NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

 

Figure 233 Power vs. time (mask) measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 418 for 
more information. The DwPTS Power and UpPTS Power are not used in the power vs. 
time (mask) tests. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
3 To set the number of maximum users, complete the following steps: 
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 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

4 To set the time interval, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

5 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 

NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 
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Figure 234 Timogram with TD-SCDMA signal analyzer 

 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Slot power Slot Power High Limit, Low Limit 

Downlink pilot signal power DwPTS Power High Limit, Low Limit 

Uplink pilot signal power UpPTS Power High Limit, Low Limit 

Power between on and off 
portions of the downlink slots 

On/Off Ratio High Limit, Low Limit 

 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

TD-SCDMA receivers rely on the frequency or phase quality of the QPSK or 8PSK signal in order to achieve 
the expected carrier to noise performance. A transmitter with high frequency or phase error is often still able 
to support phone calls during a functional test. It displays the frequency errors numerically and graphically, 
showing the binary representation of the demodulated data bits of the received signal using Constellation, 
Midamble Power, Code Power, and Code Error screens. 
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The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys, and then press the Enter soft key. b

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c
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Figure 235 Constellation measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 424 for 
more information. The Max Inactive is not used in the Constellation mode. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c
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NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c

 

Figure 236 Midamble measurement with TD-SCDMA signal analyzer 

 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c
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Figure 237 Code power measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 424 for more information. 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 



Chapter 12 Using TD-SCDMA Signal Analyzer 

424 JD700B Series User’s Guide 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c

 

Figure 238 Code error measurement with TD-SCDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 424 for more information. 

 

Procedure 

1 Press the LIMIT hot key. 
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2 Press the Modulation Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Error vector magnitude rms EVM RMS High Limit 

Peak code domain error PCDE High Limit 

Highest level among inactive channels Max Inactive High Limit 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
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2 Toggle the Configuration soft key and select the configuration option: 
–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, a

TS1, TS2, TS3, TS4, TS5, or TS6. 
 Toggle the External Offset soft key and select On. b
 Enter a value by using the numeric keys, and then press the dB soft key. c

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 
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After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 239 Sync-DL ID scanner measurement with TD-SCDMA OTA signal analyzer 

 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 240 Sync-DL ID vs. Tau measurement with TD-SCDMA OTA signal analyzer 

 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
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 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

Figure 241 Sync-DL ID multipath measurement with TD-SCDMA OTA signal analyzer 

 
 

After configuring test parameters as described in the “Configuring test parameters” on page 399, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Procedure 

1 Press the LIMIT hot key. 
2 To set the limit for rms of the error vector magnitude, complete the following steps: 

 Press the EVM RMS soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key, and then enter a value for the upper threshold. c
 Press the Enter soft key. d

3 To set the limit for frequency error, complete the following steps: 
 Press the Frequency Error soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key, and then enter a value for the upper threshold. c
 Press the ppm soft key. d
 Press the Low Limit soft key, and then enter a value for the lower threshold. e
 Press the ppm soft key. f

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

Figure 242 Sync-DL ID analyzer measurement with TD-SCDMA OTA signal analyzer 

 
 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map. 
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Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 399. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Toggle the Plot soft key and select Start to start plotting. 
7 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

8 Toggle the Plot soft key and select Stop to stop plotting. 
9 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 33 for more information. 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Excellent soft key to set its threshold. 
3 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
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4 Press the Very Good soft key to set its threshold. 
5 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
6 Press the Good soft key to set its threshold. 
7 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
8 Press the Fair soft key to set its threshold. 
9 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
10 Press the Poor soft key to set its threshold. 
11 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
12 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 243 Route map measurement with TD-SCDMA OTA signal analyzer 

1) Map view 

 

2) Full view 
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If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 

 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 

 
 



 
 

   

 

 

This chapter provides instructions for using the Mobile WiMAX Signal Analyzer function (option 026) with the 
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The Mobile WiMAX Signal Analyzer performs power and spectrum measurements as well as modulation 
analysis to test the proper transmitter performance of Mobile WiMAX systems. It performs conformance 
testing according to the following standards providing a simple Pass/Fail indication on each test. 
 

 IEEE 802.16e-2005 

 WiBro (Korean Mobile WiMAX OFDMA Service) 
 
This instrument provides the following measurement tools for Mobile WiMAX system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask 
- Spurious Emissions 

 Power vs. Time (Frame) 

 Modulation Analysis 
- Constellation 
- Spectral Flatness 
- EVM vs. Subcarrier 
- EVM vs. Symbol 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Preamble Scanner 
- Multipath Profile 
- Preamble Power Trend 
- Route Map 

 

Figure 244 provides descriptions for each segment of the measurement screen. 
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Figure 244 Mobile WiMAX signal analyzer measurement screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 245 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 
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Figure 246 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 247 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Select More (1/2) > Mobile WiMAX. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, or  
Spurious Emissions 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Spectral Flatness, EVM vs Subcarrier, or  
EVM vs. Symbol 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Preamble Scanner, Multipath Profile, Preamble Power Trend, or Route Map 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 



Chapter 13 Using Mobile WiMAX Signal Analyzer 

 JD700B Series User’s Guide 439 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

 

NOTE 
This frequency setting is not used in the Spurious Emissions mode. 

 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 

 

NOTE 
In the measurements such as Midamble Power, Code Power, and Code Error, you 
may need to select the reference option between Relative and Absolute before setting 
the reference level. 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
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As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set 
up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 
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To turn the external offset off: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

To enhance the reliability of modulation analysis measurements the JD700B series must be synchronized 
with a base station. When an external clock is not supplied, the instrument works with its built-in internal 
high-accuracy time base and some measurement results may exhibit inaccurate values. Therefore, it is 
highly recommended that you use the same reference clock as the signal source. You can use the 
TRIGGER hot key to set the external clock. 
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Figure 248 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
Table 19 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 
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conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 
Your measurement result is displayed on the screen as like the following example, Figure 249. 
 

Figure 249 Spectrum measurement screen with Mobile WiMAX signal analyzer 

 
 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 
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To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak to 
average ratio (PAR) of the signal in the Mobile WiMAX channel bandwidth. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 
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conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

4 To set the start/stop symbols, complete the following steps: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

 

Figure 250 Channel power measurement with Mobile WiMAX signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 450 for more 
information. 

 



Chapter 13 Using Mobile WiMAX Signal Analyzer 

446 JD700B Series User’s Guide 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

4 To set the start/stop symbols, complete the following steps: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d
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Figure 251 Occupied bandwidth measurement with Mobile WiMAX signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 450 for more 
information. 

 

The Spectrum Emission Mask (SEM) measurement compares the total power level within the defined carrier 
bandwidth and the given offset channels according to the standards. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
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 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

4 To set the start/stop symbols, complete the following steps: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

 

Figure 252 SEM measurement with Mobile WiMAX signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 450 for more 
information. 

 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting from 
the modulation process and non-linearity in the transmitter but excluding spurious emissions. The Spurious 
Emissions measurement is to identify and determine the power level of out-of-band spurious emission within 
the necessary channel bandwidth and modulated signal measured at the RF port of the Base Station. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 
 Press the Range soft key, and then select the range number between 1 and 20 to add  a

as a new or change the existing settings. 
 Do the following as desired: b

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

 Press the PREV hard key. c
 Toggle the Range soft key and select On to display the selected range in the result table or d

Off to hide it from the table. 
3 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

4 To set the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100, and then press the Enter soft key. b

5 To move the highlighted bar in the result table to other range, complete the following steps: 
 Press the Range soft key in the Measure Setup menu bar. a
 Enter a value between 1 and 20, and then press the Enter soft key. b

 

Figure 253 Spurious emissions measurement with Mobile WiMAX signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 450 for more 
information. 

 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot in a Mobile WiMAX signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
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 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e
1/32. 

 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Toggle the Video Filter soft key and select On or Off to enable or disable the video filter. 
7 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s): 

To set the limit for Select Set 

Preamble power Preamble Power High Limit, Low Limit 

Downlink burst power DL Burst Power High Limit, Low Limit 

Uplink burst power UL Burst Power High Limit, Low Limit 

Frame average power Frame Average Power High Limit, Low Limit 

Time offset Time Offset High Limit, Low Limit 

I/Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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Figure 254 Power vs. time (frame) measurement with Mobile WiMAX signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e
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1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start/Stop Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

NOTE 
The permutation zone that is a number of contiguous OFDMA symbols in downlink that 
use the same permutation. The DL subframe may contain more than one permutation 
zone. The maximum number of DL zone is 8 in one DL subframe. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Figure 255 Constellation measurement with Mobile WiMAX signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 458 for 
more information. The Spectral Flatness is not used in the Constellation mode. 
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The Spectral Flatness is used to measure the flatness energy of the constellation according to the WiMAX 
specification IEEE 802.16e. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

NOTE 
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c
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NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Figure 256 Spectral flatness measurement with Mobile WiMAX signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Spectral Flatness. See “Setting limit for modulation 
tests” on page 458 for more information. 

 

The EVM vs Subcarrier shows the error vector magnitude representing the average constellation error of 
WIMAX OFDMA subcarriers. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
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 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c
sample of the downlink burst and the first sample of the subsequent uplink burst. 

 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start/Stop Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

NOTE 
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Figure 257 EVM vs. subcarrier measurement with Mobile WiMAX signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 458 for 
more information. The Spectral Flatness and Frequency Error are not used in the EVM 
vs. Subcarrier mode. 

 

The EVM vs Symbol is used to show the error vector magnitude representing the average constellation error 
of WiMAX OFDMA symbols. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start/Stop Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

NOTE 
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 
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–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Figure 258 EVM vs. symbol measurement with Mobile WiMAX signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 458 for 
more information. The Spectral Flatness and Frequency Error are not used in the EVM 
vs. Subcarrier mode. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

To set the limit for Select Set 

Spectral flatness Spectral Flatness On/Off 

Frequency error Frequency Error High Limit, Low Limit 

RMS for RCE RCE RMS High Limit 

Peak for RCE RCE Peak High Limit 

RMS for error vector magnitude EVM RMS High Limit 

Peak for error vector magnitude EVM Peak High Limit 
 



Chapter 13 Using Mobile WiMAX Signal Analyzer 

 JD700B Series User’s Guide 459 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on an 
overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrument use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 
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5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Toggle the External Offset soft key and select On or Off. e
 Enter a value by using the numeric keys, and then press the dB soft key. f

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 33 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can view 
the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
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After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can also 
use JDViewer, PC application software to configure a measure setup, save as a file, and load the file on to 
the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Figure 259 CCDF measurement with Mobile WiMAX signal analyzer 

 
 

This Over The Air (OTA) measurement has preamble scanner, multipath profile, and preamble power trend 
screens. Preamble scanner displays six preambles and relative powers to inform neighbor cells existence. 
The multipath profile graph helps the user to determine testing area's RF environmental condition. The 
preamble power trend shows power variations of selected preamble over time along with relative power 
trend for strongest preamble. 
 

The OTA Preamble Scanner displays the six strongest preambles to inform neighbor cells existence of 
testing area. Preamble Index, Relative Power, Cell ID, and Sector ID are listed in for each preamble signal 
with Time Offset in us. Positioning information, latitude, and longitude will be displayed if a GPS antenna is 
supplied and locked to the GPS satellites on the bottom of the screen. 
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After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. Press the Miscellaneous soft key, and then do the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 260 Preamble scanner measurement with Mobile WiMAX OTA signal analyzer 

 
 

The Multipath Profile enables the user to determine RF environmental conditions of testing area. It indicates 
the multipath power with time delay in us up to six. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving antenna 
out of phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16,  e

or 1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
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 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. Press the Miscellaneous soft key, and then do the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 261 Multipath profile measurement with Mobile WiMAX OTA signal analyzer 

 
 

The Preamble Power Trend shows power variations of a strongest preamble signal over time along with the 
relative power trend compare to total preamble power. Searching preamble index can be set auto to detect 
strongest or manual to search specific preamble. Positioning information, latitude, and longitude will be 
displayed if a GPS antenna is supplied and locked to the GPS satellites on the bottom of the screen. 
 

After configuring test parameters as described in the “Configuring test parameters” on page 438, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
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–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 
conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16,  e

or 1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
4 Optional. Press the Miscellaneous soft key, and then do the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 262 Preamble power trend with Mobile WiMAX OTA signal analyzer 

 
 

The JD700B Series provides the Route Map function that allows you to collect data of points in an indoor or 
outdoor environment and track the received signals and coverage of RF transmitters by plotting data real 
time directly on top of a loaded floor plan or a map. 
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Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 438. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If a
the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 
after loading it. 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
35 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Toggle the Plot soft key and select Start to start plotting. 
7 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

8 Toggle the Plot soft key and select Stop to stop plotting. 
9 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 33 for more information. 

 

 

NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Excellent soft key to set its threshold. 
3 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
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4 Press the Very Good soft key to set its threshold. 
5 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
6 Press the Good soft key to set its threshold. 
7 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
8 Press the Fair soft key to set its threshold. 
9 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
10 Press the Poor soft key to set its threshold. 
11 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
12 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Figure 263 Route map measurement with Mobile WiMAX OTA signal analyzer 

 
 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the Map 
Control feature that enables you to zoom into the map and view a specific area of interest in detail. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Map Control soft key. This key is active only when you have loaded a sizable map. 
3 Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 
 Toggle the Zoom to soft key and select Area. a

The black rectangle appears on the map. 
 Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase b

the selected area. 
 Move the rectangle by using the four arrow keys, as you need, to place it in a specific c

area of interest. 
 Press the center of the rotary knob to zoom into the selected area. You can also press d

the Zoom to soft key again to zoom into the selected area. 
–  To zoom into the center or zoom out from the center, complete the following steps: 
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 Toggle the Zoom to soft key and select Center. a
 Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. b
 Move the zoomed-in area by using the four arrow keys, as you need. c

4 To set the location mode, toggle the Location Mode soft key between Auto and Manual and 
select the one you desire. 
–  Auto: The instrument compares the coordinates of the displayed map with recevied GPS 

information. If your current location goes out of the displayed area and enters into the next 
zoomed-in section within the base map, the map display changes automatically to the next 
section in which your current position is. 

–  Manual: The map display of the zoomed-in area remains unchanged even if your current 
location goes out of the displayed area. You can change the displayed area manually by 
using the arrow keys. 
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The Cable and Antenna Analyzer is a diagnostic tool needed to accurately detect operational problems by 
performing cable and antenna measurements to verify the base station’s infrastructure, including feed lines, 
connectors, antennas, cables, jumpers, amplifiers, and filters. The JD785B/JD745B Base Station Analyzer 
and the JD786B/JD746B RF Analyzer have all of the measurement functions necessary to verify cable and 
antenna systems from Voltage Standing Wave Ratio (VSWR) to power measurements. In addition, the 
JD785B/JD745B and the JD786B/JD746B make distance-to-fault measurements to pinpoint a faulty location 
accurately. 
 
To get maximum power into a load it is required that the load impedance match the generator impedance. 
Any difference in impedance or mismatching would not produce maximum power transfer. An impedance 
mismatch at the antenna system produces a reflective ‘traveling wave’, which goes in the opposite direction 
from the incident wave. As the two traveling waves cross each other in opposite direction, it is produce an 
interference pattern called a "standing wave". VSWR is the ratio between the power sent forward to the 
cable and/or antenna and the amount of power that is reflected back to the transmitter. 
 
Some of the consequences of having a high VSWR condition in cellular services include dropped calls, poor 
reception, and an overall unacceptable performance in the cell (or section of cell) covered by the base 
station antenna. Therefore, the VSWR of the antenna system including the feed line is one of the most 
critical factors in the service and maintenance of the RF transmitter systems. 
 
This Cable and Antenna Analyzer function performs following measurements: 
 

 Reflection: VSWR and Return Loss 

 Distance to Fault (DTF): VSWR and Return Loss 

 Reflection-DTF (dual measurement) 

 2 Port Measurements: Vector and Scalar (Optional) 

 Cable Loss (1 Port) 

 1 Port Phase 

 Smith Chart 
 

Figure 264 provides descriptions for each segment of the measurement screen. 
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Figure 264 Reflection measurement screen 

 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Cable & Antenna Analyzer soft key. The Reflection (VSWR) mode is selected by 

default. 
3 To change the mode, press the MEASURE hot key and then select the measurement mode: 

–  Reflection (Return Loss) 

–  DTF (VSWR) 

–  DTF (Return Loss) 

–  Reflection-DTF 

–  Cable Loss (1 Port) 

–  1 Port Phase, Smith Chart 

–  2 Port Measurement (Vector/Scalar) 

 

You can set frequencies manually using the Start Frequency/Stop Frequency or Center Frequency/Span. 
You can also select from the band list stored in the instrument. It is recommended to set the frequency to a 
value that covers the normal range of the measurement with enough margins. 
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Procedure 

To set the start and stop frequencies: 
1 Press the FREQ/DIST hard key. 
2 Press the Start Frequency soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
4 Select the unit: GHz, MHz, kHz, or Hz. 
5 Press the Stop Frequency soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
7 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the center frequency and span: 

1 Press the FREQ/DIST hard key. 
2 Press the Center Frequency soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
4 Select the unit: GHz, MHz, kHz, or Hz. 
5 Press the Span soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
7 Select the unit: GHz, MHz, kHz, or Hz. 

 
To select the band from the band list: 

1 Press the FREQ/DIST hard key. 
2 Press the Band List soft key, and then select Standard Band or Custom Band. 

The band list window appears. 
3 Select a frequency band from the list, and then press the Select soft key. 

The start and stop frequency information on the screen changes according to your choice. 

 

In the DTF measurement mode, you need to set the start and stop distances. The maximum measurable 
distance is displayed on the left side of the screen depending on the frequency setting. You can set any 
distance within the maximum measurable distance. Optimum resolution is achieved when the user setting 
distance is the same as the maximum measurable distance 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 Press the Start Distance soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
4 Select the Enter soft key. 
5 Press the Stop Frequency soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
7 Select the Enter soft key. 

 

You can adjust the Y-axis scale to optimize the display of measurement trace(s). Adjusting scale does not 
affect the calibration state. 
 



Chapter 14 Using Cable and Antenna Analyzer 

 JD700B Series User’s Guide 473 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Do one of the following choices: 

–  Press the Auto Scale to optimize the display of the measured trace by letting the 
instrument set the minimum and maximum values for the Y-axis automatically. 
Each time this key is pressed, the top and bottom scales are set to the minimum and 
maximum values with margin on the Y-axis of the chart. 

–  Press the Full Scale to restore the insturment’s default amplitude range for the Y-scale 
automatically. 

–  To set the minimum and maximum values for the Y-axis manually, complete the following 
steps: 

 Press the Maximum (Top) soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c
 Press the Minimum (Top) soft key. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

 

 

NOTE 
This setting is not used in the Smith Chart measurement mode. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

To get reliable and accurate measurement results, you must perform a calibration on your instrument after 
setting frequencies and prior to making a measurement. To perform the calibration, you need to have the 
following ready: 
 

 Calibration accessories (optional) 

 Mechanical Y-Cal kit or electronic EZ-Cal kit 

 Phase-stabilized test cable 
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Measurement modes that need the 1-port calibration are Reflection, DTF, Cable Loss, 1 Port Phase, and 
Smith Chart. 
 
It is recommended that you perform an O-S-L calibration right at the Reflection/RF Out port of the instrument 
without using an extension cable in order to minimize a measurement error. If using an extension cable is 
inevitable, you need to use a phase stable cable and perform the O-S-L calibration at the open end of the 
extension cable. 
 

 

NOTE 
If the O-S-L calibration is done at the end of the port extension cable for DTF 
measurement, the length of the port extension cable is compensated automatically and is 
not included in the distance to the point of discontinuity. 
 
Bending or moving the extension cable while making a measurement may cause errors in 
the measurement. 

 

Figure 265 illustrates the connection when a port extension cable is used for calibration. 
 

Figure 265 1-port calibration connection with mechanical Y-Cal kit 

 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 
3 Connect the OPEN connector of the CAL Kit directly to the Reflection/RF Out port or at the end 

of the connected extension cable. 
4 Press the Continue soft key to start calibration.  

The calibration progress bar appears. 
5 Connect the SHORT connector of the CAL Kit directly to the Reflection/RF Out port or at the 

end of the connected extension cable. 
6 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
7 Connect the LOAD connector of the CAL Kit directly to the Reflection/RF Out port or at the end 

of the connected extension cable. 
8 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 
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The e-Calibration is an Open-Short-Load calibration using the electronic EZ-Cal kit, which lets you perform 
the O-S-L calibration easy and fast with only one connection of the kit to the instrument. 
 
The O-S-L calibration must be performed after setting the frequencies and connecting an extension cable as 
like any mechanical calibration. Figure 266 illustrates the connection when a port extension cable is used 
for calibration. 
 

Figure 266 1-port calibration connection with electronic EZ-Cal kit 

 
 

Procedure 

1 Connect an extension cable, if necessary, to the Reflection/RF Out port of the instrument. 
2 Connect your EZ-Cal to the other open end of the extension cable or to your instrument's 

Reflection/RF Out port directly. 
3 Connect the USB cable to the side of the EZ-Cal and then to the USB Host port to power the 

e-calibration kit. 
The instrument detects the EZ-Cal automatically and displays the EZ-Cal icon. 

4 Press the MEASURE SETUP hot key. 
5 Press the Calibrate soft key. 

The on-screen instruction appears. to guide you through the e-calibration. 
6 Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON (E). 

 

The Quick calibration that is available only in the DTF measurement mode is useful when you want to 
measure the cable length only, without having to perform a full O-S-L calibration with a mechanical  
Y-Cal kit. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 
3 Connect the OPEN connector of your mechanical Y-Cal kit directly to the Reflection/RF Out port 

or at the end of the connected extension cable. 
4 Press the Quick Cal. soft key to start the quick calibration. 

The calibration status on the screen appears. 
After completion, the calibration status on the screen changes to ON (Q). 
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Measurement modes that need the 2-port calibration are 2 Port Vector and Scalar measurements and 2 Port 
Phase. You must perform 2-port calibration before making a measurement. 
 

Figure 267 illustrates the connection using the Y-Cal kit for calibration in Vector measurements. 

Figure 267 2-port calibration connection with Y-Cal in vector measurements 

1) 

 

2) 

 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 
3 Connect the OPEN connector of the CAL Kit directly to the Reflection/RF Out port or at the end 

of the connected test cable as illustrated in Figure 267-1. 
4 Press the Continue soft key to start calibration.  

The calibration progress bar appears. 
5 Connect the SHORT connector of the CAL Kit directly to the Reflection/RF Out port or at the 

end of the connected test cable. 
6 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
7 Connect the LOAD connector of the CAL Kit directly to the Reflection/RF Out port or at the end 

of the connected test cable. 
8 Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 
9 Connect the Reflection/RF Out port and the RF In port for the Cable and Antenna Analyzer with 

the test cable and the proper adapter as illustrated in Figure 267-2. 
10 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 

 

Figure 268 illustrates the connection using the EZ-Cal kit for calibration in Vector measurements. 



Chapter 14 Using Cable and Antenna Analyzer 

 JD700B Series User’s Guide 477 

Figure 268 2-port calibration connection with EZ-Cal in vector measurements 

1) 

 

2) 

 

 

Procedure 

1 Connect an extension cable, if necessary, to the Reflection/RF Out port of the instrument. 
2 Connect your EZ-Cal to the other open end of the extension cable or to your instrument's 

Reflection/RF Out port directly. 
3 Connect the USB cable to the side of the EZ-Cal and then to the USB Host port to power the 

e-calibration kit as illustrated in Figure 268-1. 
The instrument detects the EZ-Cal automatically and displays the EZ-Cal icon. 

4 Press the MEASURE SETUP hot key. 
5 Press the Calibrate soft key. 

The on-screen instruction appears to guide you through the e-calibration. 
6 Connect the Reflection/RF Out port and the RF In port for the Cable and Antenna Analyzer with 

the test cable and the proper adapter as illustrated in Figure 268-2. 
7 Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 

 

Figure 269 illustrates the connection for calibration in Scalar measurements. 

Figure 269 2-port calibration connection in Scalar measurements 

 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 
3 Connect the Cable and Antenna Analyzer Reflection/RF Out port and the Spectrum Analyzer 

RF In port with a test cable as illustrated in Figure 269. 
4 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 
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The instrument displays calibration status that is an important indicator to get reliable and accurate 
measurement results from CAA testing. The calibration status includes ON, ON (E), ON (I), ON (Q),  
OFF (T), and OFF. 
 

Table 20 Calibration status indicators 

Indicator(s) Description 

ON Indicates that a mechanical O-S-L calibration is performed using a Y-Cal kit and the 
instrument is ready to make a measurement. 

ON (E) Indicates that an electronic O-S-L calibration or e-calibration is performed using Viavi’s 
EZ-Cal kit and the instrument is ready to make a measurement. 

ON (I) 
 

Indicates that the frequency setting is changed within the frequency range registered 
for the O-S-L calibration and so the calibration is still valid. When the calibration status 
changes from ON to ON (I), re-calibration is not necessarily required. 

ON (Q) Indicates that quick calibration (Quick Cal) is performed. It is useful only if cable length 
measurement is needed. 

OFF (T) Indicates that the temperature registered during the calibration is changed by ±10C or 
greater. It is recommended that you perform a new O-S-L calibration to obtain accurate 
measurement results. When the temperature comes back within the registered range, 
the status may be changed to ON. 

OFF Indicates that the frequency setting is changed off the frequency range registered for 
the calibration. The calibration is no longer valid. 

 

 
Figure 270 Connection for reflection measurement 
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Procedure 

1 Connect the one end of the port extension cable to the Cable and Antenna Analyzer 
Reflection/RF Out port of the instrument. 

2 Connect the other end of the port extension cable to an antenna or feed line as illustrated in 
Figure 270. Measurement result is displayed on the screen. 

 

 

NOTE 
After calibration, do not change the connection of the port extension cable or the 
frequency setting. It may cause a measurement error. 
 
Changing any frequency settings will automatically turn the calibration status to OFF on 
the display screen, which requires re-calibration to proceed next measurement. 

 

 

CAUTION 
The maximum input power for the Cable and Antenna Analyzer Reflection/RF Out port 
is +25 dBm. Do not connect this port directly to the output port of the system to prevent 
degraded performance or malfunctioning. 

 

 

WARNING 
Do not attempt to connect the instrument to the antenna when there is a risk of lightning. 
Electric shock may cause malfunction of or damage to the instrument. 

 

Procedure 

1 Connect the one end of the cable under test to the Cable and Antenna Analyzer Reflection/RF 
Out port of the instrument. 

2 Connect the SHORT standard of the Cal Kit to the other end of the cable under test as illustrated 
in Figure 271. Measurement result is displayed on the screen. 

 
Figure 271 Connection for cable loss (1 port) measurement 

 
 

Procedure 

1 Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out 
port of the instrument and the other end of the cable to DUT. 

2 Connect the DUT to the Cable and Antenna Analyzer RF In port of the instrument as illustrated 
in Figure 272. Measurement result is displayed on the screen. 
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Figure 272 Connection for 2-port vector measurement 

 
 

 

CAUTION 
The maximum input power for the Cable and Antenna Analyzer RF In port is +25 dBm. 
However, a proper level of input to the Cable and Antenna Analyzer RF In port is  
0 dBm. When the input power is expected to be greater than 0 dBm, you must adjust the 
output power for the RF Out. 

 

Procedure 

1 Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out 
port of the instrument and the other end of the cable to DUT. 

2 Connect the DUT to the Spectrum Analyzer RF In port of the instrument as illustrated in 
Figure 273. Measurement result is displayed on the screen. 

 
Figure 273 Connection for 2-port scalar measurement 

 
 

 

CAUTION 
The maximum input power for the Spectrum Analyzer RF In port is +25 dBm for JD780B 
series and +20 dBm for JD740B series. 
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The Reflection measurement can be used to characterize cable and antenna system to ensure transmission 
line impedance performance and signal reflection characteristics of cell-site across a specific frequency 
range in voltage standing-wave ration (VSWR) or return loss. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 478. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step, and then press the V soft key. b

 

NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

5 Optional. To select the output power, toggle the Output Power soft key between 0 dBm and  
-30 dBm. 

 

NOTE 
When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

 

6 Optional. To turn the interference rejection on, toggle the Interference Rej soft key between 
On and Off to enable or disable the feature. 

 

NOTE 
It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 
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Figure 274 Reflection measurement in return loss scale 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
494 for more information. 

 

 

NOTE 
You can go to MEASURE SETUP > Zoom to view your measurements in detail with the 
user-definable zoom zones. See “Setting zoom zones” on page 493 for more information. 

 

The Distance-To-Fault (DTF) measurement can be used to accurately identify fault locations in the cell-site 
transmission (cable and feed line) system, indicating signal discontinuities in VSWR or return loss over 
distance in meter or foot. This measurement precisely pinpoints the location of such things as damaged or 
degraded antennas, connectors, amplifiers, filters, and duplexers. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 478. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 
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4 Press the DTF Settings soft key, and then do the following: 
–  To select a cable from the list, complete the following steps: 

 Press the Cable List soft key, and then select Standard Cable or Custom Cable. a
The cable list window appears. 

 Select a cable by using the rotary knob or the Page Up/Page Down soft keys. b
 Press the Select soft key. c
 Optional. In the standard cable list window, press the Add to Custom soft key to add d

the selected cable to the custom list. 
–  To define a new cable, complete the following steps: 

 Press the Prop Velocity soft key to define the cable’s relative propagation delay. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c
 Press the Cable Loss soft key to define the cable’s cable loss. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Press the Enter soft key. f

 

 

NOTE 
The propagation velocity affects the calculation of the distance and the cable loss does 
the peak level of the discontinuity in a DTF measurement. 

 

–  Toggle the Metrics soft key and select the unit option for the X-axis: Meter or Foot. 

–  Press the Windowing soft key, and then select the video filtering option: Rectangular, 
Blackman, Nominal Side Lobe, Low Side Lobe, or Minimum Side Lobe. 

5 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step, and then press the V soft key. b

 

 

NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

6 Optional. To select the output power, toggle the Output Power soft key between 0 dBm and 
-30 dBm. 

 

 

NOTE 
When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

 

7 Optional. To turn the interference rejection on, toggle the Interference Rej soft key between 
On and Off to enable or disable the feature. 

 

 

NOTE 
It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 
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Figure 275 DTF measurement 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
494 for more information. 

 
Figure 276 DTF measurement with the alternate sweep on 

 
 

 

NOTE 
You can go to MEASURE SETUP > Alternate Sweep Settings to scale down a specific 
sub-band. See “Setting alternate sweep” on page 494 for more information. 

 

You can view two measurement results simultaneously on the screen as you configure each measurement 
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setting. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 478. 

2 Press the MEASURE SETUP hot key. 
3 Toggle the Active Window soft key between Top and Bottom and select the window to be 

active for setting. 
4 Press the Dual Config soft key, and then select the dual configuration option: 

–  To select the measurement mode for the top window, press the Top soft key, and then 
select Reflection (VSWR) or Reflection (Return Loss). 

–  To select the measurement mode for the bottom window, press the Bottom soft key, and 
then select DTF (VSWR) or DTF (Return Loss). 

–  To configure DTF settings for the bottom window, select Bottom > DTF Settings. 
See “Performing DTF measurements” on page 482 for more information. 

–  To set the alternate sweep settings for the bottom window, select Bottom > Alternate 
Sweep Settings. See “Setting alternate sweep” on page 494 for more information. 

 

 

NOTE 
See “Performing reflection measurements” and “Performing DTF measurements” for 
more information on how to set other measurement setup parameters for the Reflection-
DTF measurement. 

 

Figure 277 Reflection-DTF dual measurement 

1) Alternate sweep off: 
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2) Alternate sweep on: 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
494 for more information. 

 

The Cable Loss (1 Port) measurement quantifies signal loss through a cable or other device over a defined 
frequency range by range by connecting one end of the cable to the instrument measurement port and 
terminating the other end of the cable with a short, or leaving it open altogether. This measurement can be 
particularly useful in measuring the loss of feed line connected to the antenna. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for cable loss (1 port) 
measurements” on page 479. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step, and then press the V soft key. b

 

 

NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 



Chapter 14 Using Cable and Antenna Analyzer 

 JD700B Series User’s Guide 487 

 

 

NOTE 
See “Performing reflection measurements” for more information on how to set other 
measurement setup parameters for the Cable Loss (1 Port) measurement. 

 

Figure 278 Cable loss (1 port) measurement 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
494 for more information. 

 
Figure 279 Cable loss (1 port) measurement with the zone enabled 

 
 

 

NOTE 
You can go to MEASURE SETUP > Zoom to view your measurements in detail with the 
user-definable zoom zones. See “Setting zoom zones” on page 493 for more information. 

 



Chapter 14 Using Cable and Antenna Analyzer 

488 JD700B Series User’s Guide 

The 1-port Phase measurement is used to measure S11 phase to tune antennas and to phase-match cables. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 478. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step, and then press the V soft key. b

 

 

NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 

 

NOTE 
See “Performing reflection measurements” on page 481 for more information on how to 
set other measurement setup parameters for the Cable Loss (1 Port) measurement. 

 

Figure 280 Cable loss (1 port) measurement 
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Figure 281 Cable loss (1 port) measurement with zoom 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
494 for more information. 

 

 

NOTE 
You can go to MEASURE SETUP > Zoom to view your measurements in detail with the 
user-definable zoom zones. See “Setting zoom zones” on page 493 for more information. 

 

The Smith Chart measurement is used to measure DUTs’ impedance and phase to properly tune RF devices. 
Smith chart also displays impedance-matching characteristics in cable and antenna systems or filter and 
duplexer devices. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 478. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step, and then press the V soft key. b
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NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 

 

NOTE 
See “Performing reflection measurements” on page 481 for more information on how to 
set other measurement setup parameters for the Smith Chart measurement. 

 

Figure 282 Smith chart measurement 

 

 

The Vector measurement is used to perform faster and more accurate measurement with around 80 dB 
dynamic range. It also provides antenna isolation measurement. You can determine DUT’s S21 phase 
characteristic by selecting the measurement display type as Phase. 
 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for 2-port vector 
measurements” on page 479. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Toggle the Display soft key and select Magnitude to view measurements in dB or Phase in 



Chapter 14 Using Cable and Antenna Analyzer 

 JD700B Series User’s Guide 491 

degree. 
5 Optional. To turn the bias tee on, complete the following steps: 

 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step, and then press the V soft key. b

 

 

NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

6 Optional. To set the level of the output power to be inserted, complete the following steps: 
 Press the Output Power soft key. a
 Enter the following value by rotating the knob or using the numeric keys: b

–  0 dBm: To test a passive RF device’s loss such as a cable or a filter. 

–  -30 dBm: To test an active RF device’s gain such as an amplifier with JD740B series. 

–  -50 – -30 dBm: To test an active RF device’s gain such as an amplifier with JD780B 
series. You need to enter a value with an increment of 5 dBm. 

 

 

NOTE 
Changing the output power to a value between -50 dBm and -30 dBm may result in 
reduced measurement dynamic range and re-calibration is required. 

. 

7 Optional. To set the number of measurements to be averaged, press the Average soft key and 
then adjust the number between one and five by using the rotary knob. 

8 Optional. To turn the interference rejection on, toggle the Interference Rej soft key between  
On and Off to enable or disable the feature. 

 

 

NOTE 
It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 

 

 

Figure 283 2-port vector measurement 

 
 

The Scalar measurement enables full characterization of DUT with dynamics over 100 dB. 
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Procedure 

1 Make a proper cable connection as described in “Connecting a cable for 2-port scalar 
measurements” on page 480. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 

NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To set the level of the output power to be inserted, complete the following steps: 
 Press the Output Power soft key. a
 Enter the following value by rotating the knob or using the numeric keys: b

–  0 dBm: To test a passive RF device’s loss such as a cable or a filter. 

–  -30 dBm: To test an active RF device’s gain such as an amplifier with JD740B series. 

–  -50 – -30 dBm: To test an active RF device’s gain such as an amplifier with JD780B 
series. You need to enter a value with an increment of 5 dBm. 

 

 

NOTE 
Changing the output power to a value between -50 dBm and -30 dBm may result in 
reduced measurement dynamic range and re-calibration is required. 

 

 

Figure 284 2-port scalar measurement 
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You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Capture the selected trace and compare traces Capture C 

Load a saved trace Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

Trace Clear All  

 

4 Optional. If you have at least two traces (T1 and T2), you can perform trace math: 
 Press the Trace Math soft key. a
 Press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. b

 

 

NOTE 
The trace to be loaded must be in the same measurement mode and has the same 
frequency setting as the current measurement. 

 

You can define up to three zoom-in zones so that you can view uplink and downlink frequencies in detail on 
a single measurement window for compliance verification. 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Zoom soft key. 
3 To view a zoom zone in a separate chart, complete the following steps: 

 Press the Zoom soft key, and then select the zone number to zoom in: Zone 1, Zone 2,  a
or Zone 3. 

 Toggle the Zoom soft key and select On. b
The zoom-in chart for the selected zone appears under the measurement result. 

4 To define a zone range, complete the following steps: 
 Press the Zone [1|2|3] soft key. a
 Toggle the Zone [1|2|3] soft key between On and Off to view or dismiss the zone. b
 Press the Start Frequency soft key. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key. f
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 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

5 To clear all the zones, press the Clear All soft key. 

 

 

You can use the Alternate Sweep in DTF measurements to scale down a specific sub-band without a need 
of an additional calibration. 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Alternate Sweep Settings soft key. 
3 Toggle the Alternate Sweep soft key and select On or Off to enable or disable the alternate 

sweep feature. 
4 To set the start and stop distances for the alternate sweep, complete the following steps: 

 Press the Start Distance soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow b

keys. 
 Select the Enter soft key. c
 Press the Stop Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys. 
 Select the Enter soft key. f

5 To set the start and stop frequencies for the alternate sweep, complete the following steps: 
 Press the Alternate Start Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow b

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. c
 Press the Alternate Stop Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. f

6 To set the center and span frequencies for the alternate sweep, complete the following steps: 
 Press the Alternate Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow b

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. c
 Press the Alternate Span Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. f

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 

 Press the # of Line soft key. a
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 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 
6 Optional. To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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Cell sites today have a distributed architecture of the radio that consists of the radio equipment control (REC) 
or base band unit (BBU) installed at the bottom of the tower and the radio equipment (RE) or remote radio 
head (RRH) installed at the top of the tower. These two elements communicate with each other via the 
Common Public Radio Interference (CPRI) protocol over fiber links. 
 
This distributed architecture provides the benefit of replacing coax-based feeders with fiber- based feeders, 
significantly reducing the problems of signal loss and reflections. However, since all the RF interfaces reside 
on the RRH, any RF maintenance or troubleshooting requires climbing to the top of the tower to access the 
RRH, increasing operational cost and unnecessary safety issues. 
 
JD700B series analyzers provide the option of RFoCPRI that allows you to perform RF maintenance and 
troubleshooting activities on the ground via the fiber interfaces at the BBU, significantly reducing 
maintenance time and operational expenses. Thanks to the RFoCPRI technology, you can verify the CPRI 
control signals and extracts the IQ data transmitted between the BBU and RRH to monitor and analyze the 
uplink interferences and the downlink signals. 
 
The RFoCPRI testing provides following measurements and analysis: 
 

 Layer 2 monitoring of link maintenance alarms and optical power 
o Loss of Signal (LOS) – Code violation or low optical power 
o Loss of Frame (LOF) – Frame synchronization or alignment 
o Remote Alarm Indication (RAI) – Any error including LOS and LOF 
o SAP Defect Indication (SDI) – Link not to be used for service access points 
o Optical Rx and Tx power levels 

 Layer 2 terminate testing 
 Interference analysis 

o Spectrum (Single and Dual) 
o Spectrogram (Single and Dual) 
o Received Signal Strength Indicator (RSSI) 
o Spectrum replayer 

 PIM detection of single or multiple carrier(s) 
 LTE-FDD downlink signal analysis over CPRI 

o Spectrum 
o RF analysis – Channel Power and Occupied Bandwidth 
o Power vs. Time (Frame) 
o Modulation analysis – Constellation, Data Channel, Control Channel, Subframe, Frame, 

Time Alignment Error, and Data Allocation Map 
o Power Statistics CCDF 

 LTE-TDD downlink signal analysis over CPRI 
o Spectrum 
o RF analysis – Channel Power and Occupied Bandwidth 
o Power vs. Time (Frame) 
o Modulation analysis – Constellation, Data Channel, Control Channel, Subframe, 

Time Alignment Error, and Data Allocation Map 
o Power Statistics CCDF 
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 Alcatel-Lucent BBU emulation 

o Profiling 

o Configuration verification – Carrier Information, CPRI & Active SW, and SFP Information 

o Spectrum clearance – Spectrum, Spectrogram, RSSI, Dual Spectrum, and Dual Spectrum 

o Coverage range 

o PIM analysis 
 
Full function of RFoCPRI testing requires the following options installed on your CellAdvisor. For more 
information on available options for your instrument, see “Appendix I – Ordering information” on page 700. 
 

 Optical Hardware (option 008) 

 RFoCPRI Interference Analyzer (options 060 – 065) 

 RFoCPRI LTE-FDD Signal Generator (option 081) 

 RFoCPRI LTE-TDD Signal Generator (option 082) 

 RFoCPRI LTE-FDD Signal Analyzer (option 091) 

 RFoCPRI LTE-TDD Signal Analyzer (option 092) 

 RFoCPRI Alcatel-Lucent BBU Emulation (option 101) 
 

Figure 285 provides descriptions for each segment of the measurement screen. 
 

Figure 285 RFoCPRI analysis screen 
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Procedure 

1 Press the MODE hard key. 
2 Select RFoFiber > RFoCPRI. The Layer 2 Monitoring mode is set by default. 
3 Press the MEASURE hot key, and then select the measurement mode as desired: 

–  Layer 2 Monitoring 

–  Layer 2 Term 

–  Interference Analyzer > Spectrum, Spectrogram, RSSI, Spectrum Replayer, 
Dual Spectrum, or Dual Spectrogram 

–  PIM Detection > PIM Detection Single Carrier, PIM Detection Multiple Carriers, or 
Calculated PIM 

–  Signal Analyzer > LTE-FDD > Spectrum, RF Analysis, P vs T (Frame),  
Modulation Analysis, or Power Statistics CCDF 

–  Signal Analyzer > LTE-TDD > Spectrum, RF Analysis, P vs T (Frame),  
Modulation Analysis, or Power Statistics CCDF 

–  BBU Emulation > Alcatel-Lucent > Profiling, Configuration Verification,  
Spectrum Clearance, Coverage Range, and PIM Analysis 

 

The in-service Layer 2 Monitoring is used to monitor link maintenance alarms of the physical layer (Layer 1) 
that is delivered on the L1 in-band protocol, which resides on the layer 2 of CPRI. It also verifies proper 
optical power level of the received signal. 
 

The monitoring mode lets you perform in-service testing by using coupler(s) or nTap(s). You can connect 
cables with a tap or without a tap as illustrated in Figure 286. If you have connected cables directly from 
RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the CPRI parameter 
settings.  
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 286 Connection diagram for Layer-2 monitoring mode 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
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Procedure 

1 Press the MEASURE hot key. 
2 Select Layer 2 Monitoring. 

 

Procedure 

1 Press the MEASURE SETUP hot key  
2 To set the CPRI line bit rate of the fronthaul under test, complete the following steps: 

 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

 

 

A RRH has a finite dynamic range for input optic power and it can cause an abnormal behavior of the RRH if 
the optical power is weaker than certain level. To differentiate intermittent low optic power issues from any 
RSSI, interference and signal quality issues, it is important for you to monitor the input optic power level 
during the monitoring of the spectrum and the signal quality. Using this Rx optic limit feature, you can set 
lower and upper limits and monitor the Rx optic level with Pass/Fail indication in green and red colors. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Rx Optic Level soft key. 
3 Set a threshold for High Limit and Low Limit. 
4 To enable the Rx optic limit, toggle the Test Limits soft key and select On. 

If the optic power level falls out of the specified thresholds, the color of the power reading or 
indicator turns red. 

5 To disable the Rx optic limit, toggle the Test Limits soft key and select Off. 

 

After you have configured test parameters, you can monitor the alarms of the Layer 1 as you desire. 
 

Procedure 

1 Monitor the following alarm indicators and the optical signal level. Green dots indicate no 
occurrence of an alarm while red ones mean occurrence(s). 
–  LOS: Loss of Signal (code violation or low optical power) 

–  LOF: Loss of Frame (frame synchronization or alignment) 

–  RAI: Remote Alarm Indication (any errors including LOS and LOF) 
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–  SDI: SAP Defect Indication (link not to be used for serivce access points) 

–  Optic Rx Level: If the optical signal level is lower than the threshold, the CPRI link may not 
work properly and the RRH may not be in service mode. 

2 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 
format. See “Using save” on page 33 for more information. 

3 To clear the previous event history and start a new monitoring, press the MEASURE SETUP hot 
key and then the Clear History soft key. 

 

Figure 287 CPRI layer 2 monitoring 

 
 

The out-of-service Layer 2 Term is to test CPRI fronthaul in the terminated state and it is used to monitor link 
maintenance alarms of the physical layer (Layer 1) that is delivered on the L1 in-band protocol, which 
resides on the layer 2 of CPRI. It also monitors the received optical power level. 
 
In addition, CellAdvisor JD700B series can emulate the Base Band Unit (BBU) without C&M messages. 
Once the RRH enters the operation state, JD700B series can generate an alarm or error and send it to the 
RRH so that you can verify the optical cabling and proper RRH operation at the ground. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select Layer 2 Term. 

 

The terminate mode allows you to do out-of-service testing. You can connect cables with a tap or without a 
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tap as illustrated in Figure 288. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 288 Connection diagram for Layer-2 term testing mode 

With nTap: 
 

 

Without nTap: 

 

 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the CPRI line bit rate of the fronthaul under test, complete the following steps: 

 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

 

 

A RRH has a finite dynamic range for input optic power and it can cause an abnormal behavior of the RRH if 
the optical power is weaker than certain level. To differentiate intermittent low optic power issues from any 
RSSI, interference and signal quality issues, it is important for you to monitor the input optic power level 
during the monitoring of the spectrum and the signal quality. Using this Rx optic limit feature, you can set 
lower and upper limits and monitor the Rx optic level with Pass/Fail indication in green and red colors. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Rx Optic Level soft key. 
3 Set a threshold for High Limit and Low Limit. 
4 To enable the Rx optic limit, toggle the Test Limits soft key and select On. 

If the optic power level falls out of the specified thresholds, the color of the power reading or 
indicator turns red. 

5 To disable the Rx optic limit, toggle the Test Limits soft key and select Off. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Laser soft key and select On to activate the transmission. 
3 To configure BBU emulation parameters, select More (1/2) > BBU Emulation and then do one of 

the following: 
–  To negotiate with RRH to support the start-up process, toggle the Start-up Sequence soft 

key and select Normal. 

–  To force the RRH to configure the predefined parameters, complete the following steps: 
 Toggle the Start-up Sequence soft key and select Bypass. a

Setting it to Bypass activates additional soft keys. 
 Press the Protocol Version soft key. b
 Enter a value between one and 10 by using the rotary knob. You can also use the c

numeric keys and then press the Enter soft key. 
 Press the HDLC Rate soft key. d
 Select the High level Data Link Control (HDLC) rate option from the choices:  e

No HDLC, 240, 480, 960, 1920, and 2400. 
 Toggle the Eth Channel soft key between Enable and Disable. f

Enabling the Ethernet Channel activates the Eth Subchannel Number menu. 
 Press the Eth Subchannel Number soft key. g
 Enter a value between 20 and 63 by using the rotary knob. You can also use the h

numeric keys and then press the Enter soft key. You can also use the rotary knob. 

 

NOTE 
This BBU emulation capability in the Layer-2 Term Testing does not include capturing 
C&M (Control and Management) messages. 

4 Press the PREV hard key twice to return the Measure Setup menu bar. 
5 To insert an alarm signal, complete the following steps: 

 Press the Alarm/Error soft key. a
 Press the Alarm Type soft key. b
 Select the alarm type option from the choices: R-LOS, R-LOF, RAI, and SDI. c
 Toggle the Alarm Insertion soft key and select On to start to insert the selected alarm. d
 To stop inserting the alarm, toggle the Alarm Insertion soft key and select Off. e

6 To insert a code error signal, complete the following steps: 
 Toggle the Error Type soft key between Code and K30.7 and select Code. a
 Toggle the Insert Type soft key between Single and Rate, and then select the insert type b

option you want. 
–  Single: It inserts an error once and then turns off the error insertion. 

–  Rate: It inserts an error according to the set error rate in the Error Rate menu. 

 If you have selected Rate in step b, press the Error Rate and then select the error rate c
option from the choices: 1E-3, 1E-4, 1E-5, 1E-6, 1E-7, 1E-8, and 1E-9. 

 Toggle the Error Insertion soft key and select On to start to insert the error. d
 To stop inserting the error, toggle the Error Insertion soft key and select Off. e

7 To insert a K30.7 error signal, complete the following steps: 
 Toggle the Error Type soft key between Code and K30.7 and select K30.7. a
 Toggle the Error Insertion soft key and select On to insert the error. b

The K30.7 error signal is one time insertion. This setting changes back to Off after insertion. 
8 Check the real time results on the screen. 
9 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 

format. See “Using save” on page 33 for more information. 
10 To clear the previous event history and start a new testing, press the MEASURE SETUP hot key 

and then the Clear History soft key. 
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Figure 289 CPRI layer 2 term test 

 
 

After checking that the link connection is good with no errors and alarms, you can proceed to the 
interference analysis activities including spectrum, spectrogram, RSSI, spectrum replayer, dual spectrum, 
and dual spectrogram. You can also monitor current and history CPRI alarm status for LOS and LOF 
displayed on the interference measurement screen. 
 

You can connect cables with a tap or without a tap as illustrated in Figure 290. If you have connected cables 
directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the CPRI 
parameter settings. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 290 Connection diagram for interference analysis 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
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Procedure 

1 Press the MEASURE hot key. 
2 Press the Interference Analyzer soft key. 
3 Select the interference measurement mode from the following choices:  

–  Spectrum 

–  Spectrogram 

–  RSSI 

–  Spectrum Replayer 

–  Dual Spectrum 

–  Dual Spectrogram 

 

Configuration of test parameters described in this section is used in the Interference Analyzer mode 
including spectrum measurements, spectrogram, RSSI, dual spectrum, and dual spectrogram. 
 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the frequency with center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of increment for rotary operation, complete the following steps: 

 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the frequency with channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the scanning direction and select Fwd (forward) or Rev 

(reverse). 
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5 Press the Channel Number soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob. 
7 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

8 Optional. To define the amount of increment for rotary operation, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the reference level automatically or manually to optimize the display of the traces measured, as 
you desire. 
 

Procedure 

To automatically set the reference level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, the Y-axis scale changes to be optimized with some margin. 
 
To set the reference level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

You can use the Scale/Div feature to change the scale per division, representing the value of one division 
on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set up to 
20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset, and the measurement result shows the value reflecting both offset values. When the 



Chapter 15 Performing RFoCPRI Testing 

 JD700B Series User’s Guide 507 

external offset value is set at 40 dB, the measurement result compensates 40 dB. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

It is normal that you see higher level of RSSI in CPRI spectrum than you have seen in RF spectrum because 
the digital signal has a different gain level from RF’s. If you use the Auto Leveling feature and enter the 
Noise Figure (NF) for the system to be tested, the instrument calculates an offset that compensates the 
digital gain of RRH and applies it to the spectrum automatically to displace the level of spectrum to a known 
RSSI power even though its accuracy cannot be guaranteed. Offset calculation for Auto Leveling is based 
on the following: 
 
Auto Level offset = (Noise Floor of RFoCPRI) – (Ideal Noise Floor of RRH), where (Idea Noise Floor) =  
N.F (RRH) + Thermal Noise + 10log (RBW) 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Press the Auto Leveling soft key. 

A calculated level of offset without NF is applied as the external offset and the user input field is 
activated for entry of the noise figure value. 

3 Enter a noise figure value by using the numeric keys. 

 

NOTE 
Having the noise figure factored in the offset calculation for Auto Leveling will enable you 
to view the CPRI spectrum closer to what you can view in the RF spectrum, but if you do 
not know the noise figure, you can skip this noise figure setting. 

4 Press the dB soft key to complete the entry. 
New external offset value appears in the External Offset menu box. 
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Figure 291 Before enabling Auto Leveling 

   
 

Figure 292 After enabling Auto Leveling 

 
 

You can set the RBW and VBW in the Spectrum, Spectrogram, and RSSI modes. The RBW range is limited 
as per the bandwidth of the signal under test. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key to set the resolution bandwidth. 
3 Enter a value in 1-3 sequence by using the numeric keys, and then select kHz soft key. 

You can also use the rotary knob. 
–  For signal bandwidths 1.4 MHz and 3 MHz: RBW from 1 kHz to 30 kHz 

–  For signal bandwidths 5 MHz, 10 MHz, 15 MHz, and 20 MHz: RBW from 1 kHz to 100 kHz 

4 Press the VBW soft key to set the video bandwidth. 
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5 Enter a value by using the numeric keys, and then select the unit option from the choices:  
MHz, kHz, and Hz. You can also use the rotary knob. 

 

You can set the number of measurements to be averaged for the trace presentation in the Spectrum, 
Spectrogram, and RSSI modes. A maximum of 100 times of averaging can be set. When the averaging 
reaches to your setting, a new measurement value replaces the measurement value in sequence from the 
earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between one and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. This setting is used in the 
Spectrum, Spectrogram, and RSSI modes. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 
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Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 To select the detection option, select More (1/2) > Detectors, and then do one of the following: 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 

5 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

 

NOTE 
To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the bandwidth of the downlink signal, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz,  b

15 MHz, and 20 MHz. 
The RBW range changes based on this bandwidth setting. 
Required number of AxC containers varies depending on the selected bandwidth. 

3 To use the pre-configured settings for a NEM, complete the following steps: 
 Press the NEM soft key. a
 Select an NEM from the following choices: b

–  None (no pre-configuration) 

–  Ericsson > Ericsson (UL) and Ericsson (DL) 

–  Alcatel-Lucent (UL/DL) 

–  Samsung (UL/DL) 
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–  Huawei > Huawei (UL) and Huawei (DL) 

–  ZTE (UL/DL) 

 

NOTE 
If you have selected a NEM, the instrument sets the Map Postion and other releated 
settings automatically based on the selected NEM and you cannot edit the map position 
setting. The pre-configured information may be subject to changes at any times by NEMs. 

4 To set the CPRI line bit rate of the fronthaul under test, complete the following steps: 
 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

 

5 To configure CPRI parameters including loop on/off, number of AxC groups, IQ sample width, 
mapping method, Tx clock type, port type, and map position, complete the steps described in the 
“Configuring CPRI parameters” on page 511. 

6 Optional. To use the RF signal generator function, see “Using RF source in RFoCPRI testing” 
on page 579. 

7 Optional. To use the CPRI signal generator function, see “Using CPRI source” on page 580. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 
3 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 

To turn it off, select Off. 
4 To set the antenna per carrier group, complete the following steps: 

 Press the AxC Group soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

NOTE 
Maximum number of the AxC Group is determined by the factors of link rate, sample 
width, oversampling, and signal bandwidth. 

5 To set the I and Q sample widths, complete the following steps: 
 Press the IQ Sample Width soft key a
 Enter a value between four and 20 by using the rotary knob. You can also use the numeric b

keys, and then press the Enter soft key. 

 

NOTE 
According to the CPRI specification, the IQ sample width shall be between 4 and 20 bits 
for I and Q in the uplink and between 8 and 20 bits in the downlink. 

6 To set the mapping method, complete the following steps: 
 Press the Mapping Method soft key. a
 Select the mapping method option from the choices: 1and 3. b

–  Mapping Method 1: IQ sample based for packed position. An RRH of GSM, UMTS, 
and LTE supports this mapping method. 

–  Mapping Method 3: Backward compatible with the mapping method 1 for flexible 
position. An RRH of GSM, UMS, and LTE supports this mapping method. 

7 Toggle the Port Type soft key and select Slave (default). 
8 Press the Tx Clock soft key, and then select Recovered (default). 
9 To set the first bit position of each AxC Container in the IQ data block of a basic frame, complete 
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the following steps: 
 Press the Map Position soft key. a
 Select the AxC Container number you want to set from the choices: AxC 0, AxC 1, AxC 2,  b

AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. Not all of these are activated depending on your 
bandwidth setting. 

 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d

 

NOTE 
The Antenna-Carrier (AxC) is the amount of digital baseband (IQ) U-plane data 
necessary for either reception or transmission of one carrier at one independent antenna 
element. The number of required AxC Container for a basic frame are two AxCs for 5 
MHz, four AxCs for 10 MHz, and eight AxCs for 20 MHz. 
 

Following is an example of test configuration for a DUT. 
 

     
 
 
For this test configuration, IQ allocation will be like this in the CPRI basic frame. 
 

    
 

 

After setting test parameters as described in “Configuring test parameters” on page 505, you can perform 
spectrum measurements with an audible indicator. You can also turn on the interference ID. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the sound indicator, complete the following steps: 

 Press the Sound Indicator soft key. a
 Toggle the Alarm Reference soft key and select the option from the choices: b

–  Marker: Sets the active marker position as the alarm reference if you have enabled a 
marker on the spectrum. 

–  Line: Lets the limit line as the alarm reference. 

 If you have set the alarm reference to Line, press the Limit Line soft key to set a threshold c
for an alarm. 

 Enter a value, and then press the dBm soft key. d
 Toggle the Sound soft key and select On to enable to sound or Off to turn it off. e
 Optional. To adjust the volume for alarm sound, press the Volume soft key, and then turn f
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the rotary knob clockwise or counter clockwise. 

 

NOTE 
The Sound Indicator is used to identify interfering signals with alarm sound. It is 
especially useful for locating interferer sources with a directional antenna. 

3 To set the interference ID, complete the following steps: 
 Press the Interference ID soft key. a
 Press the Threshold soft key. b
 Enter a value, and then press the dBm soft key. c
 Toggle the Interference ID soft key and select On to turn on Interference ID or Off to turn d

it off. 

 

NOTE 
The Interference ID automatically classifies interfering signals over a designated 
spectrum and displays a list of possible signal types corresponding to the selected signal. 

4 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 
monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
If you have saved logging data, you can play them in the Spectrum Replayer mode. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 523 
for more information. 

 
Figure 293 RFoCPRI spectrum measurement 
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Figure 294 RFoCPRI spectrum analysis on LTE Uplink 10 MHz, antenna 1 

 
 

Figure 295 RFoCPRI spectrum analysis on LTE Uplink 10 MHz, antenna 2 

 
 

The Dual Spectrum feature lets you observe two spectrums for different map positions on the same link 
simultaneously. If you enable the new Dual Active Trace function that is available in the Dual Spectrum mode, 
you can view two sweeping traces, one from the top window and the other from the bottom window, 
overlapped on one chart. 
 
After setting test parameters as described in the “Configuring test parameters” on page 505, you can 
perform dual spectrum measurements. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Active Window soft key and select [Top|Bottom]. You can also tap on the top or 
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bottom chart on the screen. 
3 To change the AxC group and map position settings for the window you have selected, complete 

the following steps:  
 Press the CPRI Parameters soft key. a
 Press the AxC Group soft key. b
 Enter a value between one and 24, and then press the Enter soft key. c
 Press the Map Position soft key, and then select the AxC Container number you want to d

set from the choices: AxC 0, AxC 1, AxC 2, AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. 
 Enter a value, and then press the Enter soft key. e

 

NOTE 
The AxC Group and Map Position settings for the top and bottom windows work 
independently each other while all other parameter settings change concurrently. If you 
have selected one of the NEMs, you cannot change the Map Position setting. 

4 To view both traces writing currently in each window together on one chart with overlapping, 
complete the following steps: 

 Press the More (1/2) soft key in the Measure Setup menu bar. a
 To enable the overlap view, toggle the Dual Active Trace and select On. b

Traces from the top and bottom charts appear overlapped on one chart. 

 

NOTE 
As shown in Figure 298, there appears [Top] or [Bottom] at the top left of the chart to 
indicate which window is active now. Currently selected active window’s trace is brought 
to front in its bold color while the inactive window’s trace sent to back with lighter color. 

 To change the selection of the active window and trace(s), press the PREV hard key and c
then toggle the Active Window soft key between Top and Bottom. You can also tap on the 
upper or lower portion of the chart on the screen. 

 To disable the overlap view and return to the dual spectrum view, toggle the Dual Active d
Trace and select Off. 

5 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 
monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
If you have saved logging data, you can play them in the Spectrum Replayer mode. 

 
Figure 296 RFoCPRI dual spectrum analysis 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 523 
for more information. 
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Figure 297 RFoCPRI dual spectrum with dual active trace off 

 
 

Figure 298 RFoCPRI dual spectrum with dual active trace on 

 
 

The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it 
captures spectrum activity over time and uses various colors to differentiate spectrum power levels. When 
the directional antenna is used to receive the signal, you will see a change in the amplitude of the tracked 
signal as you change the direction of the antenna and see a change in the Spectrogram colors. The source 
of the signal is located in the direction that results in the highest signal strength. 
 
After setting test parameters as described in “Configuring test parameters” on page 505, you can perform 
spectrogram measurements. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value, and then press the Sec soft key. b

3 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 
 To turn the time cursor off, toggle the Time Cursor soft key and select Off. d

 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

4 To start a new measurement, press the Reset/Restart soft key. 
5 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 
The spectrogram shows a vertical line on the chart when the marker is enabled on the screen. 
 

Figure 299 RFoCPRI interference measurement in spectrogram 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 523 
for more information. 

 

The Dual Spectrogram feature lets you observe two spectrograms for different map positions on the same 
link simultaneously. 
 
After setting test parameters as described in the “Configuring test parameters” on page 505, you can 
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perform dual spectrogram measurements.  
 

Procedure 

1 In the Dual Spectrogram mode, press the MEASURE SETUP hot key. 
2 Press the More (1/2) soft key. 
3 Toggle the Active Window soft key and select [Left|Right]. You can also tap on the left or right 

chart on the screen. 
4 To change the AxC group and map position settings for the window you have selected, complete 

the following steps:  
 Press the CPRI Parameters soft key. a
 Press the AxC Group soft key. b
 Enter a value between one and 24, and then press the Enter soft key. c
 Press the Map Position soft key, and then select the AxC Container number you want to d

set from the choices: AxC 0, AxC 1, AxC 2, AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. 
 Enter a value, and then press the Enter soft key. e

 

NOTE 
The AxC Group and Map Position settings for the top and bottom windows work 
independently each other while all other parameter settings change concurrently. 

5 To set the amount of time between each trace measurement, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value, and the press the Sec soft key. b

6 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

7 To start a new measurement, press the Reset/Restart soft key. 
8 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 300 RFoCPRI dual spectrogram analysis 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 523 
for more information. 

 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly useful for 
measuring power-level variations over time. The RSSI measurement lets you assign power limit line for 
audible alarms and increase alarm counters every time a signal exceeds a defined limit line. For long-term 
analysis, the spectrogram and RSSI measurements can be automatically saved into an external USB 
memory. Post-analysis can be performed with JDViewer application software. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 505, you can 
continue to proceed to the spectrogram measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the alarm parameters, complete the following steps: 

 Press the Alarm soft key. a
 Press the Alarm at soft key, and then select the marker number you want to set. b
 Press the Limit Line soft key to set a threshold for the alarm. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the dBm soft key. e
 Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. f

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as these features use 
the marker position to sound an alarm. See “Using marker” on page 54 for more 
information. 

 Optional. Press the Volume soft key and adjust the volume. g
3 Press the PREV hard key to return to the Measure Setup screen bar. 
4 To start a new measurement, press the Reset/Restart soft key. 
5 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 
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monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 
Figure 301 RFoCPRI interference measurement in RSSI 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 523 
for more information. 

 

CPRI delivers spectrum bandwidth information based on the sampling frequency of a carrier as specified in 
the 3GPP specification. 
 

Signal Bandwidth 3 MHz 5 MHz 10 MHz 15 MHz 20 MHz 

Transmission Bandwidth 2.7 MHz 4.5 MHz 9 MHz 13.5 MHz 18 MHz 

Sampling Frequency 3.84 MHz 7.68 MHz 15.36 MHz 23.04 MHz 30.72 MHz 

 
Even though it limits that you can view spectrum only within the sampling frequency, the Zoom In feature in 
JD700B series makes it easy to view the spectrum in detail. This feature is available in RFoCPRI Spectrum, 
Spectrogram, RSSI, Dual Spectrum, and Dual Spectrogram modes. 
 

Procedure 

1 Press the MARKER hard key and place the marker at the frequency that you want to zoom in. 
You will see the Zoom In menu in the Marker menu bar. 

2 Press the Zoom In soft key. 
3 Toggle the Zoom In soft key in the Zoom In menu bar and select On. 

The display refreshes with the marker frequency centered in the current spectrum view. You will 
notice “Zoom-in Frequency” at the bottom of the chart. 

 

NOTE 
Turning on Zoom In does not affect the center frequency that you have set with the 
FREQ/DIST hard key. You can still view your original center frequency information in the 



Chapter 15 Performing RFoCPRI Testing 

 JD700B Series User’s Guide 521 

input settings pane at the top. 

4 To change the zoom-in center frequency, complete the following steps. 
 Press the Zoom-in Center Frequency soft key. a
 Enter a value, and then press one of the unit soft keys that you want to select. b

You can also turn the rotary knob. 
5 To change the zoom-in span, complete the following steps: 

 Press the Zoom-in Span soft key. a
 Enter a value, and then press one of the unit soft keys that you want to select. b

You can also turn the rotary knob. 

 

NOTE 
You can have the span as low as 10 kHz. An error message appears if you change the 
zoom-in center frequency or span out of the range, which is automatically determined by 
the instrument based on the sampling frequency. 

6 To view a different position on the original spectrum, complete the following steps: 
 Toggle the Zoom In soft key and select Off. a

The screen goes back to the original spectrum. 
 Move the marker to a new position on the spectrum. b
 Turn the rotary knob to change the marker position. c
 Toggle the Zoom In soft key and select On again. d

The display refreshes with the new marker frequency centered in the current spectrum 
view. You will notice “Zoom-in Frequency” at the bottom of the chart. 

7 To disable Zoom In, toggle the Zoom In soft key in the Zoom In menu bar and select Off. 

 
Figure 302 Zoomed-in spectrum view in RFoCPRI interference analyzer 

 
 

The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference 
analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the limit line 
to create failure points when signals exceed it. The failure points are clearly displayed on the trace timeline 
for quick access during playback. 
 

Procedure 

1 Press the MEASURE hot key. 
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2 Press the Spectrum Replayer soft key. 
The file manager window appears. 

3 Select a file to be loaded, and then press the Load soft key. 
The Measure Setup screen menus appear. 

4 Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 
or reverse. 

5 Press the Replay Speed soft key, and then select the speed option: X1, X2, X3, and X4. 
6 Press the Play soft key to start playing. 
7 Press the Pause soft key to pause or stop playing data. 
8 To move to a particular failure position directly and play from there, complete the following steps: 

 Press the Jump to Fail Index soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

9 Optional. Toggle the Time Cursor soft key between On and Off to display or dismiss the time 
cursor on the screen. This key becomes activated when you play logged data in the Spectrogram 
mode. 

 

 

NOTE 
If you connected a USB drive, do not remove it while playing to prevent freezing the USB 
port, which will require you to restart the instrument to get a USB drive recognized again. 

 
Figure 303 RFoCPRI spectrum replay 

 
 

You can select the display option to view data in a different mode. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select the display option from the choices: Spectrum, Spectrogram, and RSSI. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 523 
for more information. 
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You can set threshold(s) and display either a single segment line or multi-segment line to analyze the result 
better. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and hide the reference line. 

The straight line appears across the screen to be used as a visual reference only. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 

 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 
6 To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum for 
any technology. When PIM is detected, the normal repair mode is to replace the offending cable and what 
you need to do is replacing the whole cable irrespective of the location of the fault. 
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You can connect cables with a tap or without a tap as illustrated in Figure 304. If you have connected cables 
directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the CPRI 
parameter settings. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 304 Connection diagram for PIM detection 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
 

 
 

Procedure 

1 Press the MEASURE hot key. 
2 Press the PIM Detection soft key. 
3 Select the PIM detection mode from the following choices: 

–  PIM Detection Single Carrier 

–  PIM Detection Multiple Carriers 

–  Calculated PIM 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the bandwidth of the downlink signal, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz,  b

15 MHz, and 20 MHz. 
The RBW range changes based on this bandwidth setting. 
Required number of AxC containers varies depending on the selected bandwidth. 

3 To use the pre-configured settings for a NEM, complete the following steps: 
 Press the NEM soft key. a
 Select an NEM from the following choices: b

–  None (no pre-configuration) 

–  Ericsson > Ericsson (UL) and Ericsson (DL) 
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–  Alcatel-Lucent (UL/DL) 

–  Samsung (UL/DL) 

–  Huawei > Huawei (UL) and Huawei (DL) 

–  ZTE (UL/DL) 

 

NOTE 
If you have selected a NEM, the instrument sets the Map Postion and other releated 
settings automatically based on the selected NEM and you cannot edit the map position 
setting. The pre-configured information may be subject to changes at any times by NEMs. 

4 To set the CPRI line bit rate of the fronthaul under test, complete the following steps: 
 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

 

5 To configure CPRI parameters including loop on/off, number of AxC groups, IQ sample width, 
mapping method, Tx clock type, port type, and map position, complete the steps described in the 
“Configuring CPRI parameters” on page 525. 

6 Optional. To use the RF signal generator function, see “Using RF source in RFoCPRI testing” 
on page 579. 

7 Optional. To use the CPRI signal generator function, see “Using CPRI source” on page 580. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 
3 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 

To turn it off, select Off. 
4 To set the antenna per carrier group, complete the following steps: 

 Press the AxC Group soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

NOTE 
Maximum number of the AxC Group is determined by the factors of link rate, sample 
width, oversampling, and signal bandwidth. 

5 To set the I and Q sample widths, complete the following steps: 
 Press the IQ Sample Width soft key a
 Enter a value between four and 20 by using the rotary knob. You can also use the numeric b

keys, and then press the Enter soft key. 

 

NOTE 
According to the CPRI specification, the IQ sample width shall be between 4 and 20 bits 
for I and Q in the uplink and between 8 and 20 bits in the downlink. 

6 To set the mapping method, complete the following steps: 
 Press the Mapping Method soft key. a
 Select the mapping method option from the choices: 1and 3. b

–  Mapping Method 1: IQ sample based for packed position. An RRH of GSM, UMTS, 
and LTE supports this mapping method. 

–  Mapping Method 3: Backward compatible with the mapping method 1 for flexible 
position. An RRH of GSM, UMS, and LTE supports this mapping method. 

7 Toggle the Port Type soft key and select Slave (default). 
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8 Press the Tx Clock soft key, and then select Recovered (default). 
9 To set the first bit position of each AxC Container in the IQ data block of a basic frame, complete 

the following steps: 
 Press the Map Position soft key. a
 Select the AxC Container number you want to set from the choices: AxC 0, AxC 1, AxC 2,  b

AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. Not all of these are activated depending on your 
bandwidth setting. 

 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d

 

NOTE 
The Antenna-Carrier (AxC) is the amount of digital baseband (IQ) U-plane data 
necessary for either reception or transmission of one carrier at one independent antenna 
element. The number of required AxC Container for a basic frame are two AxCs for 5 
MHz, four AxCs for 10 MHz, and eight AxCs for 20 MHz. 
 
Following is an example of test configuration for a DUT. 
 

     
 
 
For this test configuration, IQ allocation will be like this in the CPRI basic frame. 
 

    
 

 

The Calculated PIM is used when you want to check any possible existence of PIM before the actual 
measurement. The instrument displays possible PIM in red color. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calculated PIM soft key. 
3 Toggle the Radio Config soft key between Single and Multi and select the mode you want to use. 

–  Single: Sets the frequency of Radio 1. 

–  Multi: Sets the frequency of Radio 1 and Radio 2. 

4 Do one of the following: 
–  To set the frequency and span, complete the following steps: 

 Toggle the Mode soft key between Freq and Band and select Freq. a
 Press the Radio [1]2] Frequency soft key. b
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 Enter a value by using the numeric keys. c
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. d
 Press the Radio [1|2] Span soft key. e
 Enter a value by using the numeric keys. f
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. g

–  To set the radio band, complete the following steps: 
 Toggle the Mode soft key between Freq and Band and select Band. a
 Press the Radio [1]2] Band soft key. b
 Highlight the radio band to select by using the rotary knob. c
 Press the Select soft key. d

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Connect cables as instructed on the screen. 

 

NOTE 
Make sure that the Tx of RRH is connected to the Rx port of SFP/SFP+ installed in your 
CellAdvisor. 

3 Do one of the following: 
–  To set the uplink center frequency and span to be measured, complete the following steps: 

 Toggle the Unit soft key between Freq and Channel and select Freq. a
 Press the Uplink Center Frequency soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit from the choices: GHz, MHz, kHz, and Hz. d

–  To set the channel number to be measured, complete the following steps: 
 Toggle the Unit soft key between Freq and Channel and select Channel. a
 Press the Channel Std soft key, and then highlight a desired band. b
 Press the Select soft key. c
 Press the Channel Number soft key. d
 Enter a value by using the numeric keys, and then press the Enter soft key. e

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

4 Press the Continue soft key, and then follow the instructions on the screen.  
5 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
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Figure 305 PIM detection of single radio 

 
 

If your JD700B series has the option 091 RFoCPRI LTE-FDD Signal Analyzer installed with a license, you 
can performs power and spectrum measurements as well as modulation analysis to test the proper 
transmitter performance of FDD LTE systems over CPRI.  
 
This instrument provides the following measurement tools for FDD LTE system over CPRI: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

 Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Frame 

- Time Alignment Error 

- Data Allocation Map 

 Power Statistics CCDF 
 

You can connect cables with a tap or without a tap as illustrated in Figure 306. If you have connected cables 



Chapter 15 Performing RFoCPRI Testing 

 JD700B Series User’s Guide 529 

directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the CPRI 
parameter settings. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 306 Connection diagram for downlink signal analysis 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 

 

 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select Signal Analyzer > LTE-FDD. 
3 Select the downlink signal analysis mode from the following choices: 

–  Spectrum 

–  RF Analysis > Channel Power or Occupied BW 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe, 
Frame, Time Alignement Error, or Data Allocation Map 

–  Power Statistics CCDF 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 
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steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 

To set the channel number: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the reference automatically or manually to optimize the display of the trace, as you desire. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Do the following: 

–  To optimize the Y-axis scale automatically, press the Auto Scale soft key. 

–  To set the maximum reference value on the Y-axis manually, complete the following steps: 
 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

 

NOTE 
In the measurements such as Control Channel, Subframe, and Frame, you can select 
the reference option between Relative and Absolute instead. 

3 To set an external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key to complete the entry.  c

 

NOTE 
The instrument displays a measurement result with the set value reflected. For example, 
if you set it to 40 dB, the measurement result compensates 40 dB. 

4 To change the setting of the scale per division, complete the following steps: 
 Select More (1/2) > Scale/Div. a
 Enter a value between 1 and 20 by using the numeric keys. b
 Press the dB soft key to complete the entry. c

5 To change the scale unit, select More (1/2) > Units, and then select the display unit option from 
the choices: dBm, dBV, dBmV, dBµV, V, and W.  
The scale unit on the screen changes accordingly. 
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NOTE 
The Scale/Div and Units menus are available in the Spectrum and RF Analysis modes. 

 

 

In the spectrum and RF analysis, you can set the number of measurements to be averaged for the trace 
presentation. A maximum of 100 times of averaging can be set. When the averaging reaches to your setting, 
a new measurement value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Do the following: 

–  To select the single sweep mode, complete the following steps: 
 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot a

key. 
The letter HOLD in red appears and the sweeping is paused. 

 To get a new measurement Press the Sweep Once soft key. b
–  To return to the continuous sweep mode, toggle the Sweep Mode soft key and select 

Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the bandwidth of the downlink signal, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 5 MHz, 10 MHz, 15 MHz, and 20 MHz. b

The RBW range changes based on this bandwidth setting. 
Required number of AxC containers varies depending on the selected bandwidth. 

3 To use the pre-configured settings for a NEM, complete the following steps: 
 Press the NEM soft key. a
 Select an NEM from the following choices: b

–  None (no pre-configuration) 

–  Ericsson > Ericsson (UL) and Ericsson (DL) 

–  Alcatel-Lucent (UL/DL) 
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–  Samsung (UL/DL) 

–  Huawei > Huawei (UL) and Huawei (DL) 

–  ZTE (UL/DL) 

 

NOTE 
If you have selected a NEM, the instrument sets the Map Postion and other releated 
settings automatically based on the selected NEM and you cannot edit the map position 
setting. The pre-configured information may be subject to changes at any times by NEMs. 

4 To set the CPRI line bit rate of the fronthaul under test, complete the following steps: 
 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

5 To configure CPRI parameters including loop on/off, number of AxC groups, IQ sample width, 
mapping method, Tx clock type, port type, and map position, complete the steps described in the 
“Configuring CPRI parameters” on page 532. 

6 Optional. To use the RF signal generator function, see “Using RF source in RFoCPRI testing” 
on page 579. 

7 Optional. To use the CPRI signal generator function, see “Using CPRI source” on page 580. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 
3 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 

To turn it off, select Off. 
4 To set the antenna per carrier group, complete the following steps: 

 Press the AxC Group soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

NOTE 
Maximum number of the AxC Group is determined by the factors of link rate, sample 
width, oversampling, and signal bandwidth. 

5 To set the I and Q sample widths, complete the following steps: 
 Press the IQ Sample Width soft key a
 Enter a value between four and 20 by using the rotary knob. You can also use the numeric b

keys, and then press the Enter soft key. 

 

NOTE 
According to the CPRI specification, the IQ sample width shall be between 4 and 20 bits 
for I and Q in the uplink and between 8 and 20 bits in the downlink. 

6 To set the mapping method, complete the following steps: 
 Press the Mapping Method soft key. a
 Select the mapping method option from the choices: 1and 3. b

–  Mapping Method 1: IQ sample based for packed position. An RRH of GSM, UMTS, 
and LTE supports this mapping method. 

–  Mapping Method 3: Backward compatible with the mapping method 1 for flexible 
position. An RRH of GSM, UMS, and LTE supports this mapping method. 

7 Toggle the Port Type soft key and select Slave (default). 
8 Press the Tx Clock soft key, and then select Recovered (default). 
9 To set the first bit position of each AxC Container in the IQ data block of a basic frame, complete 
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the following steps: 
 Press the Map Position soft key. a
 Select the AxC Container number you want to set from the choices: AxC 0, AxC 1, AxC 2,  b

AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. Not all of these are activated depending on your 
bandwidth setting. 

 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d

 

NOTE 
The Antenna-Carrier (AxC) is the amount of digital baseband (IQ) U-plane data 
necessary for either reception or transmission of one carrier at one independent antenna 
element. The number of required AxC Container for a basic frame are two AxCs for 5 
MHz, four AxCs for 10 MHz, and eight AxCs for 20 MHz. 
 
Following is an example of test configuration for a DUT. 
 

     
 
 
For this test configuration, IQ allocation will be like this in the CPRI basic frame. 
 

    
 

 

In LTE system, the System Information (SI) that is carried over transport channel BCH or by DL-SCH 
consists of two parts: static part called MIB (Master Information Block) and dynamic part called SIBs 
(System Information Blocks). MIB contains important information such as system bandwidth, System Frame 
Number (SFN), PHICH configuration while SIBs contain other useful information including transit power, 
number of antenna, and SIB scheduling information for UE to read to access a cell. 
 
JD700B series decodes MIB, the first of SIB (SIB1), and the second of SIB (SIB2) and provides you with 
decoded information of several parameters. If you are not familiar with matching the system information 
between IQ spectrum and RF spectrum, this feature enables you to identify the uplink carrier frequency and 
bandwidth so that you can map AxC container to the RF carrier by combining the decoded information with 
other system parameters obtained by RFoCPRI signal analysis. As not all LTE frames have transmitted SIB, 
it may take time for the instrument to capture frames with the system information and decode MIB and 
SIB1/2. 
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Procedure 

1 Make sure that you have set the frequency to “Band Global” for the technology. 
2 Press the TRACE/DISPLAY hard key. 
3 Press the MIB & SIB1/2 Information soft key. 

The MIB and SIB1/2 Information window appears with the following parameters: 
–  SFN: System Frame Number. 
–  p-Max: Maximum allowed UL transmit power of the cell 
–  systemInfoValueTag: It indicates if a change has occurred in the SI messages. UEs may 

use this, e.g. upon return from out of coverage, to verify if the previously stored SI 
messages are still valid. 

–  Freqinfo-ul-CarrierFreq: Uplink channel number 
–  Freqinfo-ul-Bandwidth: Uplink bandwidth 
–  timeAlignmentTimerCommon: It is used to control how long the UE should consider to be 

time aligned in uplink. The value is in subframes. 

 

NOTE 
Some or entire parameters may not be available depending on the system configuration 
or the NEM of the system. Also, this feature may not work for Ericsson RRHs. 

 

 
Figure 307 Decoded MIB & SIB1/2 information in RFoCPRI LTE-FDD signal analyzer 

 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Spectrum. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Check your measurement result displayed on the screen. 
6 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
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7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 
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Figure 308 Spectrum measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of the 
signal in the LTE channel bandwidth. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > RF Analysis > Channel Power. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Check your measurement result displayed on the screen. 
6 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 309 Channel power measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > RF Analysis > Occupied BW. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Check your measurement result displayed on the screen.  
6 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 



Chapter 15 Performing RFoCPRI Testing 

538 JD700B Series User’s Guide 

Figure 310 Occupied bandwidth measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot in an LTE signal. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > P vs T (Frame). 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
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–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, and 1. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth.  

9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 311 Power vs. time (frame) measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Constellation. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532  

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

8 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

9 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 
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Figure 312 Constellation measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Data Channel measures the constellation for the specified resource block as well as the modulation 
accuracy of each PDSCH at the specified subframe. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Data Channel. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532  

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
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synchronization. 

7 To enable or disable the event hold feature, toggle the Event Hold soft key and then select On or 
Off. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

8 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

9 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram for 
the selected resource block. 
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Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

resource block. 

 

Figure 313 Data channel measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Control Channel measures the constellation for the specified control channel as well as modulation 
accuracy of the control channel at the specified subframe. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Control Channel. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 
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5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

6 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

7 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 
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8 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the MARKER hard key to place a marker on a control channel and display the IQ diagram for 
the selected channel. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the Channel soft key to select a channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 
3 Press the up/down arrow keys or turn the rotary knob to highlight a channel in the channel 

summary table, and then press the center of the rotary knob. 
4 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

channel. 

 

Figure 314 Control channel measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
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Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Subframe. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
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E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

9 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

10 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

11 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the TRACE/DISPLAY hard key to view the RE and RS power at a specific symbol. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or hide the chart.  

If this setting is on, the MARKER hard key is activated. 

 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 
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Figure 315 Subframe measurement (regular view) with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Frame measures the modulation accuracy of all the data and control channels at the frame  
(10 ms). 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Frame. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

6 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
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described in the following section.  
9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

9 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

10 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

11 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 



Chapter 15 Performing RFoCPRI Testing 

550 JD700B Series User’s Guide 

Figure 316 Frame measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

In eNode-B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. These 
signals shall be aligned. The time alignment error in Tx diversity is specified as the delay between the 
signals from two antennas at the antenna ports. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Time Alignment Error. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Toggle the Antenna Config soft key and select Ant0 or Ant1 as needed. 
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. To select the cyclic prefix, complete the following steps: 
 Press the Miscellaneous soft key. a
 Toggle the Cyclic Prefix soft key and select Normal or Extended. See “Appendix E – b
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Cyclic prefix table” on page 693 for OFDM parameter details by different bandwidth. 
9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 317 Time alignment error measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Data Allocation Map function represents data allocation as a frame. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Data Allocation Map. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Display Channel soft key. 
3 Select the display mode from the choice: PDSCH, PMCH, and Both. 

 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
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Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c

4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Figure 318 Data allocation map measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Power Statistics CCDF. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 
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–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532  

5 To set the length of the CCDF, complete the following steps: 
 Press the CCDF Length soft key. a
 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary b

knob. 
 Press the Enter soft key. c

6 Check your measurement result displayed on the screen. 
7 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 319 CCDF measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set a limit for RF analysis tests, press the RF Test Limits soft key and then set limits as 

needed, depending on where you are in the measurement mode. 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

3 To set a limit for modulation tests, press the Modulation Test Limits soft key and then set limits 
as needed, depending on where you are in the measurement mode. 
 
 



Chapter 15 Performing RFoCPRI Testing 

 JD700B Series User’s Guide 555 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit, Low Limit 

P-SS power Power > P-SS Power High Limit, Low Limit 

S-SS power Power > S-SS Power High Limit, Low Limit 

PBCH power Power > PBCH Power High Limit, Low Limit 

Subframe power Power > Subframe Power High Limit, Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit, Low Limit 

Frame average power Power > Frame Avg Power High Limit, Low Limit 

Time alignment error for MIMO Time Alignment Error > MIMO High Limit 

Time error Time Error High Limit, Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

If your JD700B series has the option 092 RFoCPRI LTE-TDD Signal Analyzer installed with a license, you 
can performs power and spectrum measurements as well as modulation analysis to test the proper 
transmitter performance of TDD LTE systems over CPRI.  
 
This instrument provides the following measurement tools for TDD LTE system over CPRI: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

 Power vs. Time (Frame) 
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 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Time Alignment Error 

- Data Allocation Map 

 Power Statistics CCDF 
 

You can connect cables with a tap or without a tap as illustrated in Figure 320. If you have connected cables 
directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the CPRI 
parameter settings. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 320 Connection diagram for downlink signal analysis 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 

 

 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select Signal Analyzer > LTE-TDD. 
3 Select the downlink signal analysis mode from the following choices: 

–  Spectrum 

–  RF Analysis > Channel Power or Occupied BW 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe,  
Time Alignement Error, or Data Allocation Map 

–  Power Statistics CCDF 
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You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 

To set the channel number: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the reference automatically or manually to optimize the display of the trace, as you desire. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Do the following: 

–  To optimize the Y-axis scale automatically, press the Auto Scale soft key. 

–  To set the maximum reference value on the Y-axis manually, complete the following steps: 
 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c
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NOTE 
In the measurements such as Control Channel, Subframe, and Frame, you can select 
the reference option between Relative and Absolute instead. 

3 To set an external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key to complete the entry.  c

 

NOTE 
The instrument displays a measurement result with the set value reflected. For example, 
if you set it to 40 dB, the measurement result compensates 40 dB. 

4 To change the setting of the scale per division, complete the following steps: 
 Select More (1/2) > Scale/Div. a
 Enter a value between 1 and 20 by using the numeric keys. b
 Press the dB soft key to complete the entry. c

5 To change the scale unit, select More (1/2) > Units, and then select the display unit option from 
the choices: dBm, dBV, dBmV, dBµV, V, and W.  
The scale unit on the screen changes accordingly. 

 

NOTE 
The Scale/Div and Units menus are available in the Spectrum and RF Analysis modes. 

 

 

In the spectrum and RF analysis, you can set the number of measurements to be averaged for the trace 
presentation. A maximum of 100 times of averaging can be set. When the averaging reaches to your setting, 
a new measurement value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Do the following: 

–  To select the single sweep mode, complete the following steps: 
 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot a

key. 
The letter HOLD in red appears and the sweeping is paused. 

 To get a new measurement Press the Sweep Once soft key. b
–  To return to the continuous sweep mode, toggle the Sweep Mode soft key and select 

Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the bandwidth of the downlink signal, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 5 MHz, 10 MHz, 15 MHz, and 20 MHz. b

The RBW range changes based on this bandwidth setting. 
Required number of AxC containers varies depending on the selected bandwidth. 

3 To use the pre-configured settings for a NEM, complete the following steps: 
 Press the NEM soft key. c
 Select an NEM from the following choices: d

–  None (no pre-configuration) 

–  Ericsson > Ericsson (UL) and Ericsson (DL) 

–  Alcatel-Lucent (UL/DL) 

–  Samsung (UL/DL) 

–  Huawei > Huawei (UL) and Huawei (DL) 

–  ZTE (UL/DL) 

 

NOTE 
If you have selected a NEM, the instrument sets the Map Postion and other releated 
settings automatically based on the selected NEM and you cannot edit the map position 
setting. The pre-configured information may be subject to changes at any times by NEMs. 

4 To set the CPRI line bit rate of the fronthaul under test, complete the following steps: 
 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

5 To configure CPRI parameters including loop on/off, number of AxC groups, IQ sample width, 
mapping method, Tx clock type, port type, and map position, complete the steps described in the 
“Configuring CPRI parameters” on page 532. 

6 Optional. To use the RF signal generator function, see “Using RF source in RFoCPRI testing” 
on page 579. 

7 Optional. To use the CPRI signal generator function, see “Using CPRI source” on page 580. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 
3 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 

To turn it off, select Off. 
4 To set the antenna per carrier group, complete the following steps: 

 Press the AxC Group soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

NOTE 
Maximum number of the AxC Group is determined by the factors of link rate, sample 
width, oversampling, and signal bandwidth. 
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5 To set the I and Q sample widths, complete the following steps: 
 Press the IQ Sample Width soft key a
 Enter a value between four and 20 by using the rotary knob. You can also use the numeric b

keys, and then press the Enter soft key. 

 

NOTE 
According to the CPRI specification, the IQ sample width shall be between 4 and 20 bits 
for I and Q in the uplink and between 8 and 20 bits in the downlink. 

6 To set the mapping method, complete the following steps: 
 Press the Mapping Method soft key. a
 Select the mapping method option from the choices: 1and 3. b

–  Mapping Method 1: IQ sample based for packed position. An RRH of GSM, UMTS, 
and LTE supports this mapping method. 

–  Mapping Method 3: Backward compatible with the mapping method 1 for flexible 
position. An RRH of GSM, UMS, and LTE supports this mapping method. 

7 Toggle the Port Type soft key and select Slave (default). 
8 Press the Tx Clock soft key, and then select Recovered (default). 
9 To set the first bit position of each AxC Container in the IQ data block of a basic frame, complete 

the following steps: 
 Press the Map Position soft key. a
 Select the AxC Container number you want to set from the choices: AxC 0, AxC 1, AxC 2,  b

AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. Not all of these are activated depending on your 
bandwidth setting. 

 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d

 

NOTE 
The Antenna-Carrier (AxC) is the amount of digital baseband (IQ) U-plane data 
necessary for either reception or transmission of one carrier at one independent antenna 
element. The number of required AxC Container for a basic frame are two AxCs for 5 
MHz, four AxCs for 10 MHz, and eight AxCs for 20 MHz. 
 
Following is an example of test configuration for a DUT. 
 

     
 
 
For this test configuration, IQ allocation will be like this in the CPRI basic frame. 
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Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Spectrum. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Check your measurement result displayed on the screen. 
6 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
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The result is overlaid on the screen along with the second Y-axis. 

 

Figure 321 Spectrum measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of the 
signal in the LTE channel bandwidth. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > RF Analysis > Channel Power. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Check your measurement result displayed on the screen. 
6 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 322 Channel power measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > RF Analysis > Occupied BW. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Check your measurement result displayed on the screen.  
6 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 323 Occupied bandwidth measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot in an LTE signal. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > P vs T (Frame). 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
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–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, and 1. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth.  

9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 324 Power vs. time (frame) measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Modulation Analysis > Constellation. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532  

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

8 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

9 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 
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Figure 325 Constellation measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Data Channel measures the constellation for the specified resource block as well as the modulation 
accuracy of each PDSCH at the specified subframe. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Modulation Analysis > Data Channel. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532  

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
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synchronization. 

7 To enable or disable the event hold feature, toggle the Event Hold soft key and then select On or 
Off. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

8 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

9 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram for 
the selected resource block. 
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Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

resource block. 

 

Figure 326 Data channel measurement with RFoCPRI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Control Channel measures the constellation for the specified control channel as well as modulation 
accuracy of the control channel at the specified subframe. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Modulation Analysis > Control Channel. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 
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5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

6 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

7 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 



Chapter 15 Performing RFoCPRI Testing 

 JD700B Series User’s Guide 571 

8 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the MARKER hard key to place a marker on a control channel and display the IQ diagram for 
the selected channel. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the Channel soft key to select a channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 
3 Press the up/down arrow keys or turn the rotary knob to highlight a channel in the channel 

summary table, and then press the center of the rotary knob. 
4 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

channel. 

 

Figure 327 Control channel measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
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Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Modulation Analysis > Subframe. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
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E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

9 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

10 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

11 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the TRACE/DISPLAY hard key to view the RE and RS power at a specific symbol. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or hide the chart.  

If this setting is on, the MARKER hard key is activated. 

 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 
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Figure 328 Subframe measurement (regular view) with RFoCPRI LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

In eNode-B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. These 
signals shall be aligned. The time alignment error in Tx diversity is specified as the delay between the 
signals from two antennas at the antenna ports. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Modulation Analysis > Time Alignment Error. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 Toggle the Antenna Config soft key and select Ant0 or Ant1 as needed. 
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. To select the cyclic prefix, complete the following steps: 
 Press the Miscellaneous soft key. a
 Toggle the Cyclic Prefix soft key and select Normal or Extended. See “Appendix E – b
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Cyclic prefix table” on page 693 for OFDM parameter details by different bandwidth. 
9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 329 Time alignment error measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoCPRI signal analysis” on page 
554 for more information. 

 

The Data Allocation Map function represents data allocation as a frame. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Modulation Analysis > Data Allocation Map. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 

–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532 

5 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Display Channel soft key. 
3 Select the display mode from the choice: PDSCH, PMCH, and Both. 

 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
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Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c

4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Figure 330 Data allocation map measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-TDD > Power Statistics CCDF. 
3 Configure test parameters as described in the “Configuring test parameters” on page 529. 
4 Press the MEASURE SETUP hot key, and then set the following parameters: 
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–  Measurement setups as described in the “Setting measure setup” on page 531 

–  CPRI parameters as described in the “Configuring CPRI parameters” on page 532  

5 To set the length of the CCDF, complete the following steps: 
 Press the CCDF Length soft key. a
 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary b

knob. 
 Press the Enter soft key. c

6 Check your measurement result displayed on the screen. 
7 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 331 CCDF measurement with RFoCPRI LTE-TDD signal analyzer 

 
 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set a limit for RF analysis tests, press the RF Test Limits soft key and then set limits as 

needed, depending on where you are in the measurement mode. 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

3 To set a limit for modulation tests, press the Modulation Test Limits soft key and then set limits 
as needed, depending on where you are in the measurement mode. 
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To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit, Low Limit 

P-SS power Power > P-SS Power High Limit, Low Limit 

S-SS power Power > S-SS Power High Limit, Low Limit 

PBCH power Power > PBCH Power High Limit, Low Limit 

Subframe power Power > Subframe Power High Limit, Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit, Low Limit 

Frame average power Power > Frame Avg Power High Limit, Low Limit 

Time alignment error for MIMO Time Alignment Error > MIMO High Limit 

Time error Time Error High Limit, Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

If your JD700B series has the signal generator options installed with a license, you can use RF Source or 
CPRI Source, or both. 
 

You can use the RF Source feature to calibrate the uplink noise floor at a given point, check the uplink gain 
and dynamic range, and verify that current AxC configuration including map positioning is correct. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
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2 Press the Source soft key. Depending on your selection of measurement mode, you may need 
to select More (1/2) > Source. 

3 Press the RF Source soft key. 
4 To set the frequency of the CW signal to be injected, complete the following steps: 

 Press the Frequency soft key. a
 Enter a value within the frequency range of your instrument. b

–  JD740B series: 25 MHz to 4 GHz 

–  JD780B series: 5 MHz to 6 GHz 

 

NOTE 
The frequency of the CW signal must be in the uplink band of the RRH under test. 

 Select the unit option from the choices: GHz, MHz, kHz, and Hz. c
5 To set the output level of the CW signal to be injected, complete following steps: 

 Press the Power Level soft key. a
 Enter a value within the output range for the frequency you have set in step 4. b

–  JD740B series: -80 dBm to -30 dBm, 0 dBm 

–  JD780B series: -60 dBm to 10 dBm 

 Press the unit soft key. c
6 To start to inject the set signal, toggle the RF Source soft key and select On. 
7 To stop injecting the signal, toggle the RF Source soft key and select Off. 

 

You can use the CPRI Source feature to generate CW and six types of E-UTRA Test Model waveforms in 
RFoCPRI testing for LTE-FDD and LTE-TDD: CW, E-TM1.1, E-TM1.2, E-TM2, E-TM3.1, E-TM3.2, and  
E-TM3.3. 
 

Procedure 

1 Make the Tx of a SFP/SFP+ module looped back to the Rx of the same module. 

 

NOTE 
When two SFP/SFP+ modules are installed in both Port 1 and Port 2, the CPRI source 
always works via the Port 1, which is the primary port. If you want to use the Port 2 for 
this CPRI signal generation, make sure to eject the module from the Port 1. 

2 Press the MEASURE SETUP hot key. 
3 To set the Tx Clock and Port Type settings correctly, complete the following steps: 

 Press the CPRI Parameters soft key. a
 Press the Tx Clock soft key and then select Internal. b
 Toggle the Port Type soft key and then select Master. c
 Press the PREV hard key to return to the Measure Setup main menu. d

4 Press the Source soft key. Depending on your selection of measurement mode, you may need 
to select More (1/2) > Source. 

5 Press the CPRI Source soft key. 
6 To adjust the gain of the waveform to be transmitted in order to prevent an overrun or underrun of 

the RRH, complete the following steps: 
 Press the Gain soft key. a
 Enter a value between -50.00 and 0.00. b
 Press the dB soft key or the ENTER hard key. c

7 To select a waveform to be generated, complete the following steps: 
 Press the Waveforms soft key. a

The Waveform list dialog box appears. 
 Select a signal from the list that you want to generate for your selected NEM. Supported b
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bandwidths are 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Tap the Apply button on the screen or press the ENTER hard key. c

8 To start to inject the selected signal, toggle the CPRI Source soft key and select On. 
9 To stop injecting the signal, toggle the CPRI Source soft key and select Off. 

 

Today’s deployment of Fiber to the Antenna (FTTA) network has some challenges. One of them is that not all 
network components are present at the initial stage of RRH installation and testing. For example, when a 
new RRH is installed, a BBU is not yet connected to the backhaul of the network. Thanks to the capability of 
BBU emulation in JD700B series, you can now capture C&M messages, configure the RRH successfully to 
start it up, and perform testing on the RRH without a live BBU. 
 
The RFoCPRI BBU Emulation includes the following functions: 

 Configuration Verification – It enables you not only to verify that RRH configuration is correct, but 
also to apply saved or edited profile to the RRH to set up the RRH with correct carrier information. 
You can also view CPRI State, activated SW, and SFP Information. 

 RRH Profiling – It retrieves a complete set of profile information that is essential to bring a RRH up 
and running from a live link between BBU and RRH so that you can save the profile as a file and 
use it to configure a new RRH out in the field. It is not mandatory in BBU emulation, but it makes it 
easy to configure RRHs of the same kind. 

 Spectrum Clearance – It helps you identify and clear signals interfering with the uplink signal. This 
provides the same functions as the RFoCPRI Interference Analyzer, which includes Spectrum, 
Spectrogram, RSSI, Dual Spectrum, and Dual Spectrogram. 

 Coverage Range – With checking the transmission of a carrier at a certain frequency, it enables you 
to manipulate the tilt of the antenna in the way to minimize the interference with neighboring cells 
and optimize the coverage range. 

 PIM Analysis – It helps you view the flatness of the spectrum to analyze PIM. 
 

Figure 332 High-level workflow of BBU emulation 
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Procedure 

1 Press the MODE hard key. 
2 Select RFoFiber > RFoCPRI. 
3 Press the MEASURE hot key. 
4 Select BBU Emulation > Alcatel-Lucent. 

 

NOTE 
CellAdvior FW3.060 supports Alcatel-Lucent BBU only. 

5 Select the mode that you want to open: 
–  Profiling 

–  Configuration Verification > Carrier Information, CPRI & Active SW, or  
SFP Information 

–  Spectrum Clearance > Spectrum, Spectrogram, RSSI, Dual Spectrum, or  
Dual Spectrogram 

–  Coverage Range 

–  PIM Analysis 

 

If the RRH is new and you do not have a saved profile that you can use to configure the RRH, you can run 
this RRH Profiling to capture C&M messages, and retrieve profile parameter values, such as RHH vendor, 
technology, VSWR level, RSSI level, carrier frequency, Link ID, and RE ID, from both BBU and RRH. If you 
already have a saved profile that works for the RRH, you can skip this RRH Profiling.  
 

You need to make the Thru mode cable connection as illustrated in Figure 333 in order to perform profiling. 
 

Figure 333 Thru connection diagram 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
 

 

 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Profiling. 
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3 Press the MEASURE SETUP hot key. 
4 Toggle the Laser soft key and select On. 
5 Press the More (1/2) soft key.   
6 Toggle the Thru soft key and select On. 

 

After you have connected cables and set up your CellAdvisor for the through mode, you need to configure 
measure parameters to capture C&M messages successfully. 
 

Procedure 

1 Press the MEASURE SETUP hot key.  
2 To set the CPRI line bit rate of the fronthaul link between BBU and RRH, complete the following 

steps: 
 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 
 Make sure that the current LOS and LOF alarms are all green. c

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 

3 To set the Rx optic limit to visually check if the received power is within the range that you 
specify, complete the following steps: 

 Press the LIMIT hot key. a
 Press the Rx Optic Level soft key. b
 Set a threshold for High Limit and Low Limit. c
 To enable the Rx optic limit, toggle the Test Limits soft key and select On. d

If the optic power level falls out of the specified thresholds, the color of the power reading or 
indicator turns red. 

 

After you have configured your instrument’s measure parameters, you can start to capture C&M messages 
and retrieve profile information. 
 

Procedure 

1 Press the MEASURE SETUP hot key.  
2 Press the More (1/2) soft key. 
3 To start the profiling, toggle the Profiling soft key and select On. 

The screen displays elapsed time from the start of the profiling and the size of captured data. 
The Profiling screen is updated with retrieved RRH and carrier information. 

4 To stop the profiling after obtaining carrier information that you want, toggle the Profiling soft key 
and select Off. Example is Figure 334. 

 

NOTE 
All carriers in use must display “Enable” and have valid information for all parameters. 
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Figure 334 Example of RRH profiling results with carrier information 

 
 

As you can see in the example of RRH profiling results in  
Figure 334, RRH profiling provides you with the following information: 

 RRH Description – It contains information for a RRH, specified by its manufacturer. It may not be 
identical with the field-optimized information. Some of BBUs may not request this information to the 
RRH depending on its version. 

 Carrier Information – It is field-optimized information that includes carrier frequency and CPRI 
mapping. You can edit the carrier information using the Profile Editor. 
- Carrier: It means a set of signals assigned to and transmitted at a certain frequency. A different 

carrier should be at a different frequency. For example, a triple band RRH activates three 
carriers: Carrier 1, Carrier 2, and Carrier 3. 

- Number of Tx Container: It means how many antenna branches the RRH has. A different Tx 
container is sent to a different antenna branch. For example, a 2x2 MIMO system activated two 
Tx Containers: Tx Container 1 and Tx Container 2. 

- State: It indicates the state of the carrier use. If the carrier is in use, the state changes from 
None to Disable, and then to Enable. 

- Carrier Type: It is the technology and the signal bandwidth information. 
- Uplink and Downlink Frequencies: They are center frequencies of the carrier actually being 

serviced. 
- Uplink Noise: It is the threshold for UL RSSI, expressed in dBFS (Full Scale). 

 

After you have retrieved all necessary information and stopped the RRH profiling, you can change the 
display option to view other parameters than carrier information. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key.  
2 Press the Select Parameter soft key. 
3 Select the display option that you want from the following choices: 
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–  Carrier Information: It contains information of carrier frequencies and CPRI mapping. 

–  CPRI & Active SW: It contains information of CPRI configuration and activated software in 
the RRH. 

–  SFP Information: It contains information of the SFP installed in the RRH. 

 
Figure 335 Example of RRH profiling results with CPRI state and activated SW 

 
 

Figure 336 Example of RRH profiling results with SFP information 

 
 

After you have checked that you have retrieved all required information, you need to save your RRH profiling 
results as a file so that you can use it to configure and bring up a new RRH of the same kind later. 
 

Procedure 

1 Press the SAVE/LOAD hard key.  
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2 Select Save > Save Profile. 
3 Type a file name that you want to use. 
4 Press the Save soft key. 

It saves the profile as a file with .jcm extension. 

 

A BBU connected to the network can send and receive C&M messages to and from a RRH to configure the 
RRH correctly and start it up and running successfully. Using the BBU Emulation available in JD700B series, 
you can work with the RRH, without connecting to a BBU, to configure it correctly as if you do from the BBU. 
 

Before starting to verify RRH configuration using your CellAdvisor as a BBU, you need to make the Term 
mode cable connection as illustrated in Figure 337 and configure the instrument correctly. 
 

Figure 337 Term mode connection diagram 

With nTap: 
 

 

Without nTap: 

 

 
 

 

NOTE 
When your CellAdvisor has two SFP transceivers installed in Port 1 and Port 2, you must 
connect the cables to the SFP in Port 1 because BBU emulation in FW3.060 supports 
and works with Port 1 only.  

 

After you have made the Term mode cable connection, you need to get your CellAdvisor ready to work as a 
BBU. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Configuration Verification > Carrier Information.   
3 Once you change the mode in step 2, the instrument automatically sets itself to be ready for the 

communication with the RRH and starts to update the screen with retrieved RRH profile, 
including RRH and carrier information. Following are the indications of successful connection that 
you can find on the screen: 
–  The status of RRH connection changes to “RRH Connection: On”. 

–  The RRH symbol ( ) appears in the system status bar at the top. 

4 If you do not have these indicators on, press the MEASURE SETUP hot key and check that the 
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following parameters have been set up correctly: 
–  Laser: On 

–  CPRI Parameters > Tx Clock: Internal 

–  CPRI Parameters > Port Type: Master 

–  CPRI Network > Standard Indicator: LTE 

–  CPRI Network > DHCP Server: On 

5 If the type of the connected RRH is not LTE, you can change it to others as needed. 

 

 

NOTE 
Make sure to keep the RRH connection on throughout the BBU emulation.  

 

Once you have enabled the DHCP session, your CellAdvisor starts to retrieve the profile of the connected 
RRH sequentially, updating the RRH description first and then the carrier information. It may take a few 
minutes to complete.  
 

Procedure 

1 In the Carrier Information screen, check the state of the carriers. You must have at least one 
carrier with its state of Disable or Enable. 
–  None: It indicates that the carrier is not in use. 

–  Disable: It indicates that the carrier is in use and your CellAdvisor is waiting for mapping 
information from the RRH. 

–  Enable: It indicates that the carrier is in use and your CellAdvisor retrieved mapping 
information. 

2 Check that the number of the Tx container for the carrier in use is equal to or greater than “1”. 
3 Check if the uplink and downlink frequencies for the carrier are retrieved. Most of the cases you 

will see these fields are “None”, requiring you to use the Profile Editor to send frequency values 
to the RRH. 

 
Figure 338 Example of verification of carrier configuration 

 Profil  
 
Figure 338 is an example of missing carrier frequencies for Carrier 1 and Carrier 2. If any of the required 
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fields for the carriers in use were not retrieved, it means that you have to send C&M messages with new 
parameter values using Profile Editor. You can also load a profile using Load Profile that you have saved in 
the same type of the RRH before to re-configure the RRH. For more information, see “Loading a saved RRH 
profile on page 589 and “Editing RRH profile” on page 590. 
 

You can also verify that the RRH has set for CPRI and activated software correctly.  
 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Configuration Verification > CPRI & Active SW. 

The CPRI & Active SW screen appears with “RRH Connection: On”. 

 
Figure 339 Example of verification of CPRI state and active software 

 Profil  
 

You can also view the SFP information to verify if correct SFPs are installed in the RRH.  
 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Configuration Verification > SFP Information. 

The SFP Information screen appears with “RRH Connection: On”. 
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Figure 340 Example of verification of SFP information 

 Profil  
 

If you already have a saved profile that matches with the RRH, you can load it instead of editing parameters. 
 

Procedure 

1 Press the SAVE/LOAD hard key.  
2 Select Load > Load Profile. 
3 Navigate to the .jcm file that you want to load and send to the connected RRH. 

If the RRH description stored in the file does not match with the description of the connected 
RRH, you will encounter an error message “File Mismatch”.  

4 Press the Load soft key. 
It sends the profile to the RRH to try to set it up with new values as stored in the file. If you are 
viewing all the fields filled with values, you are now done with bringing up the RRH with correct 
configuration. 

 
Figure 341 Example of loading a saved RRH profile 

 Profil  
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If you do not have a save profile that can bring up the connected RRH, you need to edit profile parameters 
with values that work for the RRH. You can edit only carrier parameters. 

Procedure 

1 Make sure that you maintain the RRH connection on. 
2 In the Carrier Information screen, press the MEASURE SETUP hot key. 
3 Press the More (1/2) soft key. 
4 Press the Profile Editor soft key. 

The Profile Editor menu bar appears with the soft keys activated for the carriers in use. For 
example, if the Carrier Information screen shows two carriers with their state DISABLE or 
ENABLE, you will have Carrier 1 and Carrier 2 soft keys activated. 

5 Select the carrier number soft key for which you want to edit values. 
The Profile Editor screen for the selected carrier number appears with the on-screen keyboard as 
shown in Figure 342. 

 

NOTE 
Not always is the order of the parameter names the same. In addition, parameters can 
vary depending on the RRH vendor or technology.  

6 To edit a value in the Value column, complete the following steps: 
 Scroll up or down to navigate to the value field that you want to edit. a
 Tap on the value field, and then enter a new value. Here are some of examples when you b

may need to edit the profile. 
–  If you want to change the carrier state from DISABLE to ENABLE, tap on the value 

field next to the STATE and then type ENABLE.  

–  If you want to enter a downlink frequency of 709 MHz, tap on the value field next to the 
TXFREQ and then enter 709000 in kHz.  

–  If you need to change the retrieved carrier type from LTE_20 to LTE_10 because it is 
actually serviced with 10 MHz bandwidth even though the RRH’s description says  
20 MHz, tap on the value field next to the CARRTYPE and then correct it as LTE_10. 

 

NOTE 
In Profile Editor, you can rename a parameter name or add a new parameter with a value 
for some cases. As doing this requires much knowledge and experience with RRH 
configuration, it is not recommended for general users. 

7 To apply your changes and send your edited C&M message to the RRH, tap the Done button. 
8 Verify that you have received all required information. If you have set up the RRH correctly and 

the RRH has been brought up and running successfully, you will have all fields in the Carrier 
Information filled properly. If not, repeat steps 4-7. 
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Figure 342 Example of RRH profile editor 

 Profil  
 
Following is an example of parameters and values that you can find in Profile Editor. 
 

Table 21 Example of RRH profile parameters and values for 2x2 MIMO 

Parameters Values Description 

STATE ENABLE This is the carrier status. There are three available states: 
- None: Unused 
- Disable: Used but inactivated 
- Enable: Used and activated 
This value must be “ENABLE” for every carrier being used by RRH. 

TXCONTAINER 1 It means the first Tx Container (antenna branch for downlink) that is 
equivalent to AxC Group. Zero (0) is no activation. 
This value must not be used by other containers. 

TX2CONTAINER 2 It means the second Tx Container (antenna branch for downlink) that 
is equivalent to AxC Group. Zero (0) is no activation. 
This value must not be used by other containers. 

RX1CONTAINER 1 It means the first Rx Container (antenna branch for uplink) that is 
equivalent to AxC Group. Zero (0) is no activation. 
This value must not be used by other containers. 

RX2CONTAINER 2 It means the second Rx Container (antenna branch for downlink) that 
is equivalent to AxC Group. Zero (0) is no activation. 
This value must not be used by other containers. 

GRPSIZEDOWN 4 It means four downlink AxC containers are used for Tx Container. 
Signal 

Bandwidth 3 MHz 5 MHz 10 MHz 15 MHz 20 MHz 

GRPSIZEDOWN 1 2 4 6 8 
 

GRPSIZEUP 4 It means four uplink AxC containers used for Rx Container. 
Signal 

Bandwidth 3 MHz 5 MHz 10 MHz 15 MHz 20 MHz 

GRPSIZEUP 1 2 4 6 8 
 

TXFREQ 782000 This value is the carrier’s downlink center frequency in kHz. 

RXFREQ 751000 This value is the carrier’s uplink center frequency in kHz. 

POWER 447 This value must be between the minimum and the maximum Tx 
power levels that are displayed in the RRH Description pane and be 
expressed in 0.1 dB. 



Chapter 15 Performing RFoCPRI Testing 

592 JD700B Series User’s Guide 

SIGTYPE NONE This is a default setting for RRH. Do not change. 

CARRTYPE LTE_10 This is a default setting for RRH. It is not recommended, but you can 
change the signal bandwidth as needed when you have to. 

ULNOISE -6442 It means the uplink noise floor threshold expressed in 0.01 dBFS. 
This is a default setting for RRH. Do not change. 

APCFPOWER 0 This is for RFM overload protection. 
This is a default setting for RRH. Do not change. 

 

After you have successfully brought up and running the RRH, you can save your complete profile as a file so 
that you can use it to configure and bring up other RRHs of the same kind later. 
 

Procedure 

1 Press the SAVE/LOAD hard key.  
2 Select Save > Save Profile. 
3 Type a file name that you want to use. 
4 Press the Save soft key. 

It saves the profile as a file with .jcm extension. 

 

After you have started up the RRH successfully, meaning that you have at least one enabled carrier with 
uplink and downlink frequency information, you can move to Spectrum Clearance to identify any interfering 
signals in the uplink carrier by performing the following measurements while keeping your CellAdvisor to 
work as a BBU. 
 
This instrument provides the following measurements in the BBU Emulation mode: 

 Spectrum 

 Spectrogram 

 RSSI 

 Dual spectrum 

 Dual spectrogram 
 

 

NOTE 
It is very important that you maintain the Term mode cable connection as illustrated in 
Figure 337 and keep the RRH connection on as you have done in the RRH configuration 
verification. 

 

In this Spectrum mode, you only need to change the following settings as needed.  

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Spectrum Clearance > Spectrum. 
3 Press the MEASURE SETUP hot key. 
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4 To select the carrier and Tx container to measure, complete the following steps: 
 Press the CPRI Parameters soft key. a
 Press the Select Carrier soft key, and then select the carrier of your choice. b

Only carriers that have been enabled have activated soft keys. 
 Press the Select Tx Container soft key, and then select the Tx Container of your choice. c

 

NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

5 To enable alarm sound, complete the following steps: 
 Press the MEASURE SETUP hot key. a
 Press the Sound Indicator soft key. b
 Toggle the Alarm Reference soft key and select the option from the choices: c

–  Marker: Sets the active marker position as the alarm reference if you have enabled a 
marker on the spectrum. 

–  Line: Lets the limit line as the alarm reference. 

 If you have set the alarm reference to Line, press the Limit Line soft key to set a threshold d
for an alarm. 

 Enter a value, and then press the dBm soft key. e
 Toggle the Sound soft key and select On to enable or Off to disable. f
 Optional. To adjust the volume for alarm sound, press the Volume soft key, and then turn g

the rotary knob clockwise or counter clockwise. 
6 To set the interference ID, complete the following steps: 

 Press the MEASURE SETUP hot key and then the More (1/2) soft key. a
 Press the Interference ID soft key. b
 Press the Threshold soft key. c
 Enter a value, and then press the dBm soft key. d
 Toggle the Interference ID soft key and select On to turn on Interference ID or Off to turn e

it off. 

 

NOTE 
The Interference ID automatically classifies interfering signals over a designated 
spectrum and displays a list of possible signal types corresponding to the selected signal. 

7 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 
SETUP hot key, the More (1/2) soft key, and then the Clear History soft key. 

 
Figure 343 Example of spectrum measurement in BBU emulation 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the limit line or multi-
segment line. See “Setting limit for spectrum clearance” on page 599 for more information. 

 

If you have two or more carriers enabled, you can view two spectrums for different carriers and Tx 
containers simultaneously. If you enable the Dual Active Trace function that is available in the Dual Spectrum 
mode, you can view two sweeping traces, one from the top window and the other from the bottom window, 
overlapped on one chart. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Spectrum Clearance > Dual Spectrum. 
3 Press the MEASURE SETUP hot key. 
4 Toggle the Active Window soft key and select [Top|Bottom]. You can also tap on the top or 

bottom chart. 
5 To select the carrier and Tx container, complete the following steps: 

 Press the CPRI Parameters soft key. a
 Press the Select Carrier soft key, and then select the carrier of your choice. b

Only carriers that have been enabled have activated soft keys. 
 Press the Select Tx Container soft key, and then select the Tx Container of your choice. c

 

NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

6 To view both traces writing currently in each window together on one chart with overlapping, 
complete the following steps: 

 Press the More (1/2) soft key in the Measure Setup menu bar. a
 To enable the overlap view, toggle the Dual Active Trace and select On. b

Traces from the top and bottom charts appear overlapped on one chart. 

 

NOTE 
There appears [Top] or [Bottom] at the top left of the chart to indicate which window is 
active now. Currently selected active window’s trace is brought to front in its bold color 
while the inactive window’s trace sent to back with lighter color. 

 To change the selection of the active window and trace(s), press the PREV hard key and c
then toggle the Active Window soft key between Top and Bottom. You can also tap on the 
upper or lower portion of the chart on the screen. 

 To disable the overlap view and return to the dual spectrum view, toggle the Dual Active d
Trace and select Off. 

7 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 
SETUP hot key, the More (1/2) soft key, and then the Clear History soft key. 
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Figure 344 Example of dual spectrum analysis in BBU emulation 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the limit line or multi-
segment line. See “Setting limit for spectrum clearance” on page 599 for more information. 

 

In this Spectrogram mode, you only need to change the following settings as needed. 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Spectrum Clearance > Spectrogram. 
3 Press the MEASURE SETUP hot key. 
4 To select the carrier and Tx container to measure, complete the following steps: 

 Press the CPRI Parameters soft key. a
 Press the Select Carrier soft key, and then select the carrier of your choice. b

Only carriers that have been enabled have activated soft keys. 
 Press the Select Tx Container soft key, and then select the Tx Container of your choice. c

 

NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

5 To set the amount of time between each trace measurement: 
 Press the More (1/2) soft key and then the Time Interval soft key. a
 Enter a value, and then press the Sec soft key. b

6 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 
 To turn the time cursor off, toggle the Time Cursor soft key and select Off. d

 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

7 To start a new measurement, press the Reset/Restart soft key. 
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8 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 
SETUP hot key, the More (1/2) soft key, and then the Clear History soft key. 

 
Figure 345 Example of spectrogram in BBU emulation 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the limit line or multi-
segment line. See “Setting limit for spectrum clearance” on page 599 for more information. 

 

The Dual Spectrogram feature lets you observe two spectrograms for different carriers and Tx containers 
simultaneously. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Spectrum Clearance > Dual Spectrogram. 
3 Press the MEASURE SETUP hot key. 
4 Press the More (1/2) soft key. 
5 Toggle the Active Window soft key and select [Left|Right]. You can also tap on the left or right 

chart. 
6 To select the carrier and Tx container to measure, complete the following steps: 

 Press the More (2/2) soft key. a
 Press the CPRI Parameters soft key. b
 Press the Select Carrier soft key, and then select the carrier of your choice. c

Only carriers that have been enabled have activated soft keys. 
 Press the Select Tx Container soft key, and then select the Tx Container of your choice. d

 

NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

7 To set the amount of time between each trace measurement: 
 Press the MEASURE SETUP hot key and then the More (1/2) soft key. a
 Press the Time Interval soft key. b
 Enter a value, and then press the Sec soft key. c
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8 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 
 To turn the time cursor off, toggle the Time Cursor soft key and select Off. d

 

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

9 To start a new measurement, press the Reset/Restart soft key. 
10 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 

SETUP hot key, the More (1/2) soft key, and then the Clear History soft key. 

 
Figure 346 Example of dual spectrogram analysis in BBU emulation 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the limit line or multi-
segment line. See “Setting limit for spectrum clearance” on page 599 for more information. 

 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly useful for 
measuring power-level variations over time. The RSSI measurement lets you assign power limit line for 
audible alarms and increase alarm counters every time a signal exceeds a defined limit line. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Spectrum Clearance > RSSI. 
3 Press the MEASURE SETUP hot key. 
4 To select the carrier and Tx container to measure, complete the following steps: 

 Press the CPRI Parameters soft key. a
 Press the Select Carrier soft key, and then select the carrier of your choice. b

Only carriers that have been enabled have activated soft keys. 
 Press the Select Tx Container soft key, and then select the Tx Container of your choice. c
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NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

5 To set up the alarm parameters, complete the following steps: 
 Press the More (1/2) soft key and then the Alarm soft key. a
 Press the Alarm at soft key, and then select the marker number you want to set. b
 Press the Limit Line soft key to set a threshold for the alarm. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the dBm soft key. e
 Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. f

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as these features use 
the marker position to sound an alarm. See “Using marker” on page 54 for more 
information. 

 Optional. Press the Volume soft key and adjust the volume. g
6 Press the PREV hard key to return to the Measure Setup menu bar. 
7 To start a new measurement, press the Reset/Restart soft key. 
8 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 

SETUP hot key, the More (1/2) soft key, and then the Clear History soft key.  

 
Figure 347 Example of RSSI in BBU emulation 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the limit line or multi-
segment line. See “Setting limit for spectrum clearance” on page 599 for more information. 

 

CPRI delivers spectrum bandwidth information based on the sampling frequency of a carrier as specified in 
the 3GPP specification. 
 

Signal Bandwidth 3 MHz 5 MHz 10 MHz 15 MHz 20 MHz 

Transmission Bandwidth 2.7 MHz 4.5 MHz 9 MHz 13.5 MHz 18 MHz 

Sampling Frequency 3.84 MHz 7.68 MHz 15.36 MHz 23.04 MHz 30.72 MHz 
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Even though it limits that you can view spectrum only within the sampling frequency, the Zoom In feature in 
JD700B series makes it easy to view the spectrum in detail. 
 

Procedure 

1 Press the MARKER hard key and place the marker at the frequency that you want to zoom in. 
You will see the Zoom In menu in the Marker menu bar. 

2 Press the Zoom In soft key. 
3 Toggle the Zoom In soft key in the Zoom In menu bar and select On. 

The display refreshes with the marker frequency centered in the current spectrum view. You will 
notice “Zoom-in Frequency” at the bottom of the chart. 

 

NOTE 
Turning on Zoom In does not affect the center frequency that you have set with the 
FREQ/DIST hard key. You can still view your original center frequency information in the 
input settings pane at the top. 

4 To change the zoom-in center frequency, complete the following steps. 
 Press the Zoom-in Center Frequency soft key. a
 Enter a value, and then press one of the unit soft keys that you want to select. b

You can also turn the rotary knob. 
5 To change the zoom-in span, complete the following steps: 

 Press the Zoom-in Span soft key. a
 Enter a value, and then press one of the unit soft keys that you want to select. b

You can also turn the rotary knob. 

 

NOTE 
You can have the span as low as 10 kHz. An error message appears if you change the 
zoom-in center frequency or span out of the range, which is automatically determined by 
the instrument based on the sampling frequency. 

6 To view a different position on the original spectrum, complete the following steps: 
 Toggle the Zoom In soft key and select Off. a

The screen goes back to the original spectrum. 
 Move the marker to a new position on the spectrum. b
 Turn the rotary knob to change the marker position. c
 Toggle the Zoom In soft key and select On again. d

The display refreshes with the new marker frequency centered in the current spectrum 
view. You will notice “Zoom-in Frequency” at the bottom of the chart. 

7 To disable Zoom In, toggle the Zoom In soft key in the Zoom In menu bar and select Off. 

 

You can set a display line or multi-segment limit line to analyze results better. 
 

Procedure 

To set a single limit line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and hide the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
 
To set a multi-segment limit line: 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 
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 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 
6 To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information 

 

If your CellAdvisor has the CPRI source installed, you can use it to check the coverage range of the antenna 
and adjust its tilt to maximize the coverage range as much as possible. 
 

 

NOTE 
It is very important that you maintain the Term mode cable connection as illustrated in 
Figure 337 and keep the RRH connection on as you have done in the RRH configuration 
verification. 

 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > Coverage Range. 
3 Press the MEASURE SETUP hot key. 
4 Select More (1/2) > Source > CPRI Source. 
5 Press the Select Carrier soft key, and then select the carrier of your choice. 

Only carriers that have been enabled have activated soft keys. 
6 Press the Select Tx Container soft key, and then select the Tx Container of your choice. 

 

NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

7 To set the power level, complete the following steps: 
 Press the Power Level soft key. a
 Enter a value, and then press the Enter soft key. b

8 To select the CW waveform, complete the following steps: 
 Press the Waveforms soft key. a

The Waveform list dialog box appears. 
 From the list, select CW or one of the LTE signals that you want to transmit to the RRH. b
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NOTE 
If you have a second unit of JD700B series or a scanner, you can use it to measure RS 
Power and RS SINR with transmitting a LTE signal from your CellAdvisor to the RRH so 
that you can optimize the coverage more accurately. 

 Tap the Apply button on the screen or press the ENTER hard key. c
9 To start to inject the CW signal, toggle the CPRI Source soft key and select On. 
10 Optional. To enable alarm sound, complete the following steps: 

 Press the MEASURE SETUP hot key. a
 Press the Sound Indicator soft key. b
 Toggle the Alarm Reference soft key and select the option from the choices: c

–  Marker: Sets the active marker position as the alarm reference if you have enabled a 
marker on the spectrum. 

–  Line: Lets the limit line as the alarm reference. 

 If you have set the alarm reference to Line, press the Limit Line soft key to set a threshold d
for an alarm. 

 Enter a value, and then press the dBm soft key. e
 Toggle the Sound soft key and select On to enable or Off to disable. f
 To adjust the volume for alarm sound, press the Volume soft key, and then turn the rotary g

knob clockwise or counter clockwise. 
11 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 

SETUP hot key, the More (1/2) soft key, and then the Clear History soft key. 

 
Figure 348 Example of coverage range in BBU emulation 

 
 

Procedure 

1 In the Coverage Range mode, press the MEASURE SETUP hot key. 
2 Select More (1/2) > Antenna Tilt. 
3 To select the antenna that you want to manipulate, complete the following steps: 

 Press the Select Antenna soft key to select the antenna port in the RRH. a
 Enter the value that you know, and then press the Enter soft key. b
 If there are more than one antenna chained for the selected antenna port, press the  c

ALD SUB soft key to select the antenna line device subscription number. 
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 Enter the value that you know, and then press the Enter soft key.  d
4 To manipulate the tilt of the selected antenna, complete the following steps: 

 Press the Degree soft key. a
 Enter a value within the range that you know for the selected antenna. b
 Press the Enter soft key. c

The antenna tilts forward accordingly. 

 

NOTE 
It is recommended that you wait for a few minutes because it may take two minutes or so 
to get the antenna actually tilted. 

5 Check the coverage range again to see if you have the antenna tilt at its best. 

 

If your CellAdvisor has the CPRI source installed, you can use it to view the flatness of the spectrum.  
 

 

NOTE 
It is very important that you maintain the Term mode cable connection as illustrated in 
Figure 337 and keep the RRH connection on as you have done in the RRH configuration 
verification. 

 

Procedure 

1 Press the MEASURE hot key. 
2 Select BBU Emulation > Alcatel-Lucent > PIM Analysis. 
3 Press the MEASURE SETUP hot key. 
4 Select More (1/2) > Source > CPRI Source. 
5 Press the Select Carrier soft key, and then select the carrier of your choice. 

Only carriers that have been enabled have activated soft keys. 
6 Press the Select Tx Container soft key, and then select the Tx Container of your choice. 

 

NOTE 
In the BBU Emulation mode, retrieved carrier and Tx container information is used for  
de-mapping and signal transmission instead of Map Position. 

7 To set the power level, complete the following steps: 
 Press the Power Level soft key. a
 Enter a value, and then press the Enter soft key. b

8 To select the CW waveform, complete the following steps: 
 Press the Waveforms soft key. a

The Waveform list dialog box appears. 
 Select one of the LTE E_UTRA Test Model waveforms available in the list as desired. b

Supported bandwidths are 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Tap the Apply button on the screen or press the ENTER hard key. c

9 To start to inject the CW signal, toggle the CPRI Source soft key and select On. 
10 To enable alarm sound, complete the following steps: 

 Press the MEASURE SETUP hot key. a
 Press the Sound Indicator soft key. b
 Toggle the Alarm Reference soft key and select the option from the choices: c

–  Marker: Sets the active marker position as the alarm reference if you have enabled a 
marker on the spectrum. 

–  Line: Lets the limit line as the alarm reference. 

 If you have set the alarm reference to Line, press the Limit Line soft key to set a threshold d



Chapter 15 Performing RFoCPRI Testing 

 JD700B Series User’s Guide 603 

for an alarm. 
 Enter a value, and then press the dBm soft key. e
 Toggle the Sound soft key and select On to enable or Off to disable. f
 Optional. To adjust the volume for alarm sound, press the Volume soft key, and then turn g

the rotary knob clockwise or counter clockwise. 
11 To set the interference ID, complete the following steps: 

 Press the MEASURE SETUP hot key and then the More (1/2) soft key. a
 Press the Interference ID soft key. b
 Press the Threshold soft key. c
 Enter a value, and then press the dBm soft key. d
 Toggle the Interference ID soft key and select On to turn on Interference ID or Off to turn e

it off. 

 

NOTE 
The Interference ID automatically classifies interfering signals over a designated 
spectrum and displays a list of possible signal types corresponding to the selected signal. 

12 To clear current (C) and history (H) status of CPRI alarm on LOS and LOF, press the MEASURE 
SETUP hot key, the More (1/2) soft key, and then the Clear History soft key. 

 

The flatness in this PIM analysis is an elevation angel that two points create, resulting from the difference in 
power level at the two ends. 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Select More (1/2) > Flatness. 
3 To set the bandwidth for the flatness calculation, complete the following steps: 

 Press the Bandwidth soft key. a
 Enter a value that is smaller than the transmission bandwidth to prevent the spectrum data b

points from being at the edges of the chart.  
4 Toggle the Flatness soft key and select On. 
5 To turn it off, toggle the Flatness soft key and select Off. 

 
Figure 349 Example of PIM analysis in BBU emulation 

 
 



 
 

   

 

 

 

This chapter provides instructions for using the RFoOBSAI function that requires Optical Hardware (option 
008), RFoOBSAI Interference Analyzer (options 070 – 073), and RFoOBSAI LTE-FDD Signal Analyzer 
(option 096). Topics discussed in this chapter are as follows: 
 

 Introduction .............................................................................................................................. 605 

 Display overview ..................................................................................................................... 605 

 Selecting measurement mode ................................................................................................ 606 

 Performing layer 2 monitoring ................................................................................................. 606 

 Performing layer 2 term testing ............................................................................................... 609 

 Performing interference analysis ............................................................................................. 612 

 Performing PIM detection (single and multiple carriers) ......................................................... 624 

 Performing LTE-FDD downlink signal analysis ....................................................................... 627 

 Using signal generator ............................................................................................................ 652 
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Cell sites today have a distributed architecture of the radio that consists of the baseband (BB) module or 
baseband unit (BBU) installed at the bottom of the tower and the remote RF unit (RRU) or remote radio 
head (RRH) installed at the top of the tower. These two elements interface with each other for data transfer 
over fiber links via the Reference Point 3 (RP3) protocol, which is specified by Open Base Station 
Architecture Initiative (OBSAI). 
 
This distributed architecture provides the benefit of replacing coax-based feeders with fiber- based feeders, 
significantly reducing the problems of signal loss and reflections. However, since all the RF modules reside 
on the RRU, any RF maintenance or troubleshooting requires climbing to the top of the tower to access the 
RRU, increasing operational cost and unnecessary safety issues. 
 
JD700B series analyzers provide the option of RFoOBSAI that allows you to perform RF maintenance and 
troubleshooting activities on the ground via the fiber interfaces at the BB module, significantly reducing 
maintenance time and operational expenses. Thanks to the RFoOBSAI technology, you can verify the 
OBSAI RP3 protocol and extracts the RP3 messages transmitted between the BBU and RRU to monitor and 
analyze the uplink interferences and the downlink signals. 
 
The RFoOBSAI testing provides following measurements and analysis: 
 

 Layer 2 monitoring of link maintenance errors and optical power 
o Loss of Signal (LOS) 
o Loss of Frame (LOF) – Frame synchronization or alignment 
o Optical Rx and Tx power levels 
o Line Code Violation 
o Rx K30.7 words 
o RP3 address/message counts 

 Layer 2 terminate testing 
 Interference analysis 

o Spectrum 
o Spectrogram 
o Received Signal Strength Indicator (RSSI) 
o Spectrum replayer 

 PIM detection of single or multiple carrier(s) 
 LTE-FDD downlink signal analysis over OBSAI 

o Spectrum 
o RF analysis – Channel Power and Occupied Bandwidth 
o Power vs. Time (Frame) 
o Modulation analysis – Constellation, Data Channel, Control Channel, Subframe, Frame, 

Time Alignment Error, and Data Allocation Map 
o Power Statistics CCDF 

 

Figure 350 provides descriptions for each segment of the measurement screen. 
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Figure 350 RFoOBSAI analysis screen 

 

 

Procedure 

1 Press the MODE hard key. 
2 Press the RFoFiber soft key. 
3 Press the RFoOBSAI soft key. The Layer 2 Monitoring mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Layer 2 Monitoring 

–  Layer 2 Term 

–  Interference Analyzer > Spectrum, Spectrogram, RSSI, or Spectrum Replayer 

–  PIM Detection > PIM Detection Single Carrier, PIM Detection Multiple Carriers, or 
Calculated PIM 

–  Signal Analyzer > LTE-FDD > Spectrum, RF Analysis, P vs T (Frame),  
Modulation Analysis, or Power Statistics CCDF 

 

The in-service Layer 2 Monitoring is used to monitor link maintenance errors of the physical layer (Layer 1) 
of the RP3 bus protocol. It also verifies proper optical power levels of the received and transmitted signals. 
 

The monitoring mode lets you perform in-service testing by using coupler(s) or nTap(s). You can connect 
cables with a tap or without a tap as illustrated in Figure 351. If you have connected cables directly from 
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RRU and BBU without using the nTap, you must turn on the through mode (Thru) in the Measure Setup 
menu. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 351 Connection diagram for Layer-2 monitoring mode 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
 

 

 

Procedure 

1 Press the MEASURE hot key. 
2 Select Layer 2 Monitoring. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Link Rate soft key to set the line rate of the OBSAI RP3 interface between the BB and 

the RRU. 
3 Select the RP3 line rate option from the choices: 768 Mbps, 1536 Mbps, 3072 Mbps, and  

6144 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 
 
If you select 6144 Mbps, the Scrambler Seed soft key becomes active in the OBSAI 
Parameters menu so that you can specify a seed value to avoid false byte alignment. 

4 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 
To turn it off, select Off. 

 

A RRH has a finite dynamic range for input optic power and it can cause an abnormal behavior of the RRH if 
the optical power is weaker than certain level. To differentiate intermittent low optic power issues from any 
RSSI, interference and signal quality issues, it is important for you to monitor the input optic power level 
during the monitoring of the spectrum and the signal quality. Using this Rx optic limit feature, you can set 
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lower and upper limits and monitor the Rx optic level with Pass/Fail indication in green and red colors. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Rx Optic Level soft key. 
3 Set a threshold for High Limit and Low Limit. 
4 To enable the Rx optic limit, toggle the Test Limits soft key and select On. 

If the optic power level falls out of the specified thresholds, the color of the power reading or 
indicator turns red. 

5 To disable the Rx optic limit, toggle the Test Limits soft key and select Off. 

 

After you have set the test parameters, you can monitor errors in OBSAI L2 signals. 
 

Procedure 

1 Monitor the following error indicators and the optical signal level. Test results in green indicate no 
detection of errors and red ones represent occurrence(s) of errors. 
–  LOS: Loss of Signal (code violation or low optical power) 

–  LOF: Loss of Frame (frame synchronization or alignment) 

–  Optic Rx Level: If the optical signal level is lower than the threshold, the OBSAI RP3 link 
may not work properly and the RRU may not be in service mode. 

–  Code Violations: Number of occurrence of invalid line codes 

–  Rx K30.7 Words: Number of counts of K30.7 character, which indicates an error in the byte 

–  RP3 Address: Rx RP3 addresses in the received messages 

–  Message Counts: Number of counts of received messages addressed to the same RP3 
address specified in the Measure Setup > OBSAI Parameters > Rx RP3 Address  

 

NOTE 
If you have selected the link rate 6144 Mbps, displayed RP3 addresses may include 
invalid or erroneous addresses.  

2 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 
format. See “Using save” on page 33 for more information. 

3 To clear the previous event history and start a new monitoring, press the MEASURE SETUP hot 
key and then the Clear History soft key. 
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Figure 352 OBSAI RP3 layer 2 monitoring 

 
 

The out-of-service Layer 2 Term is to test the OBSAI RP3 fronthaul in the terminated state and it is used to 
monitor link maintenance errors of the physical layer (Layer 1) of the RP3 bus protocol. It also verifies proper 
optical power levels of received and transmitted signals. 
 

The terminate mode allows you to do out-of-service testing. You can connect cables with a tap or without a 
tap as illustrated in Figure 353. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 353 Connection diagram for Layer-2 term testing mode 

With nTap: 
 

 

Without nTap: 
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Procedure 

1 Press the MEASURE hot key. 
2 Select Layer 2 Term. 

 

Procedure 

1 Press the MEASURE SETUP hot key  
2 Press the Link Rate soft key to set the line rate of the OBSAI RP3 interface between the BB and 

the RRU. 
3 Select the RP3 line rate option from the choices: 768 Mbps, 1536 Mbps, 3072 Mbps, and  

6144 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 
 
If you select 6144 Mbps, the Scrambler Seed soft key becomes active in the OBSAI 
Parameters menu so that you can specify a scrambler seed. 

4 Make sure to turn off the through mode by toggling the Thru soft key and selecting Off. 
5 Press the OBSAI Parameters soft key to select the port type and the clock reference. 
6 Toggle the Port Type soft key and select Master. 
7 Press the Tx Clock soft key, and then select Internal for transmission clock reference. 

 

A RRH has a finite dynamic range for input optic power and it can cause an abnormal behavior of the RRH if 
the optical power is weaker than certain level. To differentiate intermittent low optic power issues from any 
RSSI, interference and signal quality issues, it is important for you to monitor the input optic power level 
during the monitoring of the spectrum and the signal quality. Using this Rx optic limit feature, you can set 
lower and upper limits and monitor the Rx optic level with Pass/Fail indication in green and red colors. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Rx Optic Level soft key. 
3 Set a threshold for High Limit and Low Limit. 
4 To enable the Rx optic limit, toggle the Test Limits soft key and select On. 

If the optic power level falls out of the specified thresholds, the color of the power reading or 
indicator turns red. 

5 To disable the Rx optic limit, toggle the Test Limits soft key and select Off. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the More (1/2) soft key to go to the Alarm/Error and Laser menus. 
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3 Toggle the Laser soft key and select On to activate the transmission. 
4 To insert a code error, complete the following steps: 

 Toggle the Error Type soft key between Code and K30.7 and select Code. a
 Toggle the Insert Type soft key between Single and Rate and select the insert type option b

you want. 
–  Single: It inserts an error once and then turns off the error insertion. 

–  Rate: It inserts an error according to the set error rate in the Error Rate menu. 

 If you have selected Rate in step b, press the Error Rate and then select the error rate c
option from the choices: 1E-3, 1E-4, 1E-5, 1E-6, 1E-7, 1E-8, and 1E-9. 

 Toggle the Error Insertion soft key and select On to start to insert the specified error. d
 To stop inserting the error, toggle the Error Insertion soft key and select Off. e

5 To insert a K30.7 error signal, complete the following steps: 
 Toggle the Error Type soft key between Code and K30.7 and select K30.7. a
 Toggle the Error Insertion soft key and select On to insert the specified error. b

The K30.7 error signal is one time insertion. This setting changes back to Off after insertion. 
6 Check the real time results on the screen. 

–  LOS: Loss of Signal (code violation or low optical power) 

–  LOF: Loss of Frame (frame synchronization or alignment) 

–  Optic Rx Level: If the optical signal level is lower than the threshold, the OBSAI RP3 link 
may not work properly and the RRU may not be in service mode. 

–  Optic Tx Level: If the optical signal level is lower than the threshold, the OBSAI RP3 link 
may not work properly and the BB may not be in service mode. 

–  Word Sync Loss Events: Number of occurrence of word sync losses 

–  Code Violations: Number of occurrence of invalid line codes 

–  Rx K30.7 Words: Number of counts of K30.7 character, which indicates an error in the byte 

–  Frame Sync Loss Events: Number of detected frame sync losses 

7 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 
format. See “Using save” on page 33 for more information. 

8 To clear the previous event history and start a new testing, press the PREV hard key and then 
press the MEASURE SETUP hot key and then the Clear History soft key. 
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Figure 354 OBSAI layer 2 term test 

 
 

After checking that the link connection is good with no errors, you can proceed to the interference analysis 
activities including spectrum, spectrogram, RSSI, and spectrum replayer. You can also monitor current and 
history OBSAI alarm status for LOS and LOF displayed on the interference measurement screen. 
 

You can connect cables with a tap or without a tap as illustrated in Figure 355. If you have connected cables 
directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the 
Measure Setup menu. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 355 Connection diagram for interference analysis 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
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Procedure 

1 Press the MEASURE hot key. 
2 Press the Interference Analyzer soft key. 
3 Select the interference measurement mode from the following choices:  

–  Spectrum 

–  Spectrogram 

–  RSSI 

–  Spectrum Replayer 

 

Configuration of test parameters described in this section is used in the Interference Analyzer mode 
including spectrum measurements, spectrogram, and RSSI. 
 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the frequency with center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of increment for rotary operation, complete the following steps: 

 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the frequency with channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the scanning direction and select Fwd (forward) or Rev 

(reverse). 
5 Press the Channel Number soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob. 
7 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 
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8 Optional. To define the amount of increment for rotary operation, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the reference level automatically or manually to optimize the display of the traces measured, as 
you desire. 
 

Procedure 

To automatically set the reference level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, the Y-axis scale changes to be optimized with some margin. 
 
To set the reference level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

You can use the Scale/Div feature to change the scale per division, representing the value of one division 
on the horizontal scale. The default setting is 10 dB per division and the maximum value can be set up to  
20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset, and the measurement result shows the value reflecting both offset values. When the 
external offset value is set at 40 dB, the measurement result compensates 40 dB. 
 

Procedure 

To set the external offset: 
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1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

To turn the external offset off: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

It is normal that you see higher level of RSSI in OBSAI spectrum than you have seen in RF spectrum 
because the digital signal has a different gain level from RF’s. If you use the Auto Leveling feature and enter 
the Noise Figure (NF) for the system to be tested, the instrument calculates an offset that compensates the 
digital gain of RRH and applies it to the spectrum automatically to displace the level of spectrum to a known 
RSSI power even though its accuracy cannot be guaranteed. Offset calculation for Auto Leveling is based 
on the following: 
 
Auto Level offset = (Noise Floor of RFoOBSAI) – (Ideal Noise Floor of RRH), where (Idea Noise Floor) =  
N.F (RRH) + Thermal Noise + 10log (RBW) 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Press the Auto Leveling soft key. 

A calculated level of offset without NF is applied as the external offset and the user input field is 
activated for entry of the noise figure value. 

3 Enter a noise figure value by using the numeric keys. 

 

NOTE 
Having the noise figure factored in the offset calculation for Auto Leveling will enable you 
to view the OBSAI spectrum closer to what you can view in the RF spectrum, but if you 
do not know the noise figure, you can skip this noise figure setting. 

4 Press the dB soft key to complete the entry. 
New external offset value appears in the External Offset menu box. 

 

You can set the RBW and VBW in the Spectrum, Spectrogram, and RSSI modes. The RBW range is limited 
as per the bandwidth of the signal under test. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key to set the resolution bandwidth. 
3 Enter a value in 1-3 sequence by using the numeric keys, and then select kHz soft key. 

You can also use the rotary knob. 
–  For signal bandwidths 1.4 MHz and 3 MHz: RBW from 1 kHz to 30 kHz 

–  For signal bandwidths 5 MHz, 10 MHz, 15 MHz, and 20 MHz: RBW from 1 kHz to 100 kHz 

4 Press the VBW soft key to set the video bandwidth. 
5 Enter a value by using the numeric keys, and then select the unit option from the choices:  

MHz, kHz, and Hz. You can also use the rotary knob. 
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You can set the number of measurements to be averaged for the trace presentation in the Spectrum, 
Spectrogram, and RSSI modes. A maximum of 100 times of averaging can be set. When the averaging 
reaches to your setting, a new measurement value replaces the measurement value in sequence from the 
earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between one and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. This setting is used in the 
Spectrum, Spectrogram, and RSSI modes. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 
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Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 To select the detection option, select More (1/2) > Detectors, and then do one of the following: 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 

5 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

 

NOTE 
To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Procedure 

1 Press the MEASURE SETUP hot key  
2 Press the Link Rate soft key to set the line rate of the OBSAI RP3 interface between the BB and 

the RRU. 
3 Select the RP3 line rate option from the choices: 768 Mbps, 1536 Mbps, 3072 Mbps, and  

6144 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 
 
If you select 6144 Mbps, the Scrambler Seed soft key becomes active in the OBSAI 
Parameters menu so that you can specify a scrambler seed. 

4 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 
To turn it off, select Off. 

5 Press the OBSAI Parameters soft key, and then do the following: 
–  To specify Rx RP3 Type and RP3 Address of the received message for link rates  

768 Mbps, 1536 Mbps, and 3072 Mbps, complete the following steps: 
 Select More (1/2) > Rx Address List. a

The Rx Address List box appears. JD700B series lists all Rx messages detected by the 
instrument with RP3 Address and RP3 Type values. 
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 From the list, select the message to monitor. b
 Tap the Apply button. c

The instrument automatically sets the RP3 Address and RP3 Type with the selected 
values. 

 

NOTE 
You can also manually specify the RP3 Address and RP3 Type for the received message 
using the Rx RP3 Type and Rx RP3 Address soft keys. 

 If you have selected a WCDMA/FDD message, toggle the WCDMA Link soft key and d
select the link direction between FWD for forward (downlink) and REV for reverse 
(uplink). 

–  To specify Rx RP3 Type and RP3 Address of the received message for link rate 6144 Mbps, 
complete the following steps: 

 Select More (1/2) > Rx Address Valid List. a
The Rx Address List box appears. Unlike the Rx Address List, the Rx Address Valid 
List feature shows only the messages that contain scrambling code seed values. 

 From the list, select the message to monitor. b
 Tap the Apply button. c

The instrument automatically sets the RP3 Address, RP3 Type, and Scrambler Seed 
with the selected values. 

 

NOTE 
You can also manually specify the RP3 Address, RP3 Type, and Scrambler Seed for the 
received message using the Rx RP3 Type, Rx RP3 Address, and Scrambler Seed soft 
keys. 

 If you have selected a WCDMA/FDD message, toggle the WCDMA Link soft key and d
select the link direction between FWD for forward (downlink) and REV for reverse 
(uplink). 

–  To set the port type and transmission clock reference, complete the following steps: 
 Toggle the Port Type soft key and select Slave (default). a
 Press the Tx Clock soft key, and then select Recovered (default). b

6 Press the Bandwidth soft key, and then specify the bandwidth depending on the RP3 type of the 
received signal. 
–  WCDMA/FDD REV (uplink): 5 MHz 

–  WCDMA/FDD FWD (downlink): 3 MHz 

–  LTE: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

The RBW range changes based on this bandwidth setting. 

7 Optional. To use the RF signal generator function, see “Using RF source in RFoOBSAI testing” 
on page 652. 

 

After setting test parameters as described in “Configuring test parameters” on page 613, you can perform 
spectrum measurements with an audible indicator. You can also turn on the interference ID. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the sound indicator, complete the following steps: 

 Press the Sound Indicator soft key. a
 Select the alarm reference option from the choices: Marker and Line. b

–  Marker: Sets the active marker position as the alarm reference. 

–  Line: Lets the limit line as the alarm reference. 

 Press the Limit Line soft key to set a threshold for an alarm. c
 Enter a value, and then press the dBm soft key. d
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 Toggle the Sound soft key and select On to enable to sound or Off to turn it off. e
 Optional. To adjust the volume for alarm sound, press the Volume soft key, and then turn f

the rotary knob clockwise or counter clockwise. 

 

NOTE 
The Sound Indicator is used to identify interfering signals with alarm sound. It is 
especially useful for locating interferer sources with a directional antenna. 

3 To set the interference ID, complete the following steps: 
 Press the Interference ID soft key. a
 Press the Threshold soft key. b
 Enter a value, and then press the dBm soft key. c
 Toggle the Interference ID soft key and select On to turn on Interference ID or Off to turn d

it off. 

 

NOTE 
The Interference ID automatically classifies interfering signals over a designated 
spectrum and displays a list of possible signal types corresponding to the selected signal. 

4 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 
monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
If you have saved logging data, you can play them in the Spectrum Replayer mode. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 623 
for more information. 

 
Figure 356 RFoOBSAI spectrum measurement 

 
 

The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it 
captures spectrum activity over time and uses various colors to differentiate spectrum power levels. When 
the directional antenna is used to receive the signal, you will see a change in the amplitude of the tracked 
signal as you change the direction of the antenna and see a change in the Spectrogram colors. The source 
of the signal is located in the direction that results in the highest signal strength. 
 
After setting test parameters as described in “Configuring test parameters” on page 613, you can perform 
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spectrogram measurements. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value, and then press the Sec soft key. b

3 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Press the Position soft key. b
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the c

Enter soft key. 
 To turn the time cursor off, toggle the Time Cursor soft key and select Off. d

 

NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

4 To start a new measurement, press the Reset/Restart soft key. 
5 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 
The spectrogram shows a vertical line on the chart when the marker is enabled on the screen. 
 

Figure 357 RFoOBSAI interference measurement in spectrogram 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 623 
for more information. 

 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly useful for 
measuring power-level variations over time. The RSSI measurement lets you assign power limit line for 
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audible alarms and increase alarm counters every time a signal exceeds a defined limit line. For long-term 
analysis, the spectrogram and RSSI measurements can be automatically saved into an external USB 
memory. Post-analysis can be performed with JDViewer application software. 
 
After configuring test parameters as described in “Configuring test parameters” on page 613, you can 
continue to proceed to the spectrogram measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the alarm parameters, complete the following steps: 

 Press the Alarm soft key. a
 Press the Alarm at soft key, and then select the marker number you want to set. b
 Press the Limit Line soft key to set a threshold for the alarm. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the dBm soft key. e
 Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. f

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as these features use 
the marker position to sound an alarm. See “Using marker” on page 54 for more 
information. 

 Optional. Press the Volume soft key and adjust the volume. g
3 Press the PREV hard key to return to the Measure Setup screen bar. 
4 To start a new measurement, press the Reset/Restart soft key. 
5 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 
Figure 358 RFoOBSAI interference measurement in RSSI 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 623 
for more information. 
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The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference 
analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the limit line 
to create failure points when signals exceed it. The failure points are clearly displayed on the trace timeline 
for quick access during playback. 
 

Procedure 

1 Press the MEASURE hot key. 
2 Press the Spectrum Replayer soft key. 

The file manager window appears. 
3 Select a file to be loaded, and then press the Load soft key. 

The Measure Setup screen menus appear. 
4 Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 

or reverse. 
5 Press the Replay Speed soft key, and then select the speed option: X1, X2, X3, and X4. 
6 Press the Play soft key to start playing. 
7 Press the Pause soft key to pause or stop playing data. 
8 To move to a particular failure position directly and play from there, complete the following steps: 

 Press the Jump to Fail Index soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

9 Optional. Toggle the Time Cursor soft key between On and Off to display or dismiss the time 
cursor on the screen. This key becomes activated when you play logged data in the Spectrogram 
mode. 

 

 

NOTE 
If you connected a USB drive, do not remove it while playing to prevent freezing the USB 
port, which will require you to restart the instrument to get a USB drive recognized again. 

 
Figure 359 RFoOBSAI spectrum replay 

 
 

You can select the display option to view data in a different mode. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select the display option from the choices: Spectrum, Spectrogram, and RSSI. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analysis” on page 623 
for more information. 

 

You can set threshold(s) and display either a single segment line or multi-segment line to analyze the result 
better. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and hide the reference line. 

The straight line appears across the screen to be used as a visual reference only. 

 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line, up to 50 segments. 

 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 
6 To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 
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The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum for 
any technology. When PIM is detected, the normal repair mode is to replace the offending cable and what 
you need to do is replacing the whole cable irrespective of the location of the fault. 
 

You can connect cables with a tap or without a tap as illustrated in Figure 360. If you have connected cables 
directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the 
Measure Setup menu. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 360 Connection diagram for PIM detection 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 
 

 
 

Procedure 

1 Press the MEASURE hot key. 
2 Press the PIM Detection soft key. 
3 Select the PIM detection mode from the following choices: 

–  PIM Detection Single Carrier 

–  PIM Detection Multiple Carriers 

–  Calculated PIM 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Link Rate soft key to set the line rate of the OBSAI RP3 interface between the BB and 

the RRU. 
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3 Select the RP3 line rate option from the choices: 768 Mbps, 1536 Mbps, 3072 Mbps, and  
6144 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 
 
If you select 6144 Mbps, the Scrambler Seed soft key becomes active in the OBSAI 
Parameters menu so that you can specify a scrambler seed. 

4 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 
To turn it off, select Off. 

5 Press the OBSAI Parameters soft key, and then do the following: 
–  To specify Rx RP3 Type and RP3 Address of the received message for link rates  

768 Mbps, 1536 Mbps, and 3072 Mbps, complete the following steps: 

 Select More (1/2) > Rx Address List. a
The Rx Address List box appears. JD700B series lists all Rx messages detected by the 
instrument with RP3 Address and RP3 Type values. 

 From the list, select the message to monitor. b
 Tap the Apply button. c

The instrument automatically sets the RP3 Address and RP3 Type with the selected 
values. 

 

NOTE 
You can also manually specify the RP3 Address and RP3 Type for the received message 
using the Rx RP3 Type and Rx RP3 Address soft keys. 

 If you have selected a WCDMA/FDD message, toggle the WCDMA Link soft key and d
select the link direction between FWD for forward (downlink) and REV for reverse 
(uplink). 

–  To specify Rx RP3 Type and RP3 Address of the received message for link rate 6144 Mbps, 
complete the following steps: 

 Select More (1/2) > Rx Address Valid List. a
The Rx Address List box appears. Unlike the Rx Address List, the Rx Address Valid 
List feature shows only the messages that contain scrambling code seed values. 

 From the list, select the message to monitor. b
 Tap the Apply button. c

The instrument automatically sets the RP3 Address, RP3 Type, and Scrambler Seed 
with the selected values. 

 

NOTE 
You can also manually specify the RP3 Address, RP3 Type, and Scrambler Seed for the 
received message using the Rx RP3 Type, Rx RP3 Address, and Scrambler Seed soft 
keys. 

 If you have selected a WCDMA/FDD message, toggle the WCDMA Link soft key and d
select the link direction between FWD for forward (downlink) and REV for reverse 
(uplink). 

–  To set the port type and transmission clock reference, complete the following steps: 
 Toggle the Port Type soft key and select Slave (default). a
 Press the Tx Clock soft key, and then select Recovered (default). b

6 Press the Bandwidth soft key, and then specify the bandwidth depending on the RP3 type of the 
received signal. 
–  WCDMA/FDD REV (uplink): 5 MHz 

–  WCDMA/FDD FWD (downlink): 3 MHz 

–  LTE: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

The RBW range changes based on this bandwidth setting. 

7 Optional. To use the RF signal generator function, see “Using RF source in RFoOBSAI testing” 
on page 652. 
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The Calculated PIM is used when you want to check any possible existence of PIM before the actual 
measurement. The instrument displays possible PIM in red color. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calculated PIM soft key. 
3 Toggle the Radio Config soft key between Single and Multi and select the mode you want to 

use. 
–  Single: Sets the frequency of Radio 1. 

–  Multi: Sets the frequency of Radio 1 and Radio 2. 

4 Do one of the following: 
–  To set the frequency and span, complete the following steps: 

 Toggle the Mode soft key between Freq and Band and select Freq. a
 Press the Radio [1]2] Frequency soft key. b
 Enter a value by using the numeric keys. c
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. d
 Press the Radio [1|2] Span soft key. e
 Enter a value by using the numeric keys. f
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. g

–  To set the radio band, complete the following steps: 
 Toggle the Mode soft key between Freq and Band and select Band. a
 Press the Radio [1]2] Band soft key. b
 Highlight the radio band to select by using the rotary knob. c
 Press the Select soft key. d

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Connect cables as instructed on the screen. 

 

NOTE 
Make sure that the Tx of RRH is connected to the Rx port of SFP/SFP+ installed in your 
CellAdvisor. 

3 Do one of the following: 
–  To set the uplink center frequency and span to be measured, complete the following steps: 

 Toggle the Unit soft key between Freq and Channel and select Freq. a
 Press the Uplink Center Frequency soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit from the choices: GHz, MHz, kHz, and Hz. d

–  To set the channel number to be measured, complete the following steps: 
 Toggle the Unit soft key between Freq and Channel and select Channel. a
 Press the Channel Std soft key, and then highlight a desired band. b
 Press the Select soft key. c
 Press the Channel Number soft key. d
 Enter a value by using the numeric keys, and then press the Enter soft key. e

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 
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4 Press the Continue soft key, and then follow the instructions on the screen.  
5 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 

 

Figure 361 PIM detection of single radio 

 
 

If your JD700B series has the option 096 RFoOBSAI LTE-FDD Signal Analyzer installed with a license, you 
can performs power and spectrum measurements as well as modulation analysis to test the proper 
transmitter performance of FDD LTE systems over OBSAI.  
 
This instrument provides the following measurement tools for FDD LTE system over OBSAI: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

 Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Frame 

- Time Alignment Error 

- Data Allocation Map 

 Power Statistics CCDF 
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You can connect cables with a tap or without a tap as illustrated in Figure 362. If you have connected cables 
directly from RRH and BBU without using the nTap, you must turn on the through mode (Thru) in the 
Measure Setup menu. 
 
A SFP/SFP+ transceiver that is connected to your JD700B series must be compatible with your DUT and 
you must have your module information such as line rate, wavelength, and mode (MM or SM) handy. 
 

Figure 362 Connection diagram for downlink signal analysis 

With nTap (both Thru On/Off): 
 

 

Without nTap (Thru On only): 

 

 
 

Procedure 

1 Press the MEASURE hot key. 
2 Select Signal Analyzer > LTE-FDD. 
3 Select the downlink signal analysis mode from the following choices: 

–  Spectrum 

–  RF Analysis > Channel Power or Occupied BW 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe, 
Frame, Time Alignement Error, or Data Allocation Map 

–  Power Statistics CCDF 

 

You can set the frequency with either frequency or channel number. If a frequency to be set matches to the 
frequency corresponding to the selected channel standard, the instrument calculates its channel number 
and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
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2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 

To set the channel number: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6 Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

You can set the reference automatically or manually to optimize the display of the trace, as you desire. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Do the following: 

–  To optimize the Y-axis scale automatically, press the Auto Scale soft key. 

–  To set the maximum reference value on the Y-axis manually, complete the following steps: 
 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

 

NOTE 
In the measurements such as Control Channel, Subframe, and Frame, you can select 
the reference option between Relative and Absolute instead. 

3 To set an external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key to complete the entry.  c

 

NOTE 
The instrument displays a measurement result with the set value reflected. For example, 
if you set it to 40 dB, the measurement result compensates 40 dB. 

4 To change the setting of the scale per division, complete the following steps: 
 Select More (1/2) > Scale/Div. a
 Enter a value between 1 and 20 by using the numeric keys. b
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 Press the dB soft key to complete the entry. c
5 To change the scale unit, select More (1/2) > Units, and then select the display unit option from 

the choices: dBm, dBV, dBmV, dBµV, V, and W.  
The scale unit on the screen changes accordingly. 

 

NOTE 
The Scale/Div and Units menus are available in the Spectrum and RF Analysis modes. 

 

 

In the spectrum and RF analysis, you can set the number of measurements to be averaged for the trace 
presentation. A maximum of 100 times of averaging can be set. When the averaging reaches to your setting, 
a new measurement value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Do the following: 

–  To select the single sweep mode, complete the following steps: 
 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot a

key. 
The letter HOLD in red appears and the sweeping is paused. 

 To get a new measurement Press the Sweep Once soft key. b
–  To return to the continuous sweep mode, toggle the Sweep Mode soft key and select 

Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Procedure 

1 Press the MEASURE SETUP hot key  
2 Press the Link Rate soft key to set the line rate of the OBSAI RP3 interface between the BB and 

the RRU. 
3 Select the RP3 line rate option from the choices: 768 Mbps, 1536 Mbps, 3072 Mbps, and  

6144 Mbps. 

 

NOTE 
It is important that you set the link rate correctly to avoid any misleading LOS and LOF 
alarms displayed on the screen. 
 
If you select 6144 Mbps, the Scrambler Seed soft key becomes active in the OBSAI 
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Parameters menu so that you can specify a scrambler seed. 

4 To turn on the through mode if you have not used a tap, toggle the Thru soft key and select On. 
To turn it off, select Off. 

5 Press the OBSAI Parameters soft key, and then do the following: 
–  To specify Rx RP3 Type and RP3 Address of the received message for link rates  

768 Mbps, 1536 Mbps, and 3072 Mbps, complete the following steps: 
 Select More (1/2) > Rx Address List. a

The Rx Address List box appears. JD700B series lists all Rx messages detected by the 
instrument with RP3 Address and RP3 Type values. 

 From the list, select the message to monitor. b
 Tap the Apply button. c

The instrument automatically sets the RP3 Address and RP3 Type with the selected 
values. 

 

NOTE 
You can also manually specify the RP3 Address and RP3 Type for the received message 
using the Rx RP3 Type and Rx RP3 Address soft keys. 

 If you have selected a WCDMA/FDD message, toggle the WCDMA Link soft key and d
select the link direction between FWD for forward (downlink) and REV for reverse 
(uplink). 

–  To specify Rx RP3 Type and RP3 Address of the received message for link rate 6144 Mbps, 
complete the following steps: 

 Select More (1/2) > Rx Address Valid List. a
The Rx Address List box appears. Unlike the Rx Address List, the Rx Address Valid 
List feature shows only the messages that contain scrambling code seed values. 

 From the list, select the message to monitor. b
 Tap the Apply button. c

The instrument automatically sets the RP3 Address, RP3 Type, and Scrambler Seed 
with the selected values. 

 

NOTE 
You can also manually specify the RP3 Address, RP3 Type, and Scrambler Seed for the 
received message using the Rx RP3 Type, Rx RP3 Address, and Scrambler Seed soft 
keys. 

 If you have selected a WCDMA/FDD message, toggle the WCDMA Link soft key and d
select the link direction between FWD for forward (downlink) and REV for reverse 
(uplink). 

–  To set the port type and transmission clock reference, complete the following steps: 
 Toggle the Port Type soft key and select Slave (default). a
 Press the Tx Clock soft key, and then select Recovered (default). b

6 To set the bandwidth of the downlink signal, complete the following steps: 
 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 5 MHz, 10 MHz, 15 MHz, and 20 MHz. b

The RBW range changes based on this bandwidth setting. 
7 Optional. To use the RF signal generator function, see “Using RF source in RFoOBSAI testing” 

on page 652. 

 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Spectrum. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
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4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 
“Setting measure setup” on page 630. 

5 Check your measurement result displayed on the screen. 
6 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the displayed trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4 Optional. Select More (1/2) > Trace Info, and then select the trace number to view the trace’s 
parameter setting information stored at the time of the measurement or None to hide the 
information display. 

5 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 
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Figure 363 Spectrum measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points representing 
the input signal in the time domain, transforms this information into the frequency domain using Fast Fourier 
Transform (FFT), and then calculates the channel power. The effective resolution bandwidth of the frequency 
domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of the 
signal in the LTE channel bandwidth. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > RF Analysis > Channel Power. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 Check your measurement result displayed on the screen. 
6 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 364 Channel power measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, which 
includes 99% of the transmitted power among total transmitted power. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > RF Analysis > Occupied BW. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 Check your measurement result displayed on the screen.  
6 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 365 Occupied bandwidth measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the power of 
each time slot in an LTE signal. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > P vs T (Frame). 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
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key and select the option: Auto, 0, and 1. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details 
by different bandwidth.  

9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 366 Power vs. time (frame) measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain fault 
mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation diagram by 
modulation types. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Constellation. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
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subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

9 Check your measurement result displayed on the screen.  
10 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

8 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

9 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 
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Figure 367 Constellation measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Data Channel measures the constellation for the specified resource block as well as the modulation 
accuracy of each PDSCH at the specified subframe. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Data Channel. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 To enable or disable the event hold feature, toggle the Event Hold soft key and then select On or 
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Off. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

8 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

9 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram for 
the selected resource block. 
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Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

resource block. 

 

Figure 368 Data channel measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Control Channel measures the constellation for the specified control channel as well as modulation 
accuracy of the control channel at the specified subframe. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Control Channel. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
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 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off. 

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

6 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

7 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

8 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 
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You can use the MARKER hard key to place a marker on a control channel and display the IQ diagram for 
the selected channel. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the Channel soft key to select a channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 
3 Press the up/down arrow keys or turn the rotary knob to highlight a channel in the channel 

summary table, and then press the center of the rotary knob. 
4 Toggle the Marker View soft key between On and Off to display or hide the result of the selected 

channel. 

 

Figure 369 Control channel measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
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2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Subframe.  
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
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 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

9 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

10 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

11 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

 

You can use the TRACE/DISPLAY hard key to view the RE and RS power at a specific symbol. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or hide the chart.  

If this setting is on, the MARKER hard key is activated. 

 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 
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Figure 370 Subframe measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Frame measures the modulation accuracy of all the data and control channels at the frame  
(10 ms). 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Frame.  
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

6 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 
combiner or an antenna. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

9 Check your measurement result displayed on the screen.  
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10 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 
monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  

11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

5 To select the PDSCH modulation type, press the PDSCH Modulation Type soft key and then 
select the option from the choices: Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2,  
E-TM3.1, E-TM2, E-TM1.2, and E-TM1.1. 

 

NOTE 
If two or more modulation types are used in a frame, select Auto. If the PDSCH uses the 
same modulation type in a frame or in a subframe, select a specific modulation type to 
get more accurate EVM. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the PDCCH Mode soft key and select REG or Avg. 
–  REG: Calculates EVM based on Resource Element Group 

–  Avg: Calculates EVM after adding all the PDCCH signals from one subframe. 

9 To enable or disable the PDSCH precoding, toggle the PDSCH Precoding soft key and select 
On or Off. 

10 To set the Control Format Indicator, toggle the CFI soft key and select Auto or Manual: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. 

11 To select the number of PHICH groups (Ng), press the PHICH Ng soft key and then select the 
option from the choices: 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 
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Figure 371 Frame measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

In eNode-B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. These 
signals shall be aligned. The time alignment error in Tx diversity is specified as the delay between the 
signals from two antennas at the antenna ports. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Time Alignment Error. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 Toggle the Antenna Config soft key and select Ant0 or Ant1 as needed. 
6 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

8 Optional. To select the cyclic prefix, complete the following steps: 
 Press the Miscellaneous soft key. d
 Toggle the Cyclic Prefix soft key and select Normal or Extended. See “Appendix E – e

Cyclic prefix table” on page 693 for OFDM parameter details by different bandwidth. 
9 Check your measurement result displayed on the screen.  
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10 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 
monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  

11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 372 Time alignment error measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RFoOBSAI signal analysis” on page 
651 for more information. 

 

The Data Allocation Map function represents data allocation as a frame. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Modulation Analysis > Data Allocation Map. 
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 Press the Enter soft key. c



Chapter 16 Performing RFoOBSAI Testing  

 JD700B Series User’s Guide 649 

6 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization. 

7 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Depending on your selected NEM, you may need to turn on or off the inversion of the I and Q 
order by toggling the IQ Invert soft key and selecting On or Off.   

9 Optional. Press the Miscellaneous soft key, and then set other miscellaneous setups as 
described in the following section.  

10 Check your measurement result displayed on the screen.  
11 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key.  
12 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Procedure 

1 To assign a antenna port number automatically or manually, press the Antenna Port soft key 
and select the option: Auto, 0, and 1. 

2 To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or Extended. See 
“Appendix E – Cyclic prefix table” on page 693 for OFDM parameter details by different 
bandwidth. 

3 To turn on or off the Multimedia Broadcast Multicast Service (MBMS) feature, toggle the MBMS 
soft key and select On or Off. For proper MBMS testing, you need to set the Subframe No with 
the same PMCH subframe number. If this setting is on, either PMCH or PDSCH appears on the 
screen depending on the detected channel. 

4 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically or 
manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Display Channel soft key. 
3 Select the display mode from the choice: PDSCH, PMCH, and Both. 

 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
 

Procedure 

1 Press the MARKER hard key. 
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2 Toggle the Marker View soft key between On and Off to display or hide the marker on the chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c

4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Figure 373 Data allocation map measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement characterizes 
the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) versus different 
probabilities. 
 

Procedure 

1 Press the MEASURE hot key to select the measurement mode. 
2 Select Signal Analyzer > LTE-FDD > Power Statistics CCDF.  
3 Configure test parameters as described in the “Configuring test parameters” on page 628. 
4 Press the MEASURE SETUP hot key and set the measurement setups as described in the 

“Setting measure setup” on page 630. 
5 To set the length of the CCDF, complete the following steps: 

 Press the CCDF Length soft key. a
 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary b

knob. 
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 Press the Enter soft key. c
6 Check your measurement result displayed on the screen. 
7 To clear current (C) and history (H) status of OBSAI alarm on LOS and LOF and start a new 

monitoring, press the MEASURE SETUP hot key and then the Clear History soft key. 
8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 374 CCDF measurement with RFoOBSAI LTE-FDD signal analyzer 

 
 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set a limit for RF analysis tests, press the RF Test Limits soft key and then set limits as 

needed, depending on where you are in the measurement mode. 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

3 To set a limit for modulation tests, press the Modulation Test Limits soft key and then set limits 
as needed, depending on where you are in the measurement mode. 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
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detected High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit, Low Limit 

P-SS power Power > P-SS Power High Limit, Low Limit 

S-SS power Power > S-SS Power High Limit, Low Limit 

PBCH power Power > PBCH Power High Limit, Low Limit 

Subframe power Power > Subframe Power High Limit, Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit, Low Limit 

Frame average power Power > Frame Avg Power High Limit, Low Limit 

Time alignment error for MIMO Time Alignment Error > MIMO High Limit 

Time error Time Error High Limit, Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 33 for more information. 

 

If your JD700B series has the signal generator options installed with a license, you can use RF Source or 
CPRI Source, or both. 
 

You can use the RF Source feature to calibrate the uplink noise floor at a given point, check the uplink gain 
and dynamic range, and verify the current RP3 link. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Source soft key. Depending on your selection of measurement mode, you may need 

to select More (1/2) > Source. 
3 Press the RF Source soft key. 
4 To set the frequency of the CW signal to be injected, complete the following steps: 

 Press the Frequency soft key. a
 Enter a value within the frequency range of your instrument. b

–  JD740B series: 25 MHz to 4 GHz 
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–  JD780B series: 5 MHz to 6 GHz 

 

NOTE 
The frequency of the CW signal must be in the uplink band of the RRH under test. 

 Select the unit option from the choices: GHz, MHz, kHz, and Hz. c
5 To set the output level of the CW signal to be injected, complete following steps: 

 Press the Power Level soft key. a
 Enter a value within the output range for the frequency you have set in step 4. b

–  JD740B series: -80 dBm to -30 dBm, 0 dBm 

–  JD780B series: -60 dBm to 10 dBm 

 Press the unit soft key. c
6 To start to inject the set signal, toggle the RF Source soft key and select On. 
7 To stop injecting the signal, toggle the RF Source soft key and select Off. 

 

You can use the OBSAI Source feature to generate CW and six types of E-UTRA Test Model waveforms in 
RFoOBSAI testing for LTE-FDD: CW, E-TM1.1, E-TM1.2, E-TM2, E-TM3.1, E-TM3.2, and E-TM3.3. 
 

Procedure 

1 Make the Tx of a SFP/SFP+ module looped back to the Rx of the same module. 

 

NOTE 
When two SFP/SFP+ modules are installed in both Port 1 and Port 2, the OBSAI source 
always works via the Port 1, which is the primary port. If you want to use the Port 2 for 
this OBSAI signal generation, make sure to eject the module from the Port 1. 

2 Press the MEASURE SETUP hot key. 
3 To set the Tx Clock and Port Type settings correctly, complete the following steps: 

 Press the OBSAI Parameters soft key. a
 Press the Tx Clock soft key and then select Internal. b
 Toggle the Port Type soft key and then select Master. c
 Press the PREV hard key to return to the Measure Setup main menu. d

4 Press the Source soft key. Depending on your selection of measurement mode, you may need 
to select More (1/2) > Source. 

5 Press the OBSAI Source soft key. 
6 To adjust the gain of the waveform to be transmitted in order to prevent an overrun or underrun of 

the RRU, complete the following steps: 
 Press the Gain soft key. a
 Enter a value between -50.00 and 0.00. b
 Press the dB soft key or the ENTER hard key. c

7 To select a waveform to be generated, complete the following steps: 
 Press the Waveforms soft key. a

The Waveform list dialog box appears. 
 Select a signal that you want to generate for your selected NEM. Supported bandwidths are b

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Tap the Apply button on the screen or press the ENTER hard key. c

8 To start to inject the selected signal, toggle the OBSAI Source soft key and select On. 
9 To stop injecting the signal, toggle the OBSAI Source soft key and select Off. 

 
 
 
 



 
 

   

 

 

This chapter provides instructions for using the Channel Scanner function (option 012). Topics discussed in 
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A Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete frequencies 
and multi-channels, indicating when it finds a signal on one of them and then continuing scanning when that 
frequency goes silent. 
 
You can measure up to 20 channels with this channel scanner. Using existing format-based or custom 
parameters, you will be able to easily verify improper multi-channel power levels. 
 

 Channel Scanner 

 Frequency Scanner 

 Custom Scanner (Channel or Frequency) 
 

Figure 375 provides descriptions for each segment of the measurement screen. 
 

Figure 375 Channel scanner screen 

 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
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port of BTS. 

 
Figure 376 Direct connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 377 Indirect connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 
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Figure 378 OTA connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Procedure 

1 Press the MODE hard key. 
2 Press the Channel Scanner soft key. The Channel Scanner mode is selected by default. 
3 To change the measurement mode, press the MEASURE hot key and then select the 

measurement mode: 
–  Channel Scanner 

–  Frequency Scanner 

–  Custom Scanner 

 

You need to set the channel or frequency to be scanned depending on the scanner mode: channel scanner, 
frequency scanner, and custom scanner. Refer to each scanner mode for how to set the channel or 
frequency. 
 

You can set the reference and attenuation levels automatically or manually to optimize the display of the 
traces measured, as you desire. 
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Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the unit soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.  

The scale unit on the screen changes accordingly. 

 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

You can turn the External Offset on and manually set the external offset value. An offset consists of a cable 
loss and a user offset and the measurement result shows the value reflecting both offset values. When the 
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external offset value is set at 40 dB in the Spectrum mode, the measurement result compensates 40 dB at 
both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 100 
times of averaging can be set. When the averaging reaches to your setting, a new measurement value 
replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to hold 
the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

 

NOTE 
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use 
this fast sweep mode to identify the existence of interfering signals. 
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You need to set the channel to be scanned. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
3 Toggle the Link soft key to select the scanning direction and select Fwd (forward) or Rev 

(reverse). 
4 To set the starting channel, complete the following steps: 

 Press the Start Channel soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

5 To set the amount of channel increment in scanning channels, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 To set the integration bandwidth, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

7 To set the number of channels to be displayed in the measurement table, complete the following 
steps: 

 Press the # of Channels soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

Test results can be saved as a .csv file format so that you can work on it in any spreadsheet software. 
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Figure 379 Channel scanner measurement 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 664 for more information. 

 

You need to set the frequency to be scanned. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To set the starting center frequency, complete the following steps: 

 Press the Start Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

3 To set the amount of frequency increment in scanning channels, complete the following steps: 
 Press the Frequency Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

4 To set the integration bandwidth, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the number of frequencies to be displayed in the measurement table, complete the 
following steps: 

 Press the # of Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c
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Figure 380 Frequency scanner measurement 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 664 for more information. 

 

You can customize channels or frequencies to be scanned as you desire. 
 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the scanning direction and select Fwd (forward) or Rev 

(reverse). 
5 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
6 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 
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 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 5-7. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Figure 381 Custom scanner measurement 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 664 for more information. 
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Procedure 

To use the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display or dismiss the limit line. 

 
To use the channel limit: 

1 Press the LIMIT hot key. 
2 Press the Channel Limit soft key to set the limits for each channel index. 
3 Press the Index soft key, and then select the channel/frequency index number by turning the 

rotary knob or using the numeric keys. 
4 Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. 
5 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit. b
 Press the dBm unit soft key. c

6 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit. b
 Press the dBm unit soft key. c

7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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The Power Meter of the JD700B series uses power measurement based on spectrum measurement results 
to provide an accurate power measurement result unlike a general spectrum analyzer, of which power 
accuracy may be degraded if the span is set too wide. 
 
The power meter also provides Pass/Fail indication with user-defined lower and upper limits. 
 
The Power Meter function provides following measurements: 

 Internal RF Power Measurement 

 External RF Power Measurement 

 Optical Power Measurement 
 

Figure 382 provides descriptions for each segment of the measurement screen. 
 

Figure 382 Power measurement screen 

 

 

The internal power measurement of the JD700B series collects powers from the raw data of spectrum 
analyzer in the optimal span and integrates the powers up to the specified user span, which results in an 
accurate power measurement, independent of the span setting. 
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Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS as shown in Figure 383. 

 
Figure 383 Direct connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS as shown in Figure 384. 

 
Figure 384 Indirect connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Procedure 

1 Press the MODE hard key. 
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2 Select More (1/2) > Power Meter > Internal RF Power Meter. 

 

You need to set the frequency range to be measured with either the center frequency/span or the start/stop 
frequencies. You can also set the frequency with the channel number and span. 
 

Procedure 

To set the center frequency and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Start Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Stop Frequency soft key. 
7 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
8 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the channel number and span: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 689 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the sweep direction and select Fwd (forward) or Rev (reverse). 
5 To set the channel number, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key or ENTER hard key to complete the entry. c

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6 To set the span, complete the following steps: 
 Press the Span soft key. a
 Select the span option, from the following choices: b

–  To set the span manually, select Span, enter a value, and then select the unit. 
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–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1 Press the Frequency Step soft key, if the Freq is selected. 
2 Enter a value by using the numeric keys. 
3 Press the unit: GHz, MHz, kHz, or Hz. 

 
Optional. To define the amount of channel increment for the rotary knob: 

1 Press the Channel Step soft key, if the Channel is selected. 
2 Enter a value by using the numeric keys. 
3 Press the Enter soft key. 

 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Display soft key and select the display method: Relative or Absolute. 
3 If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 
4 To specify the display range, complete the following steps: 

 Press the Display Maximum soft key to set the maximum value for the power meter. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c
 Press the Display Minimum soft key to set the minimum value for the power meter. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Press the dBm soft key. f

5 Optional. To enable the external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value between 0 and 60 by using the numeric keys. b
 Press the dB soft key. c

 

The default setting of the sweep mode is Continue. If you want to hold the measurement, you can change 
the sweep mode. 
 

Procedure 

1 Press the SWEEP hot key. 
2 To select the single sweep mode, toggle the Sweep Mode soft key and select Single. You can 

also use the HOLD hot key. 
The letter HOLD in red appears and the sweeping is paused. 

3 To return to the continuous sweep mode, toggle the Sweep Mode soft key and select Continue. 
You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Resolution soft key, and then select the resolution option from the following choices: 

–  0: Displays the reading with no decimal place 

–  1: Displays the reading with one decimal place 

–  2 : Displays the reading with two decimal places 

3 To set the resolution bandwidth, complete the following steps: 
 Press the RBW soft key. a
 Enter a value by using the numeric keys. b
 Press the unit: MHz, kHz, or Hz. c

4 Press the Accuracy Mode soft key, and then select the accuracy mode option:  
Low, Middle, and High. 

5 To specify the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100 by using the numeric keys. b
 Press the Enter soft key. c

6 To set a threshold and view the results with Pass/Fail indication, complete the following steps: 
 Press the LIMIT hot key. a
 Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. b
 Press the High Limit soft key, and then enter a threshold value. c
 Press the dBm unit soft key. d
 Press the Low Limit soft key, and then enter a threshold value. e
 Press the dBm unit soft key. f

7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 385 Internal power measurement 

 
 



Chapter 18 Using Power Meter 

 JD700B Series User’s Guide 671 

This instrument performs radio output power measurement with the use of optional external power sens
ors including JD730 series power sensors. It serves as the highly accurate RF power meter and gives wider 
range of power measurement. 
 

There are two types of power sensors. Directional power sensors are used in in-service power measurement. 
Terminating power sensors are used in out-of-service power measurement. 
 

Table 22 External power sensor type 

Part No. Description Frequency Range Power Range 

JD731B Directional Power Sensor 300-3800 MHz Average: +21.76 to +51.76 dBm 
(0.15 to 150 W) 
Peak: +36.02 to +56.02 dBm 
(4 to 400 W) 

JD732B Terminating Power Sensor 20-3800 MHz Average: -30 to +20 dBm 

JD733A Directional Power Sensor 150-3500 MHz Average/Peak: +20 to +47 dBm 
(0.1 to 50 W) 

JD734B Terminating Power Sensor 20-3800 MHz Peak: -30 to +20 dBm 

JD736B Terminating Power Sensor 20-3800 MHz Average/Peak: -30 to +20 dBm 

 

Procedure 

1 Connect an external power sensor to the USB Host port of the JD700B series and to the RF 
output port of BTS. 
The JD700B series automatically detects and initializes the power sensor connected to the 
instrument. Connecting an external power sensor is mandatory. 

 
Table 23 Terminating power sensor connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Procedure 

1 Connect an external power sensor to the USB Host port of the JD700B series and to the RF 
output port of BTS as shown in Figure 386. 
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The JD700B series automatically detects and initializes the power sensor connected to the 
instrument. Connecting an external power sensor is mandatory. 

 
Figure 386 Directional power sensor connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Procedure 

1 Press the MODE hard key. 
2 Select More (1/2) > Power Meter > External RF Power Meter. 

 

You need to set the frequency to be measured depending on your connected external power sensor. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 Press the Frequency soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Select the unit: GHz, MHz, kHz, or Hz. 

 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Display soft key and select the display method: Relative or Absolute. 
3 If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 
4 To specify the display range, complete the following steps: 

 Press the Display Maximum soft key to set the maximum value for the power meter. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c
 Press the Display Minimum soft key to set the minimum value for the power meter. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
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 Press the dBm soft key. f
5 Optional. To enable the external offset, complete the following steps: 

 Toggle the External Offset soft key and select On. a
 Enter a value between 0 and 60 by using the numeric keys. b
 Press the dB soft key. c

 

Procedure 

1 Press the MEASURE hot key. 
2 Depending your connected power sensor, do one of the following: 

–  For JD736B, select the power range option: Average Power, Peak Power, or Pulse Power. 

–  For JD734B, select Peak Power. 

–  For JD732B, select Average Power. 

–  For JD731B, select the power range option: Forward Avg Power, Reverse Avg Power, 
Forward Peak Power, Pulse Power, or VSWR. 

–  For JD733A, select the power range option: Forward Avg Power, Reverse Avg Power, 
Forward Peak Power, or VSWR. 

3 Press the MEASURE SETUP hot key. 
4 Press the Resolution soft key, and then select the resolution option from the following choices: 

–  0: Displays the reading with no zero decimal place 

–  1: Displays the reading with one decimal place 

–  2: Displays the reading with two decimal places 

5 To set a threshold and view the results with Pass/Fail indication, complete the following steps: 
 Press the LIMIT hot key. a
 Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. b
 Press the High Limit soft key, and then enter a threshold value. c
 Press the dBm unit soft key. d
 Press the Low Limit soft key, and then enter a threshold value. e
 Press the dBm unit soft key. f

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 

 

You can measure and understand a trend of a system output in operation where output power constantly 
varies depending on the amount of calls being processed by the BTS or Repeater. In addition, the Log graph 
benefits you to easily examine the discontinuance of output power caused by the transmission problems or 
defective connection. 
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Figure 387 External power measurement of pulse power 

 
 

The optical power measurement is available in conjunction with MP-series power sensor, which measures 
optical power via a USB connection. 
 

Connecting an external optical power meter is mandatory for power measurements in the Optical Power 
Meter mode. There are two optical power meters (sensors) those can be connected to the instrument via 
USB. See “JD700B Series Common Options” on page 707 for the optional power meters. 
 

Procedure 

1 Connect a MP-series optical power sensor to the USB Host port of the JD700B series as shown 
in Figure 388. 
The OPS indicator appears in the system status bar. 

2 Connect the optical cable from the output port of BTS to the power meter. 

 
Figure 388 Optical power sensor connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 
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Procedure 

1 Press the MODE hard key. 
2 Select More (1/2) > Power Meter > Optical Power Meter. 

The Optical Power Meter screen appears. 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To select your desired wavelength for testing, do one of the following: 

–  To let your instrument detect the wavelength automatically, toggle the Wavelength soft key 
and select Auto. 

–  To select a wavelength from the wavelength list, complete the following steps: 
 Toggle the Wavelength soft key and select Manual. a
 Press the Stdwave soft key. b

The wavelength list box appears. 
 Select the wavelength you want from the list, and then tap the Apply button. c

3 Optional. To edit the wavelength list, complete the following steps: 
 Press the Stored Wavelength soft key. a

The Stored Wavelength dialog box appears. 
 Do the following: b

–  To add a new wavelength, enter a value between 780 and 1650 in the input box,  
and then tap the Add button. 

–  To edit an existing wavelength, highlight a wavelength in the list, enter a new value 
between 780 and 1650 in the input box, and then tap the Edit button. 

–  To delete an existing wavelength from the list, highlight a wavelength in the list, and 
then tap the Delete button. 

 Tap the Apply button to save your changes. c

 

Procedure 

1 After setting the parameters, read the absolute measurement value in dBm on the screen. 
Figure 389 is an example of the measurement screen. To view a relative power, see “Reading a 
relative power” on page 676.  

2 To view the result in mW, complete the following steps: 
 Press the AMP/SCALE hard key. a
 Press the Units soft key, and then select mW. b

3 To set a threshold and view the result with Pass/Fail indication, complete the following steps: 
 Press the LIMIT hot key. a
 Toggle the Threshold soft key between On and Off to enable or disable the Pass/Fail b

indication. 
 Press the Threshold soft key, and then enter a value. c
 Press the dBm unit soft key. d
 Toggle the Alarm soft key between On and Off to enable or disable alarming. e

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 33 for more information. 
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Figure 389 optical power measurement 

 
 

 

NOTE 
If the Wavelength is set to Auto, it displays “Auto” for the modulation frequency. It it is set 
to Manual, the instrument displays a detected modulation frequency. 

 

To view a relative power in dB, you can set a reference value automatically or manually. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Display soft key and select Relative. 
3 Do one of the following: 

–  To let the instrument set the last measurement as a reference, complete the following steps: 
 Toggle the Relative Reference soft key and select Last. a
 Press the Reference Last soft key. b

 

NOTE 
To set or release reference, you can also press and hold the physical round button on the 
connected MP-series power meter for a few seconds until you hear a beep. 

–  To set the reference manually, complete the following steps: 
 Toggle the Relative Reference soft key and select Manual. a
 Press the Reference Manual soft key. b
 Enter a value manually as you desire, and then press the Enter soft key. c

 

Procedure 

1 To hold the measurement, press the HOLD hard key. 
Measurement is paused and the text “Hold” appears. 

2 To resume the measurement, press the HOLD hard key again. 
Measurement is resumed and the text “Hold” disappears. 
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Inspection of fiber optic connections is essential for the optimal performance and longevity of fiber optic 
connectivity. Throughout their lives, fiber connectors must be inspected, analyzed, and cleaned to maintain 
an acceptable level of functionality. The JD700B series makes it fast and easy to troubleshoot and certify 
that every connection at a cell site is optimized for a lifetime of performance. 
 
The JD700B series supports the handheld fiber microscope P5000i that can capture video images from the 
sensor and analyzes the images for fiber end face defects and contamination with reliable PASS/FAIL 
results to guarantee the performance of your optical connections. 
 

Figure 390 provides descriptions for each segment of the measurement screen. 
 

Figure 390 Fiber inspection screen 

 

 

Connecting an optional fiber microscope P5000i is mandatory for fiber inspection and analysis. See 
“JD700B Series Common Options” on page 707 for available options. 
 

Procedure 

1 Connect your fiber microscope P5000i to the USB Host port of the JD700B series. 
The instrument detects the connected microscope automatically and displays the icon. 
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Procedure 

1 Press the MODE hard key. 
2 Select More (1/2) > Fiber Inspection. 

 

You can select analysis profiles and inspection tips from the list. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Profile & Tip soft key. 

The profile and tip pane appears. 
3 To select one of the pre-configured analysis profiles that match the PASS/FAIL criteria in the IEC 

visual inspection standard, complete the following steps: 
 Tap the drop-down list button for the Profile. a
 Select the profile that you want to use, from the following choices: b

–  MM (IEC-61300-3-35) 

–  Ribbon, MM (IEC-61300-3-35) 

–  Ribbon, SM APC (IEC-61300-3-35) 

–  SM APC (IEC-61300-3-35) 

–  SM PC (IEC-61300-3-35) 

–  SM UPC (IEC-61300-3-35) 

 

NOTE 
All of the profiles are factory set and cannot be edited or removed. 

 

4 To select the inspection tip (optical settings) that you want to use, complete the following steps: 
 Tap the drop-down list button for the Tip. a
 Select one of the tips available to your selected profile, from the following choices: b

–  Standard Tips (with BAP1) and Simplex Long Reach (-L) Tips 

–  Ribbon Tips and Ribbon Tips – Long Reach 

 

NOTE 
This setting allows you to select the best optical settings for the type of inspection tip 
that is attached to your microscope probe. 

 

5 Tap the Apply button or press the Apply soft key to save and return to the previous state. 

 

You can set your preferences of auto center and QuickCapture button function. The QuickCapture button is 
the small grey round button on the side of the microscope. 
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Procedure 

1 To set the function of the QuickCapture button on the side of the P5000i, toggle the Test Button 
soft key and select the option from the following choices: 
–  Test: Sets the capture button to function as Test. Pressing the Quickcapture button 

analyzes fiber image as like the Test soft key on your JD700B series. 

–  Freeze: Sets the capture button to function as Freeze. Pressing the Quickcapture button 
captures fiber image as like the Freeze soft key on your JD700B series. 

2 To turn the auto center feature on or off, toggle the Auto Center soft key between On and Off 
and select the option you want to set. Default setting is On. It automatically displays the center of 
the fiber when viewing at high magnification. 

 

Procedure 

1 Connect the fiber to be inspected to the tip of your microscope P5000i. 
The live image of the fiber is displayed on the screen. 
See the user manual of your fiber microscope for details on using the P5000i. 

2 Focus the image by rotating the Focus Control on the P5000i until the image is in focus. 
3 Toggle the Magnification soft key between Low and High and select the option you want to use. 

You can also press the Magnification Control button on either side of the P5000i. 
4 Press the Freeze soft key to capture the properly focused image. 

The text “Capturing…” appears. See Figure 391 for an example of captured image. 
5 Optional. To save the captured image as a file (.png), complete the following steps: 

 Tap the Save PNG soft key. The Save window appears with the on-screen key. a
 Type a file name in the File Name field. b
 Select a folder where you want to save the file, if desired. c
 Press the Save soft key. d

6 Press the Live soft key to return to the live image screen or press the Quit soft key to exit. 

 
Figure 391 Captured fiber image 
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Procedure 

1 Connect the fiber to be inspected to the tip of your microscope P5000i. 
The live image of the fiber is displayed on the screen. 
See the user manual of your fiber microscope for details on using the P5000i. 

2 Focus the image by rotating the Focus Control on the P5000i until the image is in focus. 
3 Toggle the Magnification soft key between Low and High and select the option you want to use. 

You can also press the Magnification Control button on either side of the P5000i. 
4 Press the Test soft key to start fiber analysis. 

The text “Analyzing…” appears. See Figure 392 for an example of fiber analysis results. 
5 Once the test is completed, check the result displayed on the screen with the following 

information: 
–  Image overlay of the zone locations, defects, and scratches 

–  PASS or FAIL result 

–  Specific test result for each zone 

6 To show or hide image overlays, press the Overlay soft key. 
Each time this key is pressed, the selection changes. 

7 Optional. To save the fiber inspection result with specific details as a report (.pdf), complete the 
following steps: 

 Tap the Save PDF soft key. a
The Save window appears with the on-screen key. 

 Type a file name in the File Name field. b
 Select a folder where you want to save the file, if desired. c
 Press the Save soft key. d

The information input window appears. 
 Type in information as required. e
 Tap the Apply button or press the Apply soft key to save and return to the previous state. f

See Figure 393 for an example of generated report. 
8 Press the Live soft key to return to the live image screen or press the Quit soft key to exit the 

fiber inspection. 

 
Figure 392 Analyzed fiber image and fiber inspection result 
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Figure 393 Fiber inspection report 
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 JD785B/JD786B JD788B Supplemental Information 
Inputs and Outputs    

RF In   Spectrum Analyzer 
Connector Type-N female Type-N female  

Impedance 50 Ω 50 Ω Nominal 
Damage Level >+33 dBm, ±50 V DC >+33 dBm, ±50 V DC Nominal 

    
Reflection/RF Out   Cable and Antenna Analyzer 

Connector Type-N female Type-N female  
Impedance 50 Ω 50 Ω Nominal 

Damage Level >+40 dBm, ±50 V DC >+40 dBm, ±50 V DC Nominal 
    

RF In   Cable and Antenna Analyzer 
Connector Type-N female N/A  

Impedance 50 Ω N/A Nominal 
Damage Level >+25 dBm, ±50 V DC N/A Nominal 

    
External Trigger, GPS    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

    
External Ref    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

Input Frequency 10, 13, 15 MHz 10, 13, 15 MHz  
Input Range -5 to +5 dBm -5 to +5 dBm  

    
USB    

USB Host Type A, 1 port Type A, 1 port  
USB Client Type B, 1 port Type B, 1 port  

    
LAN RJ45, 10/100 Base-T RJ45, 10/100 Base-T  

    
SFP/SFP+ MSA compliant MSA compliant In optical hardware option 

    
Audio Jack 3.5 mm headphone 

jack 
3.5 mm headphone 
jack 

 

    
External Power 5.5 mm barrel 

connector 
5.5 mm barrel 
connector 

 

    
Speaker Built-in speaker Built-in speaker  

    
Display    

Type 
 

Size 

Resistive touch 
screen 
8” 

Resistive touch 
screen 
8” 

 
 
LCD backlight, transflective LCD 
with anti-glare coating 

Resolution 800 x 600 800 x 600  
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 JD785B/JD786B JD788B Supplemental Information 
Power    

External DC Input 18 V DC 18 V DC  
Power Consumption 42 W 42 W 54 W maximum when charging 

battery 
    

Battery    
 10.8 V, 7800 mA-h 10.8 V, 7800 mA-h Lithium Ion 

Operating Time > 3 hours (Typical) > 3 hours (Typical) In balance mode 
Charge Time 2.5 hours (80 %) 

5 hours (100 %) 
2.5 hours (80 %) 
5 hours (100 %) 

In case of a fully discharged 
battery 

Storage Temperature 0 to 25°C 
(32 to 77°F) 
 

0 to 25°C 
(32 to 77°F) 
 

The battery pack should be 
stored in an environment with 
low humidity. Extended 
exposure to temperature above 
45°C could degrade battery 
performance and life. 

    
Data Storage    

Internal Maximum 500 MB Maximum 500 MB  
External Limited to the size of 

USB flash drive 
Limited to the size of 
USB flash drive 

Supports USB 2.0 compatible 
memory devices 

    
Environmental    

Operating Temperature 
AC Power 

 
Battery 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
With no derating 
 
At charging 
 
At discharging 

Maximum Humidity 95% RH 95% RH Non-condensing 
Shock and Vibration MIL-PRF-28800F Class 2 MIL-PRF-28800F Class 2  

Storage Temperature -30 to 71°C 
(-22 to 160°F) 

-30 to 71°C 
(-22 to 160°F) 

With the battery pack removed 

    
EMC    
 EN 61326-1:2013 EN 61326-1:2013 Complies with European EMC 
 CISPR11:2009 Class A CISPR11:2009 Class A  

Safety    
 EN 61010-1:2010 EN 61010-1:2010 Complies with European LVD 
 UL 61010-1:2012 & 

CAN/CSA C22.2 No. 
61010-1-12 

UL 61010-4:2012 & 
CAN/CSA C22.2 No. 
61010-1-12 

Complies with TUV NRTL 

Size and Weight (Standard Configuration) 
Weight <4.6 kg (10.1 lb.) <4.2 kg (9.3 lb.) With battery 

    
Size 295 x 195 x 82 (mm) 295 x 195 x 82 (mm) Approximately (W x H x D) 

 11.6 x 7.7 x 3.2 (Inch) 11.6 x 7.7 x 3.2 (Inch)  
    

Warranty    
 2 years 2 years  
    
Calibration Cycle    
 1 year 1 year  
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 JD745B/JD746B JD748B Supplemental Information 
Inputs and Outputs    

RF In   Spectrum Analyzer 
Connector Type-N female Type-N female  

Impedance 50 Ω 50 Ω Nominal 
Damage Level >+40 dBm, ±50 V DC >+40 dBm, ±50 V DC Nominal 

    
Reflection/RF Out   Cable and Antenna Analyzer 

Connector Type-N female Type-N female  
Impedance 50 Ω 50 Ω Nominal 

Damage Level >+37 dBm, ±50 V DC >+37 dBm, ±50 V DC Nominal 
    

RF In   Cable and Antenna Analyzer 
Connector Type-N female N/A  

Impedance 50 Ω N/A Nominal 
Damage Level >+25 dBm, ±50 V DC N/A Nominal 

    
External Trigger, GPS    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

    
External Ref    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

Input Frequency 10, 13, 15 MHz 10, 13, 15 MHz  
Input Range -5 to +5 dBm -5 to +5 dBm  

    
USB    

USB Host Type A, 1 port Type A, 1 port  
USB Client Type B, 1 port Type B, 1 port  

    
LAN RJ45, 10/100 Base-T RJ45, 10/100 Base-T  

    
SFP/SFP+ MSA compliant MSA compliant In optical hardware option 

    
Audio Jack 3.5 mm headphone 

jack 
3.5 mm headphone 
jack 

 

    
External Power 5.5 mm barrel 

connector 
5.5 mm barrel 
connector 

 

    
Speaker Built-in speaker Built-in speaker  

    
Display    

Type 
 

Size 

Resistive touch 
screen 
8” 

Resistive touch 
screen 
8” 

 
 
LCD backlight, transflective LCD 
with anti-glare coating 

Resolution 800 x 600 800 x 600  
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 JD745B/JD746B JD748B Supplemental Information 
Power    

External DC Input 18 V DC 18 V DC  
Power Consumption 42 W 42 W 54 W maximum when charging 

battery 
    

Battery    
 10.8 V, 7800 mA-h 10.8 V, 7800 mA-h Lithium Ion 

Operating Time > 3 hours (Typical) > 3 hours (Typical) In balance mode 
Charge Time 2.5 hours (80 %) 

5 hours (100 %) 
2.5 hours (80 %) 
5 hours (100 %) 

In case of a fully discharged 
battery 

Storage Temperature 0 to 25°C 
(32 to 77°F) 
 

0 to 25°C 
(32 to 77°F) 
 

The battery pack should be 
stored in an environment with 
low humidity. Extended 
exposure to temperature above 
45°C could degrade battery 
performance and life. 

    
Data Storage    

Internal Maximum 500 MB Maximum 500 MB  
External Limited to the size of 

USB flash drive 
Limited to the size of 
USB flash drive 

Supports USB 2.0 compatible 
memory devices 

    
Environmental    

Operating Temperature 
AC Power 

 
Battery 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
With no derating 
 
At charging 
 
At discharging 

Maximum Humidity 95% RH 95% RH Non-condensing 
Shock and Vibration MIL-PRF-28800F Class 2 MIL-PRF-28800F Class 2  

Storage Temperature -30 to 71°C 
(-22 to 160°F) 

-30 to 71°C 
(-22 to 160°F) 

With the battery pack removed 

    
EMC    
 IEC/EN 61326-1:2013 IEC/EN 61326-1:2013 Complies with European EMC 
 CISPR11:2009 Class A CISPR11:2009 Class A  
Safety    
 EN 61010-1:2010 EN 61010-1:2010 Complies with European LVD 
 UL 61010-1:2012 & 

CAN/CSA C22.2 No. 
61010-1-12 
 

UL 61010-4:2012 & 
CAN/CSA C22.2 No. 
61010-1-12 

Complies with TUV NRTL 

Size and Weight (Standard Configuration) 
Weight <4.17 kg (9.19 lb.) <3.77 kg (8.31 lb.) With battery 

    
Size 295 x 195 x 82 (mm) 295 x 195 x 82 (mm) Approximately (W x H x D) 

 11.6 x 7.7 x 3.2 (Inch) 11.6 x 7.7 x 3.2 (Inch)  
    

Warranty    
 2 years 2 years  
    
Calibration Cycle    
 1 year 1 year  
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Cable Type Relative Propagation 
Velocity (V¦) 

Nominal Attenuation dB/m 
@ 1000 MHz 

FSJ1-50A 0.84 0.197 
FSJ250 0.83 0.134 
FSJ4-50B 0.81 0.119 
HCC 12-50J 0.915 0.092 
HCC 158-50J 0.95 0.023 
HCC 300-50J 0.96 0.014 
HCC 312-50J 0.96 0.013 
HCC 78-50J 0.915 0.042 
HF 4-1/8” Cu2Y 0.97 0.01 
HF 5” Cu2Y 0.96 0.007 
HF 6-1/8”Cu2Y 0.97 0.006 
HJ4.5-50 0.92 0.054 
HJ4-50 0.914 0.087 
HJ5-50 0.916 0.042 
HJ7-50A 0.921 0.023 
LDF12-50 0.88 0.022 
LDF4-50A 0.88 0.077 
LDF5-50A 0.89 0.043 
LDF6-50 0.89 0.032 
LDFF7-50A 0.88 0.027 
LMR100 0.8 0.792 
LMR1200 0.88 0.044 
LMR1700 0.89 0.033 
LMR200 0.83 0.344 
LMR240 0.84 0.262 
LMR400 0.85 0.135 
LMR500 0.86 0.109 
LMR600 0.87 0.087 
LMR900 0.87 0.056 
RG142 0.69 0.443 
RG17, 17A 0.659 0.18 
RG174 0.66 0.984 
RG178B 0.69 1.509 
RG187, 188 0.69 1.017 
RG213/U 0.66 0.292 
RG214 0.659 0.292 
RG223 0.659 0.165 
RG55, 55A, 55B 0.659 0.541 
RG58, 58B 0.659 1.574 
RG58A, 58C 0.659 0.787 
RG8, 8A, 10, 10A 0.659 0.262 
RG9, 9A 0.659 0.289 
HFSC-12D(1/2") 0.81 0.112 
HFC-12D(1/2") 0.88 0.072 
HFC-22D(7/8") 0.88 0.041 
HFC-33D(1_1/4") 0.88 0.0294 
HFC-42D(1_5/8") 0.87 0.0243 
RFCX-12D(1/2") 0.88 0.088 
RFCX-22D(7/8") 0.88 0.049 
RFCX-33D(1_1/4") 0.88 0.038 
RFCX-42D(1_5/8") 0.87 0.028 
RFCL-22D(7/8") 0.88 0.044 
RFCL-33D(1_1/4") 0.88 0.034 
RFCL-42D(1_5/8") 0.87 0.0315 
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Standard 
Uplink Downlink 
Start Freq 
(MHz) 

Stop Freq 
(MHz) Valid Channels Start Freq 

(MHz) 
Stop Freq 
(MHz) Valid Channels 

GSM 
GSM 450  450.40  457.60  259≤n≤293 460.40  467.60  259≤n≤293 

GSM 480  478.80  486.00  306≤n≤340 488.80  496.00  306≤n≤340 

GSM 850  824.00  849.00  128≤n≤251 869.00  894.00  128≤n≤251 

P-GSM 900  890.00  915.00  1≤n≤124 935.00  960.00  1≤n≤124 

E-GSM 900  880.00 915.00 
0≤n≤124 

925.00 960.00 
0≤n≤124 

975≤n≤1023 975≤n≤1023 

R-GSM 900  876.00 915.00 
0≤n≤124 

921.00 960.00 
0≤n≤124 

955≤n≤1023 955≤n≤1023 

R-GSM 900 (China)  885.00  889.00  999≤n≤1019 930.00  934.00  999≤n≤1019 

DCS 1800 1710.00  1785.00  512≤n≤885 1805.00  1880.00  512≤n≤885 

PCS 1900 1850.00  1910.00  512≤n≤810 1930.00  1990.00  512≤n≤810 

CDMA 

Band 0 (800) 824.00  849.00  
1≤n≤799 

869.00  894.00  
1≤n≤799 

991≤n≤1023 991≤n≤1023 

Band 1 (NA PCS) 1850.00  1910.00  0≤n≤1199 1930.00  1990.00  0≤n≤1199 

Band 2 (TACS) 872.0125  914.9875  
0≤n≤1000 

917.0125  959.9875  
0≤n≤1000 

1329≤n≤2047 1329≤n≤2047 

Band 3 (JTACS) 887.0125  924.9875  

1≤n≤799 

832.0125  869.9875  

1≤n≤799 

801≤n≤1039 801≤n≤1039 

1041≤n≤1199 1041≤n≤1199 

1201≤n≤1600 1201≤n≤1600 

Band 4 (KR PCS) 1750.00  1780.00  0≤n≤599 1840.00  1870.00  0≤n≤599 

Band 5 (450) 411.675  483.480  

1≤n≤300 

421.6750  493.4800  

1≤n≤300 

539≤n≤871 539≤n≤871 

1039≤n≤1473 1039≤n≤1473 

1792≤n≤2016 1792≤n≤2016 

Band 6 (2100) 1920.00  1980.00  0≤n≤1199 2100.00  2170.00  0≤n≤1199 

Band 7 (700) 776.00  794.00  0≤n≤359 746.00  764.00  0≤n≤359 

Band 8 (1800) 1710.00  1784.95  0≤n≤1499 1805.00  1879.95  0≤n≤1499 

Band 9 (900) 880.00  914.95  0≤n≤699 925.00  959.95  0≤n≤699 

Band 10 (2nd 800) 806.000  900.975  
0≤n≤719 

851.000  939.975  
0≤n≤719 

720≤n≤919 720≤n≤919 

WCDMA 

Band Global       

Band 1 (2100-General) 1920.0  1980.0  9612≤n≤9888 2110.0  2170.0  10562≤n≤10838 

Band 2 (1900-General) 
1850.0  1910.0  

9262≤n≤9538 
1930.0  1990.0  

9662≤n≤9938 

Band 2 (1900-Additional) 12≤n≤287 412≤n≤687 

Band 3 (1800-General) 1710.0  1780.0  937≤n≤1288 1805.0  1880.0  1162≤n≤1513 

Band 4 (1700-General) 
1710.0  1775.0  

1312≤n≤1513 
2110.0  2155.0  

1537≤n≤1738 

Band 4 (1700-Additional) 1662≤n≤1862 1887≤n≤2087 

Band 5 (850-General) 
824.0  849.0  

4132≤n≤4233 
869.0  894.0  

4357≤n≤4458 

Band 5 (850-Additional) 782≤n≤862 1007≤n≤1087 

Band 6 (800-General) 
830.0  840.0  

4162≤n≤4188 
875.0  885.0  

4387≤n≤4413 

Band 6 (800-Additional) 812≤n≤837 1037≤n≤1062 

Band 7 (2600-General) 
2500.0  2570.0  

2012≤n≤2338 
2620.0  2690.0  

2237≤n≤2563 

Band 7 (2600-Additional) 2362≤n≤2687 2587≤n≤2912 

Band 8 (900-General) 880.0  915.0  2712≤n≤2863 925.0  960.0  2937≤n≤3088 

Band 9 (1700-General) 1749.9  1784.9  8762≤n≤8912 1844.9  1879.9  9237≤n≤9387 

Band 10 (1700-General) 
1710.0  1770.0  

2887≤n≤3163 
2110.0  2170.0  

3112≤n≤3388 

Band 10 (1700-Additional) 3187≤n≤3462 3412≤n≤3687 

Band 11 (1500-General) 1427.9  1447.9  3487≤n≤3562 1475.9  1495.9  3712≤n≤3787 

Band 12 (700-General) 
699.0  716.0  

3617≤n≤3678 
729.0  746.0  

3842≤n≤3903 

Band 12 (700-Additional) 3707≤n≤3767 3932≤n≤3992 

Band 13 (700-General) 
777.0  787.0  

3792≤n≤3818 
746.0  756.0  

4017≤n≤4043 

Band 13 (700-Additional) 3842≤n≤3867 4067≤n≤4092 

Band 14 (700-General) 
788.0  798.0  

3892≤n≤3918 
758.0  768.0  

4117≤n≤4143 

Band 14 (700-Additional) 3942≤n≤3967 4167≤n≤4192 

Band 19 (800-General) 
830.0  845.0  

312≤n≤363 
875.0  890.0  

712≤n≤763 

Band 19 (800-Additional) 387≤n≤437 787≤n≤837 

Band 20 (800-General) 832.0  862.0  4287≤n≤4413 791.0  821.0  4512≤n≤4638 

Band 21 (1500-General) 1447.9  1462.9  462≤n≤512 1495.9  1510.9  862≤n≤912 
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Band 22 (3500-General) 3410.0  3490.0  4437≤n≤4813 3510.0  3590.0  4662≤n≤5038 

Band 25 (1900-General) 
1850.0  1915.0  

4887≤n≤5188 
1930.0  1995.0  

5112≤n≤5413 

Band 25 (1900-Additional) 5212≤n≤5512 5437≤n≤5737 

Band 26 (800-General) 
814.0  849.0  

5537≤n≤5688 
859.0  894.0  

5762≤n≤5913 

Band 26 (800-Additional) 5712≤n≤5862 5937≤n≤6087 

LTE-FDD 
Band Global       

Band 1 (2100) 1920.0  1980.0  18000≤n≤18599 2110.0  2170.0  0≤n≤599 

Band 2 (1900) 1850.0  1910.0  18600≤n≤19199 1930.0  1990.0  600≤n≤1199 

Band 3 (1800) 1710.0  1785.0  19200≤n≤19949 1805.0  1880.0  1200≤n≤1949 

Band 4 (1700) 1710.0  1755.0  19950≤n≤20399 2110.0  2155.0  1950≤n≤2399 

Band 5 (850) 824.0  849.0  20400≤n≤20649 869.0  894.0  2400≤n≤2649 

Band 7 (2600) 2500.0  2570.0  20750≤n≤21449 2620.0  2690.0  2750≤n≤3449 

Band 8 (900) 880.0  915.0  21450≤n≤21799 925.0  960.0  3450≤n≤3799 

Band 9 (1700) 1749.9  1784.9  21800≤n≤22149 1844.9  1879.9  3800≤n≤4149 

Band 10 (1700) 1710.0  1770.0  22150≤n≤22749 2110.0  2170.0  4150≤n≤4749 

Band 11 (1500) 1427.9  1447.9  22750≤n≤22949 1475.9  1495.9  4750≤n≤4949 

Band 12 (700) 699.0  716.0  23010≤n≤23179 729.0  746.0  5010≤n≤5179 

Band 13 (700) 777.0  787.0  23180≤n≤23279 746.0  756.0  5180≤n≤5279 

Band 14 (700) 788.0  798.0  23280≤n≤23379 758.0  768.0  5280≤n≤5379 

Band 17 (700) 704.0  716.0  23730≤n≤23849 734.0  746.0  5730≤n≤5849 

Band 18 (800) 815.0  830.0  23850≤n≤23999 860.0  875.0  5850≤n≤5999 

Band 19 (800) 830.0  845.0  24000≤n≤24149 875.0  890.0  6000≤n≤6149 

Band 20 (800) 832.0  862.0  24150≤n≤24449 791.0  821.0  6150≤n≤6449 

Band 21 (1500)  1447.9  1462.9  24450≤n≤24599 1495.9  1510.9  6450≤n≤6599 

Band 22 (3500) 3410.0  3490.0  24600≤n≤25399 3510.0  3590.0  6600≤n≤7399 

Band 23 (2100) 2000.0  2020.0  25500≤n≤25699 2180.0  2200.0  7500≤n≤7699 

Band 24 (1500) 1626.5  1660.5  25700≤n≤26039 1525.0  1559.0  7700≤n≤8039 

Band 25 (1900) 1850.0  1915.0  26040≤n≤26689 1930.0  1995.0  8040≤n≤8689 

Band 26 (800) 814.0  849.0  26690≤n≤27039 859.0  894.0  8690≤n≤9039 

LTE-TDD 

Band Global    

 

Band 33 (1900) 1900.0  1920.0  36000≤n≤36199 

Band 34 (2100) 2010.0  2025.0  36200≤n≤36349 

Band 35 (1850) 1850.0  1910.0  36350≤n≤36949 

Band 36 (1930) 1930.0  1990.0  36950≤n≤37549 

Band 37 (1910) 1910.0  1930.0  37550≤n≤37749 

Band 38 (2570) 2570.0  2620.0  37750≤n≤38249 

Band 39 (1880) 1880.0  1920.0  38250≤n≤38649 

Band 40 (2300) 2300.0  2400.0  38650≤n≤39649 

Band 41 (2496) 2496.0  2690.0  39650≤n≤41589 

Band 42 (3400) 3400.0  3600.0  41590≤n≤43589 

Band 43 (3600) 3600.0  3800.0  43590≤n≤45589 

TD-SCDMA 
FBN 0 1785.0  1805.0  0≤n≤92 

 

FBN 1 1900.0  1920.0  0≤n≤92 

FBN 2 1920.0  1980.0  0≤n≤255 

FBN 3 1920.0  1980.0  0≤n≤36 

FBN 4 1980.0  2010.0  0≤n≤142 

FBN 5 2010.0  2025.0  0≤n≤67 

FBN 6 2100.0  2170.0  0≤n≤255 

FBN 7 2100.0  2170.0  0≤n≤36 

FBN 8 2170.0  2220.0  0≤n≤242 

WiMAX 

ProfR1 (1.25 2150) 2150.625  2159.375  0≤n≤7  

ProfR2 (1.25 2305) 2305.625  2320.625  0≤n≤12 

ProfR3 (1.25 2361) 2361.875  2375.625  13≤n≤24 

ProfR4 (1.25 2500) 2500.625  2688.125  0≤n≤150 

ProfR5 (1.25 3400) 3400.625  3700.625  0≤n≤240 

ProfR6 (3.5 2598) 2524.750  2591.250  0≤n≤38 2598.750  2665.250  0≤n≤38 

ProfR7 (3.5 3461) 3411.750  3443.250  0≤n≤18 3461.750  3493.250  0≤n≤18 

ProfR8 (3.5 3551) 3501.750  3598.000  0≤n≤55 3551.750  3648.000  0≤n≤55 

ProfR9 (3.5 3651) 3601.750  3698.000  0≤n≤55 3651.750  3748.000  0≤n≤55 

ProfR10 (3.5 3751) 3701.750  3798.000  0≤n≤55 3751.750  3848.000  0≤n≤55 

ProfR11 (7 2600) 2526.500  2589.500  0≤n≤36 2600.50  2663.50  0≤n≤36 

ProfR12 (7 3463) 2413.500  3441.500  0≤n≤16 3463.50  3491.50  0≤n≤16 

ProfR13 (7 3553) 3503.500  3596.250  0≤n≤53 3553.50  3646.25  0≤n≤53 

ProfR14 (7 3653) 3603.500  3696.250  0≤n≤53 3653.50  3746.25  0≤n≤53 

ProfR15 (7 3753) 3703.500  3796.250  0≤n≤53 3753.50  3846.25  0≤n≤53 
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ProfR26 (10 5275) 5275.000  5335.000  55≤n≤67  

ProfR27 (10 5740) 5740.000  5830.000  148≤n≤166 

ProfR28 (10 5735) 5735.000  5845.000  147≤n≤169 

ProfR29 (8.75 2304) 2304.375  2395.625  0≤n≤730 
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This information is for the Cable and Antenna Analyzer mode of the JD785B/JD745B Base Station Analyzer 
and the JD786B/JD746B RF Analyzer. 
 
 Return Loss=20log10(VSWR+1/VSWR-1) (dB) 

 VSWR=(10
R.L./20

+1/10
R.L./20

-1) 

 
VSWR Return 

Loss 
(dB) 

Trans. 
Loss 
(dB) 

Volt. 
Refl 
Coeff 

Power 
Trans 
(%) 

Power 
Refl 
(%) 

 VSWR Return 
Loss 
(dB) 

Trans. 
Loss 
(dB) 

Volt. 
Refl 
Coeff 

Power 
Trans 
(%) 

Power 
Refl 
(%) 

1.00 -- 0.000 0.00 100.0 0.0  1.64 12.3 0.263 0.24 94.1 5.9 
1.01 46.1 0.000 0.00 100.0 0.0  1.66 12.1 0.276 0.25 93.8 6.2 
1.02 40.1 0.000 0.01 100.0 0.0  1.68 11.9 0.289 0.25 93.6 6.4 
1.03 36.6 0.001 0.01 100.0 0.0  1.70 11.7 0.302 0.26 93.3 6.7 
1.04 34.2 0.002 0.02 100.0 0.0  1.72 11.5 0.315 0.26 93.0 7.0 
1.05 32.3 0.003 0.02 99.9 0.1  1.74 11.4 0.329 0.27 92.7 7.3 
1.06 30.7 0.004 0.03 99.9 0.1  1.76 11.2 0.342 0.28 92.4 7.6 
1.07 29.4 0.005 0.03 99.9 0.1  1.78 11.0 0.356 0.28 92.1 7.9 
1.08 28.3 0.006 0.04 99.9 0.1  1.80 10.9 0.370 0.29 91.8 8.2 
1.09 27.3 0.008 0.04 99.8 0.2  1.82 10.7 0.384 0.29 91.5 8.5 
1.10 26.4 0.010 0.05 99.8 0.2  1.84 10.6 0.398 0.30 91.3 8.7 
1.11 25.7 0.012 0.05 99.7 0.3  1.86 10.4 0.412 0.30 91.0 9.0 
1.12 24.9 0.014 0.06 99.7 0.3  1.88 10.3 0.426 0.31 90.7 9.3 
1.13 24.3 0.016 0.06 99.6 0.4  1.90 10.2 0.440 0.31 90.4 9.6 
1.14 23.7 0.019 0.07 99.6 0.4  1.92 10.0 0.454 0.32 90.1 9.9 
1.15 23.1 0.021 0.07 99.5 0.5  1.94 9.9 0.468 0.32 89.8 10.2 
1.16 22.6 0.024 0.07 99.5 0.5  1.96 9.8 0.483 0.32 89.5 10.5 
1.17 22.1 0.027 0.08 99.4 0.6  1.98 9.7 0.497 0.33 89.2 10.8 
1.18 21.7 0.030 0.08 99.3 0.7  2.00 9.5 0.512 0.33 88.9 11.1 
1.19 21.2 0.033 0.09 99.2 0.8  2.50 7.4 0.881 0.43 81.6 18.4 
1.20 20.8 0.036 0.09 99.2 0.8  3.00 6.0 1.249 0.50 75.0 25.0 
1.21 20.4 0.039 0.10 99.1 0.9  3.50 5.1 1.603 0.56 69.1 30.9 
1.22 20.1 0.043 0.10 99.0 1.0  4.00 4.4 1.938 0.60 64.0 36.0 
1.23 19.7 0.046 0.10 98.9 1.1  4.50 3.9 2.255 0.64 59.5 40.5 
1.24 19.4 0.050 0.11 98.9 1.1  5.00 3.5 2.553 0.67 55.6 44.4 
1.25 19.1 0.054 0.11 98.8 1.2  5.50 3.2 2.834 0.69 52.1 47.9 
1.26 18.8 0.058 0.12 98.7 1.3  6.00 2.9 3.100 0.71 49.0 51.0 
1.27 18.5 0.062 0.12 98.6 1.4  6.50 2.7 3.351 0.73 46.2 53.8 
1.28 18.2 0.066 0.12 98.5 1.5  7.00 2.5 3.590 0.75 43.7 56.3 
1.29 17.9 0.070 0.13 98.4 1.6  7.50 2.3 3.817 0.76 41.5 58.5 
1.30 17.7 0.075 0.13 98.3 1.7  8.00 2.2 4.033 0.78 39.5 60.5 
1.32 17.2 0.083 0.14 98.1 1.9  8.50 2.1 4.240 0.79 37.7 62.3 
1.34 16.8 0.093 0.15 97.9 2.1  9.00 1.9 4.437 0.80 36.0 64.0 
1.36 16.3 0.102 0.15 97.7 2.3  9.50 1.8 4.626 0.81 34.5 65.5 
1.38 15.9 0.112 0.16 97.5 2.5  10.00 1.7 4.807 0.82 33.1 66.9 
1.40 15.8 0.122 0.17 97.2 2.8  11.00 1.6 5.149 0.83 30.6 69.4 
1.42 15.2 0.133 0.17 97.0 3.0  12.00 1.5 5.466 0.85 28.4 71.6 
1.44 14.9 0.144 0.18 96.7 3.3  13.00 1.3 5.762 0.86 26.5 73.5 
1.46 14.6 0.155 0.19 96.5 3.5  14.00 1.2 6.040 0.87 24.9 75.1 
1.48 14.3 0.166 0.19 96.3 3.7  15.00 1.2 6.301 0.88 23.4 76.6 
1.50 14.0 0.177 0.20 96.0 4.0  16.00 1.1 6.547 0.88 22.1 77.9 
1.52 13.7 0.189 0.21 95.7 4.3  17.00 1.0 6.780 0.89 21.0 79.0 
1.54 13.4 0.201 0.21 95.5 4.5  18.00 1.0 7.002 0.89 19.9 80.1 
1.56 13.2 0.213 0.22 95.2 4.8  19.00 0.9 7.212 0.90 19.0 81.0 
1.58 13.0 0.225 0.22 94.9 5.1  20.00 0.9 7.413 0.90 18.1 81.9 
1.60 12.7 0.238 0.23 94.7 5.3  25.00 0.7 8.299 0.92 14.8 85.2 
1.62 12.5 0.250 0.24 94.4 5.6  30.00 0.6 9.035 0.94 12.5 87.5 
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This information is for the LTE – FDD Signal Analyzer mode and the LTE – TDD Signal Analyzer mode of the 
JD785B/JD745B Base Station Analyzer and the JD788B/JD748B Signal Analyzer. Following table shows 
OFDM parameter details by different bandwidth. 
 
 

Bandwidth Configuration (Downlink) 
Cyclic Prefix Length 

TS µs 

20 MHz 

Normal CP ∆f=15 kHz 
160 for l =0 

144 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 512 for l =0,1,…,5 16.667 

∆f=7.5 kHz 1024 for l =0,1,2 33.333 

15 MHz 

Normal CP ∆f=15 kHz 
120 for l =0 

108 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 384 for l =0,1,…,5 16.667 

∆f=7.5 kHz 768 for l =0,1,2 33.333 

10 MHz 

Normal CP ∆f=15 kHz 
80 for l =0 

72 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 256 for l =0,1,…,5 16.667 

∆f=7.5 kHz 512 for l =0,1,2 33.333 

5 MHz 

Normal CP ∆f=15 kHz 
40 for l =0 

36 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 128 for l =0,1,…,5 16.667 

∆f=7.5 kHz 248 for l =0,1,2 33.333 

3 MHz 

Normal CP ∆f=15 kHz 
20 for l =0 

18 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 64 for l =0,1,…,5 16.667 

∆f=7.5 kHz 128 for l =0,1,2 33.333 

1.4 MHz 

Normal CP ∆f=15 kHz 
10 for l =0 

9 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 32 for l =0,1,…,5 16.667 

∆f=7.5 kHz 64 for l =0,1,2 33.333 
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Motorola’s CDMA/EV-DO base stations (BTS) are optimized with the assistance of Local Maintenance 
Facility (LMF), a Motorola’s software tool that interfaces with the cell site and the instrument. The 
optimization process identifies the accumulated loss (or gain) for all receiving and transmitting paths at the 
cell site and stores that value in the system’s database. 
 

An emulation interface to LMF has been implemented in Viavi’s base station analyzer (JD785B/ 
JD745B) in order to perform BTS optimization procedures. The scope of this emulation is to do maintenance 
tests of TX Calibration and TX Audit required in routine maintenance practices with or without the use of an 
external power sensor. Using the external power sensor, you can get highly accurate measurement results. 
 

Procedure 

1 To connect your instrument both with BTS and PC, do one of the following: 
–  Internal power sensor: Connect the Motorola CDMA/EV-DO BTS with the Spectrum 

Analyzer RF In 50 Ω port of JD785B/JD745B and connect the WinLMF running PC with 
JD785B/JD745B via a hub as illustrated in the Figure 394. 

–  External power sensor: Connect an external power sensor to the USB Host port of JD785B/ 
JD745B and to the BTS and connect the WinLMF running PC with JD785B/JD745B via a 
hub as illustrated in the Figure 395. 

 
Figure 394 Using internal power sensor 
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Figure 395 Using external power sensor 

 
 

Procedure 

1 Press the SYSTEM hot key. 
2 To set the IP address, complete the following steps: 

 Select System Configuration > Ethernet Config > IPv4. a
 Toggle the Mode soft key and select Static. b
 Press the Field > IP Address soft key. c
 Set the IP address as “192.167.10.1”. d

3 Select Remote Interface > LAN > LMF. 
4 To set up the LMF settings, complete the following steps: 

 Press the LMF Settings soft key. a
 Select the power measurement and BTS option from the following choices: b

–  External PM 800 MHz Band for external measurement on cellular basestation 

–  External PM 1900 MHz Band for external meausrement on PCS basestation 

–  Internal PM 800 MHz Band for internal measurement on celluar basestation 

–  Internal PM 1900 MHz Band for internal measurement on PCS basestation 

5 To select the measurement mode, complete the following steps: 
 Press the MODE hard key. a
 Press the Power Meter soft key. b
 Select Internal RF Power Meter or External RF Power Meter depending on your LMF c

settings. The measurement result is displayed on the screen. 
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JD700B series’ Bluetooth mode is used for communication between the instrument and your computer with 
JDRemote or a storage device in order to use the following services if needed. 
 

 Bluetooth Personal Area Network (PAN) profile service for JDRemote. 

 Bluetooth File Transfer Profile (FTP) or Object Push Profile (OPP) service for file transfer from the 
instrument to a Bluetooth storage device. 

 
The Bluetooth Connectivity option includes a pair of Bluetooth USB Parani-UD100 Adapters and 5 dBi 
Dipole Antennas as well as the BlueSoleil application software. 
 

The BlueSoleil application must be installed in your computer prior to making a Bluetooth connection. After 
installing the software, you must disable DHCP Server option in order to use the PAN service properly. 
 

Procedure 

1 Insert the provided CD-ROM into your computer and install the software as instructed. 
The BlueSoleil Space shortcut icon appears on the desktop. 

 

 

NOTE 
For more information on installation, refer to the Quick Start Guide or the User Guide 
provided with the adapter. 

 

2 Double-click the BlueSoleil Space shortcut icon on your computer desktop to launch the 
application. 
The BlueSoleil program window appears. 

3 Right-click the My Device icon (the orange ball) in the center of the window, and then click 
Properties > Services tab. 
The My Device Properties window appears. 

4 Select the Bluetooth Personal Area Network from the list, and then click the Properties button. 
The Bluetooth Personal Area Network Properties window appears. 

5 Click the Options tab, and then uncheck the Enable DHCP Server option. 
 

 

NOTE 
You must uncheck it to disable this option as the Enable DHCP Server option is checked 
by default. 

 

6 Click the OK button. 
The Bluetooth Personal Area Network Properties window dismisses. 

7 Click the OK button. 
The My Device Properties window dismisses. 

 

The JD700B series detects a connected Parani-UD100 USB Bluetooth Adapter automatically. 
 

Procedure 

1 Connect the 5 dBi Dipole Antenna to the Parani-UD100 Bluetooth USB Adapter: one for the 
computer and the other for JD700B series. 

2 Plug in the Bluetooth adapters to the USB port of the computer and the instrument. 
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The instrument detects the connected adapter and turns the Bluetooth mode on automatically. 
The Bluetooth icon appears in the status bar at the top of the instrument screen. 

3 Double-click the BlueSoleil Space icon on the computer desktop to launch the application if not 
opened already. 
The BlueSoleil program window appears. 

4 Double-click the My Device icon (orange ball) in the center of the application window to search 
the JD700B series. 
You can view an added icon around the orange ball labeled with the detected JD700B series’ BD 
address or model and serial numbers. 

5 Right-click the device icon for the JD700B series, and then click the Pair. 
The Bluetooth Passkey window appears. 

6 Enter 0000 in the Passkey box, and then click the OK button. 
The word “Paired” appears on the window. The instrument also turns the Bluetooth Mode on 
automatically and displays the paired device and service information on the screen. 

7 Double-click the device icon for the JD700B series to search services. 
8 Right-click the icon for the JD700B series, and then select either the Connect Bluetooth 

Personal Area Network or the Connect Bluetooth File Transfer. 
 

 

NOTE 
Select one of these services as needed. If the Connect Bluetooth Personal Area Network 
is selected, a fixed IP address (192.168.10.10) is assigned for JD700B series and this 
address must be typed into the TCP/IP setting on JDViewer or JDRemote. See “Setting 
up communication in application” on page 697 for more information. 

 

 

If the Connect Bluetooth Personal Area Network service is selected on BlueSoleil, you need to configure 
communication setting on the application JDViewer or JDRemote by entering the fixed IP address for the 
instrument. 
 

Procedure 

1 Launch the JDViewer application. 
2 Go to Settings > Communication. 

The Settings dialog box appears. 
3 Click the drop-down list in the Instrument pane, and then select the instrument series to be 

communicated. 
4 In the Connection Method pane, select the TCP/IP, and then enter 192.168.10.10 without dots. 
5 Click OK to finish the communication setup. 
6 Go to Load > Connect to make a connection between the instrument and JDViewer. 

JD700B series and JDViewer become ready for communication. 

 

Procedure 

1 Launch the JDRemote application. 
The Select Model dialog box appears. 

2 Select the 740A/B, 780A/B Series, and then click the OK button. 
3 Right-click on the JDRemote window, and then click the Communication. 

The Communication dialog box appears. 
4 Select the TCP/IP, and then enter 192.168.10.10 without dots. 
5 Click OK to finish the communication setup. 
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6 Right-click on the JDRemote window, and then click the Connect. 
This enables communication between the instrument and JDRemote. 

7 Right-click on the JDRemote window, and then click the Start. 
JD700B series and JDRemote become ready for communication. 

8 Optional. To adjust the image quality, complete the following steps: 
 Right-click on the JDRemote. a
 Click the Quality. b
 Select the image quality option among High, Medium, or Low. c

You can improve refresh rate, if experiencing low-quality signal, by adjusting the image 
quality in JDRemote. 

 

JD700B series turns the Bluetooth Mode on automatically if connected. You can also turn it on and off 
manually. 
 

Procedure 

1 Press the SYSTEM hot key. 

2 Press the System Configuration > Remote Interface > Bluetooth soft key. 
The Bluetooth screen appears with the device information. 

3 Toggle the Bluetooth soft key between On and Off to turn it on and off. 
Connecting or disconnecting the adapter also turns the mode on or off automatically. 
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JD700B series can be controlled from the application software JDViewer or JDRemote installed on your 
computer. You must install driver software for the instrument on to the computer if USB Client connection is 
used for communication. 
 

Procedure 

1 Go to Control Panel > System > Device Manager. 
The Device Manager window appears. 

2 Right-click the Unknown Device under the Other Devices, and then click the Update Driver 
Software. 
The Update Driver Software – Unknown Device window appears as shown in Figure 396 below. 

3 Select the Browse my computer for driver software, and then click the Browse button to 
search for the location where the driver software is. 
The Browse For Folder window appears. 

4 Search for the JDRemote folder, and then select the driver folder for the installed OS. 
For example, OSDisk (C:) > Program Files (x86) > JDRemote > Driver > Win7 > 64bit. 

5 Click the OK button. 
The Browse For Folder window dismisses. 

6 Click the Next button to start installation. 
If the Windows Security window appears, select the Install this driver software anyway. 
Installing driver software starts. 

7 Click the Close button at the end of the installation. 

 
Figure 396 Device manager screen 
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JD785B   
9 kHz to 8 GHz Spectrum Analyzer  
5 MHz to 6 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD785B use the designation JD785BU before the respective last three-digit option number. 
JD785B001 2-Port Transmission Measurements 

2
  

JD785B002 Bias Tee (Requires option 01) 
JD785B003 High Power CW Signal Generator  
JD785B008 Optical Hardware 

3
  

JD785B010 GPS Receiver and Antenna  
JD785B011 Interference Analyzer 

4, 5
  

JD785B012 Channel Scanner  
JD785B013 Bluetooth Connectivity  
JD785B014 LTE-FDD RAN Performance Indicator  
JD785B015 LTE-TDD RAN Performance Indicator  
JD785B016 Wi-Fi Connectivity  
JD785B020 cdmaOne/cdma2000 Signal Analyzer  
JD785B021 EV-DO Signal Analyzer (Requires option 20) 
JD785B022 GSM/GPRS/EDGE Signal Analyzer  
JD785B023 WCDMA/HSPA+ Signal Analyzer  
JD785B025 TD-SCDMA Signal Analyzer  
JD785B026 Mobile WiMAX Signal Analyzer  
JD785B028 LTE-FDD Signal Analyzer  
JD785B029 LTE-TDD Signal Analyzer  
JD785B030 LTE Advanced-FDD Signal Analyzer (Requires option 28) 
JD785B031 LTE Advanced-TDD Signal Analyzer (Requires option 29) 
JD785B040 cdmaOne/cdma2000 OTA Analyzer 

5
 (Requires option 10) 

JD785B041 EV-DO OTA Analyzer 
5
 (Requires option 10) 

JD785B042 GSM/GPRS/EDGE OTA Analyzer 
5
 (Requires option 10) 

JD785B043 WCDMA/HSPA+ OTA Analyzer 
5
 (Requires option 10) 

JD785B045 TD-SCDMA OTA Analyzer 
5
 (Requires option 10) 

JD785B046 Mobile WiMAX OTA Analyzer 
5
 (Requires option 10) 

JD785B048 LTE-FDD OTA Analyzer 
5
 (Requires option 10) 

JD785B049 LTE-TDD OTA Analyzer 
5
 (Requires option 10) 

JD785B060 RFoCPRI 614M & 1.2G Interference Analyzer 
6
 (Requires option 08) 

JD785B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD785B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD785B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD785B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD785B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD785B070 RFoOBSAI 768M Interference Analyzer 
6
 (Requires option 08) 

JD785B071 RFoOBSAI 1.5G Interference Analyzer 
6
 (Requires option 08) 

JD785B072 RFoOBSAI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD785B073 RFoOBSAI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD785B081 RFoCPRI LTE-FDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD785B082 RFoCPRI LTE-TDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD785B086 RFoOBSAI LTE-FDD Signal Generator 
6
 (Requires options 08, 70-73) 

JD785B091 RFoCPRI LTE-FDD Signal Analyzer 
6
 (Requires options 08, 60-65) 

JD785B092 RFoCPRI LTE-TDD Signal Analyzer 
6
 (Requires options 08, 60-65) 

JD785B096 RFoOBSAI LTE-FDD Signal Analyzer 
6
 (Requires options 08, 70-73) 

JD785B101 Alcatel-Lucent BBU Emulation 
6
 (Requires options 08) 
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JD785B200 Calibration Service for Asia, North America 
JD785B201 Calibration Service for Latin America, EMEA 
JD785B250 Warranty extension of 1 year for Asia, North America 
JD785B251 Warranty extension of 1 year for Latin America, EMEA 
 
 

  

Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI or RFoOBSAI options 

4 
Highly recommended adding JD785B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap. 

7 
Standard accessories can be purchased separately. 

 

JD786B   
9 kHz to 8 GHz Spectrum Analyzer  
5 MHz to 6 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD786B use the designation JD786BU before the respective last three-digit option number. 
JD786B001 2-Port Transmission Measurements 

2
  

JD786B002 Bias Tee (Requires option 01) 
JD786B003 High Power CW Signal Generator  
JD786B008 Optical Hardware 

3
  

JD786B010 GPS Receiver and Antenna  
JD786B011 Interference Analyzer 

4,5
  

JD786B012 Channel Scanner  
JD786B013 Bluetooth Connectivity  
JD786B016 Wi-Fi Connectivity  
JD786B060 RFoCPRI 614M & 1.2G Interference Analyzer 

6
 (Requires option 08) 

JD786B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD786B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD786B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD786B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD786B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD786B070 RFoOBSAI 768M Interference Analyzer 
6
 (Requires option 08) 

JD786B071 RFoOBSAI 1.5G Interference Analyzer 
6
 (Requires option 08) 

JD786B072 RFoOBSAI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD786B073 RFoOBSAI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD786B081 RFoCPRI LTE-FDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD786B082 RFoCPRI LTE-TDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD786B086 RFoOBSAI LTE-FDD Signal Generator 
6
 (Requires options 08, 70-73) 

JD786B101 Alcatel-Lucent BBU Emulation 
6
 (Requires options 08) 

JD786B200 Calibration Service for Asia, North America 
JD786B201 Calibration Service for Latin America, EMEA 
JD786B250 Warranty extension of 1 year for Asia, North America 



Appendix 

702 JD700B Series User’s Guide 

JD786B251 Warranty extension of 1 year for Latin America, EMEA 
 

Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI or RFoOBSAI options 

4 
Highly recommended adding JD786B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap 

7 
Standard accessories can be purchased separately. 

 

JD788B   
9 kHz to 8 GHz Spectrum Analyzer  
10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD788B use the designation JD788BU before the respective last three-digit option number. 
JD788B001 2-Port Transmission Measurements 

1
 (Requires option 07) 

JD788B003 High Power CW Signal Generator (Requires option 07) 
JD788B007 Signal Generator Hardware  
JD788B008 Optical Hardware 

2
  

JD788B009 20 MHz Demodulation Hardware  
JD788B010 GPS Receiver and Antenna  
JD788B011 Interference Analyzer 

3,4
  

JD788B012 Channel Scanner  
JD788B013 Bluetooth Connectivity  
JD788B014 LTE-FDD RAN Performance Indicator  
JD788B015 LTE-TDD RAN Performance Indicator  
JD786B016 Wi-Fi Connectivity  
JD788B020 cdmaOne/cdma2000 Signal Analyzer (Requires option 09) 
JD788B021 EV-DO Signal Analyzer (Requires options 09 and 20) 
JD788B022 GSM/GPRS/EDGE Signal Analyzer (Requires option 09) 
JD788B023 WCDMA/HSPA+ Signal Analyzer (Requires option 09) 
JD788B025 TD-SCDMA Signal Analyzer (Requires option 09) 
JD788B026 Mobile WiMAX Signal Analyzer (Requires option 09) 
JD788B028 LTE-FDD Signal Analyzer (Requires option 09) 
JD788B029 LTE-TDD Signal Analyzer (Requires option 09) 
JD788B030 LTE Advanced-FDD Signal Analyzer (Requires options 09 and 28) 
JD788B031 LTE Advanced-TDD Signal Analyzer (Requires options 09 and 29) 
JD788B040 cdmaOne/cdma2000 OTA Analyzer 

4
 (Requires options 09 and 10) 

JD788B041 EV-DO OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B042 GSM/GPRS/EDGE OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B043 WCDMA/HSPA+ OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B045 TD-SCDMA OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B046 Mobile WiMAX OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B048 LTE-FDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B049 LTE-TDD OTA Analyzer 
4
 (Requires options 09 and 10) 
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JD788B060 RFoCPRI 614M & 1.2G Interference Analyzer 
5
 (Requires option 08) 

JD788B061 RFoCPRI 2.4G Interference Analyzer 
5
 (Requires option 08) 

JD788B062 RFoCPRI 3.1G Interference Analyzer 
5
 (Requires option 08) 

JD788B063 RFoCPRI 4.9G Interference Analyzer 
5
 (Requires option 08) 

JD788B064 RFoCPRI 6.1G Interference Analyzer 
5
 (Requires option 08) 

JD788B065 RFoCPRI 9.8G Interference Analyzer 
5
 (Requires option 08) 

JD788B070 RFoOBSAI 768M Interference Analyzer 
5
 (Requires option 08) 

JD788B071 RFoOBSAI 1.5G Interference Analyzer 
5
 (Requires option 08) 

JD788B072 RFoOBSAI 3.1G Interference Analyzer 
5
 (Requires option 08) 

JD788B073 RFoOBSAI 6.1G Interference Analyzer 
5
 (Requires option 08) 

JD788B081 RFoCPRI LTE-FDD Signal Generator 
5
 (Requires options 08, 60-65) 

JD788B082 RFoCPRI LTE-TDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD788B086 RFoOBSAI LTE-FDD Signal Generator 
6
 (Requires options 08, 70-73) 

JD788B091 RFoCPRI LTE-FDD Signal Analyzer 
5
 (Requires options 08, 60-65) 

JD788B092 RFoCPRI LTE-TDD Signal Analyzer 
5
 (Requires options 08, 60-65) 

JD788B096 RFoOBSAI LTE-FDD Signal Analyzer 
5
 (Requires options 08, 70-73) 

JD788B101 Alcatel-Lucent BBU Emulation 
6
 (Requires options 08) 

JD788B200 Calibration Service for Asia, North America 
JD788B201 Calibration Service for Latin America, EMEA 
JD788B250 Warranty extension of 1 year for Asia, North America 
JD788B251 Warranty extension of 1 year for Latin America, EMEA 
   
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

6
 

G710550335 Cross LAN Cable (1.5 m) 
6
 

GC73050515 USB A to B Cable (1.8 m) 
6
 

GC72450518 > 1 G Byte USB Memory 
6
 

G710550325 Rechargeable Lithium Ion Battery 
6
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
6
 

G710550316 Stylus Pen 
6
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires dual port calibration kit 

2 
Requires RFoCPRI or RFoOBSAI options 

3 
Highly recommended adding JD788B010 

4 
Highly recommended adding G70005035x and/or G70005036x 

5
 Requires proper SFP/SFP+ transceiver and optical pad 

6 
Standard accessories can be purchased separately. 

 

JD745B   
100 kHz to 4 GHz Spectrum Analyzer  
5 MHz to 4 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 4 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD745B use the designation JD745BU before the respective last three-digit option number. 
JD745B001 2-Port Transmission Measurements 

2
  

JD745B002 Bias Tee (Requires option 01) 
JD745B003 CW Signal Generator  
JD745B008 Optical Hardware 

3
  

JD745B010 GPS Receiver and Antenna  
JD745B011 Interference Analyzer 

4, 5
  

JD745B012 Channel Scanner  
JD745B013 Bluetooth Connectivity  
JD745B014 LTE-FDD RAN Performance Indicator  
JD745B015 LTE-TDD RAN Performance Indicator  
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JD745B016 Wi-Fi Connectivity  
JD745B020 cdmaOne/cdma2000 Signal Analyzer  
JD745B021 EV-DO Signal Analyzer (Requires option 20) 
JD745B022 GSM/GPRS/EDGE Signal Analyzer  
JD745B023 WCDMA/HSPA+ Signal Analyzer  
JD745B025 TD-SCDMA Signal Analyzer  
JD745B026 Mobile WiMAX Signal Analyzer  
JD745B028 LTE-FDD Signal Analyzer  
JD745B029 LTE-TDD Signal Analyzer  
JD745B030 LTE Advanced-FDD Signal Analyzer (Requires option 28) 
JD745B031 LTE Advanced-TDD Signal Analyzer (Requires option 29) 
JD745B040 cdmaOne/cdma2000 OTA Analyzer 

5
 (Requires option 10) 

JD745B041 EV-DO OTA Analyzer 
5
 (Requires option 10) 

JD745B042 GSM/GPRS/EDGE OTA Analyzer 
5
 (Requires option 10) 

JD745B043 WCDMA/HSPA+ OTA Analyzer 
5
 (Requires option 10) 

JD745B045 TD-SCDMA OTA Analyzer 
5
 (Requires option 10) 

JD745B046 Mobile WiMAX OTA Analyzer 
5
 (Requires option 10) 

JD745B048 LTE-FDD OTA Analyzer 
5
 (Requires option 10) 

JD745B049 LTE-TDD OTA Analyzer 
5
 (Requires option 10) 

JD745B060 RFoCPRI 614M & 1.2G Interference Analyzer 
6
 (Requires option 08) 

JD745B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD745B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD745B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD745B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD745B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD745B070 RFoOBSAI 768M Interference Analyzer 
6
 (Requires option 08) 

JD745B071 RFoOBSAI 1.5G Interference Analyzer 
6
 (Requires option 08) 

JD745B072 RFoOBSAI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD745B073 RFoOBSAI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD745B081 RFoCPRI LTE-FDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD745B091 RFoCPRI LTE-FDD Signal Analyzer 
6
 (Requires options 08, 60-65) 

JD745B082 RFoCPRI LTE-TDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD745B086 RFoOBSAI LTE-FDD Signal Generator 
6
 (Requires options 08, 70-73) 

JD745B092 RFoCPRI LTE-TDD Signal Analyzer 
6
 (Requires options 08, 60-65) 

JD745B096 RFoOBSAI LTE-FDD Signal Analyzer 
6
 (Requires options 08, 70-73) 

JD745B101 Alcatel-Lucent BBU Emulation 
6
 (Requires options 08) 

JD745B200 Calibration Service for Asia, North America 
JD745B201 Calibration Service for Latin America, EMEA 
JD745B250 Warranty extension of 1 year for Asia, North America 
JD745B251 Warranty extension of 1 year for Latin America, EMEA 
 
 

  

Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI or RFoOBSAI options 

4 
Highly recommended adding JD745B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap. 

7 
Standard accessories can be purchased separately. 
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JD746B   
100 kHz to 4 GHz Spectrum Analyzer  
5 MHz to 4 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 4 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD746B use the designation JD746BU before the respective last three-digit option number. 
JD746B001 2-Port Transmission Measurements 

2
  

JD746B002 Bias Tee (Requires option 01) 
JD746B003 CW Signal Generator  
JD746B008 Optical Hardware 

3
  

JD746B010 GPS Receiver and Antenna  
JD746B011 Interference Analyzer 

4,5
  

JD746B012 Channel Scanner  
JD746B013 Bluetooth Connectivity  
JD746B016 Wi-Fi Connectivity  
JD746B060 RFoCPRI 614M & 1.2G Interference Analyzer 

6
 (Requires option 08) 

JD746B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD746B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD746B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD746B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD746B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD746B070 RFoOBSAI 768M Interference Analyzer 
6
 (Requires option 08) 

JD746B071 RFoOBSAI 1.5G Interference Analyzer 
6
 (Requires option 08) 

JD746B072 RFoOBSAI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD746B073 RFoOBSAI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD746B081 RFoCPRI LTE-FDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD746B082 RFoCPRI LTE-TDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD746B086 RFoOBSAI LTE-FDD Signal Generator 
6
 (Requires options 08, 70-73) 

JD746B101 Alcatel-Lucent BBU Emulation 
6
 (Requires options 08) 

JD746B200 Calibration Service for Asia, North America 
JD746B201 Calibration Service for Latin America, EMEA 
JD746B250 Warranty extension of 1 year for Asia, North America 
JD746B251 Warranty extension of 1 year for Latin America, EMEA 

 
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI or RFoOBSAI options 

4 
Highly recommended adding JD746B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap 

7 
Standard accessories can be purchased separately. 
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JD748B   
100 kHz to 4 GHz Spectrum Analyzer  
10 MHz to 4 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD748B use the designation JD748BU before the respective last three-digit option 
number. 
JD748B001 2-Port Transmission Measurements 

1
 (Requires option 07) 

JD748B003 CW Signal Generator (Requires option 07) 
JD748B007 Signal Generator Hardware  
JD748B008 Optical Hardware 

2
  

JD748B009 20 MHz Demodulation Hardware  
JD748B010 GPS Receiver and Antenna  
JD748B011 Interference Analyzer 

3,4
  

JD748B012 Channel Scanner  
JD748B013 Bluetooth Connectivity  
JD748B014 LTE-FDD RAN Performance Indicator  
JD748B015 LTE-TDD RAN Performance Indicator  
JD748B016 Wi-Fi Connectivity  
JD748B020 cdmaOne/cdma2000 Signal Analyzer (Requires option 09) 
JD748B021 EV-DO Signal Analyzer (Requires options 09 and 20) 
JD748B022 GSM/GPRS/EDGE Signal Analyzer (Requires option 09) 
JD748B023 WCDMA/HSPA+ Signal Analyzer (Requires option 09) 
JD748B025 TD-SCDMA Signal Analyzer (Requires option 09) 
JD748B026 Mobile WiMAX Signal Analyzer (Requires option 09) 
JD748B028 LTE-FDD Signal Analyzer (Requires option 09) 
JD748B029 LTE-TDD Signal Analyzer (Requires option 09) 
JD748B030 LTE Advanced-FDD Signal Analyzer (Requires options 09 and 28) 
JD748B031 LTE Advanced-TDD Signal Analyzer (Requires options 09 and 29) 
JD748B040 cdmaOne/cdma2000 OTA Analyzer 

4
 (Requires options 09 and 10) 

JD748B041 EV-DO OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B042 GSM/GPRS/EDGE OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B043 WCDMA/HSPA+ OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B045 TD-SCDMA OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B046 Mobile WiMAX OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B048 LTE-FDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B049 LTE-TDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B060 RFoCPRI 614M & 1.2G Interference Analyzer 
5
 (Requires option 08) 

JD748B061 RFoCPRI 2.4G Interference Analyzer 
5
 (Requires option 08) 

JD748B062 RFoCPRI 3.1G Interference Analyzer 
5
 (Requires option 08) 

JD748B063 RFoCPRI 4.9G Interference Analyzer 
5
 (Requires option 08) 

JD748B064 RFoCPRI 6.1G Interference Analyzer 
5
 (Requires option 08) 

JD748B065 RFoCPRI 9.8G Interference Analyzer 
5
 (Requires option 08) 

JD748B070 RFoOBSAI 768M Interference Analyzer 
5
 (Requires option 08) 

JD748B071 RFoOBSAI 1.5G Interference Analyzer 
5
 (Requires option 08) 

JD748B072 RFoOBSAI 3.1G Interference Analyzer 
5
 (Requires option 08) 

JD748B073 RFoOBSAI 6.1G Interference Analyzer 
5
 (Requires option 08) 

JD748B081 RFoCPRI LTE-FDD Signal Generator 
5
 (Requires options 08, 60-65) 

JD748B082 RFoCPRI LTE-TDD Signal Generator 
6
 (Requires options 08, 60-65) 

JD748B086 RFoOBSAI LTE-FDD Signal Generator 
6
 (Requires options 08, 70-73) 

JD748B091 RFoCPRI LTE-FDD Signal Analyzer 
5
 (Requires options 08, 60-65) 

JD748B092 RFoCPRI LTE-TDD Signal Analyzer 
6
 (Requires options 08, 60-65) 

JD748B096 RFoOBSAI LTE-FDD Signal Analyzer 
6
 (Requires options 08, 70-73) 

JD788B101 Alcatel-Lucent BBU Emulation 
6
 (Requires options 08) 

JD748B200 Calibration Service for Asia, North America 
JD748B201 Calibration Service for Latin America, EMEA 
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JD748B250 Warranty extension of 1 year for Asia, North America 
JD748B251 Warranty extension of 1 year for Latin America, EMEA 
   
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

6
 

G710550335 Cross LAN Cable (1.5 m) 
6
 

GC73050515 USB A to B Cable (1.8 m) 
6
 

GC72450518 > 1 G Byte USB Memory 
6
 

G710550325 Rechargeable Lithium Ion Battery 
6
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
6
 

G710550316 Stylus Pen 
6
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires dual port calibration kit 

2 
Requires RFoCPRI or RFoOBSAI options 

3 
Highly recommended adding JD748B010 

4 
Highly recommended adding G70005035x and/or G70005036x 

5
 Requires proper SFP/SFP+ transceiver and optical pad 

6 
Standard accessories can be purchased separately. 

 

Optional RF Power Sensors 
JD731B Directional Power Sensor, Peak and Average power 300 to 3800 MHz 
JD732B Terminating Power Sensor, Average Power 20 to 3800 MHz 
JD733A Directional Power Sensor, Peak and Average power 150 to 3500 MHz 
JD734B Terminating Power Sensor, Peak power 20 to 3800 MHz 
JD736B Terminating Power Sensor, Dual (Average/Peak) power 20 to 3800 MHz 
  
  
Optional Optical Power Meters 
MP-60A USB Optical Power Meter, with software, 2.5 mm and 1.25 mm interfaces,  

30" USB extender, carrying pouch 
MP-80A USB Optical Power Meter-High Power, with software, 2.5 mm and 1.25 mm interfaces, 30" 

USB extender, carrying pouch 
  

 
Optional Calibration Kits 
JD78050509 Y-Calibration Kit Type-N(m), DC to 6 GHz, 50 Ω 
JD78050510 Y-Calibration Kit DIN(m), DC to 6 GHz, 50 Ω  
JD78050507 Dual Port Calibration Kit, Type-N(m) 6 GHz 
JD78050508 Dual Port Calibration Kit, DIN(m) 6 GHz 
JD70050509 Electronic Calibration Kit (EZ-Cal

TM
), Type-N(m), DC to 6 GHz, 50  

 
 

Optional Fiber Microscope Kits 
FBP-SD101 FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and 4 Tips 
FBP-MTS-101 FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and 7 Tips 
FIT-SD103 FBP-P5000i Digital Probe, MP-60A USB Power Meter, FiberChekPRO SW, Case, Tips and 

Adapters 
FIT-SD103-C FBP-P5000i Digital Probe, MP-60A USB Power Meter, FiberChekPRO SW, Case, Tips and 

Adapters 
FIT-SD113 FBP-P5000i Digital Probe, MP-80A USB Power Meter, FiberChekPRO SW, Case, Tips and 

Adapters 
 
 

Optional RF Cables 
G710050530 RF Cable DC to 8 GHz Type-N(m) to Type-N(m), 1.0 m 
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G710050531 RF Cable DC to 8 GHz Type-N(m) to Type-N(f), 1.5 m 
G710050532 RF Cable DC to 8 GHz Type-N(m) to Type-N(f), 3.0 m 
G710050533 RF Cable DC to 18 GHz Type-N(m) to SMA(m), 1.5 m 
G710050534 RF Cable DC to 18 GHz Type-N(m) to QMA(m), 1.5 m 
G710050535 RF Cable DC to 18 GHz Type-N(m) to SMB(m),1.5 m 
G710050536 RF Cable DC to 6 GHz Type-N(m) to DIN(f), 1.5 m 
G710050537 RF Cable DC to 4 GHz Type-N(m) to 1.0/2.3 (m), 1.5 m 
G700050540 Phase-Stable RF Cable w Grip DC to 6 GHz Type-N(m) to Type-N(f), 1.5 m 
G700050541 Phase-Stable RF Cable w Grip DC to 6 GHz Type-N(m) to DIN(f), 1.5 m 

 
 

Optional Optic Cables 
G700050401 SM/LC T-Jumper and 1.5 m fiber cable 
G700050402 MM/LC T-Jumper and 1.5 m fiber cable 

 
  
Optional RF Omni Antennas 
G700050353 RF Omni Antenna  Type-N(m), 806 MHz to 896 MHz 
G700050354 RF Omni Antenna  Type-N(m), 870 MHz to 960 MHz 
G700050355 RF Omni Antenna  Type-N(m), 1.71 GHz to 2.17 GHz 
G700050356 RF Omni Antenna  Type-N(m), 720 MHz to 800 MHz 
G700050357 RF Omni Antenna  Type-N(m), 2.3 GHz to 2.7 GHz 

 
 

Optional RF Directional Antennas 
G700050363 RF Yagi Antenna  Type-N(f), 1.75 GHz to 2.39 GHz, 9.8 dBd 
G700050364 RF Yagi Antenna  Type-N(f), 806 MHz to 896 MHz, 10.2 dBd 
G700050365 RF Yagi Antenna  Type-N(f), 866 MHz to 960 MHz, 10.2 dBd 
G700050366 RF Log-periodic Antenna SMA(f), 700 MHz to 4 GHz, 1.85 dBd 
G700050367 RF Log-periodic Antenna SMA(f), 700 MHz to 6 GHz, 2.85 dBd 

 
 

Optional RF Adapters 
G700050571 Adapter Type-N(m) to DIN(f), DC to 7.5 GHz, 50 Ω 
G700050572 Adapter DIN(m) to DIN(m), DC to 7.5 GHz, 50 Ω 
G700050573 Adapter Type-N(m) to SMA(f) DC to 18 GHz, 50 Ω 
G700050574 Adapter Type-N(m) to BNC(f), DC to 4 GHz, 50 Ω 
G700050575 Adapter Type-N(f) to Type-N(f), DC to 18 GHz, 50 Ω 
G700050576 Adapter Type-N(m) to DIN(m), DC to7.5 GHz, 50 Ω 
G700050577 Adapter Type-N(f) to DIN(f), DC to 7.5 GHz, 50 Ω 
G700050578 Adapter Type-N(f) to DIN(m), DC to 7.5 GHz, 50 Ω 
G700050579 Adapter DIN(f) to DIN(f), DC to 7.5 GHz, 50 Ω 
G700050580 Adapter Type-N(m) to Type-N(m), DC to 11 GHz, 50 Ω 
G700050581 Adapter N(m) to QMA(f), DC to 6.0 GHz, 50 Ω 
G700050582 Adapter N(m) to QMA(m), DC to 6.0 GHz, 50 Ω 
G700050583 Adapter N(m) to 4.1/9.5 MINI DIN (f), DC to 6.0 GHz, 50 Ω 
G700050584 Adapter N(m) to 4.1/9.5 MINI DIN (m), DC to 6.0 GHz, 50 Ω 
  

 
StrataSync Subscription 
SS-CA-BSA-AM-01 StrataSync for CellAdvisor BSA - Asset Management-1 Yr. 
SS-CA-BSA-TDM-01 StrataSync for CellAdvisor BSA - Test Data Management-1 Yr. 
SS-CA-RFA-AM-01 StrataSync for CellAdvisor RFA - Asset Management-1 Yr. 
SS-CA-RFA-TDM-01 StrataSync for CellAdvisor RFA - Test Data Management-1 Yr. 
SS-CA-SA-AM-01 StrataSync for CellAdvisor SA - Asset Management-1 Yr. 
SS-CA-SA-TDM-01 StrataSync for CellAdvisor SA - Test Data Management-1 Yr. 
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Optional Miscellaneous 
G710050581 Attenuator 40 dB, 100 W, DC to 4 GHz (Unidirectional) 
G710050585 RF Directional Coupler, 700 to 4000 MHz, 30 dB, 50 W 

Input/Output; Type-N(m) to Type-N(f), Tap Off; Type-N(f)
 1

 
G710050586 RF combiner, 700 to 4000 MHz, Type-N(f) to Type-N(m)

 1
 

G710050587 4x1 RF combiner, 700 to 4000 MHz, Type-N(f) to Type-N(m)
 2

 
G700050601 Bandpass filter 696 MHz to 716 MHz, N(m) to N(f), 50 ohm 
G700050602 Bandpass filter 776 MHz to 788 MHz, N(m) to N(f), 50 ohm 
G700050603 Bandpass filter 806 MHz to 849 MHz, N(m) to N(f), 50 ohm 
G700050604 Bandpass filter 1710 MHz to 1755 MHz, N(m) to N(f), 50 ohm 
G700050605 Bandpass filter 1850 MHz to 1910 MHz, N(m) to N(f), 50 ohm 
JD74050341 Soft carrying case 
JD71050342 Hard Carrying Case 
JD70050342 Hard Carrying Case with wheels 
JD70050343 CellAdvisor Backpack Carrying Case 
JD70050006 USB Bluetooth Dongle and 5 dBi Dipole Antenna 
JD70050007 AntennaAdvisor Handle

3
 

JD71050351 GPS Antenna for JD740 and JD780 Series 
G710550324 External Battery Charger 
JD700B362 JD700B Series User’s Guide – Printed Version 

 

1 
Highly recommended for LTE testing 

2 
Highly recommended for LTE Advanced testing 

3 
Requires G700050366 RF Log-Periodic Antenna 
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This appendix describes the RoHS (Restriction of Hazardous Substances) information, which is a mandatory 
requirement from China. The RoHS directive consists in the restriction on the use of certain hazardous substances in 
electrical or electronic equipment sold or used in the European Union, after July 1, 2006. These substances are: lead, 
mercury, cadmium, hexavalent chromium, polybrominated biphenyls, and polybrominated diphenyl ethers. 
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You can use the on-screen keyboard to type in texts, file names, and folder names. 
 

Procedure 

1 Tap keys on the on-screen keyboard. As you type, each letter is displayed in the name field. If 
you want to change the letter case between uppercase and lowercase, tap the Caps key. 

2 To delete a letter, tap the Back key on the keyboard or press the backspace key on the keypad. 
3 To move the cursor along the name field, tap the < or > key, turn the rotary knob, or touch in 

between letters in the name field. 
4 To delete all the letters displayed in the name field, tap the Clear key on the on-screen keyboard. 

 
Figure 397 On-screen keyboard 

 
 

You can edit and delete a keyword or add a new one, as you desire. 

Procedure 

1 Tap the Edit Keywords bar on the on-screen keyboard. 
The edit keywords keyboard appears. 

2 To edit a keyword, select the keyword box and then change the letters. 
3 To delete a keyword, select the keyword box and then tap the Clear key. 
4 To add a keyword, select a blank keyword box and then type in a keyword. 
5 Tap the Save key on the keyboard to save and continue saving. 
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Figure 398 Edit keywords keyboard 

 
 

You can append a factory-stored or custom-defined keyword, as you want. 
 

Procedure 

1 Tap the Append Keywords bar on the on-screen keyboard. 
The append keywords window appears. 

2 To append a keyword, complete the following steps: 
 Select the keyword tag button to view available keywords for the tag. a
 Select one keyword, from the following choices for each keyword tag: b

 

Keyword tag Keyword (tag value) 

Site-ID* SiteA, SiteB, and SiteC 

Sector* Alpha, Beta, and Gamma 

Technology* GSM900, WCDMA850, and LTE180 

Test Type* RL, VSWR, DTF-RL, DTF-VSWR, and CL 

Termination* Open, Load, and Antenna 

Custom Any keywords you have added 
 

 To delete the keyword you have added to the keyword field, tap the Delete button. c
 To clear the keyword field, tap the Clear button. d

3 Optional. You can edit any of the custom keyword tags or tag values by tapping the Edit Tags 
Values or Edit Tags button, but not the factory keyword tags marked with the asterisk (*). 

 

 

NOTE 
You must keep the keywords marked with the asterisk (*) intact as the StrataSync 
server uses them when transferring data. 

 

4 Select the Separator option from the choices: hyphen [-], underscore [_], and None. 
5 Select the As a filename option between On and Off. If you select Off, the keyword will not be 

placed in a file name, but in the trace/PNG file information. 
6 Tap the Save and Exit button to save and exit or the Keyboard button to return to the keyboard. 
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Figure 399 Append keywords window 
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Your CellAdvisor instrument provides the RAN Performance Indicator feature in the LTE signal analyzer 
mode. Setting map display parameters that your instrument supports is important to have test results as you 
desire as the instrument supports RANAdvisor’s map display parameters with limitations. Following table will 
help you select parameters properly by showing what are supported. 
 

Parameter 
Category 

Parameter Name Support  Parameter 
Category 

Parameter Name Support 

LTE Cell 
Info 
Parameters 

Cell Name   LTE 
Serving 
and 
Neighbor 
Parameters 
(continued) 

N1 RSRP Rx(1) (dBm)  

Cell Identity   N1 RSRP (dBm)  

Physical Cell ID   N1 RSRQ (dB)  

Tracking Area Code   N2 PCI  

MCC   N2 RSRP Rx(0) (dBm)  

MNC   N2 RSRP Rx(1) (dBm)  

DL E-ARFCN   N2 RSRP (dBm)  

UL E-ARFCN   N2 RSRQ (dB)  

DL Bandwidth   N3 PCI  

UL Bandwidth   N3 RSRP Rx(0) (dBm)  

Band Indicator   N3 RSRP Rx(1) (dBm)  

Allowed Access   N3 RSRP (dBm)  

RLC Tx Throughput YES  N3 RSRQ (dB)  

RLC Rx Throughput YES  N4 PCI  

MAC Tx Throughput YES  N4 RSRP Rx(0) (dBm)  

MAX Rx Throughput YES  N4 RSRP Rx(1) (dBm)  

LTE Mode   N4 RSRP (dBm)  

LTE TDD SF Assignment   N4 RSRQ (dB)  

LTE TDD Special SF 
Patterns 

  N5 PCI  

CQI CW0 YES  N5 RSRP Rx(0) (dBm)  

CQI CW1 YES  N5 RSRP Rx(1) (dBm)  

LTE ML1 
Serving Cell 
Measurement 

RSSI RX (0) (dBm) YES  N5 RSRP (dBm)  

RSSI RX (1) (dBm) YES  N5 RSRQ (dB)  

RSSI (dBm) YES  N6 PCI  

RSRP Rx(0) (dBm) YES  N6 RSRP Rx(0) (dBm)  

RSRP Rx(0) (dBm) YES  N6 RSRP Rx(1) (dBm)  

RSRP (dBm) YES  N6 RSRP (dBm)  

RSRQ Rx(0) (dBm) YES  LTE Demod 
Config 
Parameters 

PDSCH RNTI ID  

RSRQ RX(1) (dBm) YES  PDSCH RNTI Type  

RSRQ (dB) YES  eNodeB Tx Antennas  

SINR Rx(0) (dB) YES  eNodeB Rx Antennas  

SINR Rx(1) (dB) YES  Transmission Mode  

PUSCH Tx (dBm) YES  Spatial Rank  

PUCCH Tx (dBm) YES  RB Alloc for Slot 0 (%)  

SRS Tx (dBm) YES  RB Alloc for Slot 1 (%)  

LTE 
Serving and 
Neighbor 
Parameters 

Serving E-ARFCN YES  Freq Selective PMI  

Serving Physical Cell-ID YES  PMI Index  

Serving RSRP (dBm) YES  Stream 0 TBS (bits)  

Serving RSRQ (dB) YES  Stream 0 Modulation YES 

Detected Cells PCI   Traffic to Pilot Block Ratio  

Neighbor Cell Count   Stream 1 TBS (bits)  

N1 PCI   Stream 1 Modulation  

N1 RSRP Rx(0) (dBm)   PB  
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